






	 •	LDMLReference.LassoApp – The Lasso Reference is the definitive source for information about each tag 
in Lasso Dynamic Markup Language. This LassoApp is pre-installed in the LassoApps folder within the Lasso 
Professional 8 application folder.

	 •	RPC.LassoApp – This LassoApp responds to incoming remote procedure calls using the XML-RPC format. 
This LassoApp is pre-installed in the LassoApps folder within the Lasso Professional 8 application folder.

	 •	Startup.LassoApp – This LassoApp defines custom tags and performs initialization for Lasso Security, the 
email sender, and the event queue. This LassoApp is installed in the LassoStartup folder and must be present 
for Lasso Service to start.

The code for each of these LassoApps can be found within the Documentation Folder > 2 - Language Guide 
> LassoApps folder. This code is provided as-is without any warranty or support.

Warning: Do not compile LassoApps with the same name as the LassoSoft supplied LassoApps (e.g. 
Startup.LassoApp or SiteAdmin.LassoApp). LassoSoft cannot provide any support for customized versions of these 
LassoApps or for Lasso Professional 8 installations which make use of customized versions of these LassoApps.

Administration
This section discusses how to enable or disable LassoApp support and how administer the LassoApp cache 
using Lasso tags and within Lasso Site Administration.

Enabling LassoApp Support
Lasso Site Administration includes a global setting to enable or disable LassoApp support. This setting can be 
found in the Setup > Global Settings > LassoApps section of Lasso Site Administration.

When LassoApp support is disabled only the LassoApps which ship with Lasso Professional 8 can be 
served (including Admin.LassoApp, GroupAdmin.LassoApp, LDMLReference.LassoApp, and Startup.LassoApp in the 
LassoStartup folder.

Please see the Site Utilities chapter of the Lasso Professional 8 Setup Guide for more information about 
enabling or disabling LassoApp support.

LassoApp Cache
LassoApps are cached in RAM for efficient serving. Each LassoApp only needs to be read from disk once and 
from then on is served from high-speed memory. LassoApps are read from disk automatically the first time 
they are called so there is no need to pre-load them (unless the fastest performance is required on the first 
load).

Since LassoApps are only read from disk the first time they are called it is necessary to ask Lasso to dump any 
LassoApps that need to be re-read from disk. For example, this is necessary if a new version of a LassoApp is 
copied into the Web serving folder.

LassoApps can be removed from the cache using the Cache page in the Setup > Global Settings > 
LassoApps section of Lasso Site Administration. See the Site Utilities chapter of the Lasso Professional 8 
Setup Guide for more information. LassoApps can also be removed from the cache programatically using the 
following steps.

To remove a LassoApp from the cache:

Use the [LassoApp_Dump] tag with the name of the LassoApp. The following example shows how to remove a 
LassoApp named MySolution.LassoApp from the cache. The LassoApp will be read from disk the next time the 
LassoApp is called.

[LassoApp_Dump: 'MySolution.LassoApp']
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To remove all LassoApps from the cache:

Use the [LassoApp_Dump] tag without any parameters The following example shows how to remove all 
LassoApps from the cache. Each LassoApp will be read from disk the next time it is called.

[LassoApp_Dump]

To preload a LassoApp into the cache:

LassoApps can be preloaded into the cache by calling them from a Web browser or by using the [Include_URL] 
tag. The following example shows how to preload a LassoApp named MySolution.LassoApp using [Include_URL].

[Include_URL: 'http://www.example.com/Lasso/MySolution.LassoApp']

If a LassoApp will be used frequently on the server it can be preloaded using the [Event_Schedule] tag in a Lasso 
page in LassoStartup. The following code would preload a LassoApp named MySolution.LassoApp five minutes 
after Lasso Service is started. The delay is specified so the other initialization steps have a chance to complete 
before the LassoApp is loaded.

[Event_Schedule: -URL='http://www.example.com/MySolution.LassoApp',  
	 -Delay=5]

Serving LassoApps
LassoApps can be served the same way as Lasso pages. They can be served from the Web server root or the 
LassoApps folder in the Lasso Professional 8 application folder, included in other Lasso pages, or placed in the 
LassoStartup folder and executed at startup. This section includes information about how to use LassoApps in 
each of these situations.

Web Serving Folder
LassoApps which are placed in the Web serving folder are served like any Lasso-based Lasso pages. When they 
are referenced by name in HTML anchor tags, HTML form actions, [Include] or [Library] tags, or as the target of a 
-Response… tag. The entry page for the LassoApp is always the page that is served.

Since LassoApps are cached, only one copy of each named LassoApp can be served from a single site in Lasso 
Professional 8. If a second LassoApp with the same name is called the cached copy of the first LassoApp will 
be served in its place. It is important to ensure that multiple copies of the same LassoApp are identical or 
unexpected results can occur.

LassoApps Folder
LassoApps which are placed in the LassoApps folder in the Lasso Professional 8 application folder are served 
when they are referenced by name in HTML anchor tags, HTML form actions, [Include] or [Library] tags, or as the 
target of a -Response… tag. The entry page for the LassoApp is always the page that is served.

Since LassoApps are cached, only one copy of each named LassoApp can be served from a single site in Lasso 
Professional 8. If a second LassoApp with the same name is called the cached copy of the first LassoApp will 
be served in its place. It is important to ensure that multiple copies of the same LassoApp are identical or 
unexpected results can occur.

LassoApp Links
The links in the entry page must be marked with the [LassoApp_Link] tag in order to reference other files 
contained within the LassoApp. See the section on Preparing Solutions for more details. 

The [LassoApp_Link] tag modifies internal links to be of the form LassoAppName.FileNumber.LassoApp. For example, 
the link to the entry page of a LassoApp named MySolution.LassoApp would be formated as follows in the 
source of the LassoApp.

<a href="[LassoApp_Link: 'default.lasso']"> Entry Page </a>
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After the LassoApp is compiled, this link will be changed to the following code. The number referenced in the 
link is determined when the LassoApp is compiled. This number should not be relied on since it may change 
if the LassoApp is recompiled.

<a href="MySolution.0.LassoApp"> Entry Page </a>

The conversion of links marked [LassoApp_Link] is handled automatically. No further action beyond marking 
internal links with the [LassoApp_Link] tag is required. The site visitor will be able to visit any pages which can 
be reached from the entry page within the LassoApp and will be able to view any linked images within the 
LassoApp.

To reference pages in a LassoApp from outside the LassoApp:

Individual pages within a LassoApp can be referenced using the -ResponseLassoApp tag as a parameter to the 
LassoApp name. For example, the entry page (e.g. default.lasso) of the MySolution.LassoApp LassoApp could be 
referenced explicitly using the following link.

<a href="MySolution.LassoApp?-ResponseLassoApp=default.lasso"> Entry Page </a>

The path specified for the -ResponseLassoApp tag should be relative to the folder which was compiled into 
the LassoApp. The -ResponseLassoApp tag should not be used as part of a database action or to specify the 
response file for a database action. It should only be used to return a specific Lasso page or image file from 
within a LassoApp.

Note: By using this technique, even files and images within a LassoApp which cannot be reached from the entry 
page can be viewed if the visitor knows the path to the file they want to view within the LassoApp.

Database Action Responses
The entry page of a LassoApp can be used as the response to a database action by specifying the path to the 
LassoApp as the parameter for any of the -Response… command tags. The following form returns the entry file 
of MySolution.LassoApp as the response to a -FindAll action.

<form action="Action.Lasso" method="POST"> 
	 <input type="hidden" name="-FindAll" value=""> 
	 <input type="hidden" name="-Database" value="Contacts"> 
	 <input type="hidden" name="-Table" value="People"> 
	 <input type="hidden" name="-Response" value="MySolution.LassoApp"> 
	 <input type="submit" name="-FindAll" value="Find All People"> 
</form>

Note: The -ResponseLassoApp tag cannot be used in conjunction with a database action to return a particular page 
from within a LassoApp. Only the entry page of a LassoApp can be returned as the result of a database action.

Lasso Libraries Folder
A LassoApp can define a set of custom tags which are all in the same namespace for on-demand loading. 
The LassoApp should be named with the same name as the namespace of the tags. For example, a LassoApp 
named Example.LassoApp could define a set of custom tags in the Example_ namespace [Example_TagOne], 
[Example_TagTwo], etc.

When Lasso is asked to execute a tag that has not yet been defined it checks in the LassoLibraries folder for a 
tag library with the name of the namespace of the desired tag. The entry page of a matching LassoApp will be 
loaded defining all of the tags within.

Note: All of the tags must be defined within the entry page of the LassoApp.
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Lasso Startup Folder
The entry page of a LassoApp can be executed when Lasso Service starts up by placing the LassoApp file 
within the LassoStartup folder inside the Lasso Professional 8 application folder. The entry file can include 
as many other files within the LassoApp as it needs in order to perform the desired actions. For example, 
the Startup.LassoApp LassoApp located in the LassoStartup folder executes code which defines a number of 
custom tags (e.g. [Email_Send], [Include_URL]) in Lasso Professional 8. Because Startup.LassoApp is located in the 
LassoStartup folder, these custom tags are automatically available upon startup.

Preparing Solutions
Any Lasso-based solution can be compiled into a LassoApp following these preparation instructions. These 
steps require changes to be made to each Lasso page which needs to link to another file within the LassoApp 
and requires files that need to remain user customizable to be stored and referenced outside the LassoApp.

The following steps need to be performed to prepare a solution for compilation as a LassoApp.

	 •	The entire solution must be contained in a single folder including all Lasso pages and image files which 
will be compiled into the LassoApp. The folder should only contain text and GIF or JPEG image files.

	 •	The solution must have a single entry point. One file will be loaded when the LassoApp is called, this file 
must reference other files within the LassoApp either through HTML links, HTML form actions, redirects or 
[Include] tags.

	 •	All links to files or images within the LassoApp must be marked with the [LassoApp_Link] tag. This tag 
changes relative paths to a LassoApp specific format.

Preparing Links
The biggest change required to make most solutions ready to be compiled as a LassoApp is to mark all 
of the links which reference other files within the solution with the [LassoApp_Link] tag. All HTML anchor 
<a ref=" … "> … </a>, image <img>, and form <form> … </form> tags which reference other files within the 
LassoApp need to be marked as well as [Include] and [Library] tags. The [LassoApp_Link] tag is processed when the 
solution is compiled into a LassoApp.

Named anchors, links to targets within the same file, mailto links to email addresses, and links to Web sites on 
other servers do not need to be marked with the [LassoApp_Link] tag.

The [LassoApp_Link] tag can be safely used in any Lasso solution whether it is compiled into a LassoApp or not. 
When used in a non-compiled solution the [LassoApp_Link] simply returns the specified link value unchanged.

Note: The [LassoApp_Link] tag cannot be used within custom tags or custom data types. Since a custom tag could 
be called from a different LassoApp than the one in which it is defined (e.g. if a custom tag is defined in the 
LassoStartup folder, there is no way for Lasso to determine to which LassoApp the [LassoApp_Link] tag should refer. 
See the end of this section for tips on working with custom tags within LassoApps.

To prepare links to other files within the LassoApp:

	 •	Anchor tags which reference other files within the LassoApp need to be marked with the [LassoApp_Link] tag. 
The [LassoApp_Link] tag will accept any relative path which is legal within an HTML anchor tag including 
those which contain ../ to reference files higher in the folder structure. The following example shows an 
HTML anchor tag that references a file named default.lasso contained in a folder named People.

<a href="People/default.lasso"> People Page </a>

After being marked with the [LassoApp_Link] tag this anchor tag appears as follows.

<a href="[LassoApp_Link: 'People/default.lasso']"> People Page </a>

Note: Do not mark named anchors, links to targets within the same file, mailto links to email addresses, or 
links to Web sites on other servers with the [LassoApp_Link] tag.
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	 •	Image tags should be marked with the [LassoApp_Link] tag if the referenced image is contained within 
the compiled LassoApp. The following example shows an HTML image tag that references a file named 
boat.gif  contained in a folder named Images.

<img src="Images/boat.gif" height="288" width="288">

After being marked with the [LassoApp_Link] tag this anchor tag appears as follows.

<img src="[LassoApp_Link: 'Images/boat.gif']" height="288" width="288">

	 •	The action parameter for HTML <form> tags should be marked with the [LassoApp_Link] tag if it reference 
a Lasso page explicitly. The following example shows an HTML <form> tag that references a file named 
result.lasso which is contained in the same folder as the current page.

<form action="result.lasso" method="POST"> 
	 … 
</form>

After being marked with the [LassoApp_Link] tag this HTML <form> tag appears as follows.

<form action="[LassoApp_Link: 'result.lasso']" method="POST"> 
	 … 
</form>

	 •	If an HTML <form> tag references Action.Lasso as its action then the value parameter for the appropriate 
<input> tag for the -Response command tag should be marked with the [LassoApp_Link] tag. The following 
example shows an HTML <form> tag that references Action.Lasso. The response for the form is specified as 
response.lasso in a hidden input for the -Response command tag.

<form action="Action.Lasso" method="POST"> 
	 <input type="hidden" name="-Response" value="response.lasso"> 
	 … 
</form>

After being marked with the [LassoApp_Link] tag the hidden input appears as follows.

<form action="Action.Lasso" method="POST"> 
	 <input type="hidden" name="-Response" 
		  value="[LassoApp_Link: 'response.lasso']"> 
	 … 
</form>

	 •	The file parameter for an [Include] or [Library] tag needs to be marked using the [LassoApp_Link] tag. The 
following examples show an [Include] tag for a file named include.lasso and a [Library] tag for a file library.lasso.

[Include: 'include.lasso']

[Library: 'library.lasso']

After being marked with the [LassoApp_Link] tag the tags appear as follows.

[Include: (LassoApp_Link: 'include.lasso')]

[Library: (LassoApp_Link: 'library.lasso')]

	 •	The response parameter for a [Link_…] tag needs to be marked using the [LassoApp_Link] tag. For example, 
the [Link_DetailURL] tag accepts a -Response parameter which specifies the Lasso page that should be returned 
when the link is selected. The following example shows a [Link_DetailURL] tag used within an HTML anchor 
<a> tag.

<a href="[Link_DetailURL: -Response='response.lasso', -Table='People']"> … </a>

After being marked with the [LassoApp_Link] tag, the [Link_DetailURL] tag appears as follows.

<a href="[Link_DetailURL: -Response=(LassoApp_Link: 'response.lasso'), 
	 -Table='People']"> … </a>
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Notice that only the name of the response page is marked with the [LassoApp_Link] tag, not the entire 
href  attribute of the anchor tag.

To reference files within a LassoApp from a custom tag:

The [LassoApp_Link] tag cannot be used within custom tags and custom data types. The following techniques 
can be used to reference files within a LassoApp from custom tags or custom data types.

	 •	References to files can be stored in variables and referenced by variable name within a custom tag. In the 
following example a reference to a file include.lasso is stored in a variable named IncludeFile. This variable is 
then referenced within a custom tag.

[Variable: 'IncludeFile' = (LassoApp_Link: 'include.lasso')] 
… 
[Define_Tag: 'myInclude'] 
	 [Return: (Include: $IncludeFile)] 
[/Define_Tag]

	 •	References to LassoApp files can be passed into custom tags as parameters. In the following example a 
reference to a file include.lasso is passed as a parameter to a custom tag.

[Define_Tag: 'myInclude', -Required='IncludeFile'] 
	 [Return: (Include: #IncludeFile)] 
[/Define_Tag] 
… 
[myInclude: (LassoApp_Link: 'include.lasso')]

Building LassoApps
LassoApps can be built programmatically using the [LassoApp_Create] tag or can be built using 
LassoApp Builder provided in the Build > LassoApp Builder section of Lasso Site Administration.

Lasso Site Administration
In order to build a LassoApp using LassoApp Builder, the folder containing the files which will be compiled 
into the LassoApp must be within the Web server root or placed in the Lasso Admin/BuildLassoApps folder within 
the site folder of the current site (located within the Lasso Professional 8 application folder).

The path to the root of the LassoApp is entered or the name of the folder to be converted to a LassoApp is 
selected from a pop-up menu. The name of the entry file within the folder must also specified. Any errors 
which occur are reported within the interface. If successful, the completed LassoApp is created in the parent 
of the source folder. The LassoApp will have the same name as the source folder with .LassoApp appended.

See the Site Administration Utlities chapter of the Lasso Professional 8 Setup Guide for complete 
documentation of LassoApp Builder.

To create a LassoApp using LassoApp Builder:

	 1	Place all of the files which will be compiled into the LassoApp into a single folder. The folder should 
only contain Lasso pages and image files. All of the Lasso pages should have been prepared following the 
instructions in the Preparing Solutions section of this chapter.

For example, place the Lasso pages within a folder named MySolution. This folder contains the entry file 
default.lasso, a folder of included sub-files, and a folder of images.

Note: All of the files within the source folder will be compiled into the LassoApp even if some of the files are 
never referenced. In order to create the smallest LassoApps possible, any files which are not needed should 
be removed from the source folder prior to compiling a LassoApp

	 2	Note the location of the MySolution folder within the Web server root or place the folder MySolution into the 
Admin/BuildLassoApps folder within the Lasso Professional 8 application folder.

	 3	Load Lasso Site Administration in a Web browser and go to the Build > LassoApp Builder section.
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http://www.example.com/SiteAdmin.LassoApp

	 4	Enter the path to the MySolution folder or choose MySolution from the pop-up menu and ensure that the entry 
file is default.lasso. Select the Create LassoApp button to create the LassoApp in the Admin/BuildLassoApps 
folder. Or, select the Download LassoApp button to download the created LassoApp through the Web 
browser.

Note: If the name of the source folder is not present in the pop-up menu select the Refresh button.

	 5	If any errors are reported, correct them within the Lasso pages of the solution and then return to Lasso Site 
Administration to build the LassoApp again. The LassoApp Builder must complete without any errors in order 
for a LassoApp file to be created.

	 6	The completed LassoApp will be in the Admin/BuildLassoApps folder named MySolution.LassoApp or will be 
downloaded through the Web browser. This file should be copied into the Web serving folder and can then 
be loaded through a Web browser. If this solution were placed at the root of the Web serving folder it could 
be loaded through the following URL.

http://www.example.com/MySolution.LassoApp

[LassoApp_Create] Tag
In order to build a LassoApp using the [LassoApp_Create] tag the files which will be compiled into a LassoApp 
need to be placed in a single folder on the same machine as Lasso Service.

The parameters for the [LassoApp_Create] tag are detailed in Table 2: [LassoApp_Create] Tag Parameters. An 
example of using the tag to create a LassoApp follows. The [LassoApp_Create] tag will return 0 if it is successful 
creating a LassoApp or an error message otherwise. The tag will replace an existing LassoApp file if the -Result 
parameter specifies a file that already exists.

Table 2: [LassoApp_Create] Tag Parameters

Parameter	 Description	

-Root	 The folder which contains the files that will be compiled into the LassoApp.

-Entry	 The default Lasso page within the LassoApp which will be loaded when the 
LassoApp is called. Should be specified relative to the root folder.

-Result	 The destination file name for the created LassoApp. Must end in the file suffix 
.LassoApp.

		

To create a LassoApp using the [LassoApp_Create] tag:

	 1	Place all of the files which will be compiled into the LassoApp into a single folder. The folder should 
only contain Lasso pages and image files. All of the Lasso pages should have been prepared following 
the instructions in the Preparing Solutions section of this chapter. This folder contains the entry file 
default.lasso, a folder of included sub-files, and a folder of images.

	 2	Create a Lasso page which contains the following [LassoApp_Create] tag. This tag will build a LassoApp 
named MySolution.LassoApp stored at the same location as the root folder defined above. The entry file for the 
LassoApp will be default.lasso immediately inside the MySolution folder.

The [LassoApp_Create] tag would be as follows.

[LassoApp_Create: -Root='/MySolution/', 
	 -Entry='default.lasso', 
	 -Result=''/MySolution.LassoApp']

	 3	If any errors are reported, correct them within the Lasso pages of the solution and then reload the Lasso 
page to build the LassoApp again.

	 4	The completed LassoApp should have been created within the Web serving root and can be loaded through 
the following URL.

http://www.example.com/MySolution.LassoApp
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Tips and Techniques
This section presents a number of tips and techniques which can make creating professional quality 
LassoApps easier.

Naming Conventions
LassoApps should be named with the identifier of the company that created the LassoApp followed by 
the name of the solution. For example, if LassoSoft shipped a phone book LassoApp it could be named 
LS_PhoneBook.LassoApp. This ensures that the LassoApp name will not conflict with LassoApps created by other 
companies.

Warning: Do not compile LassoApps with the same name as the LassoSoft supplied LassoApps (e.g. 
Startup.LassoApp or Admin.LassoApp). LassoSoft cannot provide any warranty or support for customized versions 
of these LassoApps or for Lasso Professional 8 installations which make use of customized versions of these 
LassoApps.

Run-Time Errors
Errors which occur when a LassoApp is executing are reported the same way they are for any Lasso pages. It is 
important to thoroughly test a LassoApp to ensure that all errors are caught and properly reported to the site 
visitor. The [Protect] … [/Protect], [Handle] … [/Handle] and [Fail] tags can be used to trap for errors and handle them 
so that the errors are not reported to the site visitor.

Auto-Building Databases
If a LassoApp requires a database table to store solution-specific data it can be created automatically by the 
LassoApp using the [Database_Create…] tags. Using this technique ensures that a LassoApp can be shipped as a 
single file and cuts down on the installation required by the end-user.

	 •	LassoApps can safely create tables in the Site database within any installation of Lasso Professional 8. This 
database is the appropriate place to store both preferences and solution-specific data.

	 •	Tables created in the Site database should follow a naming convention which includes the name of the 
LassoApp in each table name. For example, a LassoApp named MySolution.LassoApp could create tables 
named MySolution_Preferences and MySolution_Data. Using a clear naming convention ensures that the global 
administrator knows why individual tables were created and ensures that different LassoApps do not create 
tables with the same name.

	 •	If necessary, the LassoApp may need to ask for additional permissions in order to create new tables or 
to gain access to the tables that have been created. See the section on Lasso Security below for more 
information.

	 •	Always check to make sure that a table does not exist before creating a new table. A LassoApp should never 
overwrite data in the Site table without explicitly ensuring that the administrator wants to do so.

Lasso Security
LassoApps are executed with the permissions of the current site visitor the same as any Lasso pages. If a 
LassoApp needs to have access to databases, tables, or tags that can be secured in Lasso Site Administration 
then it should check that the appropriate permissions are present before executing.

Tags

If a LassoApp requires access to tags which can be secured in Lasso Site Administration such as the [Admin_…] 
tags, [Database_Create…] tags, [File_…] tags, [Email_Send] or [Event_Schedule] tags, it should first check to be sure 
those tags are allowed by the current user before executing. The following code will check to be sure the 
[Email_Send] tag is available and display an error message if it is not.
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[If: (Lasso_TagExists: 'Email_Send') == False] 
	 <br>Error: The tag Email_Send is required in order for this LassoApp to execute. 
	 Please enable it within Lasso Site Administration before proceeding. 
[/If]

LassoApps can be created even if the tags they require are not present when they are built and compiled. 
However, syntax errors will be reported when the LassoApp is served or executed.

Databases and Tables

If a LassoApp requires access to certain databases or tables it should first check to be sure they are available 
to the current user before executing. The following code will check to be sure the People table of the 
Contacts database is available.

[Inline: -Database='People', -Table='Contacts', -Show] 
	 [If: (Error_CurretError) != (Error_NoError) || (Field_Name: -Count) == 0] 
		  <br>Error: The People table of  the Contacts database is required  
			   in order for this LassoApp to execute. Please enable it within Lasso 
			   Administration before proceeding. 
	 [/If] 
[/Inline]

Groups and Users

The [Admin_…] tags can be used to create new users and assign them to a group. These tags are essential if 
Lasso Security is going to be used to handle multiple user accounts for a LassoApp. Since there is no tag 
to create a group and assign it permissions, the documentation for a LassoApp solution will need to walk 
a Lasso global administrator through creating a group with the proper name, assigning permissions, and 
creating a group administrator.

Lasso Startup
If code needs to be executed when Lasso Service starts up, then a LassoApp can be placed within the 
LassoStartup folder within the Lasso Professional 8 application folder. Usually, a solution that requires startup 
code would consist of two LassoApps, one that installs in LassoStartup and a second that defines the user 
interface for the solution.
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57
Chapter 57

Custom Tags

This chapter introduces custom tags and shows how they can be created entirely in LassoScript.

	 •	Overview introduces the concepts behind custom tags including naming conventions, namespaces, 
parameter references, and error reporting.

	 •	Custom Tags describes how to create custom tags including information about processing parameters and 
using local variables.

	 •	Container Tags describes how to create custom container tags and looping container tags.

	 •	Web Services, Remote Procedure Calls, and SOAP describes how to create tags that function as remote 
procedure calls through XML-RPC or SOAP and how to call those tags from another server.

	 •	Atomic Tags describes how to create atomic tags which control access to shared resources.

	 •	Asynchronous Tags describes how to create custom asynchronous process tags and background processes.

	 •	Overloading Tags describes how to use criteria to determine which tag will execute and how to redefine 
built-in Lasso tags.

	 •	Constants describes how to create constants in LassoScript.

	 •	Libraries describes how to package sets of custom tags for distribution including how to create on-demand 
tag libraries.

Overview
Lasso Professional 8 allows Web developers to extend LassoScript by creating custom tags programmed using 
Lasso tags.

Custom tags have the following features:

	 •	Custom tags operate just like built-in substitution tags. They can be used in nested expressions, return data 
of any data type, and allow the use of encoding keywords.

	 •	Custom process, substitution, or container tags can be created.

	 •	They can be created in any Lasso page and used instantly.

	 •	They are written in LassoScript. No programming experience or knowledge of a programming language 
other than LassoScript is required.

	 •	They can be collected into libraries of tags which can be loaded into any Lasso page using the [Library] tag.

	 •	Custom tags can be used as the target for remote procedure calls enabling communication between Web 
servers.

	 •	Existing tags can be redefined.

	 •	Tags can be defined with criteria for when they will run. This allows the same tag name to be used with 
different parameters and makes it easy to redefine tags for custom purposes.

	 •	They can be defined in a Lasso page or library within the LassoStartup folder, making them available to all 
pages processed by Lasso.
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	• Atomic tags automatically block when they are called from separate page loads or threads. This allows for controlled 
access to shared resources such as global variables, network connections, etc.

	 •	Asynchronous tags allow operations to be performed in a separate thread so the current Lasso page is 
served as fast as possible to the site visitor.

Custom data types can also be created in LassoScript. See the Custom Types chapter for more information.

Possible Uses
Custom tags can be used in any of the following ways:

	 •	To define a new tag that can be called like any built-in Lasso tags

	 •	To reuse a portion of LassoScript code several times in the same Lasso page.

	 •	To create a macro which allows the same HTML code to be reused several times without being retyped.

	 •	To structure the logic of complex calculations using local variables and tag parameters.

	 •	To redefine and customize existing Lasso tags.

	 •	To defer processing of some code until after the visitor has already received the Lasso page.

	 •	To allow remote Web servers to make remote procedure calls to Lasso through XML-RPC.

Naming Conventions
Lasso Professional 8 has support for tag namespaces. All custom tags which are created by a developer should 
be defined in a namespace unique to the developer. For example, if LassoSoft was providing a custom tag 
which wrapped code with HTML bold tags it might be placed in the LS_ namespace and named [LS_Bold]. All 
of the tags in this guide will be defined in the Ex_ namespace meaning Example.

RPC Note: Tags which will be used for XML-RPC are typically named with a group named followed by a method, 
e.g. group.method.

Parameter References
All values are passed to and from custom tags by reference (unless the -Copy keyword is specified for specific 
parameters when creating the custom tag). This improves the speed and efficiency of custom tags by reducing 
the number of times that data needs to be copied. Parameter references make tags that perform operations on 
their parameters possible, but require careful programming in order to avoid unintended side-effects.

Lasso is an object-oriented system and every value in a given Lasso page can be thought of as an object. 
Variables are simply references to objects and it is possible to have multiple references to the same object.

For example, the [Iterate] … [/Iterate] tag accepts two parameters. The first is an array of values. The second is a 
variable that will be set as a reference to each element in the array in turn. The values are not copied out of 
the array, but the variable points to each value in turn. If the variable modifies the value then that new value 
is automatically modified in the array as well. This code modifies each element in an array to be uppercase.

[Var: 'myArray' = (Array: 'one','two','three')] 
[Iterate: $myArray, (Var: 'myItem')] 
	 [Var: 'myItem' = (String_Uppercase: $myItem)] 
[/Iterate] 
[$myArray]

�	 Array: (ONE), (TWO), (THREE)

Custom tags work similarly. The following rules defined how values are passed to and from custom tags.

	 •	All values passed into a custom tag are passed by reference. References are stored in local variables with the 
same name as the parameter and in a [Params] array.

	 •	If the -Copy keyword is used after specifying a named parameter with the -Required or -Optional keywords then 
that single parameter is passed into the custom tag by copy.
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	 •	Any modifications of the values in the automatically created local variables or the [Params] array will result 
in the original values outside the custom tag being modified.

	 •	It is recommended to use a set of uniquely named local variables within the custom tag so as not to 
interfere with the parameters passed by reference. The values of parameters can be copied into the local 
variables making their modifications safe.

	 •	Local variables are created new for each custom tag call. References to local variables do not persist from 
tag call to tag call.

	 •	All values are returned from a custom tag by reference. Normally this will be a reference to a local variable. 
Since a new set of local variables are created each time a tag is called the return value is safe.

	 •	The return value can also be a reference to one of the input parameters or to a page or global variable. In 
this case any further modifications to the return value after the custom tag has returned will be reflected in 
the original value.

These rules are illustrated in the many examples that follow.

Error Reporting
Lasso has a flexible error reporting system which can be used to control the amount of information provided 
to the site visitor when an error occurs.  Since custom tags are self-contained it is often desirable to develop 
and debug them independent of the site on which they are used.

The [Lasso_ErrorReporting] tag can be used with the -Local keyword to set the error reporting level for the current 
custom tag. Using this tag the error level can be set to Full while developing a tag in order to see detailed error 
messages.

[Lasso_ErrorReporting: 'Full', -Local]

Once the custom tag is debugged and ready for deployment the error reporting level can be adjusted to 
None in order to effectively suppress any details about the coding of the custom tag from being reported.

[Lasso_ErrorReporting: 'None', -Local]

See the Error Controls chapter in the Language Guide for additional details about the [Lasso_ErrorReporting] tag 
and other error control tags.

Custom Tags
Custom tags can be created in LassoScript using the [Define_Tag] … [/Define_Tag] tags. The following table details 
the tags that are used to create custom tags. These tags are used to process the parameters of the custom tag 
and to return values from the custom tag.

Custom substitution and process tags can be created in any Lasso page and will be available immediately. 
Custom container tags can only be created in the LassoStartup folder. See the section on Libraries for 
information about how to create libraries of tags, load tags in LassoStartup, and create tags which can be used 
by any Lasso page.

It is not possible to create custom command tags using LassoScript. Command tags are implemented in data 
source modules. See the documentation on LCAPI later in this book for more information.

See the Custom Types chapter for information about creating custom data types and member tags.

Table 1: Tags For Creating Custom Tags

Tag	 Description	

[Define_Tag]	 Defines a new substitution tag or a new member tag if  used within a type 
definition. Requires a single parameter, the name of  the tag to be defined. Other 
parameters are defined in Table 2: [Define_Tag] Parameters.	

[Local]	 Sets or retrieves the value of  a local variable within a custom tag definition.

[Local_Defined]	 Checks to see if  a local variable has been defined within a custom tag definition.
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[Local_Remove]	 Removes a local variable.

[Locals]	 Returns a map of  all the local variables which have been defined within a custom 
tag definition.

[Params]	 Returns an array of  all the parameters which were passed to the custom tag.

[Params_Up]	 Returns an array of  all the parameters which were passed to the custom tag 
which called the current custom tag.

[Return]	 Returns a value from a custom tag. No further processing is performed.

[Run_Children]	 Process the contents of  a custom tag created with the -Container option.

[Tag_Name]	 Returns the name of  the current tag.
		

The parameters for the [Define_Tag] … [/Define_Tag] tags are detailed in the following table. The type of tag 
created, required parameters, return data type, and more are all specified in the opening [Define_Tag] tag.

Table 2: [Define_Tag] Parameters

Tag	 Description	

'Tag Name'	 The name of  the tag to be defined. Required.

-Namespace	 The name of  the namespace in which the tag is defined. Optional. If  not specified 
then tags will be placed in the current namespace.

-Async	 Specifies that the tag should be run asynchronously. Asynchronous tags cannot 
return a value. Optional.

-Atomic	 Specifies that the tag should run atomically. Only one instance of  that tag will be 
allowed to run. Any other page loads or threads that call the tag will block until 
the first instance has finished running.

-Container	 Specifies that the tag is a container tag. [Run_Children] can be used if  this 
parameter is specified. Optional. See also -Looping for looping container tags.

-Copy	 Specifies that the preceding -Required or -Optional parameter should be copied 
rather than passed by reference.

-Criteria	 Specifies the criteria under which the tag will run. If  the criteria is not met then 
the next tag in the calling chain will be used instead. Optional.

-Description	 A brief  description of  the tag. Can include calling instructions, author of  the tag, 
etc. Optional.

-EncodeNone	 Specifies that the return value of  the tag should not be encoded by default. If  this 
keyword is not specified then the return value will be HTML encoded by default.

-Looping	 Specifies that the tag is a looping container tag. [Run_Children] can be used 
if  this parameter is specified. Optional. See also -Container for non-looping 
container tags.

-Optional	 Names an optional parameter of  the tag. Optional.

-Priority	 Requires the value 'High', 'Low', or 'Replace'. Specifies whether the tag should 
replace an existing tag with the same name or be placed before or after existing 
tags in the calling chain. Optional.

-Privileged	 Specifies that the custom tag should run with the privileges of  the current user 
rather than with the privileges of  the user who ultimately calls the custom tag.

-Required	 Names a required parameter of  the tag. If  the parameter is not specified then an 
error will result. Optional.

-ReturnType	 Specifies the type of  the return value of  the tag. If  a value of  different type is 
returned then an error is generated.

-RPC	 Specifies that the tag should be made available to remote Web servers as a 
remote procedure call. The tag can then be accessed through RPC.LassoApp.

-SOAP	 Specifies that the tag should be made available to remote Web servers as a 
SOAP operation.The tag can then be accessed through RPC.LassoApp.  The 
-Type and -ReturnType tags must be used to specify parameter and return types.
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-Type	 Specifies the type for the preceding -Required or  
-Optional parameter. If  the tag is called with a parameter that is not of  the proper 
type then an error is generated.

		

See the section on Libraries for information about how to create libraries of tags, load tags in LassoStartup, 
and create tags which can be used by any Lasso page.

It is not possible to create custom command tags using LassoScript. See the Custom Types chapter for 
information about creating custom data types and member tags.

Substitution Tags
A new substitution tag is defined using the [Define_Tag] … [/Define_Tag] container tag within an enclosed [Return] 
tag that defines the value of the tag. The opening [Define_Tag] tag requires the name of the new substitution 
tag to be defined. All of the LassoScript code between the two tags is stored and is executed each time the tag 
is called.

In the following example, a tag [Ex_EmailAddress] is defined which returns an example email address for John 
Doe, johndoe@example.com.

[Define_Tag: 'EmailAddress', -Namespace='Ex_'] 
	 [Return: 'johndoe@example.com'] 
[/Define_Tag]

This tag can be called like any substitution tag within the Lasso page where the tag is defined. The following 
code calls this tag twice, once to provide the address for the HTML anchor tag and a second time to provide 
the text of the anchor.

<a href="mailto:[Ex_EmailAddress]"> [Ex_EmailAddress] </a>

�	 <a href="mailto:johndoe@example.com"> johndoe@example.com</a>

Process Tags
A new process tag is defined using the [Define_Tag] … [/Define_Tag] container tags. The opening [Define_Tag] tag 
requires the name of the new process tag to be defined. All of the LassoScript code between the two tags is 
stored and is executed each time the tag is called. Since process tags do not return a value, the body of the tag 
should not contain a [Return] tag.

In the following example, a tag [Ex_SendEmail] is defined which sends an email to an example email address 
for John Doe, johndoe@example.com. The tag is defined within a LassoScript.

<?LassoScript 
	 Define_Tag: 'SendEmail', -Namespace='Ex_'; 
		  Email_Send: -Host='mail.example.com', 
			   -To='johndoe@example.com', 
			   -From='lasso@example.com', 
			   -Subject='Sample Email', 
			   -Body='This email was sent from a custom tag.'; 
	 /Define_Tag; 
?>

This tag can be called like any process tag within the Lasso page where the tag is defined. The following code 
calls this [Ex_SendEmail] so an email will be sent to johndoe@example.com each time the page with this code is 
served by Lasso.

[Ex_SendEmail]

Privileged Tags
Custom tags normally run with the permissions of the user that calls the custom tag. Using the -Privileged 
keyword a custom tag will instead run with the permissions of the user who defined the custom tag. 
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This allows the execution of privileged actions to be written into custom tags. The privileged action can be 
performed without opening up general permission for performing similar actions to the end-users.

For example, a custom tag which is defined in LassoStartup that has the -Privileged keyword will always execute 
as the global administrator of the machine. Privileged custom tags can then be used to modify internal 
security settings or perform other actions that require global administrator permission.

Returning Values
In order for a custom tag to return a value it needs to use the [Return] tag. The parameter for the [Return] tag 
will be returned as the value of the custom tag and no further processing will be performed. A value of any 
type can be returned using the [Return] tag including simple decimal or integer numbers, strings, complex 
maps and arrays, or even custom types.

Custom tags can also return values by setting variables. See the section on Page Variables that follows for 
additional details.

The following custom tag returns a string that informs the site visitor of what day it is. If the current 
day is January 1st then Happy New Year! is returned. Note that if the conditional returns True then 
the [Return: 'Happy New Year!'] tag is executed and the tag is exited without executing the second [Return] tag that 
follows.

[Define_Tag: 'Greeting', -Namespace='Ex_'] 
	 [If: (Date_GetDay) == 1 && (Date_GetMonth) == 1] 
		  [Return: 'Happy New Year!'] 
	 [/If] 
	 [Return: 'The date is ' + (Server_Date: -Long) + '.'] 
[/Define_Tag]

When executed on any day other than the 1st of January this tag returns the current date.

[Ex_Greeting]

�	 The date is August 27, 2001.

Encoding
Encoding is handled automatically by Lasso when values are returned from a custom tag. Encoding follows 
the same rules as for built-in substitution tags. These rules are summarized below.

	 •	If no encoding keyword is specified and the custom tag returns a string value then the tag follows the same 
rules as built-in substitution tags. The string value will be HTML encoded if it is output to the Lasso page or 
will have no encoding applied if the tag is used as a sub-tag or in an expression.

The following custom tag [Ex_String] would have HTML encoding applied.

[Ex_String]

�	 &lt;b&gt;Bold Text&lt;/b&gt;

However, if the same tag is used as a sub-tag, no encoding is applied.

[Variable: 'myString'=(Ex_String)] 
[Variable: 'myString', -EncodeNone]

�	 <b>Bold Text</b>

Note: If the tag is used within [Encode_Set] … [/Encode_Set] tags then the default encoding which is set in the 
opening [Encode_Set] tag will be used instead of -EncodeHTML when the tag’s value is output directly to a Lasso 
page.

	 •	If no encoding keyword is specified and the custom tag returns any data type other than string then no 
encoding is applied and the specified data type is returned.

The following custom tag [Ex_Array] has no encoding applied since it returns an array.
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[Ex_Array]

�	 (Array: (<b>Bold Text</b>))

Note: Even if the tag is used within [Encode_Set] … [/Encode_Set] tag, no encoding will by applied by default 
unless an explicit encoding keyword is specified.

	 •	If an explicit encoding keyword other than -EncodeNone is specified then the return value from the tag is 
converted to a string and the specified encoding is applied. Use of an explicit encoding keyword guarantees 
that the value from the tag will be of data type string.

The following custom tag [Ex_Array] has explicit HTML encoding applied.

[Ex_Array: -EncodeHTML]

�	 (Array: (&lt;b&gt;Bold Text&lt;/b&gt;))

Note: The encoding keyword -EncodeNone instructs Lasso that no encoding is desired for a custom tag. For 
custom tags which return any data type other than string, -EncodeNone is equivalent to not specifying an 
encoding keyword.

Parameters
Custom tags can accept any mix of named or unnamed parameters. These parameters can be named using the 
-Required and -Optional parameters in the opening [Define_Tag] tag. Each parameter is automatically defined as a 
local variable within the tag. If a required parameter is omitted from a tag call then an error is generated. If 
an optional parameter is omitted then the local variable corresponding to that parameter will not be defined.

	 •	Named Parameters – The -Required and -Optional parameters for a tag can be listed in any order. Each 
-Required parameter must have a matching keyword/value parameter in the parameters for the tag. If the 
-Copy keyword follows either a -Required or -Optional keyword then that parameter will be passed by copy 
rather than by reference.

The following example defines a tag [Ex_Note] which accepts two parameters. -Message is required and is the 
message to be displayed. -Font is an optional parameter that changes the font of the displayed message if it 
is specified, otherwise Arial is used.

[Define_Tag: 'Note', -Namespace='Ex_', -Required='Message', -Optional='Font'] 
	 [If: (Local_Defined: 'Font') == False] 
		  [Local: 'Font' = 'Arial'] 
	 [/If] 
	 [Return: '<font face="' + #Font + '"> ' + #Message + ' </font>'] 
[/Define_Tag]

The parameters can be used in any order when the tag is called, but the -Message parameter must be 
present.

[Ex_Note: -Font='Helvetica', -Message='Hello World', -EncodeNone]

�	 <font face="Helvetica"> Hello World </font>

[Ex_Note: -Message='Hello World', -EncodeNone]

�	 <font face="Arial"> Hello World </font>

Note: Extra named parameters passed into a custom tag will also create local variables automatically even if 
the -Required and -Optional parameters are not used.

	 •	Unnamed Parameters – The -Required parameters for a tag should be listed in the order they will be 
specified in the tag followed by any optional parameters that may be specified. Each unnamed parameter 
of the tag will be assigned in order to the -Required or -Optional parameter in the corresponding position.

The tag [Ex_Note] defined above accepts two parameters. The first parameter is required and is assigned the 
name Message. The second parameter is optional and is assigned the name Font if specified.
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When the tag is called at least one parameter must be specified. If a second parameter is specified it is used 
as the font for the message, otherwise the default font is used.

[Ex_Note: 'Hello World', 'Helvetica', -EncodeNone]

�	 <font face="Helvetica"> Hello World </font>

[Ex_Note: 'Hello World', -EncodeNone]

�	 <font face="Arial"> Hello World </font>

	 •	Combination Parameters – A combination of named and unnamed parameters can be used. First, all 
keyword/value parameters are assigned to the -Required or -Optional parameters specified in the opening 
[Define_Tag] tag. Then, any remaining parameters are assigned in order to any -Required or -Optional parameters 
that have not yet been assigned values.

For example, the tag [Ex_Note] defined above is called with one unnamed parameter and one keyword/value 
-Font parameter. First, the -Font parameter is assigned to the -Optional font parameter. Then, the unnamed 
parameter is assigned to the -Required message parameter.

[Ex_Note: 'Hello World', -Font='Helvetica', -EncodeNone]

�	 <font face="Helvetica"> Hello World </font>

	 •	Parameters Types – The type of each parameter can be specified by including a -Type parameter 
immediately after the -Required or -Optional parameter. When the tag is called if the specified parameter is not 
of the proper type then an error will be generated.

The [Ex_Note] tag can be redefined to require that the -Message parameter be a string.

[Define_Tag: 'Note', -Namespace='Ex_', -Required='Message', -Type='String',  
		  -Optional='Font'] 
	 [If: (Local_Defined: 'Font') == False] 
		  [Local: 'Font' = 'Arial'] 
	 [/If] 
	 [Return: '<font face="' + #Font + '"> ' + #Message + ' </font>'] 
[/Define_Tag]

Now if the tag is called with a decimal value for the -Message parameter an error will be generated.

[Ex_Note: -Message=99, -EncodeNone]

�	 Syntax Error

Any tag defined with -Required and -Optional parameters can always be called with a combination of named and 
unnamed parameters. Documentation for custom tags should always specify how a tag should be called.

Parameters Array
If greater control is required over the parameters which are passed into a tag then the [Params] array can be 
inspected directly. This array contains one element for each parameter that is passed into a custom tag.

	 •	Simple Parameters – Simple parameters are included as single elements within the array. Each parameter 
has the same data type as the literal or variable which was passed to the tag.

	 •	Name/Value Parameters – Name/Value parameters are included as elements of the data type pair within 
the array. Each part of the pair has the same data type as the literal or variable which was passed to the tag.

	 •	Keyword Parameters – Keyword parameters are included as string parameters. They should be 
distinguished by requiring that all keyword names start with a leading hyphen.

	 •	Keyword/Value Parameters – Keyword/Value parameters are included as a pair with a string as the first 
element and the value as the second element. They should be distinguished by requiring that all keyword 
names start with a leading hyphen.

	 •	Encoding Keywords – Encoding keywords are handled automatically by Lasso. They are not passed to 
custom tags within the [Params] array. Custom tags do not need to do anything special to take advantage of 
encoding nor is there any way to disable automatic encoding of returned string values.
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The [Params_Up] tag is a special purpose tag that allows inspection of the [Params] array from the custom tag 
which called the current tag. This tag can only be used if the current tag was called from within a custom tag 
and can be used to create tags that change their values based on the parameters to the calling tags.

To inspect the parameters of a custom tag:

The [Params] array provides access to all the parameters of the current tag. The following example shows a 
custom tag [Ex_Echo] that outputs information about all the parameters that were passed to the tag by looping 
through the [Params] array.

[Define_Tag: 'Echo', -Namespace='Ex_'] 
	 [Local: 'Output' = ''] 
	 [Loop: (Params)->Size] 
		  [Local: 'Temp' = (Params)->(Get: (Loop_Count))] 
		  [If: #Temp->Type == 'pair'] 
			   [#Output += '<br>Pair: '] 
			   [#Output += '<br>&nbsp;' + #Temp->First->Type + ': ' + (#Temp->First)] 
			   [#Output += '<br>&nbsp;' + #Temp->First->Type + ': ' + (#Temp->Second)] 
		  [Else] 
			   [#Output += '<br>' + #Temp->Type + ': ' + (#Temp)] 
		  [/If] 
	 [/Loop] 
	 [If: (#Output == '')] 
		  [#Output = '<br>No Parameters'] 
	 [/If] 
	 [Return: #Output] 
[/Define_Tag]

When this tag is called with different parameters the following output is created. Note that keywords are 
simply strings that start with a hyphen and that the -EncodeNone encoding keyword is not represented in the 
output.

[Ex_Echo: 'One', 'Two='Three', -Four, -Five='Six', -Seven=8, -Nine=1.0, -EncodeNone]

�	 String: One 
Pair: 
	 String: Two 
	 String: Three 
String: -Four 
Pair: 
	 String: -Five 
	 String: Six 
Pair: 
	 String: -Seven 
	 Integer: 8 
Pair: 
	 String -Nine 
	 Decimal: 1.0

To get the value of a keyword/value parameter:

The following custom tag uses the [Params->Find] tag to retrieve several named keyword/value parameters from 
the [Params] array. The tag [Ex_Greeting] accepts two parameters: -First which should have the first name of a 
person as its value and -Last which should have the last name of its person as its value. It returns a greeting to 
that person.

<?LassoScript 
	 Define_Tag: 'Greeting', -Namespace='Ex_'; 
		  Local: 'First' = Params->(Find: '-First')->(Get: 1); 
		  Local: 'Last' = Params->(Find: '-Last')->(Get: 1); 
		  Return: 'Dear ' + #First + ' ' + #Last; 
	 /Define_Tag; 
?>
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When the tag is called it parses the two defined parameters and ignores all others.

[Ex_Greeting: -First='John', -Last='Doe'] � Dear John Doe

[Ex_Greeting: -First='John', -Last='Doe', -Title='Mr.'] � Dear John Doe

To get the value of all unnamed parameters:

The [Params] array provides access to all the parameters of the current tag. The following example shows a 
custom tag [Ex_Concatenate] that concatenates the value of all simple, unnamed parameters together and 
ignores all name/value and keyword/value parameters.

[Define_Tag: 'Concatenate', -Namespace='Ex_'] 
	 [Local: 'Output' = ''] 
	 [Loop: (Params)->Size] 
		  [Local: 'Temp' = (Params)->(Get: (Loop_Count))] 
		  [If: #Temp->Type != 'pair'] 
			   [#Output += #Temp] 
		  [/If] 
	 [/Loop] 
	 [Return: #Output] 
[/Define_Tag]

When this tag is called with different parameters the following output is created. Note that any named 
parameters are ignored and that the -EncodeNone encoding keyword is not represented in the output.

[Ex_Echo: 'One', 'Two='Three', -Four, -Five='Six', -Seven=8, -Nine=1.0, -EncodeNone]

�	 One-Four

To get the parameters from the calling tag:

The [Params_Up] tag provides access to the parameters of the calling tag. The following tag 
[Ex_UnnamedParams] returns an array of all unnamed parameters from the calling tag. This tag could be used to 
filter the [Params] array so only unnamed parameters remained.

[Define_Tag: 'UnnamedParams', -Namespace='Ex_'] 
	 [Local: 'Output' = (Array)] 
	 [Loop: (Params_Up)->Size] 
		  [Local: 'Temp' = (Params_Up)->(Get: (Loop_Count))] 
		  [If: #Temp->Type != 'pair'] 
			   [#Output->(Insert: #Temp)] 
		  [/If] 
	 [/Loop] 
	 [Return: #Output] 
[/Define_Tag]

The [Ex_UnnamedParams] tag can now be used to rewrite the [Ex_Concatenate] custom tag by looping through the 
[Ex_UnnamedParams] array rather than through the [Params] array.

[Define_Tag: 'Concatenate', -Namespace='Ex_'] 
	 [Local: 'Output' = ''] 
	 [Local: 'Unnamed_Params' = (Ex_UnnamedParams)] 
	 [Loop: (#Unnamed_Params)->Size] 
		  [#Output +=  (#Unnamed_Params)->(Get: (Loop_Count))] 
	 [/Loop] 
	 [Return: #Output] 
[/Define_Tag]

When this tag is called with different parameters the following output is created. Note that any named 
parameters are ignored and that the -EncodeNone encoding keyword is not represented in the output.

[Ex_Echo: 'One', 'Two='Three', -Four, -Five='Six', -Seven=8, -Nine=1.0, -EncodeNone]

�	 One-Four
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Page Variables
Custom tags can set and retrieve the values of variables which are defined in the current Lasso page. This 
provides a method of passing additional parameters to custom tags by setting pre-defined variables and a 
method of passing multiple values out of a custom tag.

Any use of page variables should be considered carefully. Local variables, which are defined in the following 
section, are usually sufficient for storing data required while executing a tag. If data needs to be stored 
between executions of a tag then it might be more efficient to create a custom data type. See the following 
section on Custom Types for more information.

If a custom tag must store values in page variables it should precede all variable names with the full name of 
the custom tag followed by an underscore. For example, the custom tag [Ex_Concatenate] would create variables 
named Ex_Concatenate_Value, Ex_Concatenate_Output, etc.

Local Variables
Each custom tag can create and manipulate its own set of local variables. These variables are separate from 
the page variables and are deleted when the custom tag returns. Using local variables ensures that the custom 
tag does not alter any variables which other custom tags or the page developer is relying on having a certain 
value.

For example, many developers will use the variable Temp to store temporary values. If a page developer is 
using the variable Temp and then calls a custom tag which also sets the variable Temp, then the value of the 
variable will be different than expected.

The solution is for the custom tag author to use a local variable named Temp. The local variable does not 
interfere with the page variable of the same name and is automatically deleted when the custom tag returns. 
In the following example, a custom tag returns the sum of its parameters, storing the calculated value in Temp.

<?LassoScript 
	 Define_Tag: 'Sum', -Namespace='Ex_'; 
		  Local: 'Temp'=0; 
		  Loop: (Params)->Size; 
			   Local: 'Temp'=(Local: 'Temp') + (Params)->(Get: Loop_Count); 
		  /Loop; 
		  Return: #Temp; 
	 /Define_Tag; 
?>

The final reference to the local variable temp is as #Temp. The # symbol works like the $ symbol for page 
variables, allowing the variable value to be returned using shorthand syntax.

When this tag is called, it does not interfere with the page variable named Temp.

[Variable: 'Temp' = 'Important value:'] 
[Variable: 'Sum' = (Ex_Sum: 1, 2, 3, 4, 5)] 
['<br>' + $Temp + ' ' + $Sum + '.']

�	 <br>Important value: 15.

Parameter and Return Types
The -Type and -ReturnType parameters can be used to check that the parameters which are being passed to the 
tag are of the proper type before the tag is executed and that the return value of the tag is the proper type 
when the tag completes.

The -Type parameter is placed immediately after each -Required or -Optional parameter. The corresponding 
parameter must be of the specified type when the tag is executed or a syntax error is generated. Using these 
tags reduces the amount of double checking of types that is required within the body of the tag.
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The -ReturnType parameter specifies the type that the returned value of the tag must be. If the tag attempts to 
return a value of a different type then an error is generated.  Using this tag is useful as a double check for a 
tag that is always expected to return a certain data type. It makes enforcement of the return type explicit rather 
than relying on the custom tag author to ensure that the return type is always proper.

[Define_Tag: 'Ex_Bold', -Namespace='Ex_', -Required='theString', -Type='String',  
		  -ReturnType='String'] 
	 [Return: '<b>' + #theString + '</b>'] 
[/Define_Tag]

If the [Ex_Bold] tag is called with a number then a syntax error will be returned. The following example first 
shows a successful call to the tag, then an unsuccessful call.

[Ex_Bold: 'Bold Text'] � <b>Bold Text</b>

[Ex_Bold: 123.456] � Syntax Error

Criteria
The -Criteria parameter allows custom tags to check certain conditions before any code in the tag is executed. 
Usually this is used to confirm that the appropriate parameters have been passed to the custom tag. If the 
criteria fails then a syntax error will be generated.

The -Criteria parameter requires a conditional expression. If the evaluated expression returns False then the tag 
execution is halted and an error is returned.

The code within the -Criteria are executed as if they were specified within the body of the 
[Define_Tag] … [/Define_Tag]. Locals can be used to reference -Required or -Optional parameters and the [Params] 
array can be inspected. -Criteria can also inspect page variables.

To use criteria to check the parameters of a custom tag:

Specify the -Criteria parameter in the opening [Define_Tag] tag. If the condition in the criteria fails then the tag 
will not be executed. The following code checks to be sure that the tag’s required parameter is a string.

[Define_Tag: 'Bold', -Namespace='Ex_', -Required='theString',  
		  -Criteria=(#theString->Type == 'string')] 
	 [Return: '<b>' + #theString + '</b>'] 
[/Define_Tag]

If the [Ex_Bold] tag is called with a number then a syntax error will be returned. The following example first 
shows a successful call to the tag, then an unsuccessful call.

[Ex_Bold: 'Bold Text'] � <b>Bold Text</b>

[Ex_Bold: 123.456] � Syntax Error

Error Control
Custom tags should use the -Required, -Optional, -Type, -ReturnType, and -Criteria parameters to ensure that the 
parameters of the tag are of the proper type and that the return value is of the proper type. These tags ensure 
that Lasso developers are alerted of errors when the page is first executed, rather than encountering obscure 
runtime errors later.

Errors can be returned from custom tags using the [Error_SetErrorMessage] and [Error_SetErrorCode] tags. A 
custom tag which is explicitly returning an error code should always return [Error_NoError] if no error occurred 
or an explicit error message otherwise.
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Container Tags
A container tag can be created by specifying either the -Container or -Looping keyword within the opening 
[Define_Tag] tag. When the tag is used both an opening and a closing tag must be specified or an error will 
occur. The return value of the tag replaces the entire container tag. The contents of the container tag can be 
accessed using the [Run_Children] tag.

If the -Looping keyword is used the [Loop_Count] will be automatically changed when the custom tag is called. If 
the -Container keyword is used then the [Loop_Count] will not be modified by the container tag. This distinction 
allows both looping and simple container tags to be created.

Note: The output of a container tag is not encoded. This allows HTML to be output from container tags without 
requiring an -EncodeNone tag.

To create a simple container tag:

The following example creates a simple container tag [Ex_Font] … [/Ex_Font] that wraps its parameters with 
an HTML <font> tag. The tag takes three optional parameters -Face, -Size, and -Color which correspond to the 
parameters of the HTML <font> tag.

[Define_Tag: 'Font', -Namespace='Ex_', -Container, 
		  -Optional='Face', -Optional='Size', -Optional='Color'] 
	 [If: !(Local_Defined: 'Face')][Local: 'Face' = 'Verdana'][/If] 
	 [If: !(Local_Defined: 'Size')][Local: 'Size'= 1][/If] 
	 [If: !(Local_Defined: 'Color')][Local: 'Color' = 'black'][/If] 
	 [Return: '<font face="' + #face + '" size="' + #size + '" color="' + #color + '"> ' +  
		  (Run_Children) + ' </font>'] 
[/Define_Tag]

A call to this tag appears like this. The -Face and -Color of the output are specified, but the -Size is left to the 
default of 1.

[Ex_Font: -Face='Helvetica', -Color='red'] My Message [/Ex_Font]

�	 <font face="Helvetica" size="1" color="red"> My Message </font>

To use the contents of the container tag multiple times:

The following example creates a tag [Ex_Link] that creates a pair of HTML anchor tags with the contents of the 
container used as both the URL to be followed and the text of the link. This could be used to automatically 
create hyperlinks out of URLs contained in text. The tag does not require any parameters.

[Define_Tag: 'Link', -Namespace='Ex_', -Container] 
	 [Return: '<a href="' + (Run_Children) + '"> ' + (Run_Children) + ' </a>'] 
[/Define_Tag]

A call to this tag appears like this. The specified URL is included in the results twice.

[Ex_Link] http://www.lassosoft.com [/Ex_Link]

�	 <a href="http://www.lassosoft.com"> http://www.lassosoft.com </a>

To create a looping container tag:

The following example creates a tag that loops ten times repeating its contents. The -Looping keyword is used 
in the [Define_Tag] tag to indicate that this is a looping tag rather than a simple container.

[Define_Tag: 'Loop10', -Namespace='Ex_', -Looping] 
	 [Local: #Output = ''] 
	 [Loop: 10] 
		  [#Output += Run_Children] 
	 [/Loop] 
	 [Return: #Output] 
[/Define_Tag]
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A call to this tag appears like this. The specified contents of the tag is repeated ten times with the 
[Loop_Count] updated each time.

[Ex_Loop10] <br>This is loop [Loop_Count]. [/Ex_Loop10]

�	 <br>This is loop 1. 
<br>This is loop 2. 
… 
<br>This is loop 10.

If the -Container keyword rather than the -Looping keyword had been used the tag still would have repeated its 
contents ten times, but the [Loop_Count] would have returned the same value for each repetition.

Web Services, Remote Procedure Calls, and SOAP
Lasso supports remote procedure calls through the XML-RPC and Simple Object Access Protocol (SOAP) 
standards. Both types of remote procedure calls allow one server on the Internet to call a function that 
is located on another server. The parameters of the function call and the results of the function call are 
transmitted between the servers using XML.

Custom tags can be automatically made available to remote servers by specifying the -RPC or -SOAP parameter 
when the tag is created. Any tag which is specified as a remote procedure call will be accessible through 
RPC.LassoApp which is located in the LassoStartup folder. The LassoApp handles all of the translation of 
parameters and the return value to and from XML.

SOAP tags additionally require that each required and optional parameter be assigned a type using the -Type 
parameter and that the return type of the tag be specified using the -ReturnType parameter. The parameter and 
return types are used to automatically translate incoming SOAP requests into appropriate Lasso data types 
and to properly describe the return value.

When called, remote procedure call tags will be executed using the permissions of the Anonymous user. If 
the tags require additional permissions a username and password must be written into an [Inline] …  [/Inline] 
container within the tag or the tag must accept a username and password as parameters.

Tags are called within the context of a page load of the RPC.LassoApp. Tags can access global variables, but will 
not be able to access any page variables from the page where they were defined. RPC and SOAP tags function 
essentially as asynchronous tags described elsewhere in this chapter.

Remote procedure calls are well suited to a number of different applications. See the XML chapter in the 
Lasso 8 Language Guide for more information. Some possible applications of remote procedure calls include:

	 •	Serving news stories to remote servers. For example, creating a system where other Web sites can show the 
latest news stories automatically.

	 •	Performing administrative tasks on remote servers. Tags can be created which perform periodic 
administrative tasks and then those tasks can be triggered using XML-RPC or SOAP calls.

	 •	Integrating with remote systems that communicate via XML-RPC or SOAP. Both Windows 2000 and Mac 
OS X have systems for sending XML-RPC or SOAP calls and processing the results.

To create a remote procedure call tag:

Use the -RPC parameter in the opening [Define_Tag] tag. In the following example a method Example.Fortune 
is created which returns a random message each time it is called. Since the tag will not have access to page 
variables the array of messages is created inside the tag.

[Define_Tag: 'Example.Fortune', -RPC] 
	 [Local: 'Messages' = (Array: 'You will go on a long boat trip.', 
		  'You will meet a long lost friend', 
		  'You will strike it rich in the stock market')] 
	 [Local: 'Index' = (Math_Random: -Min=1, -Max=(#Messages->Size + 1))] 
	 [Return: #Messages->(Get: #Index)] 
[/Define_Tag]
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The tag can be called from a remote Lasso 8 server using the [XML-RPC] tags. A call to the 
Example.Fortune remote procedure on the server at http://www.example.com/ would look like as follows.

[Variable: 'Result' = XML_RPC->(Call: -Method='Example.Fortune', 
	 -URI='http://www.example.com/RPC.LassoApp')] 
[Variable: 'Result']

The result will be one of the messages from the Messages array.

�	 You will meet a long lost friend.

To create a remote procedure call tag with complex data types:

The previous example demonstrated how a remote procedure call tag could be created and called using a 
simple tag which accepted no parameters and returned a string result. Remote procedure calls can be used 
with any number of parameters including any of Lasso’s built-in data types such as array, map, boolean, 
integer, decimal, etc.

In the following example a method Example.TopStories is created that returns an array of formatted URLs for 
the top stories from a Web site. An optional -Count parameter allows the number of top stories to be returned 
to be specified. The top stories are found by finding all records in the Stories table of the News database and 
sorting the results first by Priority then by DateTime.

[Define_Tag: 'Example.TopStories', -Optional='Count'] 
	 [Local: 'Results' = (Array)] 
	 [If: !(Local_Defined: 'Coun't)] 
		  [Local: 'Count' = 10] 
	 [/If] 
	 [Inline: -Findall,  
			   -Database='News',  
			   -Table='Stories',  
			   -SortField='Priority', -SortOrder='Descending', 
			   -SortField='DateTime', -SortOrder='Descending', 
			   -MaxRecords=#Count]

	 [Records] 
		  [#Results->(Insert: '<a href=\"' + (Field: 'URL') + '\">' + (Field: 'Headline') + '</a>')] 
	 [/Records]

	 [Return: #Results]	  
[/Define_Tag]

The tag can be called from a remote Lasso 8 server using the [XML-RPC] tags. A call to the 
Example.TopStories remote procedure on the server at http://www.example.com/ which requests the top 3 stories 
would look like as follows.

[Variable: 'Result' = (XML_RPC: (Array: -Count=3))->(Call:  
	 -URI='http://www.example.com', 
	 -Method='Example.TopStories')] 
[Variable: 'Result']

The result will be an array of the top three stories from the database each formatted as a URL linking to the 
page which contains the story.

�	 (Array: (<a href="http://www.example.com/story.lasso?id=106">Annual Results</a>), 
	 (<a href="http://www.example.com/story.lasso?id=105">Shareholder Meeting</a>), 
	 (<a href="http://www.example.com/story.lasso?id=104">Company Picnic!</a>))

To create a SOAP tag:

Use the -SOAP parameter in the opening [Define_Tag] tag. In the following example a method Example.Repeat is 
created which returns baseString repeated multiplier number of times. Both -Required parameters are followed by 
-Type parameters and the -ReturnType for the tag is specified.
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[Define_Tag: 'Example.Repeat', -SOAP, 
		  -Required='baseString', -Type='string', 
		  -Required='multiplier', -Type='integer, 
		  -ReturnType='string'] 
	 [Return: (#baseString * #multiplier)] 
[/Define_Tag]

The tag can be called from a remote server that supports SOAP.

Atomic Tags
Atomic tags only allow one instance of the tag to execute at a time. If the tag is called from multiple page 
loads or threads then the latter calls will block automatically until the first instance of the tag has finished 
running. Tags which access shared resources such as global variables can be made atomic to automatically 
prevent collisions which may result if one instance of the tag modifies data that another instance is reading.

An atomic tag is defined by specifying the -Atomic keyword in the opening [Define_Tag] tag. 

The following example uses a global to store an array. The tag inserts a value into the array, sorts the array, 
and then returns the first value from the array.

[Global: 'Ex_Array' = (Array)] 
[Define_Tag: 'Ex_StoreAndSort', -Required='Value', -Atomic] 
	 [(Global: 'Ex_Array')->(Insert: #Value)] 
	 [(Global: 'Ex_Array')->Sort] 
	 [Return: (Global: 'Ex_Array')->First] 
[/Define_Tag]

If multiple instances of this tag executed at the same time then the inserts and sorts could be interleaved 
so one instance of the tag inserted a value after the other instance had already sorted the array. The -Atomic 
keyword ensures that each tag call completes before the next call to the same tag can begin.

The [Thread_Atomic] … [/Thread_Atomic] tags can also be used to define an atomic operation separate from a 
custom tag. See the Threads chapter for more information.

Asynchronous Tags
Asynchronous tags are process tags that are executed in a separate thread from the main portion of the 
page. Lasso does not have to wait for completion of an asynchronous tag before processing and serving the 
remainder of the Lasso page in which the tag is called.

Since asynchronous tags usually finish executing after a page has been served to the site visitor they cannot 
return values or modify the page variables for the Lasso page from which they were called.

Asynchronous tags are usually used in one of the following situations:

	 •	To perform database actions which are a side effect of loading a Lasso page, but the results of which are not 
required for serving the file to the current site visitor.

	 •	To create a background process that periodically checks for certain conditions and performs a database 
action or sends an email if that condition is met.

Asynchronous tags can be created using the [Define_Tag] … [/Define_Tag] tags. Newly defined tags will be 
available below the point where they are defined in a Lasso page. They can be used as many times as needed.

Note: There is no control over when an asynchronous tag will be executed. Depending on how busy the server is 
the tag may be executed immediately or may be delayed until after the current page is served to the client. The 
order of execution of asynchronous tags should never be assumed.
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Defining Tags
A new asynchronous tag is defined using the [Define_Tag] … [/Define_Tag] container tags. The opening [Define_Tag] 
tag requires the name of the new substitution tag to be defined and the second parameter should be -Async 
which specifies that the tag should be called asynchronously. All of the LassoScript code between the two tags 
is stored and is executed each time the tag is called.

In the following example, a tag [Ex_SendEmail] is defined which sends an email to an example email address 
for John Doe, johndoe@example.com. The tag is defined within a LassoScript and the second parameter is set to 
True to ensure that the tag will be called asynchronously.

<?LassoScript 
	 Define_Tag: 'SendEmail', -Namespace='Ex_', -Async; 
		  Email_Send: -Host='mail.example.com', 
			   -To='johndoe@example.com', 
			   -From='lasso@example.com', 
			   -Subject='Sample Email', 
			   -Body='This email was sent from a custom tag.'; 
	 /Define_Tag; 
?>

This tag can be called like any process tag within the Lasso page where the tag is defined. The following code 
calls this [Ex_SendEmail] so an email will be sent to johndoe@example.com each time the page with this code is 
loaded in a Web browser.

[Ex_SendEmail]

The code immediately following this tag is executed immediately without waiting for the tag to complete. The 
email will be queued for sending shortly after the page is finished executing and is served to the client.

Page Variables
None of the page variables which are defined when an asynchronous tag is called are available within the 
asynchronous tag. The only variables which are available to a custom asynchronous tag are server-wide global 
variables. Any values which are going to be used by an asynchronous tag should be set using the [Global] tag.

Asynchronous tags can use local variables internally in the same way as any custom tags. These variables will 
only be available while the asynchronous tag is running and will be deleted automatically when it completes.

Calling Custom Tags
Only custom tags which are defined in the LassoStartup folder can be called by an asynchronous tag. Tags 
which are defined in the same Lasso page as the asynchronous tag definition or call cannot be called by an 
asynchronous tag.

Custom tags can be defined within the body of an asynchronous tag if needed. These custom tags will be 
deleted as soon as the asynchronous tag finishes executing.

Background Processes
Asynchronous tags can be used to create background processes that continue to run independent of the 
visitors to a Lasso-powered Web site. An asynchronous tag will continue executing until the end of the tag 
body or a [Return] tag is reached. By putting an asynchronous tag into an infinite loop it will continue to run 
until Lasso Service is quit.

Warning: There is no way to stop an asynchronous tag from executing once it is started. Care should be taken to 
ensure that any background processes which are implemented with asynchronous tags are well behaved.

The [Sleep] tag can be used to pause execution of an asynchronous tag for a number of milliseconds. The 
asynchronous tag consumes virtually no resources while it is paused.

Most background processes are started by a Lasso page within the LassoStartup folder. This ensures that the 
background process runs from when Lasso Service starts up until it is quit.
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To create a background process:

Place the following code in a Lasso page within the LassoStartup folder. This code will be executed the next 
time Lasso Service is started.

Two global variables are created. Since these variables are created in the LassoStartup folder they can be read 
and set from any page which is executed by Lasso. The first global variable Ex_Background_Pause can be used to 
pause the background task if it is set to True. The second global variable Ex_Background_Kill can be used to kill 
the background task if it is set to True. 

[Global: 'Ex_Background_Pause' = False] 
[Global: 'Ex_Background_Kill' = False]

These variables are not required to create a background task, but are useful for debugging and to kill a 
runaway task. By setting the appropriate variable to True in any Lasso page the task can be paused or killed.

The task itself is defined in a [Define_Tag] … [/Define_Tag]. Notice that the naming convention has the name of 
the tag which defines the task Ex_Background as the first part of the name of the variables associated with the 
task. The task contains a while loop that checks the Ex_Background_Kill variable and a conditional that checks 
the Ex_Background_Pause variable. After each execution, the tag pauses for 15 seconds (15000 milliseconds).

[Define_Tag: 'Background', -Namespace='Ex_', -Async] 
	 [While: (Global: 'Ex_BackGround_Kill) != True] 
		  [If: (Global: 'Ex_Background_Pause') != True)] 
			   … Perform Task … 
		  [/If] 
		  [Sleep: 15000] 
	 [/While] 
[/Define_Tag]

The task is started by calling the [Ex_Background] tag immediately after it is defined. The task starts executing 
and does not stop until Lasso Service is quit or the variable Ex_Background_Kill is set to True.

[Ex_Background]

It is important not to call the [Ex_Background] tag more than once or else multiple instances of the background 
task will be created.

Background tasks can be made more robust by:

	 •	Adding a variable which is set when the background task is executed so it cannot be executed again.

	 •	Adding variables which control how long the background task sleeps.

	 •	Outputting to the console window with [Log: -Window] … [/Log] or to a log file in order to track the progress 
of a background task.

Overloading Tags
Lasso provides the ability to create several versions of a tag each with a criteria that dictates when it should be 
called. Tag overloading makes several advanced techniques possible.

	 •	Data Types – Different tags can be created which operate only when their parameters are of a certain 
data type. The logic of each tag can be made simpler by removing laborious [Select] … [Case] … [/Select] 
statements. 

	 •	Redefine Existing Tags – Existing tags can be redefined with a specified criteria. The new version of the 
tag will be called only when the criteria is met, but the old version of the tag is still available. The source 
code for the original tag is not needed and even built-in tags can be redefined.

	 •	Debug Tags – Tags can be created which output debugging information when a page variable is set 
appropriately. A page can be debugged and then all status messages can be suppressed by resetting the 
variable.

Note: Tags must reference the proper namespace in order to overload an existing tag. For example, the [Client_IP] 
tag is in the Client_ namespace so -Namespace='Client_' must be included in the new tag definition.
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When a given tag is called, Lasso will check each tag with the same name in turn until the criteria of one of 
the tags is met. A tag with no criteria will always execute. All built-in tags will always execute when called.

The -Priority and -Criteria parameters of the [Define_Tag] tag will be discussed followed by examples of how to use 
those parameters to create systems of overloaded custom tags.

Important: In Lasso Professional 8 many built-in tags which comprise the core of the language can not be 
overloaded. See the Lasso Reference for a complete list of tags that cannot be overloaded.

Priority
The placement of each custom tag in the list of tags in the calling chain can be specified using 
the -Priority parameter of the [Define_Tag] tag. The following three priorities are available.

	 •	Replace – The tag will replace any tags of the same name. Only the newly defined tag will be called 
when a tag of the given name is called. This allows existing tags to be completely redefined. Aliases and 
synonyms of the replaced tag will not be redefined.

	 •	High – The tag will be placed at the front of the calling chain. The criteria of this tag will be checked first to 
see if it can be called. If another tag is defined with high priority after this tag then that tag will actually be 
checked first.

	 •	Low – The tag will be placed at the end of the calling chain. The criteria of this tag will be checked only 
after all other tags have been checked. If another tag is defined with low priority after this tag then that tag 
will actually be checked last. If the tag is placed after a built-in tag or a custom tag with no criteria then the 
tag will never be called.

Note: By default, tags have no priority. They must have unique names and will be the sole tag in the calling 
chain.

To replace a built-in tag:

A built-in tag can be replaced by creating a new tag that has a -Priority of Replace. This technique can be used 
to redefine a custom tag or to redefine a built-in tag. The definition for the new tag must reference the 
namespace in which the pre-existing tag is defined.

Note: LassoSoft does not support systems which have built-in tags replaced. It is always advisable to create new 
tag names rather than redefining existing tags.

For example, the [Form_Param] tag could be redefined so it only retrieved parameters that were sent using the 
Post method in an HTML form. This is done by inspecting the [Client_PostParams] tag and returning those items 
from the array that match the parameter to the tag. Note that the proper Form_ namespace must be referenced 
in order to redefine this built-in tag.

<?LassoScript 
	 Define_Tag: 'Param', -Namespace='Form_', -Priority='Replace', -Require='name'; 
		  Local: 'id_array' = (Client_PostParams)->(Find: #name); 
		  Local: 'output' = ''; 
		  Iterate: #id_array, (Local: 'id_item'); 
			   #output += (Client_PostParams)->(Get: #id_item)->Second + '\r'; 
		  /Iterate; 
		  #output->(RemoveTrailing: '\r'); 
		  Return: #output; 
	 /Define_Tag; 
?>

This tag can now be used anywhere on a page to get access to the parameters that were passed through a form 
using the Post method. Since the tag uses the [Client_PostParams] tag it can even be used within nested [Inline] 
tags.

If this tag is defined on a page then it will replace the [Form_Param] tag only until the end of the page. If this 
tag is defined in the LassoStartup folder then it will replace the [Form_Param] tag for all users of the site. The 
[Action_Param] tag is not modified by redefining the [Form_Param] tag even though they are aliases.
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Criteria
If a tag has a -Criteria parameter defined then it will only be called when the specified criteria are met. If the 
criteria are not met then the next tag in the calling chain will be consulted or an error will be generated.

The -Criteria parameter should be a conditional expression that returns True of False. It is called 
within the environment of the tag being defined and has access to local variables created by the 
-Required and -Optional parameters and to the [Params] array. The -Criteria parameter can also reference page 
variables.

Required parameters specified by the -Required tag are checked prior to the -Criteria parameter. If a tag is missing 
a -Required parameter then a syntax error is returned and no further checking of the tags in the calling chain 
occurs. -Optional parameters should be used with appropriate an appropriate -Criteria expression to require 
parameters only on certain tags within a calling chain.

To execute a tag when it is called with a parameter of a given type:

Create the tag with a -Required parameter and a -Criteria expression that checks the type of the local defined 
by the -Required parameter. The following tag prints a formatted message only when it is called with a string 
parameter.

[Define_Tag: 'Print', -Namespace='Ex_',  
		  -Priority='High', 
		  -Required='myParam',  
		  -Criteria=(#myParam->Type == 'string')] 
	 [Return: '(String: \'' + #myParam + '\')] 
[/Define_Tag]

When this tag is called with a string parameter the formatted output is generated, otherwise a syntax error is 
generated.

[Ex_Print: 'Text'] � (String: 'Text')

[Ex_Print: 123.456] � Syntax Error

Now, an additional tag can be added with the same name that executes when it is called with a parameter of 
a different data type. The following version of [Ex_Print] will be called when the parameter is of type decimal. 
The -Priority of this tag is set to High ensuring that it is called before the other version of [Ex_Print] in the calling 
chain.

[Define_Tag: 'Print', -Namespace='Ex_',  
		  -Priority='High', 
		  -Required='myParam',  
		  -Criteria=(#myParam->Type == 'decimal')] 
	 [Return: '(Decimal: ' + #myParam + ')] 
[/Define_Tag]

When this tag is called with a decimal parameter the formatted output is generated. When it is called with a 
string parameter the prior version of the tag is used and its formatted output is generated. If the tag is called 
with a parameter of a different data type then a syntax error is generated.

[Ex_Print: 'Text'] � (String: 'Text')

[Ex_Print: 123.456] � (Decimal: 123.456)

[Ex_Print: 123] � Syntax Error

Additional tags can be created for each of the built-in data types: arrays, dates, maps, pairs, integers, boolean 
values, etc.

Rather than returning a syntax error when an unknown data type is specified as a parameter to the tag, a 
version of the tag can be created that accepts parameters of any type. The following version of [Ex_Print] is used 
for unknown data types. The -Priority is set to Low ensuring that this version of the tag is checked after all other 
versions of [Ex_Print] in the calling chain.
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[Define_Tag: 'Print', -Namespace='Ex_',  
		  -Priority='Low', 
		  -Required='myParam'] 
	 [Return: '(Unknown: ' + (String: #myParam) + ')] 
[/Define_Tag]

When this tag is called with a parameter of type date for which no individual version of the tag has been 
created the Unknown output is generated.

[Ex_Print: (Date)] � (Unknown: 5/15/2002 12:34:56)

The real power of this type of system of tags—which are only used when called with a parameter of a certain 
data type—is that it can be expanded by third parties to include their own custom data types. For example, if 
a new data type is created that represents currency then a new version of the [Ex_Print] tag could be created as 
well. The end-user will see that [Ex_Print] now works for the currency data type and doesn’t have to be aware of 
the mechanism which has been used to extend this tag to the additional data type.

Constants
The [Define_Constant] tag allows a constant literal value to be declared in much the same way as a custom tag. A 
constant value works just like a tag except that when the name of the constant is referenced its value is simply 
returned.

Lasso defines built-in constants for many commonly used parameter values such as All, Eq, Neq, etc.

Table 3: [Define_Constant] Tag

Tag	 Description	

[Define_Constant]	 Defines a constant. Requires two parameters: the name of  the constant to be 
defined and the value for the constant. A namespace can also be specified by 
inculding a -Namespace parameter between the name and value parameters.

		

To create a constant:

Use the [Define_Constant] tag. The defined constant can then be referenced as if it were a custom tag that 
returns the constant value or can be used as a parameter value without quotes. For example, the following 
code defines a constant MySiteName which is then output.

[Define_Constant: 'MySiteName', 'www.example.com']

Welcome to [MySiteName]! Enjoy your stay!

➜	 Welcome to www.example.com! Enjoy your stay!

Libraries
Libraries can be used to package custom tags and custom types into a format which is easy for any Lasso 
developer to incorporate into a Lasso-powered Web site.

The following types of libraries can be created:

	 •	On-Demand Tag Library – A set of custom tag and custom type declarations can be stored in a Lasso page 
or LassoApp and placed in the LassoLibraries folder in the Lasso Professional 8 application folder. The Lasso 
page or LassoApp should have the same name (before the .Lasso or .LassoApp file suffix) as the namespace 
of the tags defined within. Sub-folders can be used to define nested namespaces.

	 •	Library Lasso Page – A set of custom tag and custom type declarations can be stored in a Lasso page and 
then included in any other Lasso page using the [Library: 'library.lasso'] tag. This is a good way to create and 
use a library file whose defined tags and types will only be needed on a few pages in a site.
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	 •	LassoStartup Lasso Page – A set of custom tag and custom type declarations can be stored in a Lasso 
page placed within the LassoStartup folder in the Lasso Professional 8 application folder. After Lasso Service 
is restarted all tags, types, and page variables which are defined within the Lasso page will be available to 
all Lasso pages which are executed on the server.
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Chapter 58

Custom Types

This chapter introduces custom data types and shows how they can be created using Lasso tags.

	 •	Overview introduces the concepts behind custom data types.

	 •	Custom Types describes how to create new data types.

	 •	Member Tags describes how to create member tags for a custom data type.

	 •	Prototypes describes how to use prototypes to increase the speed of custom data types.

	 •	Callback Tags describes how to use callback tags to perform instance initialization, how to store custom 
data in serialized types, and how to process arbitrary member tag names.

	 •	Symbol Overloading describes how to use callback tags to overload the assignment, comparison, and 
mathematical operation symbols for any data type.

	 •	Inheritance describes how custom data types can inherit instance variables and member tags from other 
custom data types or from built-in data types.

	 •	Libraries describes how to package sets of custom types for distribution.

Overview
Lasso Professional 8 allows Web developers to extend LassoScript by creating custom data types programmed 
using Lasso tags.

Custom data types have the following features:

	 •	Tags for custom types operate just like built-in member tags. They can be used in nested expressions, return 
data of any type, and allow the use of encoding keywords.

	 •	Custom types are fully object-oriented. Custom types can inherit properties from other custom types.

	 •	Custom types can provide support for the built-in comparison symbols and automatic casting.

	 •	They can be created in any Lasso page and used instantly.

	 •	They are written in LassoScript. No programming experience or knowledge of a programming language 
other than LassoScript is required.

	 •	They can be collected into libraries of tags which can be loaded into any Lasso page using the [Library] tag.

	 •	They can be defined in a Lasso page or library within the LassoStartup folder, making them available to all 
pages processed by Lasso.

Naming Conventions
Lasso Professional 8 has support for tag namespaces. All custom types which are created by a developer 
should be defined in a namespace unique to the developer. For example, if LassoSoft was providing a custom 
type which implemented POP support it might be placed in the LS_ namespace and named [LS_Pop]. All of 
the types in this guide will be defined in the Ex_ namespace meaning Example.
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The member tags of a custom type do note need a prefix since member tags only need to be unique within 
each data type. In fact, it is recommended to use the same names as built-in member tags for custom member 
tags if the functionality is equivalent. For example, a custom data type might implement [Type->Get] and 
[Type->Size] member tags.

If either a member tag or instance variable of a custom tag starts with an underscore then the tag or variable 
will be transient in the data type. Transient member tags and instance variables will not be copied when the 
type is assigned to a different variable or serialized.

Error Reporting
Lasso has a flexible error reporting system which can be used to control the amount of information provided 
to the site visitor when an error occurs.  Since custom types are self-contained it is often desirable to develop 
and debug them independent of the site on which they are used.

The [Lasso_ErrorReporting] tag can be used with the -Local keyword to set the error reporting level for each 
custom member tag. Using this tag the error level can be set to Full while developing a tag in order to see 
detailed error messages.

[Lasso_ErrorReporting: 'Full', -Local]

Once the custom type is debugged and ready for deployment the error reporting level can be adjusted to 
None in order to effectively suppress any details about the coding of the custom tag from being reported.

[Lasso_ErrorReporting: 'None', -Local]

See the Error Controls chapter in the Language Guide for additional details about the [Lasso_ErrorReporting] tag 
and other error control tags.

Custom Types
Custom data types can be created in LassoScript using the [Define_Type] … [/Define_Type] tags. Newly defined 
types will be available below the point where they are defined in a Lasso page.

See the section on Libraries for information about how to create libraries of types, load types in LassoStartup, 
and create types which can be used by any Lasso page.

Table 1: Tags for Creating Custom Data Types

Tag	 Description	

[Define_Type] … [/Define_Type]	 Defines a new data type. Requires a single parameter, the name of  the type to be 
defined. Additional string parameters list the custom types which this type inherits 
from. Optional -Namespace parameter defined what namespace the custom type 
should be placed in. Optional (but recommended) -Prototype parameter specifies 
that the type should be defined as a prototype. Optional -Description provides a 
description of  the type.

[Define_Tag] … [/Define_Tag]	 Defines a new new member tag within a type definition.	

[Local]	 Sets or retrieves the value of  a member variable within a custom type definition.

[Local_Defined]	 Checks to see if  a member variable has been defined within a custom type 
definition.

[Locals]	 Returns a map of  all the member variables which have been defined within a 
custom type definition.

[Params]	 Returns an array of  all the parameters which were passed to the custom tag.

[Private] … [/Private]	 Surrounds member tags and variables which are private to the type instance.

[Self]	 Returns a reference to the current data type instance.

[Self->Parent]	 Returns a reference to the parent type for the current data type instance. For use 
within custom type declarations with inheritance.
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Note: In addition to the listed tags all of the tags which are used for creating custom tags are used when 
creating member tags. A custom type shares many characteristics with a custom tag including namespace, calling 
methods, etc. A good understanding of custom tags (described in the prior chapter) is essential to understanding 
custom types.

Defining a Type
A new data type is defined by specifying its name in the opening [Define_Type] tag. The body of the 
[Define_Type] … [/Define_Type] tags contains code which will be executed each time a new instance of the data 
type is created.

For example, a new data type Ex_Dollar could be created which will store dollar amounts. The basic type 
definition is as follows. Each of the parts of this definition are discussed in more detail in the sections that 
follow.

[Define_Type: 'Dollar', -Namespace='Ex_'] 
	 [Local: 'Amount' = 0] 
	 [Define_Tag: 'onCreate', -Optional='Amount'] 
		  [If: (Local_Defined: 'Amount')] 
			   [Self->'Amount' = (Decimal: #Amount)] 
			   [Self->'Amount'->(SetFormat: -DecimalChar=',', -Precision=2)] 
		  [/If] 
	 [/Define_Tag]

	 … Member Tags …

[/Define_Type]

The [Define_Type] … [/Define_Type] tags define a tag with the same name as the data type. Each time a new 
instance of [Ex_Dollar] is created the [Ex_Dollar->onCreate] tag is called to initialize the instance. 

The code within [Define_Type] … [/Define_Type] should be used only to define instance variables and to create 
member tags. The code within [Ex_Dollar->onCreate] should be used to create a specific instance of the t ype 
based on the parameters passed to the [Ex_Dollar] tag.

Instance Variables
A data type can contain definitions for local variables within the [Define_Type] … [/Define_Type] tags. These local 
variables are called instance variables since their values are stored separately for each instance of the data type 
which is created.

In the example above, the local variable Amount is created. This variable will store a dollar amount, the current 
value of the data type. Each time a new instance of [Ex_Dollar] is created, a new instance of the Amount instance 
variable will be created. For example, the following two lines create two variables each of which stores a value 
of type Ex_Dollar. Each stores its own independent Amount.

[Variable: 'Price' = (Ex_Dollar: 10)]

[Variable: 'Tax' = (Ex_Dollar: 0.93)]

Instance variables can be referenced explicitly by name using the member symbol -> with the name 
of the instance variable. The values for the Amount instance variable can be retrieved from each of the 
Ex_Dollar amounts defined above using the following code.

[(Variable: 'Price')->'Amount'] ➜ 10.00

[(Variable: 'Tax')->'Amount'] ➜ 0.93

The quotes around the variable name Amount can be omitted if the type does not define a tag with the same 
name as the member variable. Usually, $Price->'Amount' is equivalent to $Price->Amount however for clarity it is 
best to use quotes around the member variable name when possible.
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Private Variables
The [Private] …[/Private] container tags can be used to designate one or more instance variables as private to the 
type. These variables can only be accessed from one of the member tags of the type.

Important: The properties map of the data type must be frozen when private instance variables are used. 
Freezing the properties map ensures that no additional instance variables or member tags can be added to the 
data type after it is created.

The example above can be rewritten so that Amount is a private variable. The variable can be accessed as 
follows using [Self->'Amount'], but cannot be accessed using (Variable: Price')->'Amount'.

[Define_Type: 'Dollar', -Namespace='Ex_'] 
	 [Private] 
		  [Local: 'Amount' = 0] 
	 [/Private] 
	 [Define_Tag: 'onCreate', -Optional='Amount'] 
		  [If: (Local_Defined: 'Amount')] 
			   [Self->'Amount' = (Decimal: #Amount)] 
			   [Self->'Amount'->(SetFormat: -DecimalChar=',', -Precision=2)] 
		  [/If] 
		  [Self->Properties->First->FreezeValue] 
		  [Self->Properties->Second->FreezeValue] 
	 [/Define_Tag]

	 … Member Tags …

[/Define_Type]

Private variables are not output using the [Null->Properties] or [Null->Dump] tags, are not output when a data type 
is serialized, and are not accessible by sub-types of the current type. The [Null->onSerialize] and [Null->onDeserialize] 
callbacks could be used to encrypt private variables and decrypt when the type is restored.

Transient Variables
Instance variables which start with an underscore are transient variables that will not be copied when the 
instance is assigned to another variable or serialized. Transient variables should only be used to store static 
data that does not need to be propagated to new instances of the data type and does not need to survive 
being stored in a session and retrieved.

The [Null->onSerialize] and [Null->onDeserialize] callbacks can be used to clean up or close any resources referenced 
by transient variables and to set them back up when the type is restored. The [Null->onAssign] callback can be 
used similarly when an instance is copied to another variable.

Serialization
Lasso serializes custom data types without member tags. When Lasso deserializes a type it creates a new 
instance of the type and copies all the data members from the serialized data into this new instance. A 
custom type must be defined on the page before it is deserialized.

	 •	Custom types which are stored in sessions must be defined before the [Session_Start] tag is called which 
implicitly deserializes the stored custom types.

	 •	Custom types which are stored in database fields must be defined before the [Null->Unserialize] tag is called.

The [Null->onSerialize] and [Null->onDeserialize] callbacks can be used for any special pre- or post-processing 
required before and after serializing a custom type.
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Member Tags

Built-In Member Tags
Each custom type can automatically make use of any of the tags of the null data type. These tags are detailed 
in Table 2: Built-In Tags. These tags are used by Lasso to provide information about data of any type and 
to provide efficient storage for custom data types. None of the tags in this table should be overriden by the 
custom data type.

In addition to these built-in member tags there are several tags that are defined as placeholders on the null 
data type. The [Null->Size] and [Null->SetFormat] tags are defined for every data type. [Null->Size] always returns 
0 and [Null->SetFormat] is a placeholder that returns no value if called. Either of these tags can be overridden 
using custom member tags. 

Note: It is desirable for custom data types to create custom [Type->Get] and [Type->Size] member tags so the 
[Iterate] … [/Iterate] tags will function properly.

Table 2: Built-In Member Tags

Tag	 Description	

[Null->DetachReference]	 Detaches the variable from the instance of  the data type.

[Null->FreezeType]	 Freezes the type of  a variable. After calling this tag the current variable cannot be 
cast to another data type.

[Null->FreezeValue]	 Freezes the value of  a variable, essentially creating a read-only variable. After 
calling this tag the current variable cannot have its value changed.

[Null->FullType]	 Returns the full type name for an instance including namespace.

[Null->Invoke]	 This member tag normally calls the creator of  the data type, but can be 
overridden to provide type specific behavior.

[Null->IsA]	 Accepts a single parameter which is the name of  a type. Returns True if  the 
parameter matches the name of  the current  data type or any of  its parent data 
types.

[Null->Parent]	 Returns a references to the parent type of  the current data type instance.

[Null->Properties]	 Returns a pair which contains a map of  all the instance variables and a map of  
all the member tags defined for the data type. Private instance variables and 
member tags are not returned by this tag.

[Null->RefCount]	 Returns the number of  variables that currently point at the instance of  the data 
type.

[Null->Serialize]	 Returns a bit-stream representation for the data type. This tag can be used 
to store a custom data type in a database or to pass it from page to page as 
an action parameter. Note that private and transient instance variables are not 
automatically serialized.

[Null->Type]	 Returns the type which was specified when the custom type was created.

[Null->Unserialize]	 Accepts a single parameter which is a bit-stream created by [Null->Serialize]. 
This tag modifies the variable on which it is called by setting it to the custom data 
type represented by the bit-stream parameter.

		

Custom Member Tags
Each custom type can define member tags which can be called to modify the value stored in an instance of 
the custom type or to output values from an instance of the custom type.

Member tags are defined within the [Define_Type] … [/Define_Type] tags for the custom type using 
[Define_Tag] … [/Define_Tag] tags. The syntax for creating member tags is the same as that for creating custom 
tags. However, member tags cannot be called asynchronously. The [Define_Tag] tag for a member tag should 
never have -Async as the value for the second parameter.
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The [Self] tag allows member tags to reference the current instance of the data type. This allows member tags 
to call other defined member tags or to set or retrieve values stored in instance variables. See the example 
of defining a custom member tag below for more information. The [Self] tag also allows access to instance 
variables that are stored within the custom data type.

Custom member tags which are named starting with an underscore are transient member tags. These tags will 
not be copied when the data type instance is copied to another variable or serialized. The [Null->onAssign] and 
[Null->onDeserialize] callbacks can be used to redefine transient member tags.

To define custom member tags:

Two custom tags will be defined for the Ex_Dollar custom type. The [Ex_Dollar->Set] tag will accept a single 
parameter, cast it to decimal, and store it in the Amount instance variable. The [Ex_Dollar->Get] tag will simply 
return the value of the Amount instance variable formatted as a dollar amount.

	 •	The [Ex_Dollar->Set] member tag is defined within the body of the [Define_Type] … [/Define_Type] tags. It checks 
that there is at least one parameter in the [Params] array. The [Self] tag is a reference to the current instance of 
the Ex_Dollar data type, so the (Self->'Amount') statement is a reference to the Amount instance variable.

<?LassoScript 
	 Define_Tag: 'Set'; 
		  If: (Params) && ((Params)->Size > 0); 
			   (Self->'Amount') = (Decimal: (Params)->(Get:1)); 
		  /If; 
	 /Define_Tag; 
?>

	 •	The [Ex_Dollar->Get] member tag is defined within the body of the [Define_Type] … [/Define_Type] tags. It 
appends a dollar sign $ to the value in the Amount instance variable and returns the value. The [Self] tag is a 
reference to the current instance of the Ex_Dollar data type, so the (Self->'Amount') statement is a reference to 
the Amount instance variable.

<?LassoScript 
	 Define_Tag: 'Get'; 
		  Return: '$' + (Self->'Amount'); 
	 /Define_Tag; 
?>

To call a custom member tag:

Custom member tags are called in the same way that the member tags of the built-in data types are called. 
The Ex_Dollar type has two member tags [Ex_Dollar->Get] and [Ex_Dollar->Set]. They are used to set and retrieve 
dollar amounts in the following example.

[Variable: 'Price' = (Ex_Dollar: 100)] 
<br>[(Variable: 'Price')->Get] 
[(Variable: 'Price')->(Set: 19.95)] 
<br>[(Variable: 'Price')->Get]

➜	<br>$100.00 
<br>$19.95

Private Member Tags
The [Private] …[/Private] container tags can be used to designate one or more member tags as private to the type. 
These member tags can only be accessed from one of the member tags of the type. Private member tags are 
not output using the [Null->Properties] or [Null->Dump] tags, are not output when a data type is serialized, and are 
not accessible by sub-types of the current type.

Important: The properties map of the data type must be frozen when private instance variables are used. 
Freezing the properties map ensures that no additional instance variables or member tags can be added to the 
data type after it is created. See the example in the Private Variables section above.
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Atomic Member Tags
Member tags which are created with the -Atomic keyword will hold a lock on the type instance.  Only 
one atomic member tag will be able to execute at a time per instance. This allows access to the instance 
variables within a type to be controlled. However, an atomic custom tag outside of the type (or 
[Thread_Atomic] … [/Thread_Atomic] tags) must be used in order to control access to a shared resource. See the 
prior chapter for more information about atomic tags.

Prototypes
Lasso can use type prototypes to dramatically increase the performance of custom types. When Lasso creates a 
new instance of a type it normally runs all of the code within the [Define_Type] … [/Define_Type] tags in order to 
create instance variables and member tags. When the -Prototype keyword is used Lasso runs the code with the 
type definition once and stores a reference to the pre-compiled prototype. This prototype is copied each time 
an instance of the type is created.

Any data type which follows these guidelines can be used as a prototype. It is recommended that all custom 
data types be created as prototypes.

	 •	The custom type definition must only contain [Local] tags to define instance variables and 
[Define_Tag] … [/Define_Tag] tags to define member tags within the [Define_Type] … [/Define_Type] tags.

	 ˆ•	The -Prototype keyword must be referenced in the opening [Define_Type] tag.

[Define_Type: 'Ex_MyPrototype', -Prototype] 
	 [Local: 'MemberVariable' = ''] 
	 [Define_Tag: 'MemberTag'] 
		  … Code can reference local, page, or global variables … 
	 [/Define_Tag] 
[/Define_Type]

In addition, it is possible to use the [Define_Prototype] tag to create a prototype out of any data type. This tag 
takes two parameters: the name of the desired prototype and a reference to a data type which will be used 
as the prototype. The data type is copied into the tag map as a prototype. Any time the prototype name is 
referenced a copy of the prototype will be made.

Table 3: Prototype Tag

Tag	 Description	

[Define_Prototype]	 Installs a prototype in the tag map. Requires two parameters: the name by which 
the prototype will be referenced (the tag name) and a reference to the data 
type that will be copied as the prototype. A namespace can also be specified by 
inculding a -Namespace parameter between the name and reference parameters.

		

For example a map could be created that had some pre-defined values which would be used over and over 
again. This map can be installed as a prototype and then referenced as if it were a custom type.

[Var: 'Prototype_Map' = (Map: 'First_Name' = '', 'Last_Name'='')] 
[Define_Prototype: 'Ex_Person', $Prototype_Map]

[Var: 'myMap' = (Ex_Person)]

Callback Tags
Each custom type can define a number of callback tags using the [Define_Tag] … [/Define_Tag] tags within the 
[Define_Type] … [/Define_Type] definition for the type. These callback tags will be executed with appropriate 
parameters when the data type is cast to another type, a new instance is created, or an instance is destroyed.
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Table 3: Callback Tags details the tags that are available. These tag names are reserved. No member tags 
with these names should be defined. These tags are not normally called by a Lasso developer, they are called 
automatically by Lasso in the specified situation. Although there is no protection to prevent a Lasso developer 
from calling these tags directly, results should be considered undefined if they do.

The primary callback tags are shown in Table 3: Callback Tags. Additional callback tags allow the overriding 
of built-in symbols. These tags are described in the next section.

Table 4: Callback Tags

Tag	 Description	

[Null->onConvert]	 Called when the instance is cast to a built-in data type. Accepts a single 
parameter, the name of  the type to which the value should be converted (string, 
integer, or decimal). The return value should be the converted value or Null if  no 
conversion was possible.

[Null->onCreate]	 Called immediately after a new instance is created. This tag has full access to the 
variables and member tags defined within the [Define_Type] … [/Define_Type] 
tags.

[Null->onDestroy]	 Called before the custom type is destroyed, usually at the end of  the current 
Lasso page or tag execution.

[Null->onSerialize]	 Called when the custom type is serialized. The return value is stored with the 
serialized data and passed to [Null->onDeserialize].

[Null->onDeserialize]	 Called when the custom type is deserialized. The return value of  [Null-
>onSerialize] is passed as the first parameter to this tag.

[Null->_UnknownTag]	 Called when an unknown member tag is referenced. The [Tag_Name] tag can be 
used to decide what tag name was referenced.

		

Note: These callback tags are not included in the Lasso tag list. They are intended to be called by Lasso 
automatically rather than being called like other member tags.

onCreate Callback
The [Null->onCreate] callback tag is called after a new instance of a type is created. It is called once for each 
instance of a type with any parameters that were passed to the tag that created the type.

For example, when the tag [Ex_Dollar] is used to create a new instance of the dollar type the following steps are 
performed. 

	 1	The code within the [Define_Type] … [/Define_Type] container is executed, creating all the custom tags and 
instance variables for the type.

	 2	The [Ex_Dollar->onCreate] tag is called with the parameters passed to the [Ex_Dollar] tag to set up the particular 
instance of the type.

Since the callback tag is called after the code within the [Define_Type] … [/Define_Type] container is processed, the 
[Null->onCreate] tag has access to the [Self] tag and to each of the member tags which have been defined for the 
current type.

Order of operation:

A new instance of a custom type is created by calling the creator tag for the type which has the same name as 
the type. For example, to create a new Ex_Dollar type the [Ex_Dollar] tag must be called.

[Ex_Dollar: 10]

	 1	The body of the [Define_Type] … [/Define_Type] tags for the Ex_Dollar type are executed. Local instance variables 
are defined and all member tags are defined.

	 2	If the [Ex_Dollar->onCreate] callback tag is defined then it is called.
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To define a [Null->onCreate] callback tag:

The Ex_Dollar data type is too simple to require an [Ex_Dollar->onCreate] callback tag. All the initialization which 
is needed is performed in the creator tag. However, for debugging purposes it might be nice to know each 
time an instance of the new data type is created. The following [Ex_Dollar->onCreate] tag logs the current value 
of the instance variable Amount each time a new instance of the data type is created.

[Define_Tag: 'onCreate'] 
	 [Log: -Window] Create Ex_Dollar: [Self->'Amount'].[/Log] 
[/Define_Tag]

It is generally possible to modify a custom type instance after it has been created by modifying the maps 
provided by the [Null->Properties] tag. For example, instance variables and member tags can be inserted into a 
single type instance. This is often undesirable because it allows one custom type instance to be different from 
another, not just in the data it stores, but in the actual instance variables and member tags it defines! The 
two freeze value tags shown below can be used in the [Null->onCreate] callback in order to lock the data type 
instance once it is created.

[Define_Tag: 'onCreate'] 
	 … Perform Initialization … 
	 [Self->Properties->First->FreezeValue] 
	 [Self->Properties->Second->FreezeValue] 
[/Define_Tag]

onConvert Callback
The [Null->onConvert] callback tag is called when an instance of a custom type is cast to a built-in data type. This 
tag will be called when an instance of a custom type is used in an expression with built-in data types that 
requires an integer, decimal, or string value. Each custom type must support being cast to the string data type 
and should support being cast to the decimal or integer data types if possible.

The [Null->onConvert] callback is called with the name of the type to which the current instance is being 
converted (either string, integer, or decimal). If the name of the type is not recognized then the [Null->onConvert] 
tag should return Null. Lasso will attempt to convert the custom data type using another method or will throw 
an error.

To define a [Null->onConvert] callback tag:

The [Ex_Dollar->onConvert] callback tag is called when an Ex_Dollar amount is cast to a built-in data type. If 
the value is cast to a decimal or an integer then the callback tag will cast the value in the Amount instance 
variable to the appropriate data type. If the value is cast to a string then the [Ex_Dollar->Get] member tag which 
was defined previously will be called. Otherwise, the callback tag will return Null instructing Lasso that the 
conversion is not supported.

<?LassoScript 
	 Define_Tag: 'onConvert'; 
		  Local: 'Type' = (Params)->(Get: 1); 
		  If: (Local: 'Type') == 'String'; 
			   Return: (Self->Get); 
		  Else: (Local: 'Type') == 'Integer'; 
			   Return: (Integer: (Self->'Amount')); 
		  Else: (Local: 'Type') == 'Decimal'; 
			   Return: (Decimal: (Self->'Amount')); 
		  /If; 
		  Return Null; 
	 /Define_Tag; 
?>

In the following code a variable Price is set to a value of type Ex_Dollar. Then that variable is cast to different 
data types.
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[Variable: 'Price' = (Ex_Dollar: 19.95)] 
<br>[String: (Variable: 'Price')] 
<br>[(Integer: (Variable: 'Price'))] 
<br>[(Decimal: (Variable: 'Price'))]

➜	<br>$19.95 
<br>20 
<br>19.95

onDestroy Callback
The [Null->onDestroy] callback tag is the last member tag called for each instance of a custom type. The 
[Null->onDestroy] callback tag allows any cleanup code that needs to be performed to be executed before the tag 
is purged from memory. The [Null->onDestroy] tag is called once for each instance of a custom type.

The [Null->onDestroy] callback tag is called in the following instances.

	 •	If a custom type literal is created and not stored in a variable, the instance is destroyed as soon as the 
current tag completes.

[(Ex_Dollar: 10.0)]

	 •	If a custom tag is created within the [Define_Tag] … [/Define_Tag] tags of a custom tag declaration and stored in 
a local variable then the instance is destroyed as soon as the custom tag completes.

	 •	If a custom tag is created within the [Define_Type] … [/Define_Type] tags of a custom type or is stored in an 
instance variable within a custom type then the instance is destroyed as soon as the custom type within 
which it is stored is destroyed.

	 •	If a custom type is stored within a page variable then it will be destroyed as soon as the page finishes 
executing, but before it is served to the site visitor.

To define a [Null->onDestroy] callback tag:

The Ex_Dollar data type is too simple to require an [Ex_Dollar->onDestroy] callback tag. The instance variable 
Amount and each of the member tags will be destroyed automatically by Lasso. However, for debugging 
purposes it might be nice to know each time an instance of the new data type is destroyed. The following 
[Ex_Dollar->onDestroy] tag logs the current value of the instance variable Amount each time a new instance of the 
data type is destroyed.

[Define_Tag: 'onDestroy'] 
	 [Log: -Window] Destroy Ex_Dollar: [Self->'Amount'].[/Log] 
[/Define_Tag]

Unknown Tag Callback
The [Null->_UnknownTag] callback tag is called when a tag that does not exist for the current data type is 
referenced. This callback tag allows a custom data type to respond to member tags which are not explicitly 
created. The tag name which was called can be retrieved using the [Tag_Name] tag.

None of the callback tags are ever passed to the [Null->_UnknownTag] callback. Callback tags must be defined 
explicitly in order to be implemented.

Order of operation:

When a member tag is called on a custom type:

	 1	If a member tag with that name is defined then it is executed.

	 2	If no member tag with that name is defined then the [Null->_UnknownTag] callback is executed.

	 3	If an instance variable with that name is defined then its value is returned.

	 4	If the unknown tag callback is not defined then an error is returned.
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Note: If desired the _UnknownTag callback can check the properties of the type and return a reference to a 
member variable. This allows the _UnknownTag callback to simulate the built-in behavior of returning an instance 
variable even when it is referenced without quotes.

To define a [Null->_UnknownTag] callback tag:

The Ex_Dollar data type could implement a conversion to different currencies using the unknown tag callback. 

Assume that there is a tag [Currency_Convert] which accepts a value, a -From parameter with the code for what 
currency to convert from, and a -To parameter with the code for what currency to convert to. The tag uses data 
from a site on the Internet to get accureate real-time conversion rates.

Rather than coding in all currency codes explicitly and unknown tag callback can be used to pass any 
unknown member tags to the [Currency_Convert] tag. An error will be returned if the tag name is not a valid 
currency code.

[Define_Tag: '_UnknownTag'] 
	 [Local: 'Code' = (Tag_Name)] 
	 [Local: 'Result' = (Currency_Convert: (Decimal: Self->'Amount'), 
		  -From='USD', -To=#Code)] 
	 [Return: (Decimal: #Result)] 
[/Define_Tag]

The following code would now work to convert the U.S. currency represented by the [Ex_Dollar] type to U.K. 
Pounds represented by UKP.

[Variable: 'Price' = (Ex_Dollar: 19.95)] 
<br>[(Variable: 'Price')->(UKP)]

➜	<br>31.24

Symbol Overloading
Lasso allows complex expressions using math and string symbols to be specified as tag parameters. In 
addition, a set of assignment symbols allow a variable to be modified in place without returning a value. A 
list of common symbols is shown in Table 4: Overloadable Symbols.

Each data type can assign its own meanings to each of the symbols that Lasso provides. For example, the 
built-in integer and decimal data types use the + symbol for addition while the built-in string data type 
uses the + symbol for concatenation. In general it is wisest to match the common meanings of the symbols 
whenever possible. Ideally, the user will be able to use each data type’s custom symbols interchangeably with 
the symbols provided by the built-in data types.

The meaning of corresponding assignment symbols, unary symbols, and binary symbols should be 
compatible whenever possible. The operation [(Variable: 'myVariable') += 'Value'] should be the same as the 
operation [Variable 'myVariable' = $myVariable + 'Value'].

Table 5: Overloadable Symbols

Symbol	 Description	

+	 Unary/Binary symbol for addition or concatenation.

-	 Unary/Binary symbol for subtraction or deletion.

*	 Binary symbol for multiplication or repetition.

/	 Binary symbol for division.

%	 Binary symbol for modulus.

++	 Unary increment symbol prefix or postfix.

--	 Unary decrement symbol prefix or postifx.

==	 Binary symbol for equality. Returns boolean.

!=	 Binary symbol for inequality. Returns boolean.

>	 Binary symbol for greater than. Returns boolean.
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>=	 Binary symbol for greater or equal. Returns boolean.

<	 Binary symbol for less than. Returns boolean.

<=	 Binary symbol for less or equal. Returns boolean.

>>	 Binary symbol for contains. Returns boolean.

=	 Assignment symbol.

+=	 Addition assignment symbol.

-=	 Subtraction assignment symbol.

*=	 Multiplication assignment symbol.

/=	 Division assignment symbol.

%=	 Modulus assignment symbol.
		

Each of these symbols can be redefined or overloaded for a custom data type. The data type of the left 
parameter to a binary operator determines which tag is used to perform the operation. If a data type does not 
support the symbol then the parameter is cast to string and the string symbol is used instead.

Other symbols such as $, #, @ cannot be overloaded. These are core language constructs. The logical symbols 
||, &&, and ! cannot be overloaded, but a custom behavior can be defined when a custom data type is cast to 
boolean.

Callback Tags
Each custom type can define a number of callback tags using the [Define_Tag] … [/Define_Tag] tags within the 
[Define_Type] … [/Define_Type] definition for the type. These callback tags will be executed with appropriate 
parameters when the data type is used in a complex expression.

Table 5: Comparison Callback Tags, Table 6: Symbol Callback Tags, and Table 7: Assignment Callback 
Tags detail the tags that are available. These tag names are reserved. No member tags with these names 
should be defined. These tags are not normally called by a Lasso developer, they are called automatically by 
Lasso in the specified situation. Although there is no protection to prevent a Lasso developer from calling 
these tags directly, results should be considered undefined if they do.

Table 6: Comparison Callback Tags

Tag	 Description	

[Null->onCompare]	 Called when the current instance is used in a comparison expression. Accepts 
a single parameter, the value to be compared against. Should return 0 if  the 
parameter is equal to the current instance, a positive number if  the parameter is 
greater, or a negative number if  the parameter is less. Called for the ==, !=, <, <=, 
>, >= symbols.

[Null->>>]	 Called when an instance is used as the left parameter of  a contains symbol. 
Accepts a single parameter which is the right parameter of  the symbol. This tag 
should return True if  the right parameter is contained in the current instance.

		

Note: These callback tags are not included in the Lasso tag list. They are intended to be called by Lasso 
automatically rather than being called like other member tags.

onCompare Callback
The [Null->onCompare] callback tag is called when an instance of a custom type is used as the left parameter of a 
comparison symbol ==, !=, <, <=, >, or >=. The callback tag is called with the value of the right parameter of the 
symbol. The result of the tag should be one of the following.

	 •	Equality – If the value of the right parameter is equal to the value of the current instance of the custom 
type then the return value should be 0. This will evaluate to True for the ==, <=, and >= symbols.

	 •	Less Than – If the value of the right parameter is less than the value of the current instance of the custom 
type then the return value should be any number less than 0. This will evaluate to True for the <, <=, and != 
symbols.
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	 •	Greater Than – If the value of the right parameter is greater than the value of the current instance of the 
custom type then the return value should be any number greater than 0. This will evaluate to True for the >, 
>=, and != symbols.

If a comparison cannot be made then Null should be returned instead. Lasso will attempt to perform a cast in 
order to compare the two values instead. If no [Null->onCompare] callback tag is defined then Lasso will attempt 
to perform a cast in order to compare the two values as well.

The value of the left parameter determines the type of comparison which is used. If a custom type is used as 
the right parameter in a comparison expression and a built-in data type is used as the left parameter then the 
custom type is cast to the appropriate built-in data type and the values are compared.

Note: The [Array->Find] and  [Array->Sort] member tags use comparisons to determine the found set or order 
of elements in the array. A custom data type will be searched or sorted according to the results of the 
[Null->onCompare] callback tag.

To define a [Null->onCompare] callback tag:

The [Ex_Dollar->onCompare] callback tag will simply cast any value that is assigned to it to the decimal data type 
then compare that value to the value stored in the Amount instance variable.

<?LassoScript 
	 Define_Tag: 'onCompare'; 
		  Local: 'Temp' = (Decimal: (Params)->(Get: 1)); 
		  If: (Local: 'Temp') == (Self->'Amount'); 
			   Return: 0; 
		  Else: (Local: 'Temp') < (Self->'Amount'); 
			   Return -1; 
		  Else: (Local: 'Temp') > (Self->'Amount'); 
			   Return 1; 
		  /If; 
	 Return Null; 
	 /Define_Tag; 
?>

In the following code a variable Price is set to a value of type Ex_Dollar. Then that variable is compared to 
different data types.

[Variable: 'Price' = (Ex_Dollar: 19.95)] 
<br>[(Variable: 'Price') == (String: '19.95')] 
<br>[(Variable: 'Price') == (Integer: 20)] 
<br>[(Variable: 'Price') == (Decimal: 19.95)]

➜	<br>True 
<br>False 
<br>True

Contains Callback
The [Null->>>] callback tag is called when an instance of a custom type is used as the left parameter of a >> 
comparison symbol. The callback tag is called with the value of the right parameter of the symbol. The result 
of the tag should be one of the following.

	 •	True – If the value of the right parameter is contained within the current instance.

	 •	False – If the value of the right parameter is not contained within the current instance.

If the contains operation cannot be performed then Null should be returned instead. Lasso will attempt to 
perform a cast in order to perform the contains operation. If no [Null->>>] callback tag is defined then Lasso 
will attempt to perform a cast in order to perform the contains operation as well.

If a custom type is used as the right parameter in a contains expression and a built-in data type is used as the 
left parameter then the custom type is cast to the appropriate built-in data type and the values are compared.
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To define a [Null->>>] callback tag:

The [Ex_Dollar->>>] callback tag will cast any value that is assigned to it to the string data type. If the output 
from [Ex_Dollar->Get] run on the [Self] tag contains the parameter then True is returned.

<?LassoScript 
	 Define_Tag: '>>'; 
		  Local: 'Temp' = (String: (Params)->(Get: 1)); 
		  Return: (Self->Get) >> #Temp; 
	 /Define_Tag; 
?>

In the following code a variable Price is set to a value of type Ex_Dollar. Then that variable is checked to see if it 
contains $ which it does.

[Variable: 'Price' = (Ex_Dollar: 19.95)] 
<br>[(Variable: 'Price') >> '$']

➜	<br>True

Table 7: Symbol Callback Tags

Tag	 Description	

[Null->+]	 Called when an instance is used as the left parameter of  an addition symbol. 
Accepts a single parameter which is the right parameter of  the symbol. If  no 
parameter is specified then the unary symbol is being used.

[Null->-]	 Called when an instance is used as the left parameter of  a subtraction symbol. 
Accepts a single parameter which is the right parameter of  the symbol. If  no 
parameter is specified then the unary symbol is being used.

[Null->*]	 Called when an instance is used as the left parameter of  a multiplication symbol. 
Accepts a single parameter which is the right parameter of  the symbol.

[Null->/]	 Called when an instance is used as the left parameter of  a division symbol. 
Accepts a single parameter which is the right parameter of  the symbol.

[Null->%]	 Called when an instance is used as the left parameter of  a modulus symbol. 
Accepts a single parameter which is the right parameter of  the symbol.

[Null->++]	 Called when an instance is used as the left or right parameter of  a unary 
increment symbol.

[Null->--]	 Called when an instance is used as the left or right parameter of  a unary 
decrement symbol.

		

Note: These callback tags are not included in the Lasso tag list. They are intended to be called by Lasso 
automatically rather than being called like other member tags.

Symbol Callback Tags
The symbol callback tags are called whenever the custom data type is used as the left parameter to one of the 
built-in symbols +, -, *, /, or % or when the custom data type is used as the lone parameter to the + , ++, - or 
-- unary symbols. These tags usually return a value of the custom data type, but can return a value of any data 
type.

For the binary operators, the right parameter to the symbol is provided as the parameter of the callback 
function and could be of any data type. For the unary operators, no parameter is specified.

If no callback tag is defined for a given symbol then Lasso will attempt to cast values to string and will use 
the built-in string symbols.

To define a [Null->-] callback tag:

The [Ex_Dollar->-] callback tag will create a new [Ex_Dollar] data type. The value of the new type will be found by 
either subtracting a value from the Amount instance variable if a parameter is specified or by changing the sign 
of the Amount instance variable if no parameter is specified.
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<?LassoScript 
	 Define_Tag: '-'; 
	 If: (Params->Size > 0); 
		  Return: (Ex_Dollar: (Self->'Amount') - (Decimal: Params->(Get: 1))); 
	 Else; 
		  Return: (Ex_Dollar: (Self->'Amount') * (-1)); 
	 /If; 
	 /Define_Tag; 
?>

In the following code a variable Price is initialized with a value of 19.95. Then, 5.95 is subtracted from variable 
and the result is output. Notice that even though the amount subtracted is a decimal, the result is of type 
Ex_Dollar and outputs with proper formatting.

[Variable: 'Price' = (Ex_Dollar: 19.95)] 
<br>[(Variable: 'Price') - 5.95]

➜	<br>$14.00

Table 8: Assignment Callback Tags

Tag	 Description	

[Null->onAssign]	 Called when an assignment is made to the current instance from any other data 
type using the = symbol. This tag should return True if  the assignment was 
successful.

[Null->+=]	 Called when an instance is used as the left parameter of  an addition assignment 
symbol. Accepts a single parameter which is the right parameter of  the symbol. 
This tag should return true if  the assignment was successful.

[Null->-=]	 Called when an instance is used as the left parameter of  a subtraction 
assignment symbol. Accepts a single parameter which is the right parameter of  
the symbol. This tag should return true if  the assignment was successful.

[Null->*=]	 Called when an instance is used as the left parameter of  a multiplication 
assignment symbol. Accepts a single parameter which is the right parameter of  
the symbol. This tag should return true if  the assignment was successful.

[Null->/=]	 Called when an instance is used as the left parameter of  a division assignment 
symbol. Accepts a single parameter which is the right parameter of  the symbol. 
This tag should return true if  the assignment was successful.

[Null->%=]	 Called when an instance is used as the left parameter of  a modulus assignment 
symbol. Accepts a single parameter which is the right parameter of  the symbol. 
This tag should return true if  the assignment was successful.

		

Note: These callback tags are not included in the Lasso tag list. They are intended to be called by Lasso 
automatically rather than being called like other member tags.

onAssign Callback
The [Null->onAssign] callback tag is called when an instance of a custom type is used as the left parameter of 
the assignment symbol =. The callback tag is called with the value of the right parameter of the symbol. The 
tag should attempt to store the value of the right parameter as the new value of the current instance of the 
custom type. It should return one of the following values.

	 •	True – The callback tag should return True if the assignment was successful. This is the sign to Lasso that no 
further work needs to be done.

	 •	False – If for any reason the assignment cannot be performed then the callback tag should return False. 
Lasso will instead attempt to cast the value of the right parameter to the data type of the left parameter and 
try the assignment again.
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If no [Null->onAssign] callback tag is defined then Lasso will attempt to cast values to the current data type by 
calling the [Null->onConvert] tag of the right parameter of the assignment operator. For maximum compatibility, 
each data type should support at least all built-in data types for assignment and conversion.

To define a [Null->onAssign] callback tag:

The [Ex_Dollar->onAssign] callback tag will simply cast any value that is assigned to it to the decimal data type 
then store that value in the Amount instance variable. This mimics the behavior of the [Ex_Dollar->Set] member 
tag which was defined previously.

<?LassoScript 
	 Define_Tag: 'onAssign'; 
		  (Self->'Amount') = (Decimal: (Params)->(Get: 1)); 
	 /Define_Tag; 
?>

In the following code a variable Price is initialized with a value of type Ex_Dollar. The variable is then assigned 
a string value 19.95 which is cast to a decimal value by the [Ex_Dollar->onAssign] tag called implicitly by Lasso to 
perform the assignment operator.

[Variable: 'Price' = (Ex_Dollar)] 
[(Variable: 'Price') = '19.95'] 
<br>[(Variable: 'Price')->Get]

➜	<br>$19.95

Assignment Symbols Callbacks
The [Null->+=], [Null->-=], [Null->*=], [Null->/=], and [Null->%] callback tags are called when an instance of a custom 
type is used as the left parameter of the corresponding assignment symbol +=, -=, *=, /=, or %=. The callback tag 
is called with the value of the right parameter of the symbol. The tag should attempt to perform the desired 
operation and store the value of the right parameter as the new value of the current instance of the custom 
type. It should return one of the following values.

	 •	True – The callback tag should return True if the assignment was successful. This is the sign to Lasso that no 
further work needs to be done.

	 •	False – If for any reason the assignment cannot be performed then the callback tag should return False. 
Lasso will instead attempt to cast the value of the right parameter to the data type of the left parameter and 
try the assignment again.

If no callback tag for a given assignment symbol is defined then Lasso will attempt to cast values to the 
current data type by calling the [Null->onConvert] tag of the right parameter of the assignment operator.

To define a [Null->+=] callback tag:

The [Ex_Dollar->=+] callback tag will simply cast any value that is assigned to it to the decimal data type and 
add that value to the Amount instance variable.

<?LassoScript 
	 Define_Tag: '+='; 
		  (Self->'Amount') += (Decimal: (Params)->(Get: 1)); 
	 /Define_Tag; 
?>

In the following code a variable Price is initialized with a value of type Ex_Dollar and a value of 19.95. Finally, 
the += symbol is used to add an additional 5.95 to the variable.

[Variable: 'Price' = (Ex_Dollar: '19.95')] 
[(Variable: 'Price') += '5.95'] 
<br>[(Variable: 'Price')->Get]

➜	<br>$19.95
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Inheritance
Custom types can be created which inherit properties from other custom types. Each type which the custom 
type should inherit from is specified after the name of the custom type in the opening [Define_Type] tag. These 
are called parent types and the current type being defined is called a child type. 

[Define_Type: 'myType', 'ParentType'] … [/Define_Type

If a custom type inherits from multiple types then it must list each type explicitly. For example, if a custom 
type ParentType itself inherits from the built-in Array type then both ParentType and Array must be listed 
explicitly in the custom type definition.

[Define_Type: 'myType', 'ParentType', 'Array'] … [/Define_Type

All instance variables and member tags of the parent types are inherited by the child type. If the child type 
defines an instance variable or member tag with the same name as one of the parent types then the child’s 
definition overrides the parent’s definition.

Custom types can inherit properties from built-in data types. A custom type will inherit any member tags 
which the built-in type defines, but will not inherit any of the features that require callback functions. It will 
be necessary to create custom casting and assignment callbacks and to implement any symbols which are 
desired.

All custom data types inherit from the null data type. The tags of the null data type such as [Null->Type] can be 
used by any data type within Lasso. These tags can be overridden, but doing so can cause unexpected results.

The member tags and instance variables of the parent tag can be accessed using the [Parent] tag. This tag works 
like the [Self] tag, but returns the value of the current data type instance as it would be if it were of the parent 
type.

The creator tag [Null->onCreate] and destructor tag [Null->onDestroy] for each parent data type is called 
automatically when a new instance of the child data type is created.

To define a custom type that inherits from another custom type:

The Ex_Dollar type which is defined in this chapter only works with U.S. currency and outputs values using 
the dollar sign $. It is possible to create a sub-type that works with a different type of currency. For example, a 
new type Ex_UKPounds could be created which inherited from Ex_Dollar, but output values with a British pound 
symbol £. by overriding the [Ex_Dollar->Get] tag with a new [Ex_UKPounds->Get] tag.

The type is defined as inheriting from Ex_Dollar by specifying Ex_Dollar after the name of the new type in the 
opening [Define_Type] tag. All the member tags of Ex_Dollar are automatically defined as is the instance variable 
Amount. 

The [Ex_UKPounds->Get] member tag is defined and overrides the equivalent [Ex_Dollar->Get] member tag. The 
[Self->Parent] tag is used to reference the Amount instance variable from the parent type.

<?LassoScript 
	 Define_Type: 'UKPounds', 'Ex_Dollar', -Namespace='Ex_';

		  Define_Tag: 'Get'; 
			   Return: '£' + (Self->Parent->'Amount'); 
		  /Define_Tag;

	 /Define_Type; 
?>

The following example sets two variables, one to a value of Ex_Dollar type and the other to a value of 
Ex_UKPounds type, then outputs both values. The types are converted to strings when they are output and the 
appropriate [Ex_Dollar->Get] or [Ex_UKPounds->Get] tag is called to format the output.

[Variable: 'American'= (Ex_Dollar: 100)] 
<br>[Variable: 'American'] 
[Variable: 'British'= (Ex_UKPounds: 100)] 
<br>[Variable: 'British']
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�	<br>$100.00 
<br>£100.00

Libraries
Libraries can be used to package custom tags and custom types into a format which is easy for any Lasso 
developer to incorporate into a Lasso-powered Web site.

The following types of libraries can be created:

	 •	On-Demand Tag Library – A set of custom tag and custom type declarations can be stored in a Lasso page 
or LassoApp and placed in the LassoLibraries folder in the Lasso Professional 8 application folder. The Lasso 
page or LassoApp should have the same name (before the .Lasso or .LassoApp file suffix) as the namespace 
of the tags defined within. Sub-folders can be used to define nested namespaces.

	 •	Library Lasso Page – A set of custom tag and custom type declarations can be stored in a Lasso page and 
then included in any other Lasso page using the [Library: 'library.lasso'] tag. This is a good way to create and 
use a library file whose defined tags and types will only be needed on a few pages in a site.

	 •	LassoStartup Lasso Page – A set of custom tag and custom type declarations can be stored in a Lasso 
page placed within the LassoStartup folder. After Lasso Service is restarted all tags, types, and page variables 
which are defined within the Lasso page will be available to all Lasso pages which are executed on the 
server.
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Chapter 59

Custom Data Sources

Data sources can be implemented entirely in LassoScript using the techniques and tags documented in this 
chapter.

	 •	Overview describes the basic methodology of creating a LassoScript data source and how to install a 
LassoScript data source.

	 •	Data Source Tags describes the tags that are available to help make a LassoScript data source.

	 •	Data Source Type describes the data type that must be implemented to create a new LassoScript data 
source.

Overview
Lasso provides the ability to create a data source entirely in LassoScript code. This makes it possible to easily 
implement entirely new types of data source modules without using either C/C++ or Java code.

	 •	Custom data sources can use the net type to connect to a remote data source. Incoming data can be parsed 
using string or XML tags.

	 •	Custom data sources can use XML-RPC or SOAP to connect to remote procedures. Searching remote 
application servers can be made as easy as searching local databases.

	 •	Custom data sources can use the file tags to provide access to files on the local machine through standard 
Lasso actions. For example, the XML tags could be used to search local XML files.

	 •	Custom data sources can be used as a wrapper around other Lasso data sources providing round-robin load 
balancing, intelligent fail over behavior, or caching.

A LassoScript data source is implemented as a custom type that must define certain member tags. The data 
source is registered with Lasso at Lasso Startup using the [DataSource_Register] tag and then appears within 
Lasso Administration along with the standard data sources, JDBC drivers, and any third-party data sources 
implemented in LCAPI or LJAPI.

The LassoScript data source must provide a list of databases to Lasso. When any of these database names are 
used within an inline action a new instance of the LassoScript data source type is instantiated and a member 
tag is called to perform the action. Once the action is performed the instance of the LassoScript data source 
type is deleted.

Data Source Register
The following table shows the tag that is used to register a LassoScript data source. This tag should be called 
in LassoStartup once for each LassoScript data source.
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Table 1: Data Source Register

Tag	 Description	

[Datasource_Register]	 Registers a data type as a new data source. The tag requires one parameter 
which is the name of  the data source that implements the data source. The 
specified data source must implement the tags described in the following section.

		

To register a LassoScript data source:

Use the [Datasource_Register] tag with the name of the custom data source that implements the LassoScript data 
source. This tag should be called once by a file in the LassoStartup folder. In the following example a custom 
data source Ex_DataSource is registered.

<?LassoScript 
	 Define_Type: 'DataSource', -Namespace='Ex_'; 
		  … Data Source Definition … 
	 /Define_Type; 
	 Datasource_Register: 'Ex_DataSource'; 
?>

Data Source Type
Each custom type that implements a LassoScript data source must define the following member tags. Lasso 
calls these tags in order to retrieve the list of databases, tables, schemas, or fields from the data source host 
and to perform database actions when an [Inline] is called with one of the data source’s databases. Each of 
these member tags is described in more detail below.

Note: It is recommended that each data source implement each of these member tags even if they contain no 
statements.

Table 2: Data Source Member Tags

Tag	 Description	

Initialize	 Called once immediately after the data source is registered. This allows the data 
source to perform an initialization routine if  required.

Terminate	 Called once immediately before Lasso Service is quit. This tag allows the data 
source to perform a global cleanup routine if  required.

onCreate	 Called when a new instance of  the data source is created. The tag is passed an 
array of  information about the host for the data source.

DatabaseNames	 Called when Lasso needs a list of  the databases that the data source provides. 
The return value must be an array of  strings.

DatabaseExists	 Pased a single parameter which is the name of  a database. The return value 
should be True or False depending on whether this data source can handle the 
database.

SchemaNames	 Passed a single parameter which is the name of  a database. The return value 
should be an array of  strings representing the schemas (if  any) this data source 
supports.

TableNames	 Passed a single parameter which is the name of  a database. The return value 
should be an array of  strings representing the table names (if  any) this data 
source supports.

Info	 Passed two parameters: the name of  the database and name of  the table. The 
return value should be an array of  arrays for each field in the specified table. 
Each field array should contain four elements (field name, required true/false, 
type, protected true/false).

Action	 Passed a single parameter which is an array of  action parameters. The data 
source must interpret the action and provide an appropriate response.
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Tickle	 This tag is called by Lasso periodically to keep a connection alive to a remote 
data source.

		

Initialize and Terminate
The Initialize and Terminate tags are provided so that a data source can perform global initialization and cleanup 
routines if requires. Most data sources will probably not need to implement these.

For example, a data source that stores values in a global variable could set up the variable in the Initialize 
member tag.

<?LassoScript 
	 Define_Type: 'DataSource', -Namespace='Ex_';

		  Define_Tag: 'Initialize; 
			   Global: 'Ex_DataSource_Storage' = (Map); 
		  /Define_Tag;

		  … Additional Member Tags … 
	 /Define_Type; 
?>

Note: If Lasso Service crashes the Terminate tag will never be called. A data source which relies on this tag being 
called could suffer from data loss if Lasso Service crashes.

onCreate and onDestroy
The onCreate tag is called when Lasso creates a new instance of a data source. This happens when an opening 
[Inline] tag references a database provided by the data source or when the data source is refreshed in Lasso 
Administration. The onDestroy tag is called when the data source instance is destroyed.

Lasso does not create new data source instances for nested inlines that reference the same data source host. A 
single data source instance may be asked to perform actions for a series of different databases and tables on 
the same host.

The onCreate tag is passed an array of information about the host defined in Lasso Administration for the 
referenced database. The elements of the array are defined in the following table.

Table 3: Host Information

Tag	 Description	

Host	 Usually the URL of  the desired data source host.

Port	 The port number for the host.

Schema	 The default schema for the host.

Username	 The username for the host.

Password	 The password for the host.
		

The information provided to onCreate is set in Lasso Administration. The fields do not have to be used for 
the purpose their label suggests. If a LassoScript data source does not require host or port information the 
documentation for the data source can instruct the end-user to enter whatever information is desired in Lasso 
Administration.

<?LassoScript 
	 Define_Type: 'DataSource', -Namespace='Ex_';

		  Define_Tag: 'onCreate', -Required='HostInfo'; 
			    
		  /Define_Tag;
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		  … Additional Member Tags … 
	 /Define_Type; 
?>

Usually, the data source type will need to store some of the information passed to the onCreate tag in order 
to remember what host the data source is connected to when an action occurs. For data sources that establish 
connections with remote hosts or open files the reference to the remote host or local files can sometimes 
serve as the state for subsequent database actions.

Database, Schema, and Table Names
The DatabaseNames, SchemaNames, and TableNames tags are all used by Lasso Administration to create the 
entries in Lasso Security for the data source. The database entries in particular are used to route [Inline] 
database actions to the LassoScript data source so must be accurate.

This tag will always be called after an onCreate tag which contains the host information for the current data 
source connection. The onCreate tag needs to store enough state so a subsequent call to DatabaseNames can 
list the databases for the desired host. Both the SchemaNames and TableNames tags must operate similarly in 
addition to being passed a specific database name as a parameter.

In the following example the DatabaseNames tag is hard coded to return two databases Database_One 
and Database_Two. The TableNames tags returns Table_One and Table_Two for Database_One or Table_Two and 
Table_Three for Database_Two. In an actual LassoScript data source the database and table names would usually 
be generated based on what data was actually available on the remote data source.

<?LassoScript 
	 Define_Type: 'DataSource', -Namespace='Ex_';

		  Define_Tag: 'DatabaseNames'; 
			   Return: (Array: 'Database_One', 'Database_Two'); 
		  /Define_Tag;

		  Define_Tag: 'TableNames', -Required='Database'; 
			   Select: #Database; 
				    Case: 'Database_One'; 
					     Return: (Array: 'Table_One', 'Table_Two'); 
				    Case: 'Database_Two'; 
					     Return: (Array: 'Table_Three', 'Table_Four'); 
			   /Select; 
		  /Define_Tag;

		  … Additional Member Tags … 
	 /Define_Type; 
?>

SchemaNames is not shown in the example above, but can be coded in exactly the same fashion as TableNames.

Field Info
The Info tag is used by Lasso Administration to create the entries in Lasso Security for the data source. It is 
also used after a database action to establish a correspondence between field names and the positions in the 
results array.

The Info tag is passed the name of the database and the name of the table. The return value from the Info tag is 
an array of arrays. Each element of the returned array represents one field with a four element array. All four 
elements are required including: 

	 •	Field Name – A string representing the name of the field.

	 •	Required – A boolean value indicating if the field is required or not. Should be set to False by default.

	 •	Field Type – A string representing the type of the field. The types can be data source specific. They are 
displayed in the database browser and may be used by some solutions.

	 •	Protected – A boolean value indicating if the field is read-only or not. Should be set to False by default.
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A generic array for a field is shown below. A data source should use this at a minimum to ensure Lasso has all 
the information it needs about each field.

[Array: 'Field Name', False, 'Text', False]

In the following example the Info tag returns an array of fields Field_One, Field_Two, Field_Three, and Field_Four 
for Database_One and Table_One. The tag could be extended to return field info for the other databases and 
tables as well. In an actual LassoScript data source the field info would usually be generated based on what 
data was actually available on the remote data source.

<?LassoScript 
	 Define_Type: 'DataSource', -Namespace='Ex_';

		  Define_Tag: 'Info', -Required='Database', -Required='Table'; 
			   Select: #Database + '.' + #Table; 
				    Case: 'Database_One.Table_One'; 
					     Return: (Array: 
						      (Array: 'Field_One', False, 'Text', False); 
						      (Array: 'Field_Two', False, 'Number', False); 
						      (Array: 'Field_Three', False, 'Date', False); 
						      (Array: 'Field_Four', False, 'Binary', False); 
					     ); 
				    … Cases For Other Databases and Tables 
			   /Select; 
		  /Define_Tag;

		  … Additional Member Tags … 
	 /Define_Type; 
?>

Database Actions
The Action tag is called whenever a LassoScript data source is used in an inline tag by the end-user. The tag is 
passed an array of parameters which has the same content as [Action_Params] called inside of an [Inline] … [/Inline] 
container tag.

The array of parameters will contain one action (listed below), one each of -Database, -Table, -KeyField, 
-MaxRecords, -SkipRecords, and -OperatorLogical tags, and additional parameters as specified by the user. It is the 
LassoScript data source’s responsibility to interpret these parameters, decide what action to perform, and 
return appropriate results.

The list below explains how Lasso interprets each of the built-in database actions. For best results custom data 
sources should try to match these meanings as close as possible. Custom data sources should also respect the 
-MaxRecords and -SkipRecords values if possible. However, it is not necessary for a LassoScript data source to 
implement every action or to provide exactly the same behavior as built-in data sources.

	 •	-Search – The parameters specified with the action should be interpreted as search terms. -MaxRecords 
specifies the maximum number of records that should be returned and -SkipRecords specifies an offset into 
the found set at which to start returning records. See the section on Result Sets below for details about 
how to return records and set the [Found_Count] and [Total_Count].

Lasso supports a number of optional parameters that a LassoScript data source should process if possible. 
These include -Op parameters that immediately precede name/value parameters and specify what search 
operator to use, -OpBegin and -OpEnd parameters that allow sophisticated And/Or groupings, -SortField and 
-SortOrder parameters, as well as -GroupBy, -Distinct, and -SortRandom parameters. The experience of the end-
user will be richer if more of these parameters are provided by a LassoScript data source.

	 •	-FindAll – The same as a -Search action, but none of the search parameters should be regarded. Other 
parameter like -MaxRecords, -SkipRecords, -SortField, etc. should still be processed.

	 •	-Random – The same as a -Search action, but a random selection of records is returned. The behavior of 
-Random differs from data source to data source. It can either be based on -FindAll or -Search. Not all data 
sources support the -Random action.
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	 •	-Add – Add a record to the database. The parameters specify the record that is to be added. The result of an 
-Add action will often contain the single record that was just added to the database. Some data sources use 
-MaxRecords=0 to suppress returning this record.

	 •	-Update – Update a single record within a database. A -KeyField and -KeyValue must in general be specified 
in order to determine what record to update. The parameters specify the new values for the updated 
record. The result of an -Update action will often contain the single record that was just updated within the 
database. Some data sources use -MaxRecords=0 to suppress returning this record.

	 •	-Delete – Delete a single record from the database. A -KeyField and -KeyValue must in general be specified in 
order to determine what record to delete. The parameters are generally disregarded. The result of a -Delete 
action will usually be an empty set.

	 •	-Duplicate – Duplicate a record within the database. A -KeyField and -KeyValue must in general be specified 
in order to determine what record to duplicate. The parameter may be disregarded or may be used to 
update the duplicated record. The result of a -Duplicate action will often contain the single record that was 
just added to the database. Some data sources use -MaxRecords=0 to suppress returning this record. Not all 
data sources support the -Duplicate action.

	 •	-SQL – Execute a raw SQL statement on the data source. This action is used for data sources that support 
SQL, but may reasonably be used for raw database commands for any data source (e.g. XPath statements or 
data source specific low-level commands). Most of the parameters of the action are generally disregarded 
except for -MaxRecords and -SkipRecords.

	 •	-Nothing – This is the default action if no other valid action is defined. A LassoScript data source should 
in general not perform any action when a -Nothing action is specified. However, some data sources will use a 
-Nothing action to send a keep-alive ping to a data source.

Some data sources may define additional actions beyond those listed here. Those actions will be reported 
as a -Nothing action with the actual action specified within the parameters passed to the Action tag.

The actual implementation of each of the actions is up to the LassoScript data source developer. Custom data 
sources can run from simple implementations that support only a couple actions to full-fledged modules that 
support all of the rich set of actions and additional parameters that Lasso provides.

The example below uses a [Select] … [Case] … [/Select] tag to choose which action to perform based on the 
contents of the #Action_Params array. Any actions that are not supported by the data source are caught by the 
default -Nothing action option at the end. See the Result Sets section below for an example of how a -Search 
action can return results.

<?LassoScript 
	 Define_Type: 'DataSource', -Namespace='Ex_';

		  Define_Tag: 'Action', -Required='Action_Params'; 
			   Select: True; 
				    Case: (#Action_Params >> -Search); 
					     … Search Action (See Result Sets below for an example) … 
				    Case: (#Action_Params >> -FindAll); 
					     … FindAll Action … 
				    Case: (#Action_Params >> -Add); 
					     … Add Action … 
				    Case: (#Action_Params >> -Update); 
					     … Update Action … 
				    Case: (#Action_Params >> -Delete); 
					     … Delete Action … 
				    Case; 
					     … Nothing Action … 
			   /Select; 
		  /Define_Tag;

		  … Additional Member Tags … 
	 /Define_Type; 
?>
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Result Sets
Most database actions return results to the end-user. These results are returned in the same way no matter if 
the action is a -Search or -Add.

The current result set is set using the [Action_AddRecord] tag once for each record in the result set. Usually, 
the entire result set is not returned, but only up to a maximum of -MaxRecords records starting at the offset 
defined by -SkipRecords. The [Action_AddRecord] tag requires one parameter which is an array of values for 
each field in a single returned record.

The field names returned by the Info tag should correspond to the same order as the results passed to the 
[Action_AddRecord] tag. This allows Lasso to return the proper field value for each [Field] tag.

Lasso will automatically calculate [Shown_Count], [Shown_First], and [Shown_Last] based on the number of 
times [Action_AddRecord] is called and the value for -SkipRecords. The value for [Found_Count] can be set by 
calling [Action_SetFoundCount]. In addition, some databases can set [Total_Count] to the total number of records 
in the database using [Action_SetTotalCount].

Finally, when processing an -Add or -Update action the current [RecordID_Value] can be set using 
[Action_SetRecordID]. This is separate from the key field value which is set automatically based on the value for 
-KeyField and the mapping from field names to field values. Some Custom data sources may want to set this 
value in order to return an internally generated ID that may be different from the key field value.

The following table shows the tags that are available for returning database action results.

Table 4: Result Set Tags

Tag	 Description	

[Action_AddRecord]	 Adds a record to the found set after a database action. Requires one parameter 
which is an array of  strings representing the results for one record of  the found 
set.

[Action_AddInfo]	 Reports the names of  fields in the result set. Requires one parameter which is an 
array of  arrays. Each field array needs name, required, type, and protection. The 
output of  the ->Info member tag matches the required parameter of  this tag.

[Action_SetFoundCount]	 Sets the number of  records found in a database during a search action. Requires 
one integer parameter.

[Action_SetTotalCount]	 Sets the total number of  records that are in a database during a search action. 
Requires one integer parameter.

[Action_SetRecordID]	 Sets the record ID value. This is the value returned by [RecordID_Value]. 
Requires one integer parameter.

		

The example below returns a set of eight records from a -Search action. It is hard-coded to return eight records 
and set the found count to 32 records and the total count to 256 records.  In an actual LassoScript data source 
the field values would usually be generated based on what data was actually available on the remote data 
source.

<?LassoScript 
	 Define_Type: 'DataSource', -Namespace='Ex_';
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		  Define_Tag: 'Action', -Required='Action_Params'; 
			   Select: True; 
				    Case: (#Action_Params >> -Search); 
					     [Action_SetFoundCount: 32] 
					     [Action_SetTotalCount: 256] 
					     [Action_AddInfo: Self->(Info:  
						      #Action_Params->(Find: -Database)->First->Second, 
						      #Action_Params->(Find: -Table)->First->Second)] 
					     [Action_AddRecord: (Array: 'One', 'Two', 'Three', 'Four')] 
					     [Action_AddRecord: (Array: 'Five', 'Six', 'Seven', 'Eight')] 
					     [Action_AddRecord: (Array: 'Nine', 'Ten', 'Eleven', 'Twelve')] 
					     [Action_AddRecord: (Array: 'Thirteen', 'Fourteen', 'Fifteen', 'Sixteen')] 
					     [Action_AddRecord: (Array: 'One', 'Two', 'Three', 'Four')] 
					     [Action_AddRecord: (Array: 'Nine', 'Ten', 'Eleven', 'Twelve')] 
					     [Action_AddRecord: (Array: 'Five', 'Six', 'Seven', 'Eight')] 
					     [Action_AddRecord: (Array: 'Thirteen', 'Fourteen', 'Fifteen', 'Sixteen')] 
				    … Cases For Other Actions … 
			   /Select; 
		  /Define_Tag;

		  … Additional Member Tags … 
	 /Define_Type; 
?>
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IX
Section IX

Lasso C/C++ API

This section includes instructions for extending the functionality of Lasso by creating new tags, data types, 
and Web server connectors written in C/C++.

	 •	Chapter 60: LCAPI Introduction includes general information about extending Lasso’s functionality.

	 •	Chapter 61: LCAPI Tags discusses how to create new tags in LCAPI including substitution tags, asynchro-
nous tags, and remote procedures.

	 •	Chapter 62: LCAPI Data Types discusses how to create new data types in LCAPI including sub-classing 
and symbol overloading.

	 •	Chapter 63: LCAPI Data Sources discusses how to create new data sources in LCAPI.

	 •	Chapter 64: LCAPI References includes information about each of the function calls available in LCAPI.

Lasso can also be extended using LassoScript or Java. See the preceding section on the LassoScript API or the 
following section on the Lasso Java API (LJAPI) for more information..
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Chapter 60

LCAPI Introduction

This chapter provides an introduction to the Lasso C/C++ API (LCAPI) which allows new tags, data types, and 
data source connectors to be written in C/C++.

	 •	Overview includes a description of what types of modules can be built with LCAPI.

	 •	Requirements describes the basic system requirements for building LCAPI modules

	 •	Getting Started includes a walktrhough of building a sample tag module on both Mac OS X and 
Windows.

	 •	Debugging describes how the debugging tools can be used on an LCAPI module in either Mac OS X or 
Windows.

	 •	Frequently Asked Questions includes a series of common questions that new users of LCAPI have and 
answers.

Overview
The Lasso C/C++ Application Programming Interface (LCAPI) lets you write C or C++ code to add new Lasso 
substitution tags, data types, and data source connectors to Lasso Professional 8.

Writing tags in LCAPI offers advantages over LJAPI and custom Lasso tags in speed and system performance. 
However, tags must be compiled separately for Windows 2000/XP and Mac OS X in order to support each 
platform. See the Custom Tags and Custom Types chapters for more information on writing custom tags 
in Lasso. LCAPI is functionally similar to LJAPI. See the Lasso Java API chapter for more information about 
writing tags, data types, and data source connectors in Java using LJAPI.

This chapter provides a walk-through for building an example substitution tag, data source 
connector, and data type in LCAPI. Source code for the Lasso MySQL module as well as the 
code for the substitution tag, data type, and data source connector examples are included in the 
Lasso Professional 8/Documentation/3 - Language Guide/Examples/LCAPI folder on the hard drive.

Requirements
In order to write your own Lasso substitution tags or data source connectors in C or C++, you need the 
following:

Windows

	 •	Microsoft Windows 2000 or Microsoft Windows XP Professional.

	 •	Microsoft Visual C++ .NET. 

	 •	Lasso Professional 8 for Windows 2000/XP. 
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Mac OS X

	 •	Mac OS X 10.3 with GNU C++ compiler and linker (Dev Tools) installed. 

	 •	Lasso Professional 8 for Mac OS X.

Getting Started
This section provides a walk-through for building sample LCAPI tag modules in Windows 2000/XP and Mac 
OS X.

To build a sample LCAPI tag module in Windows 2000/XP:

	 1	Locate the following folder in the hard drive.

C:\Program Files\OmniPilot Software\Lasso Professional 8\ Documentation\3 - Language Guide\Examples\LCAPI\Tags\
MathFuncsTags

	 2	In the MathFuncsTags folder, double-click the MathFuncsCAPI.sln project file (you need Microsoft Visual C++ 
.NET in order to open it). 

	 3	Choose Build > Build Solution to compile and make the MathFuncsCAPI.DLL. 

	 4	After building, a Debug folder will have been created inside your MathFuncsCAPI project folder. 

	 5	Open the MathFuncsTags/Debug folder and drag MathFuncsCAPI.DLL into the Lasso Professional 8/LassoModules 
folder on the hard drive.

	 6	Stop and then restart Lasso8Service. 

	 7	New tags [Example_Math_Abs], [Example_Math_Sin] and [Example_Math_Sqrt] are now part of the Lasso language. 

	 8	Drag the sample Lasso page called MathFuncsCAPI.lasso into your Web server root. 

	 9	In a Web browser, view http://localhost/MathFuncsCAPI.lasso to see the new Lasso tags in action.

To build a sample LCAPI tag module in Mac OS X:

	 1	Open a Terminal window.

	 2	Change the current folder to the Lasso Professional 8/Documentation folder using the following command: 

	 cd /Library/Lasso Professional 8/Documentation/3 - Language Guide\Examples\LCAPI\Tags\MathFuncsTags

	 3	Build the sample project using the provided makefile (you’ll need to know a Mac OS X administrator 
password to use sudo).

sudo make

	 4	After building, a Mac OS X dynamic library file named MathFuncsCAPI.dylib will be in the current folder. This 
is the LCAPI module you’ll install into the LassoModules folder.

	 5	Copy the newly-created module to the Lasso modules folder using the following command: 

cp MathFuncsCAPI.dylib /Applications/Lasso Professional 8/LassoModules

	 6	Quit Lasso Service if it’s running, so that the next time it starts up, it will load the new module you just 
built (you’ll need to know a Mac OS X administrator password to use sudo).

sudo lasso8ctl stop 

	 7	Start Lasso Service so it will load the new module. 

sudo lasso8ctl start 

New tags [Example_Math_Abs], [Example_Math_Sin] and [Example_Math_Sqrt] are now part of the Lasso language.

	 8	Copy the sample Lasso page called MathFuncsCAPI.lasso into your Web server document root. 

	 9	Use a Web browser to view http://localhost/MathFuncsCAPI.lasso to see the new Lasso tags in action.
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Debugging
You can set breakpoints in your LCAPI DLLs or DYLIBs and perform source-level debugging for your own 
code. In order to set this up, add path information to your project so it knows where to load executables 
from. For this section, we will use the provided substitution tag project as the example.

To debug in Windows 2000/XP:

	 1	Select Processes… from the Debug main menu. 

	 2	In the Processes window, select each instance of Lasso8Service.exe and choose to Attach. 

	 3	Close the Processes window and set a breakpoint in the tagMathAbsFunc function. 

	 4	Use a Web browser to access the sample http://localhost/MathFuncsCAPI.lasso. Visual Studio will stop at the 
location that the breakpoint was placed. 

To debug in Mac OS X:

	 1	From a Terminal window, change folder into the example LCAPI source code folder by entering the 
following: 

cd /Applications/Lasso\ Professional\ 8/Documentation/3 - Language Guide\Examples\LCAPI\Tags\MathFuncsTags 

	 2	Build with debug options turned on by entering the following: 

sudo make "DEBUG += -g3 -O0" 

Note: The last two characters of the command are a letter O followed by a zero.

	 3	Copy the built DYLIB into the LassoModules folder by entering the following: 

cp MathFuncsCAPI.dylib /Applications/Lasso\ Professional\ 8/LassoModules/ 

	 4	Change folder into the Lasso Professional 8/Tools folder: 

cd /Applications/Lasso\ Professional\ 8/Tools/ 

	 5	Restart Lasso Service.  When it starts up, it will load the new module you just built (you’ll need to know a 
root password to use sudo).

sudo lasso8ctl stop 

	 6	Start the Lasso Service back up, so it will load the new module. 

sudo lasso8ctl start

	 7	Find out the process ID number of Lasso Service so you can attach to it later with GNU Debugger. Make a 
note of the process id for Lasso8Service. 

ps aux | grep Lasso8Service 

	 8	Start the GNU Debugger as a root user. You must be root in order to attach to the running Lasso Service 
process.

sudo gdb 

	 9	From within GNU Debugger’s command line, attach to the Lasso Service process ID by entering the 
following:

attach <type the process id from step 7 here> 

	 10	Instruct GNU Debugger to break whenever the function tagMathAbsFunc is called by entering the following: 

break tagMathAbsFunc 

	 11	Use a Web browser to access the sample http://localhost/MathFuncsCAPI.lasso. An example Lasso page is 
provided in the LCAPI folder; you must first copy it into your Web server’s Documents folder, which is 
typically /Library/WebServer/Documents.

7 3 4

L a s s o  8 . 5  L a n g u a g e  G u i d e

C h a p t e r  6 0  –  L C API    I n t r o d u c t i o n



	 12	GNU Debugger breaks at the first line in tagMathAbsFunc() as soon as Lasso Service executes that tag in the 
Lasso page 

	 13	Type help in GNU Debugger for more information about using the GNU Debugger, or search for gdb 
tutorial on the Web for more in-depth tutorials. 

Frequently Asked Questions

How do I install my custom tag?

Once you’ve compiled your tag module, you’ll need to move the module to your installed Lasso Professional 
LassoModules folder, and then restart Lasso Service. Step-by-step instructions are available in the Getting 
Started section.

How do I return text from my custom tag?

Use either lasso_returnTagValueString to return UTF-8 data, or lasso_returnTagValueStringW to return UTF-16 
data. Character data in other encoding methods can be returned by first allocating a string type using 
lasso_typeAllocStringConv and then returning it using lasso_returnTagValue.

How do I return binary data from my custom tag?

Use lasso_returnTagValueBytes to return binary data.

How do I prevent Lasso from automatically encoding text returned from my custom tag?

Make sure that your tag is registered with the flag_noDefaultEncoding flag. This flag is specified when you call 
lasso_registerTagModule at startup.

How do I debug my custom tag?

You can set breakpoints in your code and attach your module DLL to Lasso Service. Read the section on 
Debugging LCAPI modules.

How do I get parameters that were passed into my tag?

Most of the parameters passed into your custom tag can be retrieved using the lasso_getTagParam() 
and lasso_findTagParam() parameter info APIs. lasso_getTagParam() retrieves parameters by index and 
lasso_findTagParam() retrieves them by name. All parameters retrieved using those functions will be returned as 
strings. The access the parameters as Lasso type instances, use lasso_getTagParam2 and lasso_findTagParam2.

How do I get the value of unnamed parameters passed into my tag?

While there is no direct way to get unnamed parameters (how do you know what name to ask for?), you 
can enumerate through all the parameters by index, and then pick out the ones which do not have names. 
If, after retrieving a parameter, you discover that its data member is an empty string, then that means it 
is an unnamed parameter, and you can get its value from the name member. An example of this is in the 
substitution tag tutorial.

What’s an auto_lasso_value_t and how do I use it?

It’s a data structure which contains both a name and a value (a name/value pair). Many LCAPI APIs fill in 
this structure for you, and you can access the name and data members directly as null-terminated C-strings.

What is a lasso_type_t and how do I use it?

A lasso_type_t represents an instance of a Lasso type. Any Lasso type can be represented by a 
lasso_type_t, including strings, integers, or custom types. LassoCAPI provides many functions for allocating 
or manipulating lasso_type_t instances. All lasso_type_t instances encountered inside a LassoCAPI tag will be 
automatically garbage collected after the function returns. Therefore, a lasso_type_t instance should not be 
saved unless it if freed from the garbage collector using lasso_typeDetach.
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How do I access variables from the Lasso page I’m in?

You may need to get or even create Lasso variables (the same variables that a Lasso programmer makes when 
using the [var: 'fred'=12] variable syntax in a Lasso page) from within your LCAPI module. You can retrieve a 
global variable, as long as it has already been assigned before your custom substitution tag is executed, by 
calling lasso_getVariable() with the variable’s name. Using this method, one could directly set the __htmll_reply__ 
variable.

How do I return fatal and non-fatal error codes?

It is very important that your substitution tag return an error code of osErrNoErr (0) if nothing fatal happened. 
An example of a fatal error would be a missing required parameter, for instance. If you encounter a fatal error, 
then return a non-zero result code from your tag function, and the Lasso will stop processing the page at that 
point, and display an error page.

How do I write code that will compile easily across multiple operating systems?

While we cannot provide a complete cross-platform programming tutorial for you here, we can at least 
provide some guidance. The simplest way to make sure things compile across platforms is to make sure you 
use standard library functions (from stdio.h and stdlib.h) as much as possible: functions like strcpy(), malloc(), and 
strcmp() are always available on all platforms. Also note that Unix platforms are case-sensitive, so when you 
#include files, just make sure you keep the case the same as the file on disk. Finally, stay away from platform-
specific functions, such as Windows APIs, which most often are not available on Unix platforms. Take a look 
at our Unix makefiles which are provided with the sample projects: notice the same source code is used for 
Windows, and all source files are saved with DOS-style cr/lf linebreaks so as not to confuse the Windows 
compilers. As a last resort, you can use #ifdef to show/hide portions of source code which are platform-
specific. 
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Chapter 61

LCAPI Tags

This chapter includes information about creating tags in C/C++ using the Lasso C/C++ API (LCAPI).

	 •	Substitution Tag Operation introduces the concepts behind substitution tags and how they are loaded and 
accessed through Lasso.

	 •	Substitution Tag Tutorial documents a sample project that is shipped with Lasso including a walk-through 
of the sample code.

Substitution Tag Operation
When Lasso Professional first starts up, it looks for module files (Windows DLLs or Mac OS X DYLIBS) in its 
LassoModules folder. As it encounters each module, it executes that module’s registerLassoModule() function once 
and only once. LCAPI developers must write code to register each of the new custom tag (or data source) 
function entry points in this registerLassoModule() function. The following function is required in every LCAPI 
module. It gets called once when Lasso Professional starts up.

void registerLassoModule()  
{ 
	 lasso_registerTagModule( "CAPITester", "testtag", myTagFunc,   
		  REG_FLAGS_TAG_DEFAULT, "simple test LCAPI tag" );  
}

The preceding example registers a C function called myTagFunc to execute whenever the Lasso 
[CAPITester_testtag] is encountered inside a LassoScript. The first parameter CAPITester is the namespace in 
which testtag will be placed.

Once the tag function is registered, Lasso will call it at appropriate times while parsing and executing 
LassoScripts. The custom tag functions will not be called if none of the custom tags are encountered while 
executing a script. When Lasso Professional 8 encounters one of your custom tags, it will be called with two 
parameters: an opaque data structure called a ”token”, and an integer ”action” (which is currently unused). 
LCAPI provides many function calls which you can use to get information about the environment, variables, 
parameters, etc., when provided with a token.

The passed-in token can also be used to acquire any parameters and to return a value from your custom tag 
function.

To build a basic custom tag function: 

Enter the following code:

osError myTagFunc( lasso_request_t token, tag_action_t action )  
{ 
	 const char * retString = "Hello, World!"; 
	 return lasso_returnTagValueString( token, retString, strlen(retString));  
}

7 3 7

L a s s o  8 . 5  L a n g u a g e  G u i d e



Below is the LassoScript needed to get the custom tag to execute: 

Here's the custom tag:  
[CAPITester_testtag]  
<!-- This should display "Hello, World" when this page executes -->

This will produce the following output:

➜	 Here's the custom tag:  
Hello, World

Substitution Tag Tutorial
This section provides a walk-through of building an example tag to show how LCAPI features are used. 
This code will be most similar to the sample MathFuncsCAPI project, so in order to build this code, copy the  
MathFuncsCAPI project folder and edit the project files inside it.

The tag will simply display its parameters, and will look like the example below when called from a 
LassoScript.

Example of the sample tag’s syntax:

[sample_tag: 'some text here', -option1='named param', -option2=12.5]

Notice the tag takes one unnamed parameter, one string parameter named -option1, and a numeric parameter 
named -option2. In general, Lasso does not care about the order in which you pass parameters, so plan to 
make this tag as flexible as possible by not assuming anything about the order of parameters. The following 
variations should work exactly the same:

Example of sample tag with different ordered parameters:

[sample_tag: -option2=12.5, 'some text here', -option1='named param']

[sample_tag: -option2=12.5, -option1='named param', 'some text here']

Substitution Tag Module Code
Shown below is the code for the substitution tag module. This code is referenced in the Substitution Tag 
Module Walk Through section.

void registerLassoModule() 
{ 
	 lasso_registerTagModule( "sample", "tag", myTagFunc,  
		  REG_FLAGS_TAG_DEFAULT, "sample test" ); 
}

osError myTagFunc( lasso_request_t token, tag_action_t action ) 
{ 
	 lasso_type_t retString = NULL, opt2 = NULL; 
	 lasso_typeAllocString(token, &retString, "", 0); 
	 auto_lasso_value_t  v;   
	 INITVAL(&v);

	 if( lasso_findTagParam( token, "-option1", &v ) == osErrNoErr )  
	 { 
		  lasso_typeAppendString( token, "The value of  -option1 is ", 25 ); 
		  lasso_typeAppendString( token, v.data, v.dataSize ); 
	 }
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	 if( lasso_findTagParam2( token, "-option2", &opt2 ) == osErrNoErr )  
	 { 
		  double  tempValue; 
		  char tempText[128]; 
		  lasso_typeGetDecimal( token, opt2, &tempValue ); 
		  sprintf( tempText, "%.15lg", tempValue ); 
		  lasso_typeAppendString( token, " The value of  -option2 is ", 26 ); 
		  lasso_typeAppendString( token, tempText, strlen(tempText) ); 
	 }

	 int count = 0; 
	 lasso_getTagParamCount( token, &count );

	 for (int i = 0; i < count; ++i)  
	 { 
		  lasso_getTagParam( token, i, &v ); 
		  if  ( v.dataSize == 0 )  
		  { 
			   lasso_typeAppendString( token, " The value of  unnamed param is ", 31 ); 
			   lasso_typeAppendString( token, v.name, v.nameSize ); 
		  } 
	 }

	 return lasso_returnTagValue(token, retString); 
}

Substitution Tag Module Walk Through
This section provides a step-by-step walk through of the code for the substitution tag module.

To build a sample LCAPI tag module:

	 1	First, register the new tag in the required registerLassoModule() export function. 

void registerLassoModule() 
{ 
	 lasso_registerTagModule( "sample", "tag", myTagFunc,  
		  REG_FLAGS_TAG_DEFAULT, "sample test" ); 
}

	 2	Implement myTagFunc, which gets called when [sample_tag] is encountered. All tag functions have this 
prototype. When the tag function is called, it’s passed an opaque “token” data structure.

osError myTagFunc( lasso_request_t token, tag_action_t action ) 
{

The remainder of the code in the walk through includes the implementation for the myTagFunc function.

	 3	Allocate a string which will be this tag’s return value.

	 lasso_type_t retString = NULL, opt2 = NULL; 
	 lasso_typeAllocString(token, &retString, "", 0);

	 4	The auto_lasso_value_t variable named v will be our temporary variable for holding parameter values. Start 
off by initializing it.

	 auto_lasso_value_t  v;   
	 INITVAL(&v);  

	 5	Call lasso_FindTagParam() in order to get the value of the -option1 parameter. If it is found (no error while 
finding the named parameter), append some information about it to our return value string.
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	 if( lasso_findTagParam( token, "-option1", &v ) == osErrNoErr )  
	 { 
		  lasso_typeAppendString( token, "The value of  -option1 is ", 25 ); 
		  lasso_typeAppendString( token, v.data, v.dataSize ); 
	 }

	 6	Look for the other named parameter, -option2 and store its value into variable opt2. Because -option2 
should be a decimal value, use lasso_findTagParam2, which will preserve the original data type of the value 
as opposed to converting it into a string like lasso_findTagParam will.

	 if( lasso_findTagParam2( token, "-option2", &opt2 ) == osErrNoErr )  
	 {

	 7	Declare a temporary floating-point (double) value to hold the number passed in and then declare a 
temporary string to hold the converted number for display. Get the value of op2 as a decimal then print it 
to the tempText variable.

		  double  tempValue; 
		  char tempText[128]; 
		  lasso_typeGetDecimal( token, opt2, &tempValue ); 
		  sprintf( tempText, "%.15lg", tempValue );

	 8	Append the parameter’s information to the return string.

		  lasso_typeAppendString( token, " The value of  -option2 is ", 26 ); 
		  lasso_typeAppendString( token, tempText, strlen(tempText) ); 
	 }	

	 9	Now, we’re going to look for the unnamed parameter. Because there’s no way to ask for unnamed 
parameters, we’re going to enumerate through all the parameters looking for one without a name. The 
integer count will hold the number of parameters found. Use lasso_getTagParamCount() to find out how 
many parameters were passed into our tag. The variable count now contains the number 3, if we were 
indeed passed three parameters. 

		  int count = 0;

		  lasso_getTagParamCount( token, &count );

		  for (int i = 0; i < count; ++i) {

	 10	Use lasso_getTagParam() to retrieve a parameter by its index. If you design tags that require parameters 
to be in a particular order, then use this function to retrieve parameters by index, starting at index 0. If 
the parameter is unnamed, that means it’s the one needed.  Note that if the user passes in more than one 
unnamed parameter, this loop will find all of them, and will ignore any named parameters. 

		  lasso_getTagParam( token, i, &v ); 
		  if  ( v.dataSize == 0 )  
		  {

	 11	Again, append a descriptive line of text about the unnamed parameter and it’s value. Notice that the name 
member of the variable is what holds the text we’re looking for, and the data member is empty. 

			   lasso_typeAppendString( token, " The value of  unnamed param is ", 31 ); 
			   lasso_typeAppendString( token, v.name, v.nameSize ); 
		  } 
	 }

	 12	Returning an error code is very important. If you return a non-zero error code, then the interpreter 
will throw an exception indicating that this tag failed fatally and Lasso’s standard page error routines 
will display an error message. For non-fatal errors, you can use lasso_setResultCode() and lasso_
setResultMessage() to provide error codes for the caller; just make sure your tag function returns osErrNoErr 
from your function, otherwise Lasso’s fatal error routines will be triggered.

	 return lasso_returnTagValue(token, retString); 
}
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Chapter 62

LCAPI Data Types

This chapter includes information about creating data types in C/C++ using the Lasso C/C++ API (LCAPI).

	 •	Data Type Operation discusses how new data types can be implemented in C/C++.

	 •	Data Type Tutorial walks through a sample data type project.

Data Type Operation
Creating a new data type in LCAPI 8 is similar to creating a substitution tag. When Lasso Professional 8 starts 
up, it scans the LassoModules folder for module files (Windows DLLs or Mac OS X DYLIBS). As it encounters 
each module, it executes the registerLassoModule() function for that module. The developer registers the 
LCAPI data types or tags implemented by the module inside this function. Registering data type initializers 
differs from registering normal substitution tags in that the third parameter in lasso_registerTagMode is the 
value REG_FLAGS_TYPE_DEFAULT.

void registerLassoModule()  
{  
	 lasso_registerTagModule( "test", "type", myTypeInitFunc,  
		  REG_FLAGS_TYPE_DEFAULT, "simple test LCAPI type" );  
}

The prototype of a LCAPI type initializer is the same as a regular LCAPI substitution tag function. Lasso will 
call the type initializer each time a new instance of the type is created.

osError myTypeInitFunc( lasso_request_t token, tag_action_t action );

When the type initializer function is called, a new instance of the type is created using lasso_
typeAllocCustom. This new instance will be created with no data or tag members.

osError myTypeInitFunc( lasso_request_t token, tag_action_t action )  
{ 
	 lasso_type_t theNewInstance = NULL; 
	 lasso_typeAllocCustom( token, &theNewInstance, "test_type" );

Once the type is created, new data and tag members can be added to it using lasso_typeAddMember. Data 
members can be of any type and should be allocated using any of the LCAPI type allocation calls. Tag 
members are allocated using lasso_typeAllocTag. LCAPI tag member functions are implemented just like any 
other LCAPI tag. In the example below, myTagMemberFunction is a function with the standard LCAPI tag 
prototype.
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	 const char * kStringData = "This is a string member."; 
	 lasso_type_t stringMember = NULL; 
	 lasso_typeAllocString( token, &stringMember, kStringData, strlen(kStringData) ); 
	 lasso_typeAddMember( token, theNewInstance, "member1", stringMember );  
	 lasso_type_t tagMember = NULL;  
	 lasso_typeAllocTag( token, &tagMember, myTagMemberFunction );  
	 lasso_typeAddMember( token, theNewInstance, "member2", tagMember );

The final step in creating a new LCAPI data type instance is to return the new type to Lasso as the tag’s return 
value. After the type is returned, Lasso will complete the creation of the type by instantiating the new type’s 
parent types.

	 lasso_returnTagValue( token, theNewInstance ); 
 	 return osErrNoErr;  
}

Data Type Tutorial
This tutorial walks through the main points of creating a custom data type using LCAPI 7. The resulting 
data type is a “file” type, and the ability to open, close, read and write to the file are implemented via the 
following member tags:

[File->Open]		 [File->Close]	 [File->Read]	 [File->Write]

Data Types Code
The example project and source files contain over 800 lines of code, and are located in the following folder: 

Lasso Professional 8/Documentation/3 - Language Guide/Examples/LCAPI/Tags/CAPIFile

Do to the length of the project file (CAPIFile.cpp), the entire code is not shown here. The Data Type Walk 
Through section provides a conceptual overview of the operation behind the file type example, and describes 
the basic LCAPI functions used to implement it.

Note: This walk through is not fully up-to-date with the sample code in the documentation folder. The walk 
through should serve as a useful road map, but the sample code should be read separately to see how it has 
been updated for LCAPI 8.

Data Type Walk Through
This section provides a step-by-step conceptual walk through for building a custom file data type.

To build a custom data type:

	 1	The first step in creating a custom type is to register the type’s initializer. Type initializers are registered in 
the same way that regular tag functions are registered. The only difference being that flag_typeInitializer 
should be passed for the fourth (flags) parameter.

This concept is illustrated in lines 95-129 of the CAPIFile.cpp file.

void registerLassoModule() 
{ 
	 … 
	 lasso_registerTagModule("example", "file", file_init,  
		  REG_FLAGS_TYPE_DEFAULT, "Initializer for the file type."); 
}

	 2	The registered type initializer will be called each time a new file type is created. In the above case, the 
LCAPI function file_init was registered as being the initializer. The prototype for file_init should look like 
any other LCAPI function.

This concept is illustrated in line 272 of the CAPIFile.cpp file.
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osError file_init(lasso_request_t token, tag_action_t action)

	 3	The file_init function will now be called whenever the example_file type is used in a script. Within the 
type initializer, the type’s member tags are added. Each member tag is implemented by its own LCAPI 
tag function. However, before members can be added, the new blank type must be created using lasso_
typeAllocCustom.

lasso_typeAllocCustom can only be used within a properly registered type initializer. The value it produces 
should always be the return value of the tag as set by the lasso_returnTagValue function.

This concept is illustrated in lines 273-277 of the CAPIFile.cpp file.

{ 
	 lasso_type_t file; 
	 …	  
	 lasso_typeAllocCustom(token, &file, KFileTypeName);

	 4	Once the blank type has been created, members can be added to it. LCAPI data types often need to store 
pointers to allocated structures or memory. LCAPI provides a means to accomplish this by using the lasso_
setPtrMember and lasso_getPtrMember functions. These functions allow the developer to store a pointer 
with a specific name. The pointer is stored as a regular integer data member. The names of all pointer 
members should begin with an underscore. Naming a pointer as such will indicate to Lasso that it should 
not be copied when a copy is made of the data type instance. This LCAPI file type will store its private data 
in a structure called file_desc_t.

This concept is illustrated in lines 280-281 of the CAPIFile.cpp file.

	 file_desc_t * desc = new file_desc_t; 
	 lasso_setPtrMember(token, file, kPrivateMember, desc);

	 5	Members are also added for open, close, read and write.

	 lasso_type_t mem;  
	 lasso_typeAllocTag(token, &mem, file_open);  
	 lasso_typeAddMember(token, file, "open", mem);

	 lasso_typeAllocTag(token, &mem, file_close);  
	 lasso_typeAddMember(token, file, "close", mem);

	 lasso_typeAllocTag(token, &mem, file_read);  
	 lasso_typeAddMember(token, file, "read", mem);

	 lasso_typeAllocTag(token, &mem, file_write);  
	 lasso_typeAddMember(token, file, "write", mem);

This concept is illustrated in lines 286-295 of the CAPIFile.cpp file. The macro ADD_TAG is defined and 
used to avoid the more repetitive activities.

	 #define ADD_TAG(NAME, FUNC) {   lasso_type_t mem;\ 
		  lasso_typeAllocTag(token, &mem, FUNC);\ 
		  lasso_typeAddMember(token, file, NAME, mem);\ 
	 }

	 …	

	 ADD_TAG(kMemOpen, file_open); 
	 ADD_TAG(kMemClose, file_close); 
	 ADD_TAG(kMemRead, file_read); 
	 ADD_TAG(kMemWrite, file_write);

	 6	The final member tag to add is the onDestroy member. This tag will be called automatically by Lasso when 
the type goes away. Adding this tag will ensure that the file on disk is closed properly if the member tag 
function file_close is not called.

This concept is illustrated in line 309 of the CAPIFile.cpp file.

	 ADD_TAG(kMemOnDestroy, file_onDestroy);
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	 7	At this point, the return value should be set. Keep in mind that the new file type is completely blank 
except for the members that were added above. No inherited members are available at this point. Inherited 
members are only added after the LCAPI type initializer returns.

This concept is illustrated in line 312 of the CAPIFile.cpp file.

lasso_returnTagValue(token, file);

	 8	There were no errors in the type initialization process, so return a “no error” code to Lasso, completing the 
type’s initialization.

This concept is illustrated in line 313 of the CAPIFile.cpp file.

return osErrNoErr;

Note: For brevity, this example will not cover accepting parameters in the type’s onCreate member tag. The 
full CAPIFile project illustrates accepting parameters in the onCreate member to open the file under various 
read and write permissions.

	 9	The new file type has now been initialized and made available to the caller in the script. The first member 
of the file type is [File->Open], which is implemented as the LCAPI function file_open.

This concept is illustrated in lines 365-366 of the CAPIFile.cpp file.

osError file_open(lasso_request_t token, tag_action_t action) 
{

	 10	The first step in implementing a member tag is to acquire the “self” instance. The self is the instance upon 
which the member call was made.

This concept is illustrated in lines 367-370 of the CAPIFile.cpp file.

lasso_type_t self  = NULL; 
lasso_getTagSelf(token, &self); 
if  ( !self  ) 
	 return osErrInvalidParameter;

	 11	Once the self is successfully acquired and is not null, the rest of the member tag can proceed. This member 
tag accepts one parameter, which is the path to the file that will be opened. Since the path is a string value, 
it can be acquired using lasso_getTagParam. If the path parameter was not passed to the open member tag, 
an error should be returned and indicated to the user.

This concept is illustrated in lines 380-396 of the CAPIFile.cpp file.

	 // see what parameters we are being initialized with 
	 int count; 
	 lasso_getTagParamCount(token, &count); 
	 if  ( count < 2 ) 
	 { 
		  lasso_setResultMessage(token,  
			   "file->open requires at least a file path and open mode."); 
		  lasso_setResultCode(token, osErrInvalidParameter); 
		  return osErrInvalidParameter; 
	 } 
	 if  ( count > 0 ) // we are given *at the least* a path 
	 { 
		  // first param is going to be a string, so use the LCAPI 7 call to get it 
		  auto_lasso_value_t pathParam; 
		  pathParam.name = ""; 
		  lasso_getTagParam(token, 0, &pathParam);

	 12	Now that the path parameter has been successfully acquired, permissions should be checked to make sure 
access to the file is permitted by Lasso security.

This concept is illustrated in lines 232-237 of the CAPIFile.cpp file.

7 4 5

L a s s o  8 . 5  L a n g u a g e  G u i d e

C h a p t e r  6 2  –  L C API    D a t a  T y p e s



if  ( lasso_operationAllowed(token, op, const_cast<char*>(path)) != osErrNoErr ) 
{ 
	 lasso_setResultMessage(token,  
		  "Permission to open the file was denied by Lasso security."); 
	 lasso_setResultCode(token, osErrNoPermission); 
	 return NULL; 
}

	 13	If the current user has permission, the Lasso internal path should be converted to the platform specific 
path. This is a three-step process that begins with fully qualifying the path. This will ensure that relative 
paths are converted to root paths. The second step is to resolve the path. This converts root path to a 
complete path which will include the hard drive name, or /// if used on a Unix platform. The final step is 
to convert the path into a platform-specific format that will be understood by the platform-specific [File-
>Open] calls.

This concept is illustrated in lines 197-203 of the CAPIFile.cpp file.

{ 
	 osPathname qualifiedPath; 
	 osPathname resolvedPath; 
	 lasso_fullyQualifyPath( token, inPath, qualifiedPath ); 
	 lasso_resolvePath( token, qualifiedPath, resolvedPath ); 
	 lasso_getPlatformSpecificPath( resolvedPath, outPath ); 
}

	 14	Once security is checked and the path is properly converted, the actual file can be opened using the file 
system calls supplied by the operating system.

This concept is illustrated in line 242 of the CAPIFile.cpp file.

FILE * f  = fopen(xformPath, openMode);

	 15	The FILE pointer can now be retrieved using the lasso_typeGetCustomPtr LCAPI function. No error has 
occurred while opening the file, so complete the function call and return “no error”.

This concept is illustrated in lines 426 of the CAPIFile.cpp file.

return osErrNoErr;

	 16	The remaining tag functions are implemented in a similar manner. Study the CAPIFile example for a more 
in-depth and complete example of how to properly construct custom data types in LCAPI 8.
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Chapter 63

LCAPI Data Sources

This chapter includes information about creating data source connectors in C/C++ using the Lasso C/C++ API 
(LCAPI).

	 •	Data Source Connector Operation discusses how data source connectors can be implemented in C/C++.

	 •	Data Source Connector Tutorial walks through a sample project included with every Lasso installation.

Data Source Connector Operation
When Lasso Professional 8 starts up, it looks for module files (Windows DLLs or Mac OS X DYLIBS) in 
the LassoModules folder. As Lasso encounters each module, it executes the module’s registerLassoModule() 
function once and only once. It is your job as an LCAPI developer to write code to register each of your new 
data source (or custom tag) function entry points in this registerLassoModule() function. Both substitution 
tags and data sources may be registered at the same time, and the code for them can reside in the same 
module. The only difference between registering a data source and a substitution tag is whether you call 
lasso_registerTagModule() or lasso_registerDSModule().

Data sources are a bit more complex than substitution tags because Lasso Service calls them with many 
different actions during the course of various database operations. Whereas a substitution tag only needs 
to know how to format itself, a data source needs to enumerate its tables, search through records, add new 
records, delete records, etc. Even so, this added complexity is easily handled with a single switch() statement, as 
you will see in the following tutorial.

Data Source Connectors and Lasso Administration
Once a custom data source connector module is registered by Lasso, it will appear in the Setup > Data 
Sources > Connectors section of Lasso Site Administration. If a connector appears here, then it has been 
installed correctly.

The administrator adds the data source connection information to the Setup > Data Sources > Hosts 
section of Lasso Site Administration, which sets the parameters by which Lasso connects to the data source 
via the connector. This information is stored in the Lasso_Internal Lasso MySQL database, where the connector 
can retrieve and use the data via function calls.

The data that the administrator can submit in the Setup > Data Sources > Hosts section of Lasso Site 
Administration includes the following:

	 •	Name – The administrator-defined name of the data source host.

	 •	Connection URL – The URL string required for Lasso to connect to a data source via the connector. This 
typically includes the IP address of the machine hosting the data source.

	 •	Connection Parameters – Additional parameters passed with the Connection URL. This can include the 
TCP/IP port number of the data source.

	 •	Status – Allows the administrator to enable or disable the connector in Lasso Professional 5.
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	 •	Default Username – The data source username required for Lasso to gain access to the data source.

	 •	Default Password – The data source password required for Lasso to gain access to the data source.

The Connection URL, Connection Parameters, Default Username, and Default Password values are passed to the data 
source via the lasso_getDataHost function, which is described later in this chapter.

LCAPICALL osError lasso_getDataHost( lasso_request_t token,  
		  auto_lasso_value_t * host, auto_lasso_value_t * usernamepassword );

Data Source Connector Tutorial
This section provides a walk-through of an example data source to show how some of the LCAPI features are 
used. This code will be most similar to the sample SampleDataSource project, so if you want to actually build 
this code, then you should copy that project folder and edit the project files inside it.

The data source will simply display some simple text as each portion is called from a Lasso inline which 
does a simple database search. It is not an effective or useful data source; it’s meant to just provide an 
overview of what functions must be implemented. The sample data source will simulate a data source which 
has two databases, an Accounting database and a Customers database. Each of those databases in turn will 
report that it has a few tables within it. For a more complete example of a data source that is useful, look at 
the MySQLDataSource project.

Data Source Connector Code
Below is the code for the substitution tag module. Line numbers are provided to the left of each line of code, 
and are referenced in the Data Source Connector Walk Through section.
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	 void registerLassoModule( 
	 { 
		  lasso_registerDSModule( "SampleDatasource", sampleDS_func, 0 ); 
	 } 
	 osError sampleDS_func( lasso_request_t token, datasource_action_t action, const auto_lasso_value_t *param ) 
	 { 
		  osError	 err = osErrNoErr; 
		  auto_lasso_value_t	 v1, v2; 
		  switch( action ) 
		  { 
			   case datasourceInit: 
				    break; 
			   case datasourceTerm: 
				    break; 
			   case datasourceNames: 
				    lasso_addDataSourceResult( token, "Accounting" ); 
				    lasso_addDataSourceResult( token, "Customers" ); 
				    break; 
			   case datasourceExists: 
				    if( (strcmp( param->data, "Accounting" ) != 0) 
					     && (strcmp( param->data, "Customers" ) != 0) ) 
					     err = osErrWebNoSuchObject; 
				    break; 
			   case datasourceTableNames: 
			   if( strcmp( param->data, "Accounting" ) == 0 ) { 
					     lasso_addDataSourceResult( token, "Payroll" ); 
					     lasso_addDataSourceResult( token, "Payables" ); 
					     lasso_addDataSourceResult( token, "Receivables" ); 
				    } 
				    if( strcmp( param->data, "Customers" ) == 0 ) { 
					     lasso_addDataSourceResult( token, "ContactInfo" ); 
					     lasso_addDataSourceResult( token, "ItemsPurchased" ); 
				    } 
				    break; 
			   case datasourceSearch: 
				    lasso_getDataSourceName( token, &v1 ); 
				    lasso_getTableName( token, &v2 ); 
				    if( strcmp( v1.data, "Accounting" ) == 0 ) { 
					     int	 count, i; 
					     lasso_getInputColumnCount( token, &count ); 
					     for( i=0; i<count; i++ ) { 
						      auto_lasso_value_t	 columnItem; 
						      lasso_getInputColumn( token, i, &columnItem ); 
					      
					     if( strcmp( v2.data, "Payroll" ) == 0 ) { 
						      char *row1[] = {"Samuel Goldwyn", "1955-03-27", "15000.00"}; 
						      unsigned int sizes1[3] = {14, 10, 8}; 
						      lasso_addColumnInfo( token, "Employee", false, typeChar, kProtectionNone ); 
						      lasso_addColumnInfo( token, "StartDate", false, typeDateTime, kProtectionNone ); 
						      lasso_addColumnInfo( token, "Wages", false, typeDecimal, kProtectionNone ); 
						      lasso_addResultRow( token, (const char **)&row1, (unsigned int *)&sizes1, (int)3 ); 
						      lasso_setNumRowsFound( token, 1 ); 
					     } 
				    } 
				    if( strcmp( v1.data, "Customers" ) == 0 ) { 
				    } 
				    break; 
			   case datasourceAdd: 
				    lasso_outputTagData( token, "datasourceAdd was called to append a record<br>" ); 
				    break; 
			   case datasourceUpdate: 
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				    lasso_outputTagData( token, "datasourceUpdate was called to replace a record<br>" ); 
				    break; 
			   case datasourceDelete: 
				    lasso_outputTagData( token, "datasourceDelete was called to remove a record<br>" ); 
				    break; 
			   case datasourceInfo: 
				    lasso_outputTagData( token, "datasourceInfo was called<br>" ); 
				    break; 
			   case datasourceExecSQL: 
				    lasso_outputTagData( token, "datasourceExecSQL was called<br>" ); 
				    break; 
		  } 
		  return err; 
	 }

Data Source Connector Walk Through
This section provides a step-by-step walk through for building the data source connector.

To build a sample LCAPI Data Source Connector:

	 1	Register the new data source in the required registerLassoModule() export function. It’s similar to the way you 
register a substitution tag.

	 void registerLassoModule() 
	 { 
		  lasso_registerDSModule( "SampleDatasource", sampleDS_func, 0 ); 
	 }

	 2	Now implement sampleDS_func, the function which gets called when any database operations are 
encountered.

	 osError sampleDS_func( lasso_request_t token, datasource_action_t action, const auto_lasso_value_t *param )

All data source functions have this prototype. When your data source function is called, it’s passed an 
opaque “token” data structure, an integer “action” telling it what it should do, and an optional parameter 
which sometimes contains extra information (like a database name) needed by the action being requested 
at that time. 

	 3	Set a default error return value that indicates no error. Returning a non-zero value will cause the Lasso 
Professional engine to report a fatal error and stop processing the page.

	 { 
		  osError err = osErrNoErr; 
		  auto_lasso_value_t v1, v2; 
		  switch( action ) 
	 {

Declare a couple of temporary variables to be used later to retrieve important values such as database 
names and table names. This function gets called with various different actions as Lasso Professional 
requests information from our data source. This switch statement distinguishes between those various 
actions. 

	 4	datasourceInit is called once when Lasso Professional starts up. This gives us a chance to initialize any 
communications with our database back-end, and set any global variables (including semaphores) we’ll 
need later.  This is called once when Lasso Professional starts up. Because this data source is so simple, it 
needs no special initialization calls.
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	 case datasourceInit: 
		  break; 
	 case datasourceTerm: 
		  break; 
	 case datasourceNames: 
			   lasso_addDataSourceResult( token, "Accounting" ); 
			   lasso_addDataSourceResult( token, "Customers" ); 
		  break; 
	 case datasourceExists: 
		  if( (strcmp( param->data, "Accounting" ) != 0) 
			   && (strcmp( param->data, "Customers" ) != 0) ) 
			   err = osErrWebNoSuchObject; 
		  break;	

datasourceTerm is called once when Lasso Professional shuts down. Because this data source is so simple, it 
needs no special shutdown code. Normally you would close your connection to your back-end data source 
and release any semaphores you created. 

datasourceNames is called whenever Lasso Professional needs to get a list of databases which your data 
source provides access to. The developer must write code that discovers a list of all the databases your 
database ’knows about’ and call lasso_addDataSourceResult() once for each found database, passing the name 
of the database. If the data source deals with five databases, then you would call lasso_addDataSourceResult() 
five times, once for each database name. 

Because we are simulating a data source which knows about the Accounting and Customers databases, call 
lasso_addDataSourceResult() to add Accounting and Customers to the returned list of database names. 

For datasourceExists, Lasso Professional is asking use if we know a particular database exists (meaning, do we 
control this database). The name of the database we should look up is passed in the C-string param->data. If 
we don’t know about the database in question, then return osErrWebNoSuchObject. The conditional statement 
does a simple string comparison against our hard-coded database name Accounting, and then against our 
hard-coded database name Customers. If neither of the previous string comparisons matched, then return 
the error code osErrWebNoSuchObject indicating that we do not know anything about the requested database.

	 5	Lasso Professional will also need to call on the database tables once per database, passing the database 
name in the param->data value. datasourceTableNames enumerates the list of tables within that named 
database. 

	 case datasourceTableNames: 
		  if( strcmp( param->data, "Accounting" ) == 0 ) { 
			   lasso_addDataSourceResult( token, "Payroll" ); 
			   lasso_addDataSourceResult( token, "Payables" ); 
			   lasso_addDataSourceResult( token, "Receivables" ); 
		  }

The conditional statement checks to see if we are being asked about our Accounting database, and if so adds 
the Payroll table to the list of known tables by calling lasso_addDataSourceResult(), and so forth.

	 6	Next, Lasso Professional will need to check to see if there are inquiries regarding the Customers database.

	 if( strcmp( param->data, "Customers" ) == 0 ) { 
		  lasso_addDataSourceResult( token, "ContactInfo" ); 
		  lasso_addDataSourceResult( token, "ItemsPurchased" ); 
	 } 
		  break;

Lasso Professional adds the ContactInfo table to the list of known tables by calling lasso_addDataSourceResult().
Continue adding table names to the Customers database by calling lasso_addDataSourceResult(), this time for 
the ItemsPurchased table. 

	 7	Use datasourceSearch to perform a search on the database.
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	 case datasourceSearch: 
		  lasso_getDataSourceName( token, &v1 ); 
		  lasso_getTableName( token, &v2 ); 
			   if( strcmp( v1.data, "Accounting" ) == 0 ) { 
				    int	 count, i; 
				    lasso_getInputColumnCount( token, &count ); 
					     for( i=0; i<count; i++ ) { 
					     auto_lasso_value_t columnItem; 
					     lasso_getInputColumn( token, i, &columnItem ); 
					     } 
			   }

All of the information (database and table names, search arguments, sort arguments, etc.) can be retrieved, 
and a search can be performed by calling various LCAPI functions such as lasso_getDataSourceName() and 
lasso_getTableName() to get the name of the database and table, respectively. A complete list of data source 
functions is here. 

lasso_getDataSourceName asks Lasso Professional to give us the database name which is to be searched. 
This is often the value of the -Database parameter value in an inline tag. lasso_getTableName asks Lasso 
Professional to give us the table name to be searched. This is often the value from the -Layout or -Table 
parameter value from an inline tag. 

The conditional statement checks to see if the database being searched is Accounting. If so, declare a couple 
of temporary integers, one for holding the number of search parameters. lasso_getInputColumnCount asks Lasso 
how many search fields (columns) were specified by the user for this search. For instance, if the Lasso inline 
tag passed three different fields to be searched, then lasso_getInputColumnCount() returns 3. 

Declare a temporary variable which will receive the name/value pair information from the next line of 
code. Retrieve the name/value text for the nth requested search parameter. For instance, an inline will fill 
the columnItem variable with the values Employee, fred the first time through the loop, and Wages, 15000 the 
second time through the loop.

[Inline: -Database='Accounting', -Table='Payroll', 'Employee'='fred', 'Wages'='15000']

	 8	Next, set a conditional statement to ask if the Payroll table is being searched. If so, we’ll set up some fake 
hard-coded data in the next few lines of code. Declare an array of strings which represents the three fields 
we will return for this search. Declare an array of field sizes to match the lengths of the strings created on 
the previous line.
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	 if( strcmp( v2.data, "Payroll" ) == 0 ) { 
		  char *row1[] = {"Samuel Goldwyn", "1955-03-27", "15000.00"}; 
		  unsigned int sizes1[3] = {14, 10, 8}; 
		  lasso_addColumnInfo( token, "Employee", false, typeChar, kProtectionNone ); 
		  lasso_addColumnInfo( token, "StartDate", false, typeDateTime, kProtectionNone ); 
		  lasso_addColumnInfo( token, "Wages", false, typeDecimal, kProtectionNone ); 
		  lasso_addResultRow( token, (const char **)&row1, (unsigned int *)&sizes1(int)3 );lasso_setNumRowsFound( token, 1 ); 
		  } 
	 } 
	 if( strcmp( v1.data, "Customers" ) == 0 ) { 
	 } 
		  break; 
	 case datasourceAdd: 
		  lasso_outputTagData( token, "datasourceAdd was called to append a record<br>" ); 
		  break; 
	 case datasourceUpdate: 
			   lasso_outputTagData( token, "datasourceUpdate was called to replace a record<br>" ); 
		  break; 
	 case datasourceDelete: 
		  lasso_outputTagData( token, "datasourceDelete was called to remove a record<br>" ); 
		  break; 
	 case datasourceInfo: 
		  lasso_outputTagData( token, "datasourceInfo was called<br>" ); 
		  break; 
	 case datasourceExecSQL: 
		  lasso_outputTagData( token, "datasourceExecSQL was called<br>" ); 
		  break; 
	 } 
		  return err; 
	 }

lasso_addColumnInfo tells LCAPI what the column names and data types are. Do this by calling 
lasso_addColumnInfo() once per column. In this line, the Employee column is described as text (typeChar) with 
no protection (kProtectionNone). In the next line, the StartDate column is described as date (typeDateTime) with 
no protection (kProtectionNone). 

The last column Wages is described as being numeric (typeDecimal), with no protection (kProtectionNone). Now 
lasso_addResultRow() can be called as many times as there are rows of data to return. In this case, only one 
row is returned. Now LCAPI must be told how many total rows were found.
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Chapter 64

Lasso Connector Protocol

This chapter documents Lasso Connector Protocol (LCP) and describes how to develop Lasso Web server 
connectors.

	 •	Overview introduces Lasso Connector Protocol.

	 •	Requirements includes platform specific development environment details.

	 •	Lasso Web Server Connectors introduces the theory of operation behind creating Lasso Web server 
connectors using LCP.

	 •	Lasso Connector Operation describes the theory and operation behind building Lasso Web server 
connectors.

	 •	Lasso Connector Protocol Reference provides a reference of all commands and parameters used in LCP.

Overview
Lasso Web server connectors are small modules written specifically for a particular brand of Web server. Lasso 
Professional 8 initially includes connectors for Microsoft IIS (Intel architecture), Apple Mac OS X’s Apache 
(PowerPC architecture), and 4D WebSTAR Server Suite V for Mac OS X. A connector for Red Hat Apache 
(Intel architecture) is also available.

The purpose of Lasso Connector Protocol (LCP) is to provide an efficient and platform-independent way of 
communication between a Lasso connector (client) and Lasso Service (server). Included are sample projects 
which give you full source code to the Web server connectors which ship with Lasso (e.g. Lasso Connector for 
IIS and Lasso Connector for Apache). 

LassoSoft encourages developers to create and distribute new Web server connectors in order to give Lasso 
developers as many choices as possible for developing Lasso-based data-driven Web sites.

Requirements
In order to write your own Lasso Web server connector in C or C++, you will need the following:

Windows:

	 •	Microsoft Windows 2000 or Windows XP Professional 

	 •	Microsoft Visual C++ .NET. 

	 •	Windows Lasso Professional version 8.0 or higher.

Mac OS:

	 •	Mac OS X 10.3 with GNU C++ compiler and linker (Dev Tools) installed. 

	 •	Mac OS X Lasso Professional version 8.0 or higher. 
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Lasso Web Server Connectors
All modern Web servers have some form of suffix mapping, where they re-route HTTP requests to various 
modules based on their file suffix (e.g. .lasso). Modules have different names depending on which Web server 
you’re using: ISAPI DLL, Apache Module, W*API plugin, etc. Once the Web server calls the Lasso Web server 
connector, it is the job of the Lasso Web server connector to collect all the information from a particular 
request, and pass it all along to a Lasso Service application that it’s set up to talk to. Then it waits for Lasso 
Service to finish processing the request, and receives back some MIME headers and HTML body text. At this 
point it’s the connector’s job to pass the text back to the Web server, which in turn sends it back out to the 
requesting browser. All communication is via TCP/IP, so the Web server connector and Lasso Service may be 
on separate machines with different architectures.

Lasso Web server connectors also have another job, which is to decode and write out HTTP-upload files. As 
you examine the sample source code, you’ll see that it interprets the incoming POST arguments, writes out 
temporary files, and passes a special list of filename arguments through to Lasso Service on the other side of 
the TCP connection.

Note: Only a single Lasso Web server connector can connect with Lasso Service at a time in Lasso Professional 8.

Getting Started
This section provides a walk-through for building a custom Web server connector in Windows 2000 and Mac 
OS X.

To build a sample Web server connector in Windows 2000/XP:

	 1	Browse to the Lasso Professional 8\Documentation\3 - Language Guide/ 
Examples/LCAPI/Connectors/Lasso Connector for IIS folder on the hard drive.

	 2	Double-click the ISAPIConnector.sln project file — you need Microsoft Visual C++ .NET in order to open it. 

	 3	Choose Build/Build Solution to compile and make the ISAPIConnector.dll. 

	 4	After building, Debug and Release folders will have been created inside your ISAPIConnector project folder. 

	 5	Open IIS Admin and shut down IIS (so that any previous ISAPIConnector.dll files will not be held open inside 
IIS). 

	 6	Open the Lasso Connector for IIS/Debug folder and drag ISAPIConnector.dll into your Windows/System32 folder. 

	 7	Restart IIS using the Services menu in the windows Control Panel. 

	 8	Assuming you already have Lasso installed on this machine, your suffix mappings should all work, and 
Lasso should function just as it did before.

	 9	Use a Web browser to view http://your.Web.server/ and make sure the .lasso suffix mapping is still working. 

To build a sample Web server connector in Mac OS X:

	 1	Open a Terminal window.

	 2	Change the current folder to the Documentation folder by entering the following: 

cd /Applications/Lasso\ Professional\ 7/Documentation/3\ -\ Language\ Guide/Examples/LCAPI/Connectors/Lasso\ Connector\ 
for\ Apache

	 3	Build the sample project using the provided makefile. You must be logged in as the root user to run this 
command. 

make

	 4	After building, a Mac OS X dynamic library file will be in the current folder: Lasso8ConnectorforApache.so. 
This is the module you’ll install into the ApacheModules folder. 

	 5	Copy the newly-created module to the LassoModules folder by entering the following: 

cp LassoConnectorforApache.so /usr/libexec/httpd/

	 6	Logged in as root user, restart apache so it loads the new module. 
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su <enter root password here> apachectl restart

Assuming you already have Lasso installed on this machine, your suffix mappings should all work, and 
Lasso should function just as it did before.

	 7	In a Web browser, go to http://your.Web.server/ and try a few things to make sure the .lasso suffix mapping is 
still working. 

Lasso Connector Operation
Communication between the Lasso Web server connector (client) and Lasso Service (server) is achieved by 
means of exchanging messages via a regular TCP/IP socket on port 14552. A typical session is initiated by a 
client and consists of the following steps:

	 1	Connect to Lasso Service host on port 14552.

	 2	Send the open request command.

	 3	Handle requests sent back from Lasso.

	 4	Repeat previous step until the close request command is received.

	 5	Close the connection.

All messages to and from Lasso Service begin with the LPCommandBlock structure, and are optionally followed 
by an arbitrary number of data bytes if needed. The LPCommandBlock structure is defined as follows: 

typedef  enum LPCommand;  
typedef  int LPRequestID;  
typedef  unsigned int LPSequenceNum;  
typedef  struct LPCommandBlock   
{  
	 LPCommand  fCmd; 
 	 int fResultCode; 
 	 unsigned int fDataSize;  
};

The meaning of each LPCommandBlock structure member is explained in the following table.

Table 1: LPCommandBlock Structure Members

Command	 Description	

fCmd	 The command. For a list of  currently defined commands see the Command 
Reference at the end of  this chapter.

fResultCode	 The result of  the command. Used if  the command is a reply. 

fDataSize	 The size of  the additional command-specific data to follow (may be zero).
		

Lasso Connector Protocol Reference

LCP Commands
This section lists all of the commands used in LCP.

cmdProtoErr

Indicates that an error has occurred in the use of the protocol.

Data Required	 Four-byte integer indicating the error code. Any additional data will be a textual description of  
what went wrong.

Sent By 	 Lasso Service

Reply 	 None
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cmdCloseReq

Sent by Lasso Service when there is no more data to be sent to the Web browser.

Data Required	 None

Sent By	 Lasso Service or client.

Reply	 None

cmdGetParam

Request to return the value of a “named” parameter - server/environment variable or an HTTP request.

Data Required 	 RequestParamKeyword as defined in RequestParams.h Then a four-byte integer indicating 
the size of  the data for the argument. Multiple params may follow.

Sent By	 Lasso Service

Reply	 cmdGetParamRep

cmdGetParamRep

Returns the value of a “named” parameter, as requested by cmdGetParam command.

Data Required 	 RequestParamKeyword as defined in RequestParams.h, then a four-byte integer indicating 
the size of  the character data for the requested param. If  multiple params were requested, 
the data for each param should follow in the original order.

Sent By 	 client

Reply 	 None

cmdPushData

Push partially processed data to a Web browser.

Data Required 	 The data that should be sent to the web browser.

Sent By 	 LassoService

Reply	 None 

Named Parameters
The following table lists all named parameters used in LCP. These parameters are enumerated in the 
RequestParams.h file.

Table 2: Named Parameters

Parameter	 Description	

rpSearchArgKeyword 	 All text in URL after the question mark.

rpUserKeyword 	 Username sent from browser.

rpPasswordKeyword	 Password sent from browser.

rpAddressKeyword 	 IP address of  client browser.

rpPostKeyword 	 HTTP object body (form data, etc.).

rpMethodKeyword 	 GET or POST, depending on <form method>.

rpServerName 	 IP address of  server on which the Web server is running.

rpServerPort 	 IP port this hit came to (80 is common, 443 for SSL).

rpScriptName 	 Relative path from server root to this Lasso page.

rpContentType 	 MIME header sent from client browser.

rpContentLength 	 The length in bytes of  the POST data sent from <form POST>.

rpReferrerKeyword 	 URL of  referring page.

rpUserAgentKeyword 	 Browser name and type.

rpClientIPAddress 	 IP address of  client browser.

rpFullRequestKeyword 	 All MIME headers, uninterpreted.
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X
Section X

Lasso Java API

This section includes instructions for extending the functionality of Lasso by creating new tags, data types, 
and Web server connectors written in Java.

	 •	Chapter 65: LJAPI Introduction includes general information about extending Lasso’s functionality.

	 •	Chapter 66: LJAPI Tags discusses how to create new tags in LJAPI including substitution tags, asynchro-
nous tags, and remote procedures.

	 •	Chapter 67: LJAPI Data Types discusses how to create new data types in LJAPI including sub-classing and 
symbol overloading.

	 •	Chapter 68: LJAPI Data Sources includes information about how to create new data source in LJAPI.

	 •	Chapter 69: LJAPI Reference includes information about each of the function calls available in LJAPI.

Lasso can also be extended using LassoScript or C/C++. See the preceding sections on the LassoScript API or 
the Lasso C/C++ API (LCAPI) for more information..
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Chapter 65

LJAPI Introduction

This chapter provides an introduction to the Lasso Java API (LJAPI) which allows new tags, data types, and 
data source connectors to be written in Java.

	 •	Overview introduces the Lasso Java API.

	 •	What’s New discusses what’s new in this version of LJAPI.

	 •	LJAPI vs LCAPI discusses when modules should be implemented in C/C++ versus Java.

	 •	Requirements includes system requirements for building LJAPI modules.

	 •	Getting Started includes basic information about how to build LJAPI modules.

	 •	Debugging includes information about how to debug LJAPI modules within Lasso.

	 •	Frequently Asked Questions includes several frequently asked questions and answers.

Overview
The Lasso Java Application Programming Interface (LJAPI) lets you write Java code to add new Lasso tags, 
data source connectors, and data types to Lasso Professional 8. LJAPI is similar to LCAPI, but is tailored for 
the Java language.

Custom tags written in LJAPI instantly support each platform. One of the important reasons for developing 
LJAPI modules is an enormous class library included with each Java VM install, covering almost every single 
programming need, from text processing to 2D/3D imaging to various network protocol implementations.

This chapter provides a walk-through for building an example substitution tag in LJAPI. Source code for 
the ZipCountTag module, as well as the code for the substitution tag, data source connector, and data type 
examples are included in the Lasso Professional 8/Documentation/4-ExtendingLasso/LJAPI folder on the hard drive.

What’s New
Lasso Professional 8 includes some minor enhancements over the version of LJAPI that shipped with Lasso 
Professional 6. This section provides a quick summary of the history of LJAPI.

	 •	LJAPI – LJAPI was introduced with Lasso Web Data Engine 3 in October 1998. Modules created using 
this version of LJAPI are generally compatible with all versions of Lasso from 3 through 6. This API is 
sometimes referred to as LJAPI 5.

Lasso Professional 5 included some minor enhancements to LJAPI from Lasso WDE 3.x, but the API 
remained largly unchanged. Lasso Professional 5 also introduced the Lasso C/C++ API (LCAPI) for C/C++ 
programmers.

	 •	LJAPI 6 – Lasso Professional 6 included a complete rewrite of LJAPI. The most important change in 
LJAPI 6 is that it is now built upon LCAPI. Both API’s share the same functionality and provide a single 
programming interface, making it easier for developers who wish to learn both APIs.
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Lasso Professional 6 shipped with support for both LJAPI 5 (and earlier) modules and LJAPI 6 modules.

	 •	LJAPI 7 – Lasso Professional 7 supports all modules created with LJAPI 6. There are some minor 
enhancements to the APIs, but no significant changes over the previous version. Lasso Professional 7 did 
not support modules written for LJAPI 5 or earlier.

	 •	LJAPI 8 – Lasso Professional 8 supports all modules created with LJAPI 6 or 7. There are some minor 
enhancements to the APIs, but no significant changes over the previous version. Lasso Professional 8 does 
not support modules written for LJAPI 5 or earlier.

Each new release of Lasso brings enhancements to the Lasso programming language, built-in data types, data 
sources, LCAPI, and more. While the basic API for LJAPI is not exepcted to change significantly post-LP6, new 
releases of LJAPI may include support for any new features of Lasso or LCAPI that can be expressed in the 
API.

Modules written to the LJAPI 6 specifications should be compatible with Lasso Professional 8. Modules 
written to the LJAPI 7 specifications should be compatible with Lasso Professional 6 provided that no LP7-
specific features are accessed. Modules written to the LJAPI 5 (or earlier) specifications will not work in Lasso 
Professional 8.

LJAPI vs. LCAPI
Developers who have experience creating LCAPI modules will find themselves familiar with the Lasso Java 
API. Similarly, Java developers who learn to use LJAPI 7 will find it easy to write LCAPI modules once they are 
ready to make a transition to a different language. 

The following sections outlines a few basic differences between LCAPI 7 and LJAPI 7.

LJAPI is Object-Oriented
The majority of Lasso API functions must be aware of the current Lasso state in order to operate correctly. In 
order to solve the problem resulting from the non-OO nature of the C-based Lasso API, LCAPI introduced the 
token concept. When Lasso calls one of the methods implemented by an LCAPI module, it passes an opaque 
parameter of type lasso_request_t, which encapsulates the information about the current state of the request. 
The module then makes calls to Lasso while passing the token in the first parameter to every API function.

In LJAPI 7, the same state information is stored in an instance of the LassoCall Java class. All LJAPI 7 functions 
are implemented as members of the LassoCall class, which eliminates the need to pass a token parameter with 
each call.

This results in one of the most notable differences between LJAPI and LCAPI, in that LJAPI methods usually 
take one parameter less that their native LCAPI counterparts.

LJAPI Uses Shorter Function Names
In LCAPI, function names begin with the lasso_ prefix, reflecting the name space in which they reside. 
However, the corresponding LJAPI methods are implemented as members of LassoCall class. For this reason, 
the lasso_ prefix has been removed from all Java method names. 

The following shows the lasso_getTagName function in LCAPI: 

lasso_getTagName( lasso_request_t token, auto_lasso_value_t &name );

The following shows the equivalent getTagName method in LJAPI:

getTagName( LassoValue name );

Tokenless LCAPI Functions are Static Methods in LJAPI
There are few LCAPI functions that do not take the token state parameter. These functions are implemented 
in LJAPI as static methods of the LassoCall class:
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The following shows the lasso_registerConstant function in LCAPI:

osError lasso_registerConstant( const char * name, lasso_type_t val );

The following shows the equivalent registerConstant method in LJAPI:

int LassoCall.registerConstant( String name, LassoTypeRef  val );

LJAPI Does Not Use Function Pointers
Some LCAPI functions use a function pointer parameter of type lasso_tag_func. Since function pointers do not 
exist in Java, the corresponding LJAPI methods instead accept a pair of string parameters that specify the class 
and method name.

The following shows the lasso_typeAllocTag function in LCAPI:

osError lasso_typeAllocTag ( lasso_request_t token, lasso_type_t * outTag, lasso_tag_func nativeTagFunction );

The following shows the equivalent typeAllocTag method in LJAPI:

int typeAllocTag ( LassoTypeRef  outTag, String className, String methodName );

Requirements
In order to write your own Lasso substitution tags, data source connectors, or custom data types in Java, you 
will need the following:

Windows
	 •	Microsoft Windows 2000, Microsoft Windows XP Professional, or better.

	 •	Java 2 SDK 1.4 or higher.

	 •	Windows Lasso Professional 8 or higher.

Mac OS
	 •	Mac OS X with Java 2 SDK installed (included).

	 •	Mac OS X Lasso Professional 8 or higher.

Getting Started
This section provides a walk-through for building sample LJAPI tag modules in Windows 2000/XP and Mac 
OS X.

To build a sample LJAPI tag module using Apache Ant:

Apache Ant is a de-facto standard Java-based build tool, part of the Apache open-source initiative.

In order to build the sample code, you will need to install complete Ant package, downloadable from the 
following location:

http://ant.apache.org/

If you do not wish to install Apache Ant at this time, you can skip to the next section for instructions on 
building the code examples with the javac compiler tool.

Note: All LJAPI examples have been tested with the most recent stable version of the Ant tool (v1.5.2) available 
at the time of the Lasso Professional 8 release.
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To build all included code examples:

	 1	Launch the command prompt (Windows 2000/XP), or open the Terminal application (Mac OS X)

	 2	Locate the following folder in the hard drive:

Lasso Professional 8/Documentation/4-ExtendingLasso/LJAPI/Sample Code

	 3	Make this folder your current working directory.

		 Windows:

   cd "C:\Program Files\OmniPilot Software\Lasso Professional 8\Documentation\4-ExtendingLasso\LJAPI\Sample Code"

		 Mac OS X:

   cd "/Applications/Lasso Professional 8/Documentation/4-ExtendingLasso/LJAPI/Sample Code"

	 4	Invoke Ant tool by entering the “ant” command at the command prompt, optionally followed by the target 
(sub-project) name: 

ant <target-name>

		 Compiled LJAPI modules will be placed in the Modules (output) folder located inside the Sample Code 
directory.

	 5	To install sample LJAPI modules using the Ant tool, enter the following command at the command 
prompt:

ant install

		 Sample LJAPI modules can also be installed manually, by dragging one or more Java class/jar files from the 
Modules (output) folder to the LassoModules folder.

	 6	Restart Lasso Professional.

Please note that, when launched without an optional target name parameter (step 4), Ant will execute the 
default target defined in the “build.xml” descriptor file. This target has been pre-configured to compile all 
sample LJAPI modules. Individual modules can be also built separately by specifying one of the following 
target names on the command line: zipcount, zip, pdf, nntp, mysql, xml or docs.

Two special targets (clean and install) can be used for deleting the contents of the Modules (output) directory, and 
copying LJAPI modules to the LassoModules folder, respectively.

For further details, please see the contents of the build.xml descriptor file.

Alternately, you can also build the ZipCountTag module using the <javac> command-line tool included with 
Java SDK from Sun Microsystems.

To build ZipCountTag module using the <javac> command-line tool:

	 1	Launch the Windows 2000/XP command prompt.

	 2	Make the following folder your current directory.

C:\Program Files\OmniPilot Software\Lasso Professional 8\ 
Documentation\4-ExtendingLasso\LJAPI\Sample Code\Substitution Tags\ZipCountTag

	 3	Enter the path of the Java compiler tool javac, followed by the -classpath option keyword and the path to the 
LJAPI.jar file (contains all Java classes used by LJAPI modules), followed by the ZipCountTag module source 
file path: 

javac -classpath ../../../../../../LassoModules/LJAPI.jar ZipCountTag.java

		 If Java SDK has been installed in the jdk1.4 folder, your command line might look like this:

C:\jdk1.4\bin\javac -classpath ..\LJAPI.jar ZipCountTag.java

	 4	After building, a ZipCountTag.class file will be created inside your ZipCountTag project folder.

	 5	Open the ZipCountTag folder and drag ZipCountTag.class into the Lasso Professional 8\LassoModules folder on the 
hard drive.

	 6	Stop and then restart Lasso Service.
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	 7	The new tag [Zip_Count] is now part of the Lasso language.

	 8	Drag the sample Lasso page called ZipCountTag.lasso and the LJAPITest.zip test file into your Web server root.

	 9	In a Web browser, view http://localhost/ZipCountTag.lasso to see the new Lasso tags in action. 

To build a sample LJAPI tag module in Mac OS X:

	 1	Open a Terminal window.

	 2	Change the current folder to the Lasso Professional 8/Documentation folder using the following command:

cd /Applications/Lasso\ Professional\ 7/Documentation/4-ExtendingLasso/LJAPI/Sample\ Code/Substitution\ Tags/
ZipCountTag

	 3	Build the sample project using the provided makefile. This requires that you be logged in as the root user.

make

		 Alternatively, you can build the module by manually invoking the Java compiler:

javac -classpath ../../../../../../LJAPI.jar ZipCountTag.java

	 4	After building, a Java class file named ZipCountTag.class will be created in the current folder. This is the LJAPI 
module you’ll install into the LassoModules folder.

	 5	Copy the newly-created module to the Lasso modules folder using the following command:

cp ZipCountTag.class /Applications/Lasso\ Professional\ 7/LassoModules

	 6	Quit Lasso Service if it’s running, so that the next time it starts up, it will load the new module you just 
built (you’ll need to know a root password to use sudo).

cd /Applications/Lasso\ Professional\ 7/Tools/ 
sudo ./stoplassoservice.command

	 7	Start the Lasso Service back up, so it will load the new module.

sudo ./startlassoservice.command

		 The new [Zip_Count] tag is now part of the Lasso language.

	 8	Copy the sample Lasso page called ZipCountTag.lasso and the LJAPITest.zip test file from your 
Lasso Professional 8/Documentation/4-ExtendingLasso/LJAPI/Tags/ZipCountTag  
folder into your Web server document root.

	 9	Use a Web browser to view http://localhost/ZipCountTag.lasso to see the new Lasso tags in action.

Debugging
You can set breakpoints in your LJAPI class files and perform source-level debugging for your own code. In 
order to set this up, add path information to your project so it knows from where to load executables. For 
this section, we will use the provided substitution tag project as the example.

To set breakpoints in your LJAPI code:

	 1	Lasso Professional 8 allows you to specify Java Virtual Machine options used for launching JVM upon Lasso 
startup. These options are stored in the lasso_internal.global_prefs table as java_vm_options in the store_key field. 
To enable remote debugging on port 8000, add the following two options to the data column in the 
lasso_internal.global_pref table:

-Xdebug -Xrunjdwp:transport=dt_socket,address=8000,server=y,suspend=n

	 2	After restarting Lasso Professional 8, launch JDB with the following option:

jdb -attach 8000
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	 3	Once attached to the JVM, you can set the breakpoints, single-step through your code, catch exceptions, etc. 
Please note that you can store multiple JVM options in the same column. To monitor the GC activity, add 
-verbose:gc option, or use -verbose:jni to print JNI messages to the standard output.

		 For more information on the options available for your platform and JVM, please consult the JVM vendor 
documentation. For a list of non-standard options available for your JVM, review the Xusage.txt file:

		 Mac OS X: 

/System/Library/Frameworks/JavaVM.framework/Home/lib/Xusage.txt

		 Windows:

 <path-to-jvm.dll>/Xusage.txt
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Chapter 66

LJAPI Tags

This chapter includes information about creating tags in Java using the Lasso Java API (LJAPI).

	 •	Substitution Tag Operation discusses how to create new Lasso tags in Java.

	 •	Substitution Tag Tutorial walks through an example project that ships with every installation of Lasso.

Substitution Tag Operation
An LJAPI module is essentially a regular Java class file. When Lasso Professional 8 first starts up, it looks for 
module files (Windows DLLs or Mac OS X DYLIBS) in its LassoModules folder. As it encounters and loads an 
LJAPI 7 module, it launches the JVM and proceeds to scan the folder for other LJAPI modules. Upon finding a 
Java class file, Lasso attempts to determine if it is derived from the com.omnipilot.lassopro.JavaModule class. If it is, 
then Lasso loads the class while performing necessary instantiation and calls the registerLassoModule() function 
that is implemented in that class:

public void registerLassoModule()

At this point, the module must call the following method as many times as needed, once for each tag 
implemented by the module:

void registerTagModule( String moduleName,  
						                          String tagName,  
						                          String methodName,  
						                          int flags,  
						                          String description);

After a tag module is registered with Lasso Professional 8, it can provide information about the name of the 
tag and the name of the Java method that is implementing that tag. It also can provide a short description, 
and any special flags describing unique features implemented by that tag.

All registered information is later used for dispatching the task of executing a particular tag found in a .lasso 
Lasso page to an appropriate LJAPI module, or executing a data source action.

For example, the following code tells Lasso to call the Java class called ZipCountTag whenever the code 
[Zip_Count] is encountered inside a .lasso Lasso page. The first parameter of the registerTagModule method is the 
module name, the second is the tag name, and the third one is the name of the function implementing the 
tag. The last two parameters are the tag type flag and a short description:

public void registerLassoModule() 
	 { 
		  registerTagModule( "ZipCountTag", "zip_count", "myZipCountFunc",  
     FLAG_SUBSTITUTION, "Count items in a zip file" ); 
	 }

Below is the code needed in a Lasso page in order to get the custom tag to execute:
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<html> 
  <body> 
     Count of  items in the LjapiTest.zip file: 
     [Zip_Count:'LjapiTest.zip'] 
     <!-- This should display "2" when page executes --> 
  </body> 
</html>

This will produce the following:

➜	 2

Substitution Tag Tutorial
The following section provides a walk-through of building an example tag to show how LJAPI features are 
used. This code will be most similar to the sample ZipCountTag LJAPI project. In order to build this project, 
copy the ZipCountTag project folder and edit the project files inside it.

The module relies on a Java class library to do most of the work, particularly the java.util.zip package which 
provides a variety of functions for manipulating the contents of Zip files—standard compressed archives 
widely used on the Internet.

The [Zip_Count] tag implemented in the ZipCountTag LJAPI module simply displays the number of files and 
directories stored in a Zip file when called from a Lasso page. 

Example sample tag Lasso syntax:

[Zip_Count: -Zipfile='LJAPITest.zip', -FilesOnly]

Notice the required convention of placing a dash in front of all named parameters in order to make them 
easier to spot in the Lasso code, and prevent ambiguities in the Lasso parser. Notice the tag takes one string 
parameter named -Zipfile, and an optional keyword parameter named -FilesOnly. In general, Lasso does not 
care about the order in which you pass parameters, so plan to make this tag as flexible as possible by not 
assuming anything about the order of parameters. The following variations should work exactly the same.

Example of sample tag with different ordered parameters:

[Zip_Count: -Zipfile='LJAPITest.zip', -FilesOnly]

[Zip_Count: -FilesOnly, -Zipfile='LJAPITest.zip']

Substitution Tag Module Code
Shown below is the code for the substitution tag module. Line numbers are provided to the left of each line 
of code, and are referenced in the Substitution Tag Module Walk-Through section.

Note: The line numbers shown refer to the line numbers of the code in the actual file being created, not as 
shown in this page. Some single lines of code may carry into two or more lines as shown on this page.

Substitution Tag Module Code

	 1	 import com.omnipilot.lassopro.*;
	 2	 import java.io.*;
	 3	 import java.util.*;
	 4	 import java.util.zip.*;
	 5	 public class ZipCountTag extends LassoTagModule
	 6	 {
	 7 	 public void registerLassoModule()
	 8 	 {
	 9 		  registerTagModule( "Zip", "zip_count", "myZipCountFunc", 
	 10		  FLAG_SUBSTITUTION, "Count items in a zip file" );
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	 11	 }
	 12		
	 13		  public int myZipCountFunc(LassoCall lasso, int action)
	 14		  {
	 15			   int err = ERR_NOERR;
	 16			   try {
	 17				    IntValue count = new IntValue();
	 18				    err = lasso.getTagParamCount( count );
	 19				    if  ( err == ERR_NOERR && count.intValue() > 0 )
	 20				    {
	 21					     String zipName = null;
	 22					     boolean filesOnly = false;
	 23					     LassoValue param1 = new LassoValue();
	 24					     LassoValue param2 = new LassoValue();
	 25					     err = lasso.findTagParam( "-zipfile", param1 );
	 26					     if  ( err != ERR_NOERR || param1.name() == null )
	 27						      lasso.getTagParam( 0, param1 );
	 28					     if  ( param1.name() == null || param1.name().length() == 0 )
	 29						      return LassoErrors.InvalidParameter;
	 30					     if  ( count.intValue() > 1 && 
	 31							       lasso.getTagParam( 1, param2 ) == ERR_NOERR )
	 32						      filesOnly = param2.equalsIgnoreCase("-filesonly");
	 33					     String filePath = lasso.fullyQualifyPath( param1.name() );
	 34					     filePath = lasso.resolvePath( filePath );
	 35					     filePath = lasso.getPlatformSpecificPath( filePath );
	 36					     ZipFile zip = new ZipFile( filePath ); 	
	 37					     Enumeration enum = zip.entries();
	 38					     ZipEntry entry = null;
	 39					     int zipcount = 0;
	 40					     while ( enum.hasMoreElements() )
	 41					     {
	 42						      entry = (ZipEntry)enum.nextElement();
	 43						      if  ( !filesOnly || !entry.isDirectory() )
	 44							       ++zipcount;
	 45					     }
	 46					     err = lasso.outputTagData( Integer.toString( zipcount ) );		
	 47					     zip.close();
	 48				    }
	 49			   }
	 50			   catch ( java.io.Exception e )
	 51			   {
	 52				    lasso.setResultMessage( e.getMessage() );
	 53				    return LassoErrors.FileNotFound;
	 54			   }
	 55			   return err;
	 56		  }
	 57	 }

Substitution Tag Module Walk-Through
This section provides a step-by-step walk-through for building the substitution tag module.

To write a sample LJAPI tag module:

	 1	First, import com.omnipilot.lassopro.* classes as shown in line 1.

	 1	 import com.omnipilot.lassopro.*;
	 2	 import java.io.*;
	 3	 import java.util.*;
	 4	 import java.util.zip.*;

	 2	Define your class to be a subclass of the omnipilot.lasso.LassoSubstitutionTag class.
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	 5	 public class ZipCountTag extends LassoTagModule

	 3	Define the registerLassoModule method.

	 7 	 public void registerLassoModule() {

Every Lasso module must implement the registerLassoModule() method. This method will be called by Lasso 
at startup, giving your module a chance to register its tags.

	 4	Register the tags implemented by your module.

	 9 	 registerTagModule( "Zip", "zip_count", "myZipCountFunc", 
	 10 	 FLAG_SUBSTITUTION, "Count items in a zip file" );

Call this method as many times as there are tags implemented in your module. This method takes five 
parameters: the module name, the name of Lasso tag, the name of the Java method implemented by your 
module (to be called when the corresponding Lasso tag is found on the page), any additional tag feature 
flags, and a brief tag description.

	 5	Define the tag formatting method with the same name as indicated in the third parameter of the 
corresponding registerTagModule call.

	 13 	 public int myZipCountFunc(LassoCall lasso, int action)

This is the method that does all the work. Every tag registered by your module can have its own formatting 
method. Its purpose is to perform an action based on the parameters passed to the tag and/or current 
request properties. Most substitution tags would output the data, although some may perform other 
actions such as setting page variables, manipulating files, etc.

When Lasso encounters one of the tags registered by your module, it creates new module instance and calls 
the corresponding method, passing the LassoCall object which then can be used by the module for calling 
back into Lasso.

	 6	Define the variable to hold the result code returned by various LassoCall methods.

	 15	  int err = ERR_NOERR;

	 7	Our [Zip_Count] Lasso tag takes one required and one optional parameter. We need to make sure at least one 
parameter (filename) is present, otherwise we won’t be able to continue.

	 17 	 IntValue count = new IntValue();
	 18 	 err = lasso.getTagParamCount( count );
	 19	 if  ( err == ERR_NOERR && count.intValue() > 0 )

	 8	Define the storage for the zip file name, optional -FilesOnly parameter, and LassoValue object to be used with 
various LassoCall methods.

	 21 	 String zipName = null;
	 22 	 boolean filesOnly = false;
	 23 	 LassoValue param = new LassoValue();

	 9	Our tag should be flexible enough to accept both named and unnamed versions of the required parameter. 
First, try to search for the parameter by a name.  

	 25 	 err = lasso.findTagParam( "-zipfile", param1 );

	 10	If this fails, assume the first unnamed tag parameter to hold the file path name. Call getTagParam() with the 
index 0 (tag parameter numbering is zero-based).

	 26 	 if  ( err != ERR_NOERR || param1.name() == null )
	 27 		  err = lasso.getTagParam( 0, param1 );

	 11	Next, make sure we’ve got a valid value. If the filename parameter contains an empty string, immediately 
return from our method, passing InvalidParameter result code back to Lasso.

	 28 	 if  ( err != ERR_NOERR || param1.name().length() == 0 )
	 29 		  return LassoErrors.InvalidParameter;

	 12	Our tag also accepts an optional boolean parameter -FilesOnly, indicating that directories must be ignored 
while counting zip file items. If more than one parameter was supplied to our tag, try determining if it was 
the optional -FilesOnly parameter.

	 30 	 if  ( count.intValue() > 1 && 
	 31			   lasso.getTagParam( 1, param2 ) == ERR_NOERR )
	 32 		  filesOnly = param2.equalsIgnoreCase("-filesonly");
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	 13	The path to the zip file is relative to the server root. In order to find out the actual location of the file, you 
can use a number of LassoCall class methods suited for converting a file path name into a fully qualified 
platform-specific path. fullyQualifyPath() turns a relative path into a from-the-server-root path. resolvePath() 
converts a from-the-root path into a full internal path. Finally, getPlatformSpecificPath() will convert an 
internal path name into a platform-specific path name.

	 33 	 String filePath = lasso.fullyQualifyPath( param1.name() );
	 34 	 filePath = lasso.resolvePath( filePath );
	 35 	 filePath = lasso.getPlatformSpecificPath( filePath );

	 14	Now attempt to instantiate a ZipFile object using a platform-specific path name. Any exceptions thrown by the object constructor 
will be caught by the try/catch block wrapping our method's body.

	 36	 ZipFile zip = new ZipFile( filePath ); 

	 15	Prepare to enumerate items in the zip file.

	 37	 Enumeration enum = zip.entries();

	 16	Define the storage for holding the zip item count.

	 38 	 ZipEntry entry = null;
	 39 	 int zipcount = 0;

	 17	Iterate through the zip archive items, incrementing the counter for all items matching our criteria.

	 40 	 while ( enum.hasMoreElements() )
	 41 	 {
	 42 		  entry = (ZipEntry)enum.nextElement();
	 43 		  if  ( !filesOnly || !entry.isDirectory() )
	 44 			   ++zipcount;
	 45 	 }

	 18	Output the resulting zip file item count.

	 46 	 err = lasso.outputTagData( Integer.toString( zipcount ) );

	 19	Close the zip file.

	 47	 zip.close();

	 20	Make sure that any possible exceptions are handled correctly in your code. In this particular case, we simply 
pass the message retrieved from the Exception object back to Lasso, and return the FileNotFound error code. 
For a complete listing of error codes, see the variables defined in the LassoErrors class.

	 50 	 catch ( Exception e )
	 51 	 {
	 52 		  lasso.setResultMessage( e.getMessage() );
	 53 		  return LassoErrors.FileNotFound;
	 54 	 }
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Chapter 67

LJAPI Data Types

This chapter includes information about creating data types in Java using the Lasso Java API (LJAPI).

	 •	Data Type Operation discusses the fundamentals of implementing data types in Java.

	 •	Data Type Tutorial walks through a sample project that is installed with Lasso Professional.

Data Type Operation
Among other new features, Lasso Professional 8 Java API introduces the ability to create custom data types 
in Java. Creating a new data type in LJAPI 7 is similar to creating a substitution tag. When Lasso Professional 
8 starts up, it scans the LassoModules folder for module files (Windows DLLs or Mac OS X DYLIBS). As it 
encounters each module, it executes the registerLassoModule() function for that module. The developer may 
register new LJAPI data types implemented by the module inside this function.

Custom data types are analogous to objects used in many other programming languages. They can have 
properties (fields) and member tags (methods).

Data Type Tutorial
The following section provides a walk-through of building an example custom type to show how LJAPI 
features are used. This code will be most similar to the sample ZipType LJAPI project, so in order to build this 
code, copy the ZipType project folder and edit the project files inside it.

The module relies on a Java class library to do most of the work, particularly the java.util.zip package which 
provides variety of functions for manipulating the contents of ZIP files—standard compressed archives widely 
used on the Internet.

The resulting type will be a “zip” file with the ability to read data from a zip file given a path. The following 
member tags will be implemented:

Table 1: Type initializer and Member Tags

Name	 Description	

[Zip:'Pathname']  	 Type initializer. Creates new instance of  a custom type.

[Zip->File] 	 Return the name of  this Zip file.

[Zip->Count]	 Return the count of  entries in this file.

[Zip->Size]	 Synonym for [Zip->Count].

[Zip->Enumerate]	 Enumerates zip entries, allowing to iterate through stored items via consecutive 
calls to [Zip->Next].

[Zip->Next]	 Advance to the next entry, returning True if  more items are available.

[Zip->Position]	 Current iterator position, i.e. the index.
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The rest of the member tags are item accessors, operating on the entries stored in a zip file:

Table 2: Accessors

Name	 Description	

[Zip->Name]	 Returns the name of  an indexed entry.

[Zip->Get] 	 Synonym for [Zip->Name].

[Zip->Comment] 	 Zip entry comment.

[Zip->Date] 	 Returns the entry creation date.

[Zip->Crc]	 Checksum, or 0xffffffff  if  not available.

[Zip->Method]	 Compression method: DEFLATED or STORED.

[Zip->Extra]	 Returns any extra data stored with the entry.

[Zip->GetData]	 Returns uncompressed entry data.

[Zip->CSize]	 Returns the size of  the compressed data.

[Zip->USize] 	 Returns the size of  uncompressed data.

[Zip->IsDir]	 Returns True if  the entry is a directory.
		

All zip entry accessor tags, except for [Zip->GetData], can take either one or zero parameters. An integer 
parameter can specify the index (position) of the entry in a zip file, while a string parameter could be used to 
locate an entry by its name. When no parameters are provided, a corresponding action is performed on the 
“current” item, whose index can be obtained via the [Zip->Position] member tag.

Example sample tag Lasso syntax:

The following shows an example of using a Zip custom type.

[Var:'zip' = zip:'/archive.zip'] 
[$zip->Count] 
[$zip->Method] 
[$zip->CSize] 
[$zip->USize] 
[While: $zip->Next] 
	 [$zip->CRC] 
[/While]

Custom Data Type Module Code
Shown below is the code for the custom type tag module. Line numbers are provided to the left of each line 
of code, and are referenced in the Custom Type Tag Module Walk-Through section.

Note: The line numbers shown refer to the line numbers of the code in the actual file being created, not as 
shown in this page. Some single lines of code may carry into two or more lines as shown on this page.

Custom Data Type Module Code

	 1	  import com.omnipilot.lassopro.*;
	 2	  import java.util.*;
	 3	  import java.util.zip.*;
	 4	  import java.io.*;
	 5	  import java.text.DateFormat;
	 6	  public class ZipType extends LassoTagModule
	 7	  {
	 8 	 static final DateFormat df  = 
	 9 		  DateFormat.getDateTimeInstance(DateFormat.SHORT, DateFormat.MEDIUM);
	 10 	 static final String[] members = {
	 11 		  "File","Size","Count","Enumerate","Position","Next",
	 12 		  "GetData","Get","Name","Comment","Date","Crc",
	 13 		  "Method", "Extra", "CSize", "USize", "IsDir" };
	 14 	 ZipFile		 zip = null;
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	 15 	 Enumeration enum = null;
	 16 	 ZipEntry 	 entry = null;
	 17 	 int 		 index = 0;
	 18 	 public void registerLassoModule()
	 19 	 {
	 20 		  registerTagModule("ZipType", "zip", "format", 
	 21 				    FLAG_SUBSTITUTION | FLAG_INITIALIZER, "zip custom type tag");
	 22 	 }	
	 23 	 public int format(LassoCall lasso, int action)
	 24 	 {
	 25 		  int err = ERR_NOERR;
	 26 		  LassoValue param = new LassoValue();
	 27 		  String path name = null;
	 28 		  if  (lasso.getTagParam(0, param) != ERR_NOERR || 
	 29 			    param.name().length() < 1)
	 30 		  {
	 31 			   lasso.setResultMessage("[Zip] invalid file path name parameter");
	 32 			   return LassoErrors.InvalidParameter;
	 33 		  }			 
	 34 		  try
	 35 		  {
	 36 			   IntValue count = new IntValue();
	 37 			   err = lasso.getTagParamCount(count);
	 38 			   if  (err == ERR_NOERR && count.intValue() > 0)
	 39 			   {
	 40 				    String filePath = lasso.fullyQualifyPath(param.name());
	 41 				    filePath = lasso.resolvePath(filePath);
	 42 				    filePath = lasso.getPlatformSpecificPath(filePath);
	 43 				    this.zip = new ZipFile(filePath);
	 44 				    LassoTypeRef  self  = new LassoTypeRef();
	 45 				    if  ((err = lasso.typeAllocCustom(self, "zip")) != ERR_NOERR)
	 46 				    {
	 47 					     lasso.setResultMessage("[Zip] couldn't create new zip type instance.");
	 48 					     return err;
	 49 				    }
	 50 				    LassoTypeRef  ref  = new LassoTypeRef();
	 51 				    String className = this.getClass().getName();
	 52 				    for (int i = 0; i < this.members.length; i++)
	 53 				    {
	 54 					     if  ((err=lasso.typeAllocTag(ref, className, "memberFunc")) != ERR_NOERR ||
	 55 						       (err=lasso.typeAddMember(self, members[i], ref)) != ERR_NOERR)
	 56 					     {
	 57 						      lasso.setResultMessage("[Zip] error adding member: " + members[i]);
	 58 						      return err;
	 59 					     }
	 60 				    }
	 61 				    if  (lasso.typeAllocTag(ref, className, "convertFunc") == ERR_NOERR)
	 62 					     lasso.typeAddMember(self, "onConvert", ref);
	 63 				    if  (lasso.typeAllocTag(ref, className, "destroyFunc") == ERR_NOERR)
	 64 					     lasso.typeAddMember(self, "onDestroy", ref);	  
	 65 				    if  ((err = lasso.typeSetCustomJavaObject(self, this)) != ERR_NOERR)
	 66 				    {
	 67 					     lasso.setResultMessage("[Zip] couldn't attach java object to a custom type");
	 68 					     return err;
	 69 				    }
	 70 				    err = lasso.returnTagValue(self);
	 71 			   }
	 72 		  }
	 73 		  catch (Exception e)
	 74 		  {
	 75 			   System.err.println(e.toString());
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	 76 			   lasso.setResultMessage(e.getMessage());
	 77 			   return LassoErrors.FileNotFound;
	 78 		  }
	 79 		  return err;
	 80 	 }
	 81 	 public int destroyFunc(LassoCall lasso, int action)
	 82 	 {
	 83 		  if  (this.zip != null)
	 84 		  {
	 85 			   try { this.zip.close(); }
	 86 				    catch (IOException e) {}
	 87 			   this.zip = null;
	 88 		  }
	 89 		  return ERR_NOERR;
	 90 	 }
	 91 	 public int convertFunc(LassoCall lasso, int action)
	 92 	 {	
	 93 		  LassoValue param = new LassoValue();
	 94 		  if  (lasso.getTagParam(0, param) == ERR_NOERR && 
	 95 			   param.name().equalsIgnoreCase("string"))
	 96 		  {
	 97 			   lasso.outputTagData("zip:(" + this.zip.getName() + ")");
	 98 		  }
	 99 
	 100 	 return ERR_NOERR;
	 101	 }
	 102	 public int memberFunc(LassoCall lasso, int action)
	 103	 {
	 104 	 LassoValue tag = new LassoValue();
	 105 	 LassoTypeRef  out = new LassoTypeRef();
	 106 	 int err = lasso.getTagName(tag);	
	 107 	 if  (err != ERR_NOERR || tag.data().length() < 1)
	 108 		  return LassoErrors.InvalidParameter;
	 109 	 if  (tag.data().equalsIgnoreCase("file"))
	 110 		  return lasso.outputTagData(zip.getName());
	 111 	 else if  (tag.data().equalsIgnoreCase("size") || 
	 112 			     tag.data().equalsIgnoreCase("count"))
	 113 	 {
	 114 		  lasso.typeAllocInteger(out, zip.size());
	 115 		  return lasso.returnTagValue(out);
	 116 	 }	
	 117 	 LassoValue param = new LassoValue();		
	 118 	 ZipEntry item = this.entry;	
	 119 	 if  (lasso.getTagParam(0, param) == ERR_NOERR)
	 120 	 {
	 121 		  if  (param.type() == LassoValue.TYPE_INT)
	 122 		  {
	 123 			   try {  
	 124 				    int idx = Integer.parseInt(param.name());
	 125 				    if  (idx < 1 || idx > zip.size())
	 126 				    {
	 127 					     lasso.setResultMessage("[Zip] index out of  range: " + idx);
	 128 					     return LassoErrors.InvalidParameter;
	 129 				    }
	 130 				    else if  (idx != index)
	 131 				    {
	 132 					     index = idx;
	 133 					     Enumeration enum2 = zip.entries(); 
	 134 					     while (enum2.hasMoreElements() && idx-- > 0)
	 135 						      item = (ZipEntry)enum2.nextElement();
	 136 					     entry = item;
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	 137 				    }
	 138 			   } catch (NumberFormatException npe) {}
	 139 		  }
	 140 		  else if  (param.type() == LassoValue.TYPE_CHAR)
	 141 			   item = zip.getEntry(param.name());
	 142 	 }
	 143 	 String result = null;	
	 144 	 if  (tag.data().equalsIgnoreCase("name") || 
	 145 		   tag.data().equalsIgnoreCase("get"))
	 146 		  result = item.getName();
	 147 	 else if  (tag.data().equalsIgnoreCase("comment"))
	 148 		  result = item.getComment();
	 149 	 else if  (tag.data().equalsIgnoreCase("crc"))
	 150 		  result = Long.toHexString(item.getCrc());
	 151 	 else if  (tag.data().equalsIgnoreCase("method"))
	 152 		  result = (item.getMethod() == ZipEntry.DEFLATED ? "DEFLATED" : "STORED");
	 153 	 if  (result != null)
	 154 		  return lasso.outputTagData(result);	
	 155 	 if  (tag.data().equalsIgnoreCase("usize"))
	 156 		  lasso.typeAllocInteger(out, item.getSize());
	 157 	 else if  (tag.data().equalsIgnoreCase("csize"))
	 158 		  lasso.typeAllocInteger(out, item.getCompressedSize());
	 159 	 else if  (tag.data().equalsIgnoreCase("date"))
	 160 		  lasso.typeAllocString(out, df.format(new Date(item.getTime())));
	 161 	 else if  (tag.data().equalsIgnoreCase("isDir"))
	 162 		  lasso.typeAllocBoolean(out, entry.isDirectory());
	 163 	 else if  (tag.data().equalsIgnoreCase("position"))
	 164 		  lasso.typeAllocInteger(out, index);
	 165 	 else if  (tag.data().equalsIgnoreCase("enumerate"))
	 166 	 {
	 167 		  enum = zip.entries();
	 168 		  index = 0;
	 169 	 }
	 170 	 else if  (tag.data().equalsIgnoreCase("getdata"))
	 171 	 {	
	 172 		  int max = 0, skip = 0;
	 173 		
	 174 		  if  (lasso.findTagParam("-skip", param) == ERR_NOERR)
	 175 			   skip = Integer.parseInt(param.data());
	 176 		  if  (lasso.findTagParam("-max", param) == ERR_NOERR)
	 177 			   max = Integer.parseInt(param.data());		
	 178 		  int count = 0;
	 179 		  int toRead = 1024;		
	 180 		  if  (max == 0 || max > item.getSize())
	 181 			   max = (int)item.getSize() - skip;
	 182 		  else if  (max < 1024)
	 183 			   toRead = max;		
	 184 		  try {			 
	 185 			   InputStream is = zip.getInputStream(item);
	 186 			   is.skip(skip);
	 187 			   byte b[] = new byte[toRead];
	 188 			   while ((count=is.read(b, 0, toRead)) > -1 && max > 0)
	 189 			   {
	 190 				    max -= count;
	 191 				    if  (count > 0)
	 192 					     lasso.outputTagData(new String(b, 0, count));
	 193 			   }
	 194 			   is.close();
	 195 		  } catch (IOException ioe) {}
	 196 	 }
	 197 	 else if  (tag.data().equalsIgnoreCase("next"))
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	 198 	 {
	 199 		  boolean reset = (enum == null);			 
	 200 		  if  (enum != null && !enum.hasMoreElements())
	 201 			   enum = null;
	 202 		  else if  (reset)
	 203 			   enum = zip.entries();			 
	 204 		  boolean hasMore = (enum != null && enum.hasMoreElements());		
	 205 		  lasso.typeAllocBoolean(out, hasMore);		
	 206 		  if  (hasMore)
	 207 		  {
	 208 			   entry = (ZipEntry)enum.nextElement();
	 209 			   if  (reset)
	 210 				    index = 1;
	 211 			   else
	 212 				    index++;
	 213 		  }
	 214 	 }			 
	 215 	 if  (!out.isNull())
	 216 		  return lasso.returnTagValue(out);	
	 217 	 return err;
	 218	 }

Custom Data Type Module Walk-Through
This section provides a step-by-step walk-through for building the custom type tag module.

To write a sample LJAPI tag module:

	 1	First, import com.omnipilot.lassopro.* classes as shown in line 1.

	 1	 import com.omnipilot.lassopro.*;
	 2	 import java.util.*;
	 3	 import java.util.zip.*;
	 4	 import java.io.*;
	 5	 import java.text.DateFormat;

	 2	Define the class to be a subclass of the com.omnipilot.lassopro.LassoTagModule class.

	 6	 public class ZipType extends LassoTagModule

	 3	Store the names of member tags implemented by our custom type in a String array variable.

	 10 	 static final String[] members = {
	 11 		  "File","Size","Count","Enumerate","Position","Next",
	 12 		  "GetData","Get","Name","Comment","Date","Crc",
	 13 		  "Method", "Extra", "CSize", "USize", "IsDir" };

	 4	Register the custom type initializer method, passing FLAG_INITIALIZER flag in the fourth parameter of 
the registerLassoModule method.

	 18 	 public void registerLassoModule()
	 19 	 {
	 20 		  registerTagModule("ZipType", "zip", "format", 
	 21 				    FLAG_SUBSTITUTION | FLAG_INITIALIZER, "zip custom type tag");
	 22 	 }

	 5	Define main tag formatting method with the same name as specified in the third parameter of previously 
called registerTagModule method.

	 23 	 public int format(LassoCall lasso, int action)

	 6	Examine parameters passed to our type initializer and create new instance of a java.util.zip.ZipFile object, using 
resolved file path name.

	 40 	 String filePath = lasso.fullyQualifyPath(param.name());
	 41 	 filePath = lasso.resolvePath(filePath);
	 42 	 filePath = lasso.getPlatformSpecificPath(filePath);
	 43 	 this.zip = new ZipFile(filePath);
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	 7	 Create a new com.omnipilot.lassopro.LassoTypeRef  variable to store a reference to the custom type, 
which is about to be created in the next step.

	 44 	 LassoTypeRef  self  = new LassoTypeRef();

	 8	Allocate new custom type instance, passing the LassoTypeRef variable and the type name to 
LassoCall.typeAllocCustom method.

	 45 	 if  ((err = lasso.typeAllocCustom(self, "zip")) != ERR_NOERR)
	 46 	 {
	 47 		  lasso.setResultMessage("[Zip] couldn't create new zip type instance.");
	 48 		  return err;
	 49 	 }

	 9	Add member tags to the newly-allocated custom type. In our example, all member tags will be handled by 
the same Java method; however, LJAPI allows each member tag to have its own formatting method.

	 52 	 for (int i = 0; i < this.members.length; i++)
	 53 	 {
	 54 		  if  ((err=lasso.typeAllocTag(ref, className, "memberFunc")) != ERR_NOERR ||
	 55 			    (err=lasso.typeAddMember(self, members[i], ref)) != ERR_NOERR)
	 56 		  {
	 57 			   lasso.setResultMessage("[Zip] error adding member: " + members[i]);
	 58 			   return err;
	 59 		  }
	 60 	 }

Note that adding the member tags to a custom type is a two-step process. First, an unnamed tag object is 
created and placed in a LassoTypeRef variable. In order to be successful, the second and third parameters in 
the LassoCall.typeAllocTag method must specify a valid class and method names used by Lasso for locating a 
formatting method in a Java class. Member tag methods have the same signature as a type initializer and 
regular substitution tag methods, and although not required they are most likely to be implemented in the 
same class with the main type initializer method. 

Secondly, LassoCall.typeAddMember is used to add a reference to a newly-created tag (third parameter) to a 
custom type (first parameter), with the second parameter being a tag name.

	 10	Add all necessary callback methods, such as onConvert and onDestroy.

	 61 	 if  (lasso.typeAllocTag(ref, className, "convertFunc") == ERR_NOERR)
	 62 		  lasso.typeAddMember(self, "onConvert", ref);
	 63 	 if  (lasso.typeAllocTag(ref, className, "destroyFunc") == ERR_NOERR)
	 64 		  lasso.typeAddMember(self, "onDestroy", ref);

Callback methods are being triggered by the events that happen to a custom type in the course of its life. 
For example, when a type goes out of scope, its onDestroy tag method is called. When a custom type needs 
to be converted to a different data type such as string or integer, its onConvert method is invoked.

Callbacks are added to the custom types in a similar fashion as the other members, with only constraint 
being their tag names, which must conform to established convention for naming callback tags. For a full 
list of intrinsic member tag names, see the Lasso 7 Language Guide.

	 11	Attach this module instance to a custom type. 
	 65 	 if  ((err = lasso.typeSetCustomJavaObject(self, this)) != ERR_NOERR)
	 66 	 {
	 67 		  lasso.setResultMessage("[Zip] couldn't attach java object to a custom type");
	 68 		  return err;
	 69 	 }

LassoCall.typeSetCustomJavaObject can be used to associate any private data with an instance of a custom 
type. Any Java object can be attached to a custom type and later retrieved with a call to a complimentary 
LassoCall.typeGetCustomJavaObject method. In the situation were associated object is an instance of 
the LassoTagModule subclass, Lasso will also try to invoke formatting methods on this object instead 
of creating a new instance (as it does for all substitution tag modules). Aside from producing much 
smaller overhead, this allows direct access to all instance (e.g. private) variables from any Java method 
implemented in that module. 

	 12	Finally, return newly-generated custom type tag instance back to Lasso.
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	 70 	 err = lasso.returnTagValue(self);

	 13	Implement formatting methods for onDestroy and onConvert callbacks.

	 81 	 public int destroyFunc(LassoCall lasso, int action)
	 82 	 {
	 83 		  if  (zip != null)
	 84 		  {
	 85 			   try { zip.close(); }
	 86 				    catch (IOException e) {}
	 87 			   zip = null;
	 88 		  }
	 89 		  return ERR_NOERR;
	 90 	 }

	 14	In the case of onConvert callback, the first parameter passed to our method is the name of the type to which 
our custom Zip type should be converted to. If the desired type is a string, return the human-readable 
representation of the type, which consists of a type name and a zip file path name.

	 91 	 public int convertFunc(LassoCall lasso, int action)
	 92 	 {
	 93 		  LassoValue param = new LassoValue();
	 94 		  if  (lasso.getTagParam(0, param) == ERR_NOERR && 
	 95 			   param.name().equalsIgnoreCase("string"))
	 96 		  {
	 97 			   lasso.outputTagData("zip:(" + this.zip.getName() + ")");
	 98 		  }
	 99 
	 100 	 return ERR_NOERR;
	 101	 }

	 15	Define our main member tag method memberFunc, that will take care of formatting over a dozen member 
tags. If tag name is File, return the full path name to the zip file.

	 109	  if  (tag.data().equalsIgnoreCase("File"))
	 110 	 return lasso.outputTagData(zip.getName());

	 16	If the member tag name is Count or Size, return an integer Zip entry count value.

	 111	  else if  (tag.data().equalsIgnoreCase("size") || 
	 112 		    tag.data().equalsIgnoreCase("count"))
	 113	  {
	 114 	 lasso.typeAllocInteger(out, zip.size());
	 115 	 return lasso.returnTagValue(out);
	 116	  }

	 17	Tags that output plain text can be processed first.

	 143 	  String result = null;
	 144	  if  (tag.data().equalsIgnoreCase("name") || 
	 145 	 tag.data().equalsIgnoreCase("get"))
	 146 	 result = item.getName();
	 147	  else if  (tag.data().equalsIgnoreCase("comment"))
	 148 	 result = item.getComment();
	 149	  else if  (tag.data().equalsIgnoreCase("crc"))
	 150 	 result = Long.toHexString(item.getCrc());
	 151	  else if  (tag.data().equalsIgnoreCase("method"))
	 152 	 result = (item.getMethod() == ZipEntry.DEFLATED ? "DEFLATED" : "STORED");
	 153	  if  (result != null)
	 154 	 return lasso.outputTagData(result);

	 18	Tags that return data types, such as integers or booleans, should allocate corresponding values using various 
LassoCall.typeAlloc… methods before passing them back to Lasso.

	 155	  if  (tag.data().equalsIgnoreCase("usize"))
	 156 	 lasso.typeAllocInteger(out, item.getSize());
	 157	  else if  (tag.data().equalsIgnoreCase("csize"))
	 158 	 lasso.typeAllocInteger(out, item.getCompressedSize());
	 159	  else if  (tag.data().equalsIgnoreCase("date"))
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	 160 	 lasso.typeAllocString(out, df.format(new Date(item.getTime())));
	 161	  else if  (tag.data().equalsIgnoreCase("isDir"))
	 162 	 lasso.typeAllocBoolean(out, entry.isDirectory());
	 163	  else if  (tag.data().equalsIgnoreCase("position"))
	 164 	 lasso.typeAllocInteger(out, index);

	 19	The Enumerate member restarts a previously used enumeration. Unless it is called in a middle of iterating 
through the Zip entries, this tag has the same effect as calling Next for the very first time, or immediately 
after advancing past the very last enumerated item in a Zip file.

	 165	  else if  (tag.data().equalsIgnoreCase("enumerate"))
	 166	  {
	 167 	 enum = zip.entries();
	 168 	 index = 0;
	 169	  }

	 20	The GetData member tag reads uncompressed data from one of the zipped items. This tag accepts two 
optional parameters, -Skip and -Max, which are used to specify starting offset and maximum number of 
bytes to be read from the Zip archive entry. 

	 170	  else if  (tag.data().equalsIgnoreCase("getdata"))
	 171	  {
	 172 	 int max = 0;
	 173 	 int skip = 0;
	 174 	 if  (lasso.findTagParam("-skip", param) == ERR_NOERR)
	 175 		  skip = Integer.parseInt(param.data());
	 176 	 if  (lasso.findTagParam("-max", param) == ERR_NOERR)
	 177 		  max = Integer.parseInt(param.data());
	 178 	 int count = 0;
	 179 	 int toRead = 1024;
	 180 	 if  (max == 0 || max > item.getSize())
	 181 		  max = (int)item.getSize() - skip;
	 182 	 else if  (max < 1024)
	 183 		  toRead = max;
	 184 	 try {
	 185 		  InputStream is = zip.getInputStream(item);
	 186 		  is.skip(skip);
	 187 		  byte b[] = new byte[toRead];
	 188 		  while ((count=is.read(b, 0, toRead)) > -1 && max > 0)
	 189 		  {
	 190 			   max -= count;
	 191 			   if  (count > 0)
	 192 				    lasso.outputTagData(new String(b, 0, count));
	 193 		  }
	 194 		  is.close();
	 195 	 } catch (IOException ioe) {}
	 196	  }

	 21	The last member tag Next iterates through Zip archive entries, placing the internally maintained pointer 
at the next selected item. This tag provides fast sequential access to items stored in the Zip archive, and 
should be used in concert with various accessor tags implemented in this module. When the end of the file 
is reached and no more items are available, the tag returns False and restarts the iteration, positioning the 
internal pointer immediately before the first Zip item. 

	 197	  else if  (tag.data().equalsIgnoreCase("next"))
	 198	  {
	 199 	 boolean reset = (enum == null);
	 200 	 if  (enum != null && !enum.hasMoreElements())
	 201 		  enum = null;
	 202 	 else if  (reset)
	 203 		  enum = zip.entries();
	 204 	 boolean hasMore = (enum != null && enum.hasMoreElements());
	 205 	 lasso.typeAllocBoolean(out, hasMore);
	 206 	 if  (hasMore)
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	 207 	 {
	 208 		  entry = (ZipEntry)enum.nextElement();
	 209 		  if  (reset)
	 210 			   index = 1;
	 211 		  else
	 212 			   index++;
	 213 	 }
	 214	  }

	 22	Finally, if any of the previous operations produced a valid result, pass the resulting value back to Lasso, 
returning an ERR_NOERR error code to flag a successful member tag execution.

	 215	  if  (!out.isNull())
	 216 	 return lasso.returnTagValue(out);
	 217	  return err;
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Chapter 68

LJAPI Data Sources

This chapter includes information about creating data source connectors in Java using the Lasso Java API 
(LJAPI).

	 •	Data Source Connector Operation discusses the theory of creating data source connectors in Java.

	 •	Data Source Connector Tutorial walks through a sample project that ships with every installtion of Lasso 
Professional.

Data Source Connector Operation
When Lasso Professional 8 starts up, it looks for module files (Windows DLLs or Mac OS X DYLIBS) in the 
LassoModules folder. As Lasso encounters each module, it executes the module’s registerLassoModule() function 
once and only once. It is the job of the LJAPI developer to write code to register each new data source (or 
custom tag) methods in this registerLassoModule() function. Both substitution tags and data sources may 
be registered at the same time, and the code for them can reside in the same module. The only difference 
between registering a data source and a substitution tag is whether registerTagModule() or registerDSModule() is 
called.

Data sources are typically more complex than substitution tags because Lasso Service calls them with many 
different actions during the course of various database operations. Whereas a substitution tag only needs 
to know how to format itself, a data source needs to enumerate its tables, search through records, add new 
records, delete records, and more. Even so, this added complexity is easily handled with a single switch() 
statement, as you will see in the Data Source Connector Tutorial section of this chapter.

Data Source Connectors and Lasso Administration
Once a custom data source connector module is registered by Lasso, it will appear in the Setup > Data 
Sources > Connectors section of Lasso Site Administration. If a connector appears here, then it has been 
installed correctly.

The administrator adds the data source connection information to the Setup > Data Sources > Hosts 
section of Lasso Site Administration, which sets the parameters by which Lasso connects to the data source 
via the connector. This information is stored in the Lasso_Internal Lasso MySQL database, where the connector 
can retrieve and use the data via function calls.

The data that the administrator can submit in the Setup > Data Sources > Hosts section of Lasso Site 
Administration includes the following:

	 •	Name – The administrator-defined name of the data source host.

	 •	Connection URL – The URL string required for Lasso to connect to a data source via the connector. This 
typically includes the IP address of the machine hosting the data source.

	 •	Connection Parameters – Additional parameters passed with the Connection URL. This can include the 
TCP/IP port number of the data source.
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	 •	Status – Allows the administrator to enable or disable the connector in Lasso Professional 8.

	 •	Default Username – The data source username required for Lasso to gain access to the data source.

	 •	Default Password – The data source password required for Lasso to gain access to the data source.

The Connection URL, Connection Parameters, Default Username, and Default Password values are passed to the data 
source via data source function methods in the com.omnipilot.lassopro.LassoCall class, which are described in the 
LJAPI Class Reference section of chapter.

Data Source Connector Tutorial
The following section provides a walk-through of an example data source to show how some of the LJAPI 
features are used. This code will be most similar to the sample NNTPDataSource project, which is provided with 
Lasso Professional 8 in the following folder.

Lasso Professional 8/Documentation/3 - Lasso Langage Guide/exammples/LJAPI/ 
DataSourceConnectors/Nntp_ds

The example data source connector bridges a news (NNTP) server and Lasso Professional 8. Network News 
Transfer Protocol (NNTP) is used to read and post articles on Usenet news servers. This specific example has 
been tested with the Microsoft NNTP Service 5.0, and it provides a good start for any developer desiring to 
build a data source connector module supporting a large variety of other NNTP servers.

While an NNTP server is not exactly an RDBMS, there are some advantages to implementing the NNTP 
client as a data source connector. The hierarchy of a news storage is somewhat similar to that of a traditional 
RDBMS. News articles (rows) are organized in groups (tables), which in turn are parts of distributions 
(databases). However, due to a sheer number of news groups available on an average news server (2000-
50000+), treating groups as database tables would put a big load on the internal Lasso security mechanism, 
which is required to keep track of permissions for every registered database table. Therefore, the hierarchy has 
been adopted to minimize the stress put on Lasso security. 

The NNTP connector adds a single News database containing two static tables: Groups and Articles. Performing 
a search on the Group table returns a list of groups available on the server. Similarly, executing a query on the 
Articles table retrieves a range of articles from a specific newsgroup.

Updating groups or articles is not supported by the NNTP protocol, so only search and insert data source 
actions are implemented by this connector. SQL actions are also not supported, although it is possible to 
build a simple parser for translating SQL statements into commands understood by NNTP servers. 

Data Source Connector Code
Below is the code for the data source module. Line numbers are provided to the left of each line of code, and 
are referenced in the Data Source Connector Walk-Through section.

Data Source Connector Code

	 1	 import com.omnipilot.lassopro.*;
	 2	 import java.net.*;
	 3	 import java.io.*;
	 4	 import java.util.*;
	 5	 public class NNTP_DS extends LassoDSModule
	 6	 {
	 7 	 Socket sock;
	 8 	 PrintStream printer;
	 9 	 BufferedReader reader;
	 10 	 String host = null;
	 11 	 int port = 0;
	 12 	 String user = null, pass = null;
	 13 	 String hostInfo = "";
	 14 	 Vector headers = new Vector(10);	
	 15 	 int refsIdx = -1;
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	 16 	 int xrefIdx = -1;
	 17 	 int bytesIdx = -1;
	 18 	 boolean useXpat = false;
	 19 	 String groupFilter = "";
	 20 	 String group = "";
	 21 	 String article = "";
	 22 	 int groupCount = -1;
	 23 	 int articleCount = -1;
	 24 	
	 25 	 public void registerLassoModule () {	
	 26 		  registerDSModule("NNTP", "dsFunc", 0, "Lasso Connector for NNTP", 
				    "Simple Usenet client");
	 27 	 }
	 28 	 public int dsFunc (LassoCall lasso, int cmd, LassoValue value) {
	 29 		  int err = ERR_NOERR;
	 30 		  switch (cmd) {
	 31 			   case ACTION_INIT:
	 32 				    err = doInit(lasso);
	 33 				    break;	
	 34 			   case ACTION_TERM:
	 35 				    err = doTerm(lasso);
	 36 				    break;	
	 37 			   case ACTION_EXISTS:
	 38 				    if  (!value.data().equalsIgnoreCase("News"))
	 39 					     err = LassoErrors.WebNoSuchObject;
	 40 				    break;					   
	 41 			   case ACTION_DB_NAMES:
	 42 				    err = doDBNames(lasso);
	 43 				    break;	
	 44 			   case ACTION_TABLE_NAMES:
	 45 				    err = doTableNames(lasso, value.data());
	 46 				    break;			 
	 47 			   case ACTION_INFO:
	 48 				    err = doInfo(lasso, true);
	 49 				    break;
	 50 			   case ACTION_SEARCH:
	 51 				    err = doSearch(lasso);
	 52 				    break;
	 53 		  }
	 54 		  return err;
	 55 	 }	
	 56 	 int doInit(LassoCall lasso) {
	 57 		  return ERR_NOERR;
	 58 	 }
	 59 	 int doTerm(LassoCall lasso) {
	 60 		  close();			 
	 61 		  return ERR_NOERR;
	 62 	 }
	 63 	 int doDBNames(LassoCall lasso) {
	 64 		  return lasso.addDataSourceResult("News");
	 65 	 }
	 66 	 int doTableNames(LassoCall lasso, String db) {	
	 67 		  if  (!db.equalsIgnoreCase("News"))
	 68 			   return -1;
	 69 		  lasso.addDataSourceResult("Groups");
	 70 		  lasso.addDataSourceResult("Articles");		
	 71 		  return ERR_NOERR;
	 72 	 }
	 73 	 int doInfo(LassoCall lasso, boolean listAllCols) {
	 74 		  int err = ERR_NOERR;
	 75 		  LassoValue tbl = new LassoValue();
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	 76 		  err = lasso.getTableName(tbl);
	 77 		  if  (err != ERR_NOERR || tbl.data().length() == 0)
	 78 			   return LassoErrors.InvalidParameter;
	 79	       if  (!connect(lasso))
	 80 			   return LassoErrors.Network;
	 81 		  if  (tbl.data().equalsIgnoreCase("Groups")) {
	 82 			   lasso.addColumnInfo("Group", 0, 
						      LassoValue.TYPE_CHAR, PROTECTION_READ_ONLY);
	 83 			   lasso.addColumnInfo("Last", 0, 
						      LassoValue.TYPE_INT, PROTECTION_READ_ONLY);
	 84 			   lasso.addColumnInfo("First", 0, 
						      LassoValue.TYPE_INT, PROTECTION_READ_ONLY);
	 85 			   lasso.addColumnInfo("AllowPost", 0, 
						      LassoValue.TYPE_CHAR, PROTECTION_READ_ONLY);	
	 86 		  } else if  (tbl.data().equalsIgnoreCase("Articles")) {		
	 87 			   if  (!this.headers.isEmpty()) {	
	 88 				    String str;
	 89 				    int type, count = headers.size();
	 90 				    lasso.addColumnInfo("Number", 0, 
						      LassoValue.TYPE_INT, PROTECTION_READ_ONLY);
	 91 				    for (int i = 0; i < count; ++i) {
	 92 					     str = (String)this.headers.elementAt(i);
	 93 					     if  (str.equalsIgnoreCase("Lines") || 
							       str.equalsIgnoreCase("Bytes"))
	 94 						      type = LassoValue.TYPE_INT;
	 95 					     else if  (str.equalsIgnoreCase("Date"))
	 96 						      type = LassoValue.TYPE_DATETIME;
	 97 					     else
	 98 						      type = LassoValue.TYPE_CHAR;
	 99 					     err = lasso.addColumnInfo((String)headers.elementAt(i), 0, 
								        type, PROTECTION_READ_ONLY);		
	 100 				    }	
	 101 				    if  (listAllCols) {
	 102 					     lasso.addColumnInfo("Headers", 0, 
								        LassoValue.TYPE_CHAR, PROTECTION_READ_ONLY);
	 103 					     lasso.addColumnInfo("Body", 0, 
								        LassoValue.TYPE_CHAR, PROTECTION_READ_ONLY);
	 104 				    }
	 105 			   }
	 106 		  }
	 107 		  return err;
	 108 	 }
	 109 	 int doSearch(LassoCall lasso) {
	 110 		  int err = ERR_NOERR;
	 111 		  int skip = 0;
	 112 		  int max = 50;
	 113 		  int totalcount = 0;
	 114 		  String filter = "", reply = "";
	 115 		  LassoValue tbl = new LassoValue();
	 116 		  LassoValue val = new LassoValue();
	 117 		  IntValue ival = new IntValue();	
	 118 		  if  (lasso.getSkipRows(ival) == ERR_NOERR)
	 119 			   skip = ival.intValue();
	 120 		  if  (lasso.getMaxRows(ival) == ERR_NOERR)
	 121 			   max = ival.intValue();	
	 122 		  lasso.getTableName(tbl);
	 123 		  lasso.getInputColumnCount(ival);	
	 124 		  if  (!connect(lasso))
	 125 			   return LassoErrors.Network;
	 126 		  if  ((err = doInfo(lasso, max == 1)) != ERR_NOERR)
	 127 			   return err;
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	 128 		  try {			 
	 129 			   if  (tbl.data().equalsIgnoreCase("GROUPS")) {			 
	 130 				    if  (lasso.findInputColumn("group", val) == ERR_NOERR) {
	 131 					     if  (val.type() == LassoOperators.OP_ENDS_WITH)
	 132 						      filter = '*' + val.data();
	 133 					     else if  (val.type() == LassoOperators.OP_CONTAINS)
	 134 						      filter = '*' + val.data() + '*';
	 135 					     else if  (val.type() == LassoOperators.OP_EQUALS)
	 136 						      filter = val.data();
	 137 					     else
	 138 						      filter = val.data() + '*';
	 139 				    }
	 140 				    this.printer.print("LIST ACTIVE " + filter + "\r\n");	
	 141 				    reply=reader.readLine();
	 142 				    if  (!reply.startsWith("2"))
	 143 					     return setError(lasso, reply);
	 144 				    if  (!this.groupFilter.equalsIgnoreCase(filter)) {	
	 145 					     this.groupFilter = filter;
	 146 					     this.groupCount = -1;
	 147 				    }
	 148 				    err = addGroups(lasso, skip, max);	
	 149 			   } else if  (tbl.data().equalsIgnoreCase("ARTICLES")) {
	 150 				    if  (lasso.findInputColumn("-group", val) == ERR_NOERR ||
	 151 					     lasso.findInputColumn("group", val) == ERR_NOERR) {
	 152 					     if  (val.data().length() > 0) {
	 153 						      if  (!val.data().equalsIgnoreCase(this.group))
	 154 							       this.articleCount = -1;
	 155 						      this.group = val.data();
	 156 					     }
	 157 				    }
	 158 				    if  (this.group == null || this.group.length() < 1) {
	 159 					     lasso.setResultMessage("Missing group parameter.");
	 160 					     return LassoErrors.InvalidParameter;
	 161 				    }
	 162 				    String id = null;
	 163 				    ival.setInt(0);
	 164 				    if  (lasso.getRowID(ival) == ERR_NOERR && ival.intValue() != -1)
	 165 					     id = Integer.toString(ival.intValue());
	 166 				    else if  (lasso.getPrimaryKeyColumn(val) == ERR_NOERR &&
	 167 						       (val.name().equalsIgnoreCase("message-id") || 
	 168 						        val.name().equalsIgnoreCase("number"))) 
	 169 					     filter = val.data();
	 170 				    else if  (lasso.findInputColumn("message-id", val) == ERR_NOERR || 
	 171 						        lasso.findInputColumn("number", val) == ERR_NOERR) 
	 172 					     filter = val.data();
	 173 				    if  (this.articleCount == -1) {
	 174 					     err = selectGroup(lasso);
	 175 					     if  (err != ERR_NOERR)
	 176 						      return err;
	 177 				    }	
	 178 				    if  (max == 1 && (filter == null || filter.length() < 1))
	 179 					     id = getRange(lasso, skip, 1);
	 180 				    if  (filter.startsWith("<") || filter.indexOf('-') == -1)
	 181 					     id = filter;
	 182 				    if  (id != null && id.length() > 1) { // detail
	 183 					     this.printer.print("ARTICLE " + id + "\r\n");
	 184 					     reply=reader.readLine();
	 185 					     if  (!reply.startsWith("2"))
	 186 						      return setError(lasso, reply);
	 187 					     int idx=0, i=0, bytes=0;
	 188 					     String str;
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	 189 					     String[] data = new String[headers.size()+3];
	 190 					     data[0] = reply.substring(4, reply.indexOf(' ', 4));
	 191 					     data[data.length-1] = ""; // body
	 192 					     data[data.length-2] = ""; // headers
	 193 					     while(!(reply=reader.readLine()).startsWith(".")) {	
	 194 						      bytes += reply.length() + 2;
	 195 						      i = reply.indexOf(": ");
	 196 						      if  (i != -1) { // header
	 197 							       str = reply.substring(0,i);
	 198 							       idx = this.headers.indexOf(str);
	 199 							       if  (idx != -1) // known header
	 200 								        data[idx+1] = reply.substring(i+2);
	 201 							       else
	 202 								        data[data.length-2] += reply + '\r';
	 203 						      } else { // body
	 204 							       StringBuffer buf  = new StringBuffer();
	 205 							       while (!(reply=reader.readLine()).startsWith(".")) {
	 206 								        bytes += reply.length() + 2;
	 207 								        buf.append(reply).append('\r');
	 208 							       }
	 209 							       data[data.length-1] = buf.toString();
	 210 							       data[this.bytesIdx] = Integer.toString(bytes + 2);
	 211 							       break;
	 212 						      }
	 213 					     }
	 214 					     if  (data[0].equals("0") && this.refsIdx != -1) {
	 215 						      idx = data[this.xrefIdx].lastIndexOf(group);
	 216 						      if  (idx != -1) {
	 217 							       str = data[this.xrefIdx].substring(idx + group.length() + 1);
	 218 							       if  ((idx=str.indexOf(' ')) != -1)
	 219 								        str = str.substring(0, idx);
	 220 							       data[0] = str;
	 221 						      }
	 222 					     }
	 223 					     err = lasso.addResultRow(data);
	 224 				    } else { // GET LIST
	 225 					     if  (filter == null || filter.length() == 0)
	 226 						      filter = getRange(lasso, skip, max);
	 227 					     this.printer.print("XOVER " + filter + "\r\n");
	 228 					     reply=reader.readLine();
	 229 					     if  (!reply.startsWith("2"))
	 230 						      return setError(lasso, reply);
	 231 					     while(err == ERR_NOERR && !(reply=reader.readLine()).startsWith("."))
	 232 						      err = lasso.addResultRow(split(reply, "\t"));
	 233 				    }						    
	 234 				    lasso.setNumRowsFound(this.articleCount);
	 235 			   }	
	 236 		  } catch (Exception e) {
	 237 			   System.err.println(e.toString());
	 238 			   lasso.setResultMessage(e.getMessage());
	 239 			   err = LassoErrors.Network;
	 240 			   try { this.sock.close(); } 
	 241 				    catch (Exception e2) {}
	 242 			   this.sock = null;
	 243 		  }
	 244 		  return err;
	 245 	 }
	 246 	 int setError(LassoCall lasso, String reply) {
	 247 		  int err = -1;
	 248 		  try { 
	 249 			   err = Integer.parseInt(reply.substring(0, 3));
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	 250 			   lasso.setResultMessage(reply.substring(4));
	 251 		  } catch (Exception e) {};
	 252 		  lasso.setResultCode(err);
	 253 		  return err;
	 254 	 }
	 255 	 String[] split (String str, String ch) {
	 256 		  int i = 0;
	 257 		  int numcols = headers.size() + 1;
	 258 		  String cols[] = new String[ numcols ];
	 259 		  StringTokenizer tok = new StringTokenizer(str, ch);
	 260 		  int count = tok.countTokens();
	 261 		  while (tok.hasMoreTokens()) {
	 262 			   if  (i == this.refsIdx && numcols > count)
	 263 				    cols[i++] = ""; // empty References field
	 264 			   cols[i++] = tok.nextToken();
	 265 		  }	
	 266 		  return cols;
	 267 	 }
	 268 	 boolean connect(LassoCall lasso) {
	 269 		  if  (getHostInfo(lasso) != ERR_NOERR)
	 270 			   return false;
	 271 		  try 
	 272 		  {
	 273 			   String reply;
	 274 			   if  (this.sock != null) {
	 275 				    this.printer.print("MODE READER\r\n"); // probe the connnection
	 276 				    reply = reader.readLine();
	 277 				    if  (!reply.startsWith("2")) {
	 278 					     this.sock.close();
	 279 					     this.sock = null;
	 280 				    }
	 281 			   }
	 282 			   if  (this.sock == null) {
	 283 				    this.sock=new Socket(this.host,this.port);
	 284 				    this.reader=new BufferedReader(new InputStreamReader(this.sock.getInputStream()), 2500);
	 285 				    this.printer=new PrintStream(new BufferedOutputStream(this.sock.getOutputStream(),2500),true);
	 286 				    this.hostInfo = this.reader.readLine();
	 287 				    login();
	 288 				    this.printer.print("MODE READER\r\n");
	 289 				    reader.readLine();
	 290 				    if  (this.headers.isEmpty()) {
	 291 					     printer.print("LIST OVERVIEW.FMT\r\n");
	 292 					     reply = reader.readLine();
	 293 					     if  (reply.startsWith("2")) {	
	 294 						      int idx, i = 1;
	 295 						      while(!(reply=reader.readLine()).startsWith(".")) {
	 296 							       idx = reply.indexOf(':');
	 297 							       if  (idx != -1)
	 298 								        reply = reply.substring(0, idx);
	 299 							       this.headers.addElement(reply);
	 300 							       if  (reply.equalsIgnoreCase("References"))
	 301 								        this.refsIdx = i;
	 302 							       else if  (reply.equalsIgnoreCase("Bytes"))
	 303 								        this.bytesIdx = i;
	 304 							       else if  (reply.equalsIgnoreCase("Xref"))
	 305 								        this.xrefIdx = i;
	 306 							       ++i;
	 307 						      }
	 308 					     }	
	 309 				    }
	 310 			   }
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	 311 		  } catch (Exception e) {
	 312 			   lasso.setResultMessage(e.getMessage());
	 313 			   this.sock = null;
	 314 			   return false;
	 315 		  }
	 316 		  return true;
	 317 	 }
	 318 	 void close() {
	 319 		  this.host = null;
	 320 		  this.headers.clear();
	 321 		  this.groupCount = this.articleCount = -1;
	 322 		  this.refsIdx = this.xrefIdx = this.bytesIdx = -1;
	 323 		  try
	 324 		  {
	 325 			   this.printer.print("QUIT\r\n");
	 326 			   this.reader.close();
	 327 			   this.printer.close();
	 328 			   this.sock.close();
	 329 			   this.sock = null;
	 330 		  } catch (Exception e) {}
	 331 	 }
	 332 	 boolean login()
	 333 	 {
	 334 		  if  (user != null && user.length() > 0) {
	 335 			   try
	 336 			   {
	 337 				    this.printer.print("AUTHINFO USER " + this.user + "\r\n");
	 338 				    this.printer.print("AUTHINFO PASS " + this.pass + "\r\n");
	 339 				    return (reply.startsWith("281"));
	 340 			   } catch (Exception e) {}
	 341 		  }
	 342 		  return false;
	 343 	 }
	 344 	 int getHostInfo(LassoCall lasso) {
	 345 		  int err = ERR_NOERR;
	 346 		  LassoValue hostPort = new LassoValue();
	 347 		  LassoValue userPass = new LassoValue();
	 348 		  err = lasso.getDataHost(hostPort, userPass);
	 349 		  if  (err != ERR_NOERR || 
	 350 			    hostPort.name() == null || 
	 351 			    hostPort.name().length() == 0)
	 352 			   return err;	
	 353 		  if  (!hostPort.name().equalsIgnoreCase(this.host))
	 354 			   close();	
	 355 		  this.host = hostPort.name();
	 356 		  this.user = userPass.name();
	 357 		  this.pass = userPass.data();
	 358 		  try {
	 359 			   this.port = Integer.parseInt(hostPort.data());
	 360 		  } catch (Exception e) {}	
	 361 		
	 362 		  if  (this.port == 0)
	 363 			   this.port = 119; // default NNTP port
	 364 		  return ERR_NOERR;
	 365 	 }
	 366 	 int addGroups(LassoCall lasso, int skip, int max) {			 
	 367 		  int err = ERR_NOERR;
	 368 		  int count = 0;
	 369 		  boolean getFirst = (max == 1 || this.group == null || this.group.length() < 1);
	 370 		  String reply = "";		
	 371 		  try {
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	 372 			   while ((skip-- > 0) && !(reply=reader.readLine()).startsWith("."))
	 373 				    count++;
	 374 			   if  (!reply.startsWith(".")) {
	 375 				    String row[];
	 376 				    while (err == ERR_NOERR && !(reply=reader.readLine()).startsWith(".") && (max-- > 0)) {
	 377 					     count++;
	 378 					     row = split(reply, " ");
	 379 					     if  (getFirst) {
	 380 						      this.group = row[0];
	 381 						      err = lasso.addResultRow(row);
	 382 						      getFirst = false;
	 383 					     } else
	 384 						      err = lasso.addResultRow(row);	
	 385 				    }
	 386 				    if  (this.groupCount != -1) {
	 387 					     count = this.groupCount;
	 388 					     this.sock.close();
	 389 					     this.sock = null;
	 390 				    } else if  (!reply.startsWith(".")) {
	 391 					     while (!(reader.readLine()).startsWith("."))
	 392 						      count++;
	 393 					     this.groupCount = count;
	 394 				    }
	 395 			   }
	 396 		  } catch (Exception e) { System.err.println(e.toString()); }		
	 397 		  err = lasso.setNumRowsFound(count);
	 398 		  return err;
	 399 	 }
	 400 	 int selectGroup(LassoCall lasso) throws java.io.IOException {
	 401 		  this.printer.print("GROUP " + this.group + "\r\n"); 
	 402 		  String reply=reader.readLine();
	 403 		  if  (!reply.startsWith("2"))
	 404 			   return setError(lasso, reply);
	 405 		  else
	 406 			   return ERR_NOERR;
	 407 	 }
	 408 	 String getRange(LassoCall lasso, int skip, int max) {
	 409 		  this.printer.print("LISTGROUP " + this.group + "\r\n");
	 410 		  StringBuffer result = new StringBuffer();
	 411 		  int count = 0;
	 412 		  try {
	 413 			   String reply=reader.readLine();	
	 414 			   if  (reply.startsWith("2")) {
	 415 				    String last = "";
	 416 				    while (!(reply=reader.readLine()).startsWith(".") && (skip-- > 0))
	 417 					     count++;
	 418 				    if  (!reply.startsWith(".")) {
	 419 					     result.append(reply);
	 420 					     if  (max != 1) 
	 421 						      result.append("-");
	 422 					     while (!(reply=reader.readLine()).startsWith(".") && (--max > 0)) {
	 423 						      count++;
	 424 						      last = reply;
	 425 					     }
	 426 					     if  (this.articleCount > -1) {
	 427 						      this.printer.println("QUIT\r\n");
	 428 						      this.sock.close();
	 429 						      this.sock = null;
	 430 						      count = this.articleCount;
	 431 						      if  (connect(lasso))
	 432 							       selectGroup(lasso);
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	 433 					     } else if  (!reply.startsWith(".")) {
	 434 						      while (!(reader.readLine()).startsWith("."))
	 435 							       count++;
	 436 						      result.append(last);
	 437 						      this.articleCount = count;
	 438 					     }
	 439 				    }
	 440 			   }
	 441 		  } catch (Exception e) {} ;
	 442 		  return result.toString();
	 443 	 }
	 444	 }

Data Source Connector Walk-Through
This section provides a step-by-step walk-through for building the described data source connector.

To build a sample LJAPI Data Source Connector:

	 1	First, import com.omnipilot.lassopro.* classes as shown in line 1.

	 1	 import com.omnipilot.lassopro.*;
	 2	 import java.net.*;
	 3	 import java.io.*;
	 4	 import java.util.*;

	 2	Define your module to be a subclass of the com.omnipilot.lassopro.LassoDSModule class:

	 6	 public class NNTP_DS extends LassoDSModule {

Define the storage for global variables, which are objects used to communicate with an NNTP server, 
authentication and server info, etc.

	 7 	 Socket sock;
	 8 	 PrintStream printer;
	 9 	 BufferedReader reader;
	    …

	 3	Define the registerLassoModule method.

	 17 	 public void registerLassoModule() {

Every Lasso module must implement the registerLassoModule() method. This method will be called by Lasso 
at startup, giving your module a chance to register its data source(s). 

	 4	Define your main data source method. This function gets called with various actions as Lasso Professional 
requests information from the data source. The method name should be identical to the string passed in 
the second parameter of the registerLassoModule() method.

	 28 	 public int dsFunc (LassoCall lasso, int cmd, LassoValue value)

	 5	Dispatch the action to corresponding Java method implemented in the module. The switch statement 
distinguishes between various actions. For a complete list of action constant values, see the LassoDSModule 
class reference.

	 30 	 switch (cmd) {
	 31 		  case ACTION_INIT:
	 32 			   err = doInit(lasso);
	 33 			   break;
	 34 		  case ACTION_TERM:
	 35 			   err = doTerm(lasso);
	        		 break;

	 6	Among various actions that can be performed by a data source module the, ACTION_EXISTS command is 
sent by Lasso Professional to verify that a particular database exists on a specific host. If the name of the 
database being looked up is not known, the module must return a LassoErrors.WebNoSuchObject error:

	 37 		  case ACTION_EXISTS:
	 38 			   if  (!value.data().equalsIgnoreCase("News"))
	 39 				    err = LassoErrors.WebNoSuchObject;
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	 40 			   break;

	 7	Return the ERR_NOERR result code upon successful completion of  the task. Returning a non-zero value will cause the Lasso 
Professional engine to report a fatal error and stop processing the page.

	 54 	 return err;

	 8	After successful registration, every data source module receives the ACTION_INIT command, which gives it 
a chance to establish connection with a data source or perform any other initialization tasks. Our module 
simply returns ERR_NOERR result code:

	 56 	 int doInit(LassoCall lasso) {
	 57 		  return ERR_NOERR;
	 58 	 }

	 9	Similarly, Lasso sends the ACTION_TERM command to all registered data source modules during its 
shutdown sequence. The sample data source uses this as a signal to close the connection to a NNTP server 
and perform additional clean-up tasks:

	 59 	 int doTerm(LassoCall lasso) {
	 60 		  close();
	 61 		  return ERR_NOERR;
	 62 	 }

	 10	The ACTION_DB_NAMES command is sent whenever Lasso Professional needs to get a list of databases 
which the data source provides access to. The developer must write code that discovers all the databases the 
module knows of, and call LassoCall.addDataSourceResult() once for each database it encounters:

	 65 	 int doDBNames(LassoCall lasso) {
	 66 		  return lasso.addDataSourceResult("News");
	 67 	 }

	 11	Whenever a data source module receives the ACTION_TABLE_NAMES command, it must examine the 
database name passed in the LassoValue parameter, and return the names of all tables available in the 
specified database:

	 68 	 int doTableNames(LassoCall lasso, String db) {
	 69 		  if  (!db.equalsIgnoreCase("News"))
	 70 			   return -1;
	 71 		  lasso.addDataSourceResult("Groups");
	 72 		  lasso.addDataSourceResult("Articles");
	 73 		  return ERR_NOERR;
	 74 	 }

	 12	Lasso Professional sends the ACTION_INFO command when it needs to retrieve the information about 
columns contained in the result set. Inline tag actions like -FindAll and -Search usually return a result set 
containing certain number of rows/records, each consisting of one or more columns/fields. When data 
source module receives an ACTION_INFO command, it must call LassoCall.addColumnInfo() method once for 
each column stored in the result set.

	 73 	 int doInfo(LassoCall lasso, boolean listAllCols) {
	 74 		  int err = ERR_NOERR;
	 75 		  LassoValue tbl = new LassoValue();
	 76 		  err = lasso.getTableName(tbl);
	 77 		  if  (err != ERR_NOERR || tbl.data().length() == 0)
	 78 			   return LassoErrors.InvalidParameter;
	 79	       if  (!connect(lasso))
	 80 			   return LassoErrors.Network;
	 81 		  if  (tbl.data().equalsIgnoreCase("Groups")) {
	 82 			   lasso.addColumnInfo("Group", 0, 
	 					     LassoValue.TYPE_CHAR, PROTECTION_READ_ONLY);
	 83 			   lasso.addColumnInfo("Last", 0, 
						      LassoValue.TYPE_INT, PROTECTION_READ_ONLY);
	 84 			   lasso.addColumnInfo("First", 0, 
						      LassoValue.TYPE_INT, PROTECTION_READ_ONLY);
	 85 			   lasso.addColumnInfo("AllowPost", 0, 
						      LassoValue.TYPE_CHAR, PROTECTION_READ_ONLY);
	 86 		  } …
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	 13	The ACTION_SEARCH command is sent whenever Lasso Professional needs to perform the search action on a 
data source.

	 109 	 int doSearch(LassoCall lasso) {

	 14	All of the information about the current search parameters (database and table names, search arguments, 
sort arguments, etc.) can be retrieved by calling various LJAPI methods such as LassoCall.getDataSourceName() 
and LassoCall.getTableName(). Similarly, one can call getSkipRows() and getMaxRows() methods to retrieve the 
-SkipRecords and -MaxRecords inline parameter values. For a complete list of available methods, see LassoCall 
class reference.

	 117 	 IntValue ival = new IntValue();
	 118 	 if  (lasso.getSkipRows(ival) == ERR_NOERR)
	 119 		  skip = ival.intValue();
	 120 	 if  (lasso.getMaxRows(ival) == ERR_NOERR)
	 121 		  max = ival.intValue();
	 122 	 lasso.getTableName(tbl);
	 123 	 lasso.getInputColumnCount(ival);

	 15	The module needs to perform different actions depending on the search table name.

	 129 	 if  (tbl.data().equalsIgnoreCase("GROUPS")) {

	 16	Some NNTP servers allow retrieval of newsgroup listings filtered by a matching pattern. The module builds 
the pattern string based on the value of the inline search operator (beginsWith, endsWith, etc.). 

	 130 	 if  (lasso.findInputColumn("group", val) == ERR_NOERR) {
	 131 		  if  (val.type() == LassoOperators.OP_ENDS_WITH)
	 132 			   filter = '*' + val.data();
	 133 		  else if  (val.type() == LassoOperators.OP_CONTAINS)
	 134 			   filter = '*' + val.data() + '*';
	 135 		  else if  (val.type() == LassoOperators.OP_EQUALS)
	 136 			   filter = val.data();
	 137 		  else
	 138 			   filter = val.data() + '*';
	 139 	 }

	 17	In case the search is being performed on the ARTICLES table, we need to find out the name of a newsgroup 
before we can proceed any further.

	 149 	 } else if  (tbl.data().equalsIgnoreCase("ARTICLES")) {
	 150		  if  (lasso.findInputColumn("-group", val) == ERR_NOERR ||
	 151 		  lasso.findInputColumn("group", val) == ERR_NOERR) {

	 18	Next, we check if an article number or message ID has been included in the search criteria, either as a 
primary keyfield, record ID, or as a named search field.

	 164 	 if  (lasso.getRowID(ival) == ERR_NOERR && ival.intValue() != -1)
	 165 		  id = Integer.toString(ival.intValue());
	 166 	 else if  (lasso.getPrimaryKeyColumn(val) == ERR_NOERR &&
	 167 			    (val.name().equalsIgnoreCase("message-id") || 
	 168 			     val.name().equalsIgnoreCase("number"))) 
	 169 		  filter = val.data();
	 170 	 else if  (lasso.findInputColumn("message-id", val) == ERR_NOERR || 
	 171 		       lasso.findInputColumn("number", val) == ERR_NOERR) 
	 172 	 filter = val.data();

	 19	If none of the above was found, yet the -MaxRecords inline parameter appears to limit the query results to a 
single row, we can try finding the desired article ID based on the current -SkipRecords value.

	 178 	 if  (max == 1 && (filter == null || filter.length() < 1))
	 179 		  id = getRange(lasso, skip, 1);

	 20	If the article has been identified, proceed with retrieving the message in its entirety.

	 182 	 if  (id != null && id.length() > 1) { // detail
	 183 		  this.printer.print("ARTICLE " + id + "\r\n");
	 184 		  reply=reader.readLine();

	 21	Otherwise, select the next group of news articles and retrieve their headers.

	 225 	 if  (filter == null || filter.length() == 0)
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	 226 		  filter = getRange(lasso, skip, max);
	 227 	 this.printer.print("XOVER " + filter + "\r\n");
	 228 	 reply=reader.readLine();
	 229 	 if  (!reply.startsWith("2"))
	 230 		  return setError(lasso, reply);

	 22	The LassoCall.addResultRow() method is used to return the results of a data source action. It should be called 
as many times as there are records in the result set, once for each record.

LassoCall.addResultRow() method takes a single String array parameter. Each array element corresponds to a 
record column/field contained in the result set. The total number of array elements must be equal to the 
number of times LassoCall.addColumnInfo() method was called for this data source action. Since news article 
headers are transmitted in the form of a tab-delimited string, we use our custom split() method to convert 
the data to a String array, suitable for passing to addResultRow() method:

	 231 	 while(err == ERR_NOERR && !(reply=reader.readLine()).startsWith("."))
	 232 		  err = lasso.addResultRow(split(reply, "\t"));

	 23	Finally, implement a number of convenience methods, including the setError() routine used for standard 
error handling:

	 246 	 int setError(LassoCall lasso, String reply) {
	 247 		  int err = -1;
	 248 		  try { 
	 249 			   err = Integer.parseInt(reply.substring(0, 3));
	 250 			   lasso.setResultMessage(reply.substring(4));
	 251 		  } catch (Exception e) {};
	 252 		  lasso.setResultCode(err);
	 253 		  return err;
	 254 	 }
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69
Chapter 69

LJAPI Reference

This chapter provides a reference to all of the types and function in the Lasso Java API (LJAPI).

	 •	LJAPI Interface Reference introduces the interfaces that are provided with LJAPI.

	 •	LJAPI Class Reference documents every class this is provided with LJAPI.

LJAPI Interface Reference
This section provides a listing of all Java interfaces available for use in LJAPI 7. All variables, constructors, and 
methods for each interface are organized by category under each interface name.

com.omnipilot.lassopro.LassoJavaModule
This is the base interface implemented by both substitution tag and data source LJAPI modules. Upon Lasso 
Service startup, the registerLassoModule method is called for every Java module located inside the LassoModules 
folder. Each module returns information about their name, implemented tags or data sources, method 
names, etc.

Data source modules are instantiated only once and then used repeatedly to perform various data source 
actions. Tag modules are instantiated every time Lasso resolves a tag implemented by a LassoTagModule.

Methods

registerLassoModule()

This method must be defined in all LJAPI modules. Lasso calls this once at startup to allow a module to 
register its tags or data sources.

public void registerLassoModule ( );

Variables

ERR_NOERR

On success, every method must return ERR_NOERR result code.

public static final int ERR_NOERR

LJAPI Class Reference
This section lists all the Java classes available for use in LJAPI 7. All variables, constructors, and methods for 
each interface are organized alphabetically under each interface name, unless specified otherwise.
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com.omnipilot.lassopro.FloatValue
Wrapper class for a primitive float or double type. Used for returning decimal values from the 
LassoCall.typeGetDecimal method.

Constructors

public FloatValue() 
public FloatValue(float value) 
public FloatValue(double value)

Methods

doubleValue()

Returns the value of a FloatValue object as a double.

public double doubleValue() 

floatValue()

Returns the value of a FloatValue object as a float.

public float floatValue()

toString()

Converts an object to a string. Overrides toString() method in class Object.

public String toString()

com.omnipilot.lassopro.IntValue
Wrapper for primitive integer types. Used for returning values from LassoCall methods, which in C would 
require passing the pointer-type parameters: int*, long* and LP_TypeDesc*. In addition, this class provides 
methods for converting a 4-byte int (LP_TypeDesc type in LCAPI) to a String and back.

Constructors

public IntValue() 
public IntValue(int value) 
public IntValue(long value)

Methods

byteValue() 

Returns the value of an IntValue object as a 1-byte integer. 

public byte byteValue()  

shortValue()  

Returns the value of an IntValue object as a 2-byte integer.

public short shortValue() 

intValue()  

Returns the value of an IntValue object as a 4-byte integer.

public int intValue()  

longValue() 

Returns the value of an IntValue object as an 8-byte integer.

public long longValue()  
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setByte()

Sets the value of an IntValue object to a 1-byte integer.

public void setByte( byte value )

setShort()

Sets the value of an IntValue object to a 2-byte integer.

public void setShort( short value )

setInt()

Sets the value of an IntValue object to a 4-byte integer.

public void setInt( int value )

setLong()

Sets the value of an IntValue object to an 8-byte integer.

public void setLong( long value )

toDescType()

Converts the lower 4 bytes of an IntValue value to a 4-char String.

public String toDescType()

toString()

Converts an object to a string. Overrides toString() method in class Object.

public String toString()

IntToFourCharString()

Static method used for converting an int to a 4-char String.

public static String IntToFourCharString( int value )

com.omnipilot.lassopro.LassoCall
Of all Java classes listed in this section, the LassoCall class is of the utmost importance. All the interaction 
between an LJAPI module and Lasso Professional 8 is achieved by means of invoking various methods 
implemented in the LassoCall class. These functions can be used to do any of the following: register your tags 
or data sources, allocate memory, return error messages, get tag or parameter information, get client/server 
environment information, output text, read/set MIME headers, access Lasso variables, interpret/execute 
arbitrary Lasso tags, store persistent data, check if the user is an administrator, perform data source functions, 
and safely access multiuser/multithreaded resources.

All class methods in this section are listed by their category.

Internal Value Methods

getLassoParam()

Fetches an internal server value such as path to LassoModules folder, name of the Lasso error log file, etc. For a 
full list of available parameters, please see the listing of constants defined in the LassoParams class.

public int getRequestParam( int key, LassoValue outResult );

getRequestParam()

Fetches an HTTP request value such as server port, cookies, root path, username, etc. For a full list of available 
parameters, please see the listing of constants defined in the LassoRequestParams class. Please note that some 
of these parameters may not be available on all HTTP servers.

public int getRequestParam( int key, LassoValue outResult );
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Error Messages and Result Code Methods

setResultCode()

Sets the result code that can be displayed if the Lasso programmer inserts [Error_CurrentError: -ErrorCode] into the 
Lasso page after executing a custom LJAPI tag.

public int setResultCode( int err );

setResultMessage()

Sets the error message that can be displayed if the Lasso programmer inserts [Error_CurrentError: -ErrorMessage] 
into the Lasso page after executing a custom LJAPI tag.

public int setResultMessage( String msg );

Tag and Parameter Info Methods

getTagName()

Fetches the name of the tag that triggered this call (e.g. in the case of [my_tag: …] the resulting value would be 
my_tag). This makes it possible to design a single tag function which can perform the duties of many different 
Lasso tags, perhaps ones that all have similar functionality but different names.

public int getTagName( LassoValue result );

getTagParamCount()

Fetches the number of parameters that were passed to the tag. For instance, [my_tag: 'hello', -option=1, -hilite=false] 
will report that three parameters were passed (unnamed parameters are treated just like any other parameter).

public int getTagParamCount( IntValue result );

getTagParam()

Gets the name and value of a parameter given its index. Parameters are numbered left-to-right, starting at 
index 0: [my_tag: -param0='value0', -param1='value1', -param2=2].

public int getTagParam( int paramIndex, LassoValue result );

getTagParam2()

Get the parameter using the parameter index. This function differs from getTagParam() in that it preserves 
the actual type of the parameter instead of automatically converting it to a string. Keyword/value pairs are 
returned as a LASSO_PAIR type.

public int getTagParam2( int paramIndex, LassoTypeRef  outValue );

tagParamIsDefined()

Returns ERR_NOERR if the parameter was defined. Otherwise, the parameter wasn’t defined.

public int tagParamIsDefined( String paramName );

findTagParam()

Finds and fetches a tag parameter by name. A return value of ERR_NOERR means the parameter was found 
successfully.

public int findTagParam( String paramName, LassoValue result );

findTagParam2()

Finds and returns a tag parameter by name while preserving the original type. A returned value of ERR_NOERR 
means the parameter was successfully found.

public int findTagParam2( String paramName, LassoTypeRef  outValue );

getTagEncoding()

Fetches the encoding method indicated for this tag. This is rarely used, because Lasso handles encoding and 
decoding for you.

public int getTagEncoding( IntValue method );
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childrenRun()

Used to execute the contents of a container tag. Tags become containers when the FLAG_CONTAINER flag is 
used. The result parameter will contain the combined result data for all tags contained.

public int childrenRun( LassoTypeRef  outValue );

runRequest()

Creates and runs a new LJAPI call on the given method (methodName of the className class). If there is already 
an active request on the current thread, the method will be run within the context of that thread. If there is 
no active request on the current thread, a new request will be created and run based on the global context. 
The tagAction parameter is passed to the methodName and can be used to signal or pass information to the 
function.

public static int runRequest( String className,  
String methodName,  
 int tagAction,  
 int unused );

Output Methods

outputTagData()

Outputs any string data to the page. Lasso takes care of encoding, and this can be called as many times as 
needed. The second variant of this method is recommended for writing binary data.

public int outputTagData( String data );

public int outputTagData( byte[] data );

returnTagValue()

Specifies the return value for the tag. Note that only a single returnTagValue or outputTagData can be used from 
within a tag. returnTagValue is the prefered method for returning tag data as it allows data of any type to be 
returned (including binary data), while outputTagData is restricted to printable text data.

public int returnTagValue ( LassoTypeRef  value );

Data Type Methods

typeAlloc()

This function will allocate a new type instance. The type is specified by the typeName parameter. An array of 
parameters can be passed to the type initializer. Types created through this function will be automatically 
destroyed after the LJAPI call has returned. In order to prevent this, typeDetach should be used.

	 public int typeAlloc ( String typeName,  
						         LassoTypeRef[] params,  
						         LassoTypeRef  outType );

typeFree()

Attempts to free a type created using typeAlloc or any other method. The LassoCall variable may be null if the 
provided type has been detached using typeDetach.

public int typeFree ( LassoTypeRef  inType );

typeDetach()

Prevents the type from being destroyed once the LJAPI call returns. Types that have been detached must 
eventually be destroyed using typeFree() (passing null in the LassoCall variable) or a memory leak will occur.

public int typeDetach( LassoTypeRef  toDetach );

typeAllocNull()

This method allows new instances of LASSO_NULL data types to be allocated. Types allocated in this manner 
will be destroyed once the LJAPI call is returned.
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public int typeAllocNull ( LassoTypeRef  outNull);

typeAllocString()

This method allows new instances of string data types to be allocated. Types allocated in this manner will be 
destroyed once the LJAPI call is returned.

public int typeAllocString ( LassoTypeRef  outString, String value);

typeAllocInteger()

This method allows new instances of integer data types to be allocated (Lasso integers are 8-byte signed 
INTs). Types allocated in this manner will be destroyed once the LJAPI call is returned.

public int typeAllocInteger ( LassoTypeRef  outInteger, long value); 

typeAllocDecimal()

This method allows new instances of decimal data types to be allocated. Types allocated in this manner will 
be destroyed once the LJAPI call is returned.

public int typeAllocDecimal ( LassoTypeRef  outDecimal, double value);

typeAllocPair()

This method allows new instances of pair data types to be allocated. Types allocated in this manner will be 
destroyed once the LJAPI call is returned.

public int typeAllocPair ( LassoTypeRef  outPair,  
							          LassoTypeRef  inFirst,  
							          LassoTypeRef  inSecond);

typeAllocReference()

This method allows new instances of reference data types to be allocated. Types allocated in this manner will 
be destroyed once the LCAPI call is returned.

public int typeAllocReference ( LassoTypeRef  outRef,  
							       LassoTypeRef  referenced );

typeAllocTag()

This method allows new instances of tag data types to be allocated. Types allocated in this manner will 
be destroyed once the LJAPI call is returned. Method methodName should have the same signature as 
TAG_METHOD_PROTOTYPE() method in the LassoTagModule class.

public int typeAllocTag ( LassoTypeRef  outTag,  
							         String className,  
							         String methodName ); 

typeAllocArray()

This method allows new instances of array data types to be allocated. Types allocated in this manner will be 
destroyed once the LJAPI call is returned.

public int typeAllocArray ( LassoTypeRef  outArray,  
								        LassoTypeRef[] inElements);

typeAllocMap()

This method allows new instances of map data types to be allocated. Types allocated in this manner will be 
destroyed once the LJAPI call is returned. 

Two versions of the same method are provided: in the first case the count of elements of the inElements array 
must be divisible by 2 and contain both keys and values (odd = key, even = value). In the second case, map 
keys and values must be passed in a separate parameters.

public int typeAllocMap ( LassoTypeRef  outMap,  
							         LassoTypeRef[] inElements ); 
public int typeAllocMap ( LassoTypeRef  outMap,  
							         LassoTypeRef[] inKeys,  
							         LassoTypeRef[] inValues );
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typeAllocBoolean()

This method allows new instances of boolean data types to be allocated. Types allocated in this manner will 
be destroyed once the LJAPI call is returned.

public int typeAllocBoolean( LassoTypeRef  outBool, boolean inValue );

typeGetBytes()

This method returns the data of a type instance as an array of bytes.

public bytes[] typeGetString( LassoTypeRef  type);

typeGetString()

This method gets the data from a previously created string instance. When setting a value, the type is 
converted if required.

public int typeGetString( LassoTypeRef  type, LassoValue outValue );

typeGetInteger()

This method gets the data from a previously created integer instance. When setting a value, the type is 
converted if required.

public int typeGetInteger( LassoTypeRef  type, IntValue outValue );

typeGetDecimal()

This method gets the data from a previously created decimal instance. When setting a value, the type is 
converted if required.

public int typeGetDecimal( LassoTypeRef  type, FloatValue outValue );

typeGetBoolean()

This method gets the data from a previously created boolean instance. When setting a value, the type is 
converted if required.

public int typeGetBoolean( LassoTypeRef  type, BoolValue outValue );

typeSetBytes()

This method sets the data of a type instance. The type is converted if required.

public int typeSetBytes( LassoTypeRef  type, byte[] value );

typeSetString()

This method sets the value of a previously created string type instance.

public int typeSetString( LassoTypeRef  type, String value );

typeSetInteger()

This method sets the value of a previously created integer instance.

public int typeSetInteger( LassoTypeRef  type, long value );

typeSetDecimal()

This method sets the value of a previously created decimal instance.

public int typeSetDecimal( LassoTypeRef  type, double value );

typeSetBoolean()

This method sets the value of a previously created boolean instance.

public int typeSetBoolean( LassoTypeRef  type, boolean value );

arrayGetSize()

This method gets the size of a previously created array instance.

public int arrayGetSize( LassoTypeRef  array, IntValue outLen );
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arrayGetElement()

This method gets an array element from a previously created array instance.

public int arrayGetElement( LassoTypeRef  array,  
								        int index,  
								        LassoTypeRef  outElement );

arraySetElement()

This method sets an array element in a previously created array instance.

public int arraySetElement( LassoTypeRef  array,  
								        int index,  
								        LassoTypeRef  element );

arrayRemoveElement()

This method removes an element from a previously created array instance.

public int arrayRemoveElement( LassoTypeRef  array, int index );

mapGetSize()

This method gets the size of a previously created map instance.

public int mapGetSize( LassoTypeRef  map, IntValue outLen );

mapFindElement()

This method finds an element in a previously created map instance stored under unique key.

public int mapFindElement( LassoTypeRef  map,  
							          LassoTypeRef  key,  
							          LassoTypeRef  outElement );

mapGetElement()

This method gets an element from a previously created map instance using the element index.

public int mapGetElement( LassoTypeRef  map,  
							         int index,  
							         LassoTypeRef  outPair );

mapSetElement()

This function sets an element in a previously created map instance. If no elements were previously stored 
under the specified key, the element will be added to the map, otherwise the old element will be replaced by 
a new value.

	 public int mapSetElement( LassoTypeRef  map,  
							         LassoTypeRef  key,  
							         LassoTypeRef  value );

mapRemoveElement()

This method removes an element from a previously created map instance.

public int mapRemoveElement( LassoTypeRef  map, LassoTypeRef  key );

pairGetFirst()

This method gets the first element from a previously created pair instance.

public int pairGetFirst( LassoTypeRef  pair, LassoTypeRef  outValue );

pairGetSecond()

This method gets the second element from a previously created pair instance.

public int pairGetSecond( LassoTypeRef  pair, LassoTypeRef  outValue );

pairSetFirst()

This method sets the first element in a previously created pair instance.
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public int pairSetFirst( LassoTypeRef  pair, LassoTypeRef  first );

pairSetSecond()

This function sets the second element in a previously created pair instance.

public int pairSetSecond( LassoTypeRef  pair, LassoTypeRef  second );

typeGetMember()

This function is used to retrieve a member from a type instance. Members are searched by name with tag 
members searched first. Data members are searched if no tag member is found with the given name.

public int typeGetMember( LassoTypeRef  fromType,  
							         String named,  
							         LassoTypeRef  outMember );

typeGetProperties()

This method has two uses. If the targetType parameter is not null, it is used to get all data and tag members 
from a given type. They are returned as a pair of arrays in the outPair value. The first element of each pair is the 
map of data members for the type. The second element is the map of tag members. Each element in the array 
represents the members of each type inherited by the targetType. 

If the targetType parameter is null, typeGetProperties will return an array containing the variable maps for the 
currently active request.

public int typeGetProperties ( LassoTypeRef  targetType,  
								           LassoTypeRef  outPair );

typeGetName()

Retrieves the name of the target type.

public int typeGetName( LassoTypeRef  target, LassoValue outName );

typeRunTag()

Used to to execute a given tag. The tag can be run given a specific name and parameters, and the return value 
of the tag can be accessed. If the tag is a member tag, the instance of which it is a member can be passed 
using the final parameter. The params, returnValue, and optionalTarget parameters may all be null.

A slightly modified version of the same method is provided for convenience puproses. It accepts a single 
LassoTypeRef parameter instead of a LassoTypeRef array.

public int typeRunTag ( LassoTypeRef  tagType,  
							       String named,  
							       LassoTypeRef[] params,  
							       LassoTypeRef  returnValue,  
							       LassoTypeRef  optionalTarget );

public int typeRunTag ( LassoTypeRef  tagType,  
							       String named,  
							       LassoTypeRef  parameter,  
							       LassoTypeRef  returnValue,  
							       LassoTypeRef  optionalTarget );

typeAssign()

This performs an assignment of one type to another. The result will be the same as if the following had been 
executed in Lasso:#left_hand_side = #right_hand_side

public int typeAssign( LassoTypeRef  left_hand_side,  
						         LassoTypeRef  right_hand_side);

typeStealValue()

This function transfers the data from one type to another type. Both types must be valid and pre-allocated. 
After the call, victim will still be valid, but will be of type null.
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public int typeStealValue( LassoTypeRef  thief, LassoTypeRef  victim );

handleExternalConversion()

Converts a Lasso type into single-byte or binary data using the specific encoding name. The default for all 
database, column, table names should be “iso8859-1”.

public byte[] handleExternalConversion(LassoTypeRef  inInstance, String inEncoding);

handleInternalConversion()

Converts a single-byte or binary representation of a Lasso type back into an instance of that type.

public int handleInternalConversion( byte[] inData, String inEncoding, int inClosestLassoType, LassoTypeRef  outType );

typeInheritFrom

This function changes the inheritance structure of a type. Sets inNewParent to be the new parent of the child. 
Any parent that child currently has will be destroyed.

public int typeInheritFrom( LassoTypeRef  inChild, LassoTypeRef  inNewParent );

Custom Type Methods

typeAllocCustom()

This function is used within module methods that were registered as being a type initializer 
(FLAG_INITIALIZER). It initializes a blank custom type and sets the type’s __type_name__ member to the 
provided value. The new type does not yet have a lineage and has no members added to it besides 
__type_name__. New data or tag members should be added using typeAddMember. The new custom type should 
be the return value of the type initializer. Any inherited members will be added to the type after the LJAPI call 
returns.

Warning: Do not call this unless you are in a type initializer. If you are not in a type initializer, the result will be a 
type that will never be fully initialized.

public int typeAllocCustom( LassoTypeRef  outCustom, String name );

typeAddMember()

This is used to add new members to type instances. The member can be any sort of type including tags or 
other custom types.

public int typeAddMember( LassoTypeRef  to,  
							         String named,  
							         LassoTypeRef  member ); 

typeAllocFromProto()

Allocate a new type based on the given type. The given type’s tag members will be referenced in the new type. 
No data members are added except for the typename member. Proto must be a custom type.

public int typeAllocFromProto( LassoTypeRef  inProto, LassoTypeRef  outType );

typeAllocOneOff()

Allocate a new type with the given name. The type does not have to have been registered as a type initializer 
or registered at all. The new type will have no tag or data members, but those may be added using the appro-
priate LCAPI call at any time. If no parent type is provided (a NULL pointer or empty string is passed in), 
type null will be the default. If a parent type is provided, it must have been a validly registered type initializer. 
onCreate will be called for the parent and beyond.

public int typeAllocOneOff( String inName, String inParentTypeName, LassoTypeRef  outType );

typeGetCustomJavaObject()

Custom types can have Java objects attached to them. The object can be retrieved at any point during the 
instance’s lifetime. typeSetCustomJavaObject method retrieves the Java object associated with a custom type, or 
returns null if no object has been attached to this type.
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 public Object typeGetCustomJavaObject( LassoTypeRef  type ); 

typeSetCustomJavaObject()

typeSetCustomJavaObject permits attachment of Java objects to custom types. Java object is retained until 
typeFreeCustomJavaObject is called, or the type is destroyed.

public int typeSetCustomJavaObject( LassoTypeRef  type, Object object );

typeFreeCustomJavaObject()

Releases the Java object previously attached to a custom type. Must be called to free the Java object that is no 
longer needed, or to detach an old Java object before attaching a new one to the same custom type.

public int typeFreeCustomJavaObject( LassoTypeRef  type );

Logging Function Methods

log()

Logs a message. The message goes to the prefered destination for the message level. Messages sent to a file 
are limited to 2048 bytes in length. Messages sent to the console are limited to 512 bytes in length. Messages 
sent to the database are limited a little less than 2048 bytes since the total length of the sql statement 
used to insert the message is limited to 2048 bytes. The msgLevel parameter must be one of the following: 
LOG_LEVEL_CRITICAL, LOG_LEVEL_WARNING, or LOG_LEVEL_DETAIL.

public static int log ( int msgLevel, String message );

logSetDestination()

Changes the system-wide log destination preference. You can log messages to more than one destination at 
a time by passing several flags in the destination parameter: FLAG_DEST_CONSOLE, FLAG_DEST_FILE, and/or 
FLAG_DEST_DATABASE.

public static int logSetDestination( int msgLevel, int destination );

MIME Header Methods

getResultHeader()

Retrieves current value of the result (HTTP) header. Part of the header that is returned to browsers is 
automatically built by Lasso, and can be modi-fied or added to by Lasso tags on the page. This function 
retrieves the current set of MIME headers that would be sent back to the browser if page processing were to 
stop now.

public int getResultHeader( LassoValue result );

setResultHeader()

Sets the result header, any data will be validated so as to be in the proper format.

public int setResultHeader( String header );

addResultHeader()

Simply appends the supplied data to the header, any data will be validated so as to be in the proper format.

public int addResultHeader( String data );

getCookieValue()

Retrieves a cookie value from the passed-in data sent by the client browser.

public int getCookieValue( String named, LassoValue value );
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Page Variable Methods

getVariableCount()

Retrieves the number of array values which the named global variable has. Returns 1 if the global 
variable is not an array. Global variables are the same variables which you create in Lasso statements, like 
[var: 'fred'=1234.56]. These variables last only as long as the current Lasso page is executing; as soon as the hit 
gets sent back to the browser, these variables all get destroyed.

public int getVariableCount( String named, IntValue count );

getVariable()

Retrieves the value of the named global variable. If the global variable is an array, then the index specifies 
which array value to retrieve. If the global variable is not an array, then 0 is the only valid index. Array indices 
start at 0.

public int getVariable( String named, int index, LassoValue value );

getVariable2()

Retrieves the value of the named global variable while preserving the variable type.

public int getVariable2( String named, LassoTypeRef  outValue );

setVariable()

Stores a new value into the named global variable. If the global variable is an array, then the 0-based index 
determines which array item to replace.

public int setVariable( String named, String value, int index );

setVariable2()

Stores a new global variable while preserving the type.

public int setVariable2( String named, LassoTypeRef  inValue );

removeVariable()

Removes the specified variable (destroys it so it becomes undefined, as though it had never been created). If 
the named variable is an array, then you may pass in an index (0-based) to remove that array element. Once 
the array has 0 elements, then calling removeVariable on it will destroy the array itself.

public int removeVariable( String named, int index );

Lasso tag Interpreter Methods

formatBuffer()

Formats the supplied buffer and puts the resulting data in the data field of the LassoValue. The buffer should 
consist of plain text and bracketed Lasso tags.

public int formatBuffer( String buffer, LassoValue output );

Persistent Storage Tag Methods

storeHasData()

Returns ERR_NOERR if the data, specified by key, exists. The length of the stored data can be returned in the 
outLength parameter if you pass a valid IntValue object. You may pass null if you don’t want to retrieve the length 
of the stored data.

public int storeHasData( String key, IntValue outLength );

storeGetData()

Fetches data that has been stored under the unique identifier key. The data will be returned in the data field of 
the LassoValue object.
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public int storeGetData( String key, LassoValue outValue );

storePutData()

Adds the data to Lasso’s storage. Key is the unique identifier for the data.

public int storePutData( String key, String data ); 
public int storePutData( String key, byte[] data );

Administration Methods

isAdministrator()

Returns ERR_NOERR if the current user has administrator privileges. This is useful for doing module 
administration that only the administrator should be able to do.

public int isAdministrator( );

Data Source Function Methods

getDSConnection()

This function accesses the current datasource connection.

public Object getDSConnection();

setDSConnection()

This function sets the current connection for the data source. May recurse to deliver the ACTION_CLOSE 
message if there is already a valid connection set.

public int setDSConnection( Object inConnection );

addDataSourceResult()

Sometimes Lasso Professional will query a data source function to return information, such as a list of 
database names or table names which the data source module controls. The module will call this function 
once for each name you add to the list, so if you have three database names you want to report back to Lasso 
Professional, you would call this function three times, once per database name.

public int addDataSourceResult( String data );

getDataSourceName()

Use this function when you want to ask Lasso Professional what database is being operated on. For instance, 
if you’re being asked to perform a search, then you would call this function to retrieve the name of the 
data-base which Lasso Professional is asking you to search. It corresponds to the value of the parameter 
-Database='blah' passed to inlines. Optionally, you can use the second (outUseHostDefault) parameter to 
determine whether the current database inherits its host default settings.

Note: Even though the name of the method is getDataSourceName, it really retrieves the database name. This is 
purely cosmetic, and just happens to be how the APIs were spelled when they were originally designed.

public int getDataSourceName( LassoValue outName,  
								          BoolValue  outUseHostDefault,  
								          LassoValue outUsernamePassword );

getDataHost()

Use this function when you want to ask Lasso Professional 8 what database host is being operated on. On 
return, LassoValue will contain the name and port of the database host.

public int getDataHost( LassoValue outHost,  
							       LassoValue outUsernamePassword );

getDataHost2()

Same as getDataHost() but allows the usage of a host schema parameter for JDBC data sources.
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public int getDataHost2( LassoValue outHost,  
							       LassoValue outSchema, 
							       LassoValue outUsernamePassword );

getSchemaName()

Use this function when you want to ask Lasso Professional what schema is being operated on for a JDBC data 
source. For instance, if you’re being asked to perform a search, then you would call this function to retrieve 
the name of the schema which Lasso Professional is asking you to use for the search. It corresponds to the 
value of the parameter -Schema='blah' passed to inlines.

public int getSchemaName( LassoValue outName );

getTableName()

Use this function when you want to ask Lasso Professional what table is being operated on. For instance, if 
you’re being asked to perform a search, then you would call this function to retrieve the name of the table 
which Lasso Professional is asking you to search. It corresponds to the value of the parameter -Layout='blah' or 
-Table='blah' passed to inlines.

public int getTableName( LassoValue outName );

getSkipRows()

You can ask Lasso Professional to tell you how many records should be skipped during a search by calling 
this function. It corresponds to the value of the -SkipRecords parameter in the inline search which is being 
executed at the moment your data source function is being called.

public int getSkipRows( IntValue outRows );

getMaxRows()

You can ask Lasso Professional to tell you the maximum number of records to be returned during a search 
by calling this function. It corresponds to the value of the -MaxRecords parameter in the inline search which is 
being executed at the moment your data source function is being called.

public int getMaxRows( IntValue outRows );

getPrimaryKeyColumn()

You can ask Lasso Professional to tell you which field is being used as the primary key. This value corresponds 
to the -KeyField parameter value used in the inline.	

public int getPrimaryKeyColumn( LassoValue outColumn );

getInputColumnCount()

Tells how many fields were sent as parameters to the inline. For instance, if a Lasso programmer wants to 
append a new record to a table, and passes in name, address, city, state, zip with values for each field, then 
this function will return the number 5 to indicate that five fields were passed to the inline. You can then 
retrieve the values of each of these parameters by calling getInputColumn by index, once per field. This function 
is smart enough to ignore parameters which are not fields, such as -Database, -Layout, etc.

public int getInputColumnCount( IntValue outCount );

getInputColumn()

Retrieve the name and value of field data parameters from the inline, starting at index zero. If five fields were 
entered into the inline, then you can retrieve each of their names and values by calling this function five 
times, once per field.

[Inline: -Database='MyDatabase', -Table='Main', 'MyFirstField'='Bill', 'MySecondField'='Ted', -Search]

In the above example, calling getInputColumn( 0, v ) will fill the v variable with v.name=MyFirstField, v.data=Bill. 
Notice it is smart enough to ignore well-known parameters such as -Table, thus only retrieving field 
information.

public int getInputColumn( int index, LassoValue outColumn );
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getSortColumnCount()

Analogous to getInputColumnCount, this method retrieves the number of sort columns which were specified in 
the inline code. It basically counts how many -SortField parameters were passed. You can use this count to tell 
you how many times to enumerate through calls to getSortColumn.

public int getSortColumnCount( IntValue outCount );

getSortColumn()

Analogous to lasso_getInputColumn(), this function retrieves the names of sort parameters, starting at index zero. 
After calling this, the data field of outColumn variable will contain a String with the name of the sort field.

public int getSortColumn( int index, LassoValue outColumn );

getRowID()

Retrieves the current specified record ID (datasource-specific).

public int getRowID( IntValue outId );

setRowID()

Sets the record ID of the added record. After your custom LCAPI data source finishes adding a record to a 
database, it can call this function to let the caller know what the unique record ID of the added record was.

In FileMaker, this record ID is a standard feature of all records in its tables. In MySQL, this value is 0 unless 
there exists an AUTO_INCREMENT column. Results are not guaranteed for all database server software.

public int setRowID( int id );

findInputColumn()

Analogous to getInputColumn, except that it searches by name instead of index. If you already know the name 
of a field parameter you’re interested in, then you can ask for the value of that parameter which was passed 
into the inline.

[Inline: -Database='MyDatabase', -Table='Main', 'MyFirstField'='Bill', 'MySecondField'='Ted', -Search]

In the example above, calling findInputColumn( "MySecondField", outColumn ) will fill the outColumn variable’s data 
member with v.data=Ted.

public int findInputColumn( String name, LassoValue outColumn );

getLogicalOp()

Call this to retrieve the logical operator (OP_AND, OP_OR) which was passed to this inline. It corresponds 
to the value of -LogicalOperator passed into the inline. This function simply retrieves a single logical operator 
parameter. For more complex logical operations, with multiple operators, you will have to design a 
convention whereby you name your input fields in some unique way, and then retrieve those custom logical 
operators using the getInputColumn function in a particular order that matches your convention.

public int getLogicalOp( IntValue outOp );

getReturnColumnCount()

Queries Lasso Professional to return the number of columns (fields)  that are expected to be returned from a 
search operation. This counts how many -ReturnField parameters were encountered.

public int getReturnColumnCount( IntValue outCount );

getReturnColumn()

Once you know how many return columns are expected (from getReturnColumnCount), then you can enumerate 
through them to get their fieldnames. Use this information to retrieve field data from your database table, 
and populate the result rows when asked to perform a search operation.

public int getReturnColumn( int index, LassoValue outColumn );
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addColumnInfo()

In order to return a row of data from your data source (perhaps as a result of a search), you must first 
indicate what the structure of the table columns is. Call this function for as many table columns as your 
database has, providing the fieldname, true/false if nulls are OK in this field, the field type (numeric, string, 
date, etc), and field protection (readonly, writeable, etc).	

	 public int addColumnInfo( String name,  
							         int nullOK,  
							         int type,  
							         int protection );

addResultRow()

Call this method once per row of records you want to return (perhaps from a search operation). You may 
choose to return an array of Strings, or construct an array of byte arrays that contain data for each of your 
fields (binary data is OK).

public int addResultRow( String[] columns ); 
public int addResultRow( byte[][] columns );

setNumRowsFound()

Corresponds to [Found_Count] in Lasso. Call this when you know how many records your data source is going 
to return, and make sure you call addResultRow this many times in order to populate the rows.

public int setNumRowsFound( int num );

Semaphore Methods
createSem()

Creates a named semaphore sufficient for synchronizing multithreaded operations, which should be deleted 
after they are used. The Lasso Connector for MySQL example creates one of these at initialization time, and 
destroys it at terminate time.

public int createSem( String name );

destroySem()

Destroys a named semaphore that was created by the createSem method.

public int destroySem( String name );

acquireSem()

Attempts to acquire a lock on a semaphore, and waits until the owning thread has released the semaphore 
before acquiring the lock and continuing execution.

public int acquireSem( String name );

releaseSem()

Releases a locked semaphore so that other threads waiting for the semaphore can continue execution.

public int releaseSem( String name );

com.omnipilot.lassopro.LassoDSModule
Base class for all datasource modules. LassoDSModules are used to manipulate data sources. LassoDSModules are 
looked up by the datasource names they claim to support. They are instantiated once and used repeatedly by 
Lasso.

registerDSModule()

Your code must call this once at startup (from within your registerLassoModule() method) to register a data 
source with Lasso Professional. When Lasso encounters a data source request for moduleName, it calls the Java 
method methodName.
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	 protected void registerDSModule( String datasourceName,  
									          String methodName,  
									          int flags,  
									          String moduleName,  
									          String description);

DS_METHOD_PROTOTYPE()

A prototype for all datasource action methods registered by  registerDSModule. Since methods are being looked 
up by name, they must match exactly the values passed in a methodName parameter of the registerDSModule call.

	 public int DS_METHOD_PROTOTYPE( LassoCall lasso,  
									         int action,  
									         LassoValue data ); 

com.omnipilot.lassopro.LassoEncodings
Constants for the various text encoding methods.

ENCODE_BREAK

Static variable in class omnipilot.lasso.LassoTagEncodings.

public static final int ENCODE_BREAK

ENCODE_DEFAULT

Static variable in class com.omnipilot.lassopro.LassoEncodings.

public static final int ENCODE_DEFAULT

ENCODE_NONE

Static variable in class com.omnipilot.lassopro.LassoEncodings.

public static final int ENCODE_NONE

ENCODE_RAW

Static variable in class com.omnipilot.lassopro.LassoEncodings.

public static final int ENCODE_RAW

ENCODE_SMART

Static variable in class com.omnipilot.lassopro.LassoEncodings.

public static final int ENCODE_SMART

ENCODE_STRICT_URL

Static variable in class com.omnipilot.lassopro.LassoEncodings.

public static final int ENCODE_STRICT_URL	

ENCODE_URL

Static variable in class com.omnipilot.lassopro.LassoEncodings.

public static final int ENCODE_URL

ENCODE_XML

Static variable in class com.omnipilot.lassopro.LassoEncodings.

public static final int ENCODE_XML

com.omnipilot.lassopro.LassoErrors
Constants for the various error codes which can be returned by your module.

NO_ERR

Static variable in class com.omnipilot.lassopro.LassoErrors.
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public static final int NO_ERR

Assert

Static variable in class com.omnipilot.lassopro.LassoErrors.

public static final int Assert

StreamReadError

Could not write to stream.

public static final int StreamReadError

StreamWriteError

Could not read from stream.

public static final int StreamWriteError

Memory

Generic memory error.

public static final int Memory

InvalidMemoryObject

Invalid memory object.

public static final int InvalidMemoryObject

OutOfMemory

Not enough memory.

public static final int OutOfMemory

OutOfStackSpace

Stack overflow error.

public static final int OutOfStackSpace

CouldNotDisposeMemory

Error disposing an object.

public static final int CouldNotDisposeMemory

File	

Generic file error.

public static final int File

FileInvalid

Trying to work with an invalid file.

public static final int FileInvalid

FileInvalidAccessMode

Trying to access a file in a mode that it doesn’t support.

public static final int FileInvalidAccessMode

CouldNotCreateOrOpenFile

Could not create or open the file.

public static final int CouldNotCreateOrOpenFile

CouldNotCloseFile

Could not close the file.

public static final int CouldNotCloseFile
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CouldNotDeleteFile	

Could not delete the file.

public static final int CouldNotDeleteFile

FileNotFound

File does not exist.

public static final int FileNotFound

FileAlreadyExists

Trying to create a file that already exist.

public static final int FileAlreadyExists

FileCorrupt

File is corrupted.

public static final int FileCorrupt

VolumeDoesNotExist

Bad volume name.

public static final int VolumeDoesNotExist

DiskFull

No room left on disk.

public static final int DiskFull

DirectoryFull

No more items allowed in the directory.

public static final int DirectoryFull

IOError

I/O error.

public static final int IOError

InvalidPathname

Pathname is invalid.

public static final int InvalidPathname

InvalidFilename

Filename is invalid.

public static final int InvalidFilename

FileLocked

File is locked.

public static final int FileLocked

FileUnlocked

File is unlocked.

public static final int FileUnlocked

FileIsOpen

File is open.

public static final int FileIsOpen
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FileIsClosed

File is closed.

public static final int FileIsClosed

BOF

Beginning of file reached.

public static final int BOF

EOF

End of file reached.

public static final int EOF

CouldNotWriteToFile

Unable to complete a write operation to the file.

public static final int CouldNotWriteToFile

CouldNotReadFromFile

Unable to complete a read operation from the file.

public static final int CouldNotReadFromFile

Resource

Unknown resource error.

public static final int Resource

ResNotFound

Resource not found.

public static final int ResNotFound

Network

Unknown networking error.

public static final int Network

InvalidUsername

The username supplied for the action is not valid.

public static final int InvalidUsername

InvalidPassword

The password supplied for the action is not valid.

public static final int InvalidPassword

InvalidDatabase

The database name supplied is not valid.

public static final int InvalidDatabase

NoPermission

General permissions error.

public static final int NoPermission

FieldRestriction

The specified action is restricted.

public static final int FieldRestriction

WebAddError

Add record error.
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public static final int WebAddError

WebUpdateError

Update record error.

public static final int WebUpdateError

WebDeleteError

Delete record error.

public static final int WebDeleteError

InvalidParameter

An invalid parameter was passed to a function.

public static final int InvalidParameter

Overflow

Allocated memory was too small to hold the results.

public static final int Overflow

NilPointer

A pointer was null when it shouldn’t have been.

public static final int NilPointer

UnknownError

Default when none of the cross-platform errors seem to fit.

public static final int UnknownError

FormattingLoopAborted

A looping tag was aborted; all looping tags must catch this exception.

public static final int FormattingLoopAborted

FormattingSyntaxError

Bad syntax used in a Lasso page; parsing of the file was aborted.

public static final int FormattingSyntaxError

WebRequiredFieldMissing

Value missing for required field for Add.

public static final int WebRequiredFieldMissing

WebRepeatingRelatedField

Adding repeating related fields isn’t supported.

public static final int WebRepeatingRelatedField

WebNoSuchObject

No records found.

public static final int WebNoSuchObject

WebTimeout

Operation timed out.

public static final int WebTimeout

WebActionNotSupported

Action not supported.

public static final int WebActionNotSupported
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WebConnectionInvalid

The specified database was not found.

public static final int WebConnectionInvalid

WebModuleNotFound

The module was not found.

public static final int WebModuleNotFound

HTTPFileNotFound

The file was not found.

public static final int HTTPFileNotFound

DatasourceError

Third-party generic datasource error.

public static final int DatasourceError

com.omnipilot.lassopro.LassoOperators
Operator constants used throughout LJAPI.

Variables

OP_AND

Logical operator AND.

public static final int OP_AND

OP_ANY

Used for -Random database action.

public static final int OP_ANY

OP_BEGINS_WITH

Field search operator BW.

public static final int OP_BEGINS_WITH

OP_CONTAINS

Field search operator CN.

 public static final int OP_CONTAINS 

OP_DEFAULT

Same as OP_BEGINS_WITH.

public static final int OP_DEFAULT

OP_ENDS_WITH

Field search operator EW.

public static final int OP_ENDS_WITH

OP_EQUALS

Field search operator EQ.

public static final int OP_EQUALS

OP_GREATER_THAN

Field search operator GT.

public static final int OP_GREATER_THAN
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OP_GREATER_THAN_EQUALS

Field search operator GTE.

public static final int OP_GREATER_THAN_EQUALS

OP_IN_FULL_TEXT

Field search operator FT.

public static final int OP_IN_FULL_TEXT

OP_IN_LIST

Static variable in class com.omnipilot.lassopro.LassoOperators.

public static final int OP_IN_LIST

OP_IN_REGEXP

Field search operator RX.

public static final int OP_IN_REGEXP

OP_LESS_THAN

Field search operator LT.

public static final int OP_LESS_THAN

OP_LESS_THAN_EQUALS

Field search operator LTE.

public static final int OP_LESS_THAN_EQUALS

OP_NO

Same as OP_NOT.

public static final int OP_NO

OP_NOT

Logical operator NOT.

public static final int OP_NOT

OP_NOT_BEGINS_WITH

Field search operator NBW.

public static final int OP_NOT_BEGINS_WITH 

OP_NOT_CONTAINS

Field search operator NCN.

public static final int OP_NOT_CONTAINS

OP_NOT_ENDS_WITH

Field search operator NEW.

public static final int OP_NOT_ENDS_WITH

OP_NOT_EQUALS

Field search operator NEQ.

public static final int OP_NOT_EQUALS

OP_NOT_IN_LIST

Static variable in class com.omnipilot.lassopro.LassoOperators.

public static final int OP_NOT_IN_LIST

OP_NOT_IN_REGEXP

Field search operator NRX.
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public static final int OP_NOT_IN_REGEXP

OP_OR

Logical operator OR.

public static final int OP_OR

com.omnipilot.lassopro.LassoParams
These constants signify the different parameters which can be retrieved from the LassoCall.getLassoParam 
method.

ModulesFolderPath

Path to the LassoModules folder.

public static final int ModulesFolderPath

StartupItemsFolderPath

Path to LassoStartup folder.

public static final int StartupItemsFolderPath

LassoErrorsFilePath

Path to Lasso error log file.

public static final int LassoErrorsFilePath

StorageHost

Location of Lasso MySQL datasource.

public static final int StorageHost

ScriptsRoot

Relative path to scripts root.

public static final int ScriptsRoot

ScriptsSiteRoot

Relative path to site scripts root (most likely includes ScriptsRoot).

public static final int ScriptsSiteRoot

com.omnipilot.lassopro.LassoTagModule
Base class for any tag module. Most tag modules output data onto the Web page, though some tags may 
perform other actions based on the parameters passed to them.

Every LassoTagModule must implement registerLassoModule method, and one or more methods with the same 
signature as TAG_METHOD_PROTOTYPE.

Lasso calls registerLassoModule once at startup to give the module a chance to register its tags. LassoTagModule 
must then call registerTagModule as many times as there are tags implemented by this module.

Variables

FLAG_INITIALIZER

Type initializer tags can have their own members.

public static final int FLAG_INITIALIZER

FLAG_SUBSTITUTION

Regular substitution tags.

public static final int FLAG_SUBSTITUTION
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FLAG_ASYNC

Async tags run asynchronously in their own thread.

public static final int FLAG_ASYNC

FLAG_CONTAINER

Container tags have opening and closing. This flag will cause Lasso Professional to raise an error if the closing 
tag can’t be found.

public static final int FLAG_CONTAINER

Methods

registerTagModule()

Use this method to register substitution tags implemented by your module. You should call registerTagModule 
as many times as there are tags implemented in your module.

moduleName parameter is the name of the module as returned by [Lasso_TagModuleName] Lasso tag. tagName is 
the name of the custom Lasso tag implemented by this module. One or more OR logical FLAG constants can 
be passed in the flags parameter to specify unique tag features. Finally, a description parameter can be used to 
provide optional tag info, such as brief description of the tag usage.

protected void registerTagModule( String moduleName, 

									           String tagName,  
									           String methodName,  
									           int flags,  
									           String description);

com.omnipilot.lassopro.LassoTypeRef
This class is used for creating and manipulating custom Lasso types. Unlike LassoValue or IntValue objects 
which store copies of the data, LassoTypeRef is merely a reference to a native object instance. Native objects 
exist for a fraction of a second while Lasso is processing a page, therefore the LassoTypeRef objects should 
never be stored or reused across multiple module invocations.

Variables

LASSO_ARRAY

The name of the built-in array type in Lasso Professional 8.

public static final String LASSO_ARRAY

LASSO_BOOLEAN

The name of the built-in boolean type in Lasso Professional 8.

public static final String LASSO_BOOLEAN

LASSO_DATE

The name of the built-in date type in Lasso Professional 8.

public static final String LASSO_DATE

LASSO_DECIMAL

The name of the built-in decimal type in Lasso Professional 8.

public static final String LASSO_DECIMAL

LASSO_INTEGER

The name of the built-in integer type in Lasso Professional 8.

public static final String LASSO_INTEGER
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LASSO_MAP

The name of the built-in map type in Lasso Professional 8.

public static final String LASSO_MAP

LASSO_NULL

The name of the built-in null type in Lasso Professional 8.

public static final String LASSO_NULL

LASSO_PAIR

The name of the built-in pair type in Lasso Professional 8.

public static final String LASSO_PAIR

LASSO_STRING

The name of the built-in string type in Lasso Professional 8.

public static final String LASSO_STRING

LASSO_TAG

The name of the built-in tag type in Lasso Professional 8.

public static final String LASSO_TAG

Methods

isNull()

Returns true if this object does not refer to a valid type instance, which most likely would be a result of a 
failed LassoCall method.

public boolean isNull();

toString()

Returns string representation of the LassoTypeRef object. Overrides toString method in the class Object.

public String toString();

com.omnipilot.lassopro.LassoValue
Used for retrieving values from various LassoCall methods. Has name and data member variables of type String. 
The type member is set to one of the TYPE constants, reflecting the original type of the value before it was 
converted to string.

Variables

TYPE_ARRAY

Array type.

public static final int TYPE_ARRAY

TYPE_BLOB

Binary data.

public static final int TYPE_BLOB

TYPE_BOOLEAN

Boolean type.

public static final int TYPE_BOOLEAN

TYPE_CHAR

String type.
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public static final int TYPE_CHAR

TYPE_CODE

Substitution tag code.

public static final int TYPE_CODE

TYPE_CUSTOM

Custom type.

public static final int TYPE_CUSTOM

TYPE_DATETIME

Date type.

public static final int TYPE_DATETIME

TYPE_DECIMAL

Decimal type.

public static final int TYPE_DECIMAL

TYPE_INT

Integer type.

public static final int TYPE_INT

TYPE_MAP

Map type.

public static final int TYPE_MAP

TYPE_NULL

Null type.

public static final int TYPE_NULL

TYPE_PAIR

Pair type.

public static final int TYPE_PAIR

TYPE_REFERENCE

Reference type.

public static final int TYPE_REFERENCE

Constructors

public LassoValue(); 
public LassoValue(int type); 
public LassoValue(String data); 
public LassoValue(String name, String data); 
public LassoValue(String name, String data, int type);

Methods

data()

Returns the String object stored in the data field.

public String data();
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name()

Returns the String object stored in the name field.

public String name();

setData()

Sets the value of the data field.

public String setData(String data);

setName()

Sets the value of the name field.

public String setName(String name);

setType()

Sets the value of the type field.

public int setType(int type);

toString()

Converts this object to String.

public String toString()

type()

Returns the original type of the data retrieved from one of the LassoCall methods: TYPE_CHAR for strings, 
TYPE_INT for integers, and so on.

For unnamed tag parameters, the type field is set to the type of the data stored in the data field. For named tag 
parameters, it reflects the type of the value member.

public int type();

com.omnipilot.lassopro.RequestParams
These constants signify the different parameters which can be retrieved from the LassoCall.getRequestParam 
method.

AddressKeyword

IP address of client browser.

public static final int AddressKeyword

ActionKeyword

Type of HTTP request (GET, POST, etc.).

public static final int ActionKeyword

ClientIPAddress

IP address of client browser.

public static final int ClientIPAddress

ContentLength

The length in bytes of the POST data sent from <form POST>.

public static final int ContentLength

ContentType

MIME header sent from client browser.

public static final int ContentType
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FullRequestKeyword

All MIME headers, uninterpreted.

public static final int FullRequestKeyword

MethodKeyword

GET or POST, depending on <form method>.

public static final int MethodKeyword

PasswordKeyword

Password sent from browser.

public static final int PasswordKeyword

PostKeyword

HTTP object body (form data, etc.).

public static final int PostKeyword

ReferrerKeyword

URL of referring page.

public static final int ReferrerKeyword

ScriptName

Relative path from server root to a Lasso page.

public static final int ScriptName

SearchArgKeyword

All text in URL after the question mark.

public static final int SearchArgKeyword

ServerName

IP address or host name of the server on which the Web server is running.

public static final int ServerName

ServerPort	

IP port this hit came to (80 is common, 443 for SSL).

public static final int ServerPort

UserAgentKeyword

Browser name and type.

public static final int UserAgentKeyword

UserKeyword

Username sent from browser.

public static final int UserKeyword	

8 2 2

L a s s o  8 . 5  L a n g u a g e  G u i d e

C h a p t e r  6 9  –  L J API    R e f e r e n c e



A
Appendix A

Error Codes

This appendix contains a list of all known error codes that Lasso Professional 8, Lasso MySQL, or FileMaker 
Pro will return.

	 •	Lasso Professional 8 Error Codes contains a list of all error codes which are generated by Lasso 
Professional 8.

	 •	Lasso MySQL Error Codes contains a list of all error codes which are generated by Lasso MySQL or 
another MySQL data source.

	 •	FileMaker Pro Error Codes contains a list of known error codes which are generated by FileMaker Pro 
when used as a data source.

In addition to the error codes described in this appendix, Lasso Professional 8 will report any unknown errors 
it receives from the operating system, Web server applications, or data source applications it communicates 
with. Please consult the documentation for the operating system and each application for more information 
about the error codes they may report.

For information about how to gracefully handle and recover from errors, please see the Error Control chapter.

Lasso Professional 8 Error Codes
The following Table 1: Lasso Professional Error Codes lists all of the native error codes of Lasso Professional 
8. The error codes are listed in numerical order and are divided into general categories for easier reading. 
Many of the error codes descriptions contain helpful information about what to do to correct or prevent the 
error.
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Table 1: Lasso Professional 8 Error Codes

Error Code	 Description	

0	 No Error.

-609	 The specified database was not found. Lasso could not find the specified 
database. This error usually occurs when a database is not open or not 
accessible by Lasso. Make sure the specified database is open.

-700	 Could not find email Lasso page. The Lasso page specified by an -Email.Format 
command tag could not be found. Check the spelling of  the file name. Make sure 
the path to the file is specified properly.

-701	 All email tags must be assigned a value. In order for an email message to be 
sent, all five of  the email parameters (-Email.Host, -Email.From, -Email.To,  
-Email.Subject, and -Email.Format) must be specified. Make sure you have 
specified values for all five parameters in your HTML form. Make sure the 
parameter names are spelled correctly.

Database Errors		

-800	 Value missing for required field. The value of  one or more required field was not 
specified. Make sure that all required fields are supplied with a value.

-801	 Repeating related fields are not supported. An attempt to retrieve data from 
a repeating related field failed. Lasso does not support retrieving data from 
repeating related fields.

-802	 Action not supported. The specified Lasso action is not supported by the 
specified database or data source.

-1712	 Timeout. A database action timed out.

-1728	 No records found. No records were found in the specified database.

-2000	 The module was not found. The requested module was not found. Make sure that 
the module is located in the "Lasso Modules" folder and relaunch the Web server 
and/or Lasso.

-3000	 A data source error has occured.

		  continued
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Syntax Errors		

-9951	 A syntax error occurred. Invalid or incorrect syntax was used. Correct the syntax.

-9952	 A looping tag was aborted.

-9953	 Unknown error.

Internal Errors		

-9954	 A pointer was nil when it should not have been.

-9955	 Overflow: Some memory passed to a function that was too small to hold the 
results.

-9956	 An invalid parameter was passed to a function.

Action Errors		

-9957	 Delete error. An error occurred while deleting a record from the specified 
database. Make sure that the database or data source is set to allow record 
deletion.

-9958	 Update error. An error occurred while updating a record from the specified 
database. Make sure that the database or data source is set to allow records to 
be updated.

-9959	 Add error. An error occurred while adding a record to the specified database. 
Make sure that the database or data source is set to allow records to be added.

-9960	 Field restriction. A field security restriction prevented the action from being 
executed. Edit field security restrictions as configured within Lasso security.

Security Errors		

-9961	 No permission. The current user is not allowed to perform the specified action. 
This could mean that a file suffix is not allowed by Lasso security. Edit user 
security permissions as configured within Lasso security.

-9962	 Invalid database. The database or data source name is not valid.

-9963	 Invalid password. The password supplied is not valid.

-9964	 Invalid user name. The user name supplied is not valid.

-9965	 Network error. An error occurred accessing the network connection. This error 
usually occurs while communicating with FileMaker Pro over TCP/IP. Try quitting 
and restarting the FileMaker Pro client.

-9966	 Resource error.

-9967	 Resource not found.

		  continued
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File Errors		

-9968	 Could not read from file.

-9969	 Could not write to file.

-9970	 End of  file reached.

-9971	 Beginning of  file reached.

-9972	 File is closed.

-9973	 File already open with write permission.

-9974	 File Unlocked.

-9975	 File locked.

-9976	 Invalid filename.

-9977	 Invalid pathname.

-9978	 I/O error.

-9979	 Directory full.

-9980	 Disk full.

-9981	 Volume does not exist.

-9982	 The file is corrupt.

-9983	 File already exists.

-9984	 Unauthorized file suffix or file not found.The error -9984 can be seen if  you 
specify a Lasso page with a file suffix which is not included in the Lasso Security 
settings. Also returned by file management tags.

-9985	 Could not delete file.

-9986	 Could not close file.

-9987	 Could not create or open file.

-9988	 Invalid access mode.

-9990	 File error.

		  continued

Memory Errors		

-9991	 Could not dispose memory.

-9992	 Could not unlock memory.

-9993	 Could not lock memory.

-9994	 Lasso ran out of  stack space. This error may occur when a Lasso page contains 
too many deeply nested container tags. The [Variable] tag can be used in order to 
significantly reduce the number on nested tags in a Lasso page.

-9995	 Lasso ran out of  memory. Increase the memory which is available to the server 
running Lasso.

-9996	 Invalid memory object.

-9997	 Memory error.

-9998	 Error writing to stream.

-9999	 Error reading from stream.
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Lasso MySQL Error Codes
All of the known error codes in Lasso MySQL are listed in Table 2: Lasso MySQL Error Codes. Additional 
error codes may be reported if Lasso MySQL encounters an operating system error. If Lasso receives one of 
these error codes from Lasso MySQL or another MySQL data source then it will be passed on to the site 
visitor.

Table 2: Lasso MySQL Error Codes

Error Code	 Description	

1	 Operation not permitted.

2	 No such file or directory.

3	 No such process.

4	 Interrupted system call.

5	 Input/output error.

6	 Device not configured.

7	 Argument list too long.

8	 Exec format error.

9	 Bad file descriptor.

10	 No child processes.

11	 Resource deadlock avoided.

12	 Cannot allocate memory.

13	 Permission denied.

14	 Bad address.

15	 Block device required.

16	 Device busy.

17	 File exists.

18	 Cross-device link.

19	 Operation not supported by device.

20	 Not a directory.

21	 Is a directory.

22	 Invalid argument.

23	 Too many open files in system.

24	 Too many open files.

25	 Inappropriate ioctl for device.

		  continued
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26 – 50		

26	 Text file busy.

27	 File too large.

28	 No space left on device.

29	 Illegal seek.

30	 Read-only file system.

31	 Too many links.

32	 Broken pipe.

33	 Numerical argument out of  domain.

34	 Result too large.

35	 Resource temporarily unavailable.

36	 Operation now in progress.

37	 Operation already in progress.

38	 Socket operation on non-socket.

39	 Destination address required.

40	 Message too long.

41	 Protocol wrong type for socket.

42	 Protocol not available.

43	 Protocol not supported.

44	 Socket type not supported.

45	 Operation not supported.

46	 Protocol family not supported.

47	 Address family not supported by protocol family.

48	 Address already in use.

49	 Can't assign requested address.

50	 Network is down.

		  continued
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51 – 75		

51	 Network is unreachable.

52	 Network dropped connection on reset.

53	 Software caused connection abort.

54	 Connection reset by peer.

55	 No buffer space available.

56	 Socket is already connected.

57	 Socket is not connected.

58	 Can't send after socket shutdown.

59	 Too many references: can't splice.

60	 Operation timed out.

61	 Connection refused.

62	 Too many levels of  symbolic links.

63	 File name too long.

64	 Host is down.

65	 No route to host.

66	 Directory not empty.

67	 Too many processes.

68	 Too many users.

69	 Disc quota exceeded.

70	 Stale NFS file handle.

71	 Too many levels of  remote in path.

72	 RPC struct is bad.

73	 RPC version wrong.

74	 RPC prog. not avail.

75	 Program version wrong.

		  continued
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76 – 150		

76	 Bad procedure for program.

77	 No locks available.

78	 Function not implemented.

79	 Inappropriate file type or format.

80	 Authentication error.

81	 Need authenticator.

82	 Device power is off.

83	 Device error.

84	 Value too large to be stored in data type.

85	 Bad executable (or shared library).

86	 Bad CPU type in executable.

87	 Shared library version mismatch.

88	 Malformed Mach-O library file.

120	 Didn't find key on read or update.

121	 Duplicate key on write or update.

123	 Someone has changed the row since it was read.

124	 Wrong index given to function.

126	 Index file is crashed / Wrong file format.

127	 Record-file is crashed.

131	 Command not supported by database.

132	 Old database file.

133	 No record read before update.

134	 Record was already deleted (or record file crashed).

135	 No more room in record file.

136	 No more room in index file.

137	 No more records (read after end of  file).

138	 Unsupported extension used for table.

139	 Too big row (>= 16 M).

140	 Wrong create options.

141	 Duplicate unique key or constraint on write or update.

142	 Unknown character set used.

143	 Conflicting table definition between MERGE and mapped table.

144	 Table is crashed and last repair failed.

145	 Table was marked as crashed and should be repaired.
		

FileMaker Pro Error Codes
All of the known error codes for the FileMaker Pro Web Companion as of FileMaker Pro 5.5v3 are listed in 
Table 3: FileMaker Pro Error Codes. Additional error codes may be reported if FileMaker Pro encounters an 
operating system error. If Lasso receives one of these error codes from a FileMaker Pro data source, it will be 
passed on to the site visitor.
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Table 3: FileMaker Pro Error Codes

Error Code	 Description	

-1	 Unknown Error.

0	 No Error.

1	 User cancelled action.

2	 Memory error.

3	 Command is unavailable.

4	 Command is unknown.

5	 Command is invalid.

100 – 199		

100	 File is missing.

101	 Record is missing.

102	 Field is missing.

103	 Relation is missing.

104	 Script is missing.

105	 Layout is missing.

200 – 299		

200	 Record access is denied.

201	 Field cannot be modified.

202	 Field access is denied.

203	 No records in file to print or password doesn't allow print access.

204	 No access to field(s) in sort order.

205	 Cannot create new records; import will overwrite existing data.

		  continued

300 – 399		

300	 The file is locked or in use.

301	 Record is in use by another user.

302	 Script definitions are in use by another user.

303	 Paper size is in use by another user.

304	 Password definitions are in use by another user.

305	 Relationship or value list definitions are locked by another user.

400 – 499		

400	 Find criteria is empty.

401	 No records match the request.

402	 Not a match field for a lookup.

403	 Exceeding maximum record limit for demo.

404	 Sort order is invalid.

405	 Number of  records specified exceeds number of  records that can be omitted.

406	 Replace/Reserialize criteria is invalid.

407	 One or both key fields are missing (invalid relation).

408	 Specified field has inappropriate data type for this operation.

409	 Import order is invalid.

410	 Export order is invalid.

411	 Cannot perform delete because related records cannot be deleted.

412	 Wrong version of  FileMaker Pro used to recover file.

		  continued
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500 – 599		

500	 Date value does not meet validation entry options.

501	 Time value does not meet validation entry options.

502	 Number value does not meet validation entry options.

503	 Value in field does not meet range validation entry options.

504	 Value in field does not meet unique value validation entry options.

505	 Value in field failed existing value validation test.

506	 Value in field is not a member value of  the validation entry option value list.

507	 Value in field failed calculation test of  validation entry option.

508	 Value in field failed query value test of  validation entry option.

509	 Field requires a valid value.

510	 Related value is empty or unavailable.

600 –699		

600	 Print error has occurred.

601	 Combined header and footer exceed one page .

602	 Body doesn't fit on a page for current column setup .

603	 Print connection lost.

700 – 799		

700	 File is of  the wrong file type for import.

701	 Data Access Manager can't find database extension file.

702	 Data Access Manager was unable to open the session.

704	 Data Access Manager failed when sending a query.

705	 Data Access Manager failed when executing a query.

706	 EPSF file has no preview image.

707	 Graphic translator can not be found.

708	 Can't import the file or need color computer.

709	 QuickTime movie import failed.

710	 Unable to update Quicktime file reference, read-only.

711	 Import Translator can not be found.

712	 XTND version is incompatible.

713	 Couldn't initialize the XTND system.

714	 Insufficient password privileges to allow the operation.

		  continued
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800 – 899		

800	 Unable to create file on disk.

801	 Unable to create temporary file on System disk.

802	 Unable to open file .

803	 File is single user or host cannot be found .

804	 File cannot be opened as read-only in its current state .

805	 File is damaged; use Recover command.

806	 File cannot be opened with this version of  FileMaker Pro.

807	 File is not a FileMaker Pro file or is severely damaged .

808	 Cannot open file because of  damaged access privileges 

809	 Disk/volume is full.

810	 Disk/volume is locked.

811	 Temporary file cannot be opened as FileMaker Pro file.

812	 Cannot open the file because it exceeds host capacity.

813	 Record Synchronization error on network.

814	 File(s) cannot be opened because maximum number is open.

815	 Couldn't open lookup file.

816	 Unable to convert file.

900 – 999		

900	 General spelling engine error.

901	 Main spelling dictionary not installed.

902	 Could not launch the Help system.

903	 Command cannot be used in a shared file.

904	 Command can only be used in a file hosted under FileMaker Server.

950	 Adding repeating related fields is not supported.

951	 An unexpected error occurred.

971	 The user name is invalid.

972	 The password is invalid.

973	 The database is invalid.

974	 Permission denied.

975	 The field has restricted access.

976	 Security is disabled.

977	 Invalid client IP address (FileMaker Pro 5.x only).

978	 The number of  allowed guests has been exceeded (FileMaker Pro 5.x only).
		

JDBC Error Codes
All error codes specific to JDBC data sources are listed in Table 4: JDBC Error Codes. Additional error codes 
may be reported if the JDBC data source encounters an operating system error. If Lasso receives one of these 
error codes from a JDBC data source, it will be passed on to the site visitor.

Table 4: JDBC Error Codes

Error Code	 Description	

-11000 	 Invalid Token Error. Invalid Lasso state token passed from Java.

-10999 	 Null Parameter Error. One of  the required parameters was Null.
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Appendix B

Copyright Notice

Copyright © 1996-2007 LassoSoft, LLC.

This copyright notice applies to all source code, examples and documentation provided in the Lasso 8 
Language Guide provided in the Lasso Professional 8 software product from LassoSoft, LLC.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the “Software”), to deal in the Software without restriction, including without limitation 
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and 
to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions 
of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE X CONSORTIUM BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, 
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE 
USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of LassoSoft, LLC. shall not be used in advertising or otherwise 
to promote the sale, use or other dealings in this Software without prior written authorization from 
LassoSoft, LLC.

Lasso, Lasso Professional, Lasso Studio, Lasso Dynamic Markup Language, LDML, Lasso Service, Lasso 
Connector, Lasso Web Data Engine, OmniPilot and OmniPilot Software are trademarks of LassoSoft, LLC.
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Appendix C

Index

Symbols
^

Regular expressions  351
-

Date Subtraction  384
Keyword prefix  81
Mathematical subtraction  365
String deletion  333
Symbol overloading  718

--
Symbol overloading  718

-=
Mathematical subtraction  366
String deletion  333

->
Member symbol  82

,
Tag delimiter  81

;
LassoScript delimiter  55, 59
Tag delimiter  82

:
Naming related fields  178
Tag delimiter  81

!
Boolean not  244

!=
Boolean inequality  244
Mathematical inequality  366
String inequality  334

?
Regular expressions  349
URL delimiter  82

?>
LassoScript delimiter  55

.
Regular expressions  347

‘
String delimiter  81

“
HTML delimiter  82

( )
Regular expressions  349

[ ]
Regular expressions  347
Tag delimiter  81

{ }
Compound expressions  59, 582
Compound Expressions  82

Regular expressions  349
@  232

References  230
*

Mathematical multiplication  365
Regular expressions  349
String repetition  333
Symbol overloading  718

*=
Mathematical multiplication  366
String repetition  333

/
Mathematical division  365
Symbol overloading  718
URL delimiter  82

//
LassoScript  55
LassoScript comment  82

/=
Mathematical division  366

\
Escape Character  497
Line Endings  323, 434
Regular Expressions  347

&
URL delimiter  82

&&
Boolean and  244

#  229, 693
URL delimiter  82

%
Mathematical modulus  365
Symbol overloading  718

%=
Mathematical modulus  366

+
Date Addition  384
Mathematical addition  365
Regular expressions  349
String concatenation  333
Symbol overloading  718

++
Symbol overloading  718

+=
String concatenation  333

<
HTML delimiter  82
Mathematical less than  366
String order  334

<=

8 3 5

L a s s o  8 . 5  L a n g u a g e  G u i d e

A p p e n d i x  C  –  I n d e x



Mathematical less than or equal  366
String order  334

=
Mathematical assignment  366
Parameter delimiter  81
URL delimiter  82
Variable assignment  223

==
Boolean equality  244
Mathematical equality  366
String equality  334

>
Mathematical greater than  366
String order  334

>=
Mathematical greater than or equal  366
String order  334

>>
String contains  333
Symbol overloading  717

|
Regular expressions  349

||
Boolean or  244
Logical expressions  80

$
Page variable  223
Regular expressions  351

<?LassoScript  55
[Net_WaitTimeout]  461
-Schema  195
-Table  109
#TOKEN#  596

A
Abbreviation  69
[Abort]  243
Absolute Paths  47
Accessing PDF File Information  491
Action Errors  257
Action.Lasso  42, 678

HTML forms  95
Paths  47

Action Methods  41
[Action_Param]  98

Database searches  119
Inline actions  94

Action Parameters  98
[Action_Params]  98

Displaying the current action parameters  99
HTML forms  94
Inline actions  94
Linking to data  135
Results schema  100

[Action_Statement]  91, 98
-Add  141

Requirements  143
Adding Content to Table Cells  503
Adding Records  143

Classic Lasso  142
FileMaker Pro  144
Security  142
Using an HTML form  145
Using an inline  144
Using a URL  145

[Admin_ChangeUser]  555

[Admin_CreateUser]  555
[Admin_GroupAssignUser]  555
[Admin_GroupListUsers]  555
[Admin_GroupRemoveUser]  555
Administration Tags  555
[Admin_LassoServicePath]  556
[Admin_ListGroups]  555
[Admin_RefreshSecurity]  556
[Admin_ReloadDatasource]  556
[Admin_UserListGroups]  556
AND  121

Performing an and search  121
[Array]  390
[Array]  214
[Array->Contains]  390
[Array->Difference]  391
[Array->Find]  391
[Array->FindPosition]  391
[Array->First]  391
[Array->ForEach]  391
[Array->Get]  240, 391
[Array->Insert]  391
[Array->InsertFirst]  391
[Array->InsertFrom]  391
[Array->InsertLast]  391
[Array->Intersection]  391
[Array->Iterator]  391
[Array->Join]  391
[Array->Last]  391
[Array->Merge]  391

Parameters  395
Array Parameters  98
[Array->Remove]  391
[Array->RemoveAll]  391
[Array->RemoveFirst]  391
[Array->RemoveLast]  391
[Array->Reserve]  391
[Array->Reverse]  391
[Array->ReverseIterator]  391
Arrays  74, 386, 389

Automatic string casting  332
Compressing an array  552
Converting a string to an array  344
Creating  390
Creating an empty array  390
Creating a pair array  397
Finding an element  396
Finding a pair within an array  397
Getting an element  392
Getting the size  392
Inserting an element  393
Iterating through an array  392
Joining into a string  394
Looping through an array  392
Members tags  390
Merging arrays  395
Pair arrays  397
Passing values into an inline  98
Removing an element  394
Setting an element  393
Sorting  398
Types  389

[Array->Second]  392
[Array->Size]  392
[Array->Size]  240
[Array->Sort]  392
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[Array->SortWith]  392
[Array->Union]  392
Asynchronous Tags  698

Accessing variables  699
Calling custom tags  699
Creating background processes  699

Attachments  612
[Auth]  554
[Auth_Admin]  554
Authentication  32

B
Background Processes  699
Barcodes  507
Base 64 Encoding  248
Binary Formats  45
Binary Operations  369
Bit Operations  369
Blowfish  546

Seeds  547
Storing data securely  547

[Boolean]  214, 243
Data Type  243
False  243
Symbols  244
True  243

Boolean Operations  369
bw  120
Byte Order Mark  40
[Bytes]  214, 359
[Bytes->Append]  360
[Bytes->BeginsWith]  360
[Bytes->Contains]  360
[Bytes->EndsWith]  360
[Bytes->ExportString]  360
[Bytes->Find]  360
[Bytes->Get]  359
[Bytes->GetRange]  359
[Bytes->ImportString]  360
[Bytes->Position]  360
[Bytes->Remove]  360
[Bytes->RemoveLeading]  360
[Bytes->RemoveTrailing]  360
[Bytes->Replace]  360
[Bytes->SetPosition]  360
[Bytes->SetRange]  360
[Bytes->SetSize]  359
[Bytes->Size]  359
[Bytes->Split]  360
[Bytes->SwapBytes]  360
[Bytes->Trim]  360
Bytes Types  359

C
[Cache]  624
[Cache_Delete]  627
[Cache_Empty]  627
[Cache_Exists]  627
[Cache_Fetch]  627
[Cache_Store]  627
Caching  624
Callback Tags  711
[Case]  237
Casting

String  332

Cellular Phones  652
CGI  615
Character Encoding  40, 116, 141
character set  629
Character Sets  30
Check Boxes  166
[Checked]  163, 184

Displaying selected values  187
Cipher Tags  549
Classic Lasso

Adding records  142
Database searches  117
Deleting records  142
Tokens  96
Updating records  142

[Client_Address]  632
[Client_Browser]  632
[Client_ContentLength]  631
[Client_ContentType]  631
[Client_CookieList]  621
[Client_Cookies]  621
[Client_FormMethod]  631
[Client_GETArgs]  631
[Client_GETParams]  631
[Client_Headers]  631
[Client_IP]  632
[Client_Password]  631
[Client_POSTArgs]  631
[Client_PostParams]  701
[Client_POSTParams]  631
Client Tags  632
[Client_Type]  632
[Client_URL]  632
[Client_Username]  631
cn  120
Color

Creating a random color  372
Command Tags  66

Action tags  92
Email sending tags  591

Comments
LassoScript  54, 56

Comparators  388, 420
Complex Expressions  79
Compound Data Types  386

Common Tags  388
How to Select  387

Compound Expressions  582
Evaluation rules  59, 582
Running compound expressions  59, 582
Tag data type  579

[Compress]  551
Compression  551

Compressing an array  552
Compressing a string  551

Conditional Expressions  79
Symbols  80

Conditional Logic  233
Complex conditionals  235
If else conditionals  234
Iterations  241
Loops  238
Nested conditionals  235
Select statements  237
While loops  242

Configuration Tags  564
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Connection Parameters  747, 781
Connection URL  747, 781
Container Fields  188
Container Tags  65

Defining  695
Encoding  695
LassoScript  54, 56
Link tags  132

[Content_Body]  563
[Content_Encoding]  563
[Content_Header]  563, 629
Content Type  629
[Content_Type]  29, 30, 629

Serving images and multimedia  454
Serving WML  653
XML data  480

Control Tags  553
[Cookie]  621
Cookies  31, 621

Checking for cookie support  624
Retrieving cookies  623
Setting cookies  621

[Cookie_Set]  621
Parameters  622

Creating Barcodes  507
Creating PDF Documents  487, 490
Creating Tables  502
Creating Text Content  492
Credit Cards

Checking whether a number is valid  588
Criteria  694
[Currency]  373
Custom Error Pages  258

Defining  261
Testing  261

Custom Errors
Using the [Protect] … [/Protect] tags  268

Custom Tags  683
Creating background processes  699
Criteria  694, 702
Defining asynchronous tags  698
Defining container tags  695
Defining process tags  687
Defining substitution tags  687
Encoding  688, 695
Error control  694
Getting a parameter value  691
Inspecting parameters  691
Libraries  703
Local variables  693
Named parameters  689, 691
Naming conventions  684
Optional parameters  689
Overloading  700
Page variables  693
Parameters  689
Parameters array  690
Parameters of the calling tag  692
Possible uses  684
Priority  701
Redefining  700
Referencing LassoApp Files  679
Remote procedure calls  696
Required parameters  689
Returning values  687, 688
Tag data type  579

Tags  685
Unnamed parameters  689, 692
Using global variables  229
Using references  232
XML-RPC  637, 649

Custom Types  705
Assignment tags  719
Automatic type conversions  713
Callback tags  711
Calling custom member tags  710
Comparison tags  716
Contains tag  717
[Define_Type]  707
Defining a >> callback  718
Defining an onAssign callback  720
Defining an onCompare callback  717
Defining an onConvert callback  713
Defining an onCreate callback  713, 715
Defining an onDestory callback  714
Defining an unknown tag callback  715
Defining a Type  707
Defining custom member tags  710
Destructor tags  714
Inheritance  721
Initialization tags  712
Instance variables  707
Libraries  722
Member tags  709
Naming conventions  705
Symbol overloading  715, 718, 720
Tag module code  772
Tag module walk-through  776
Tags  706
Unknown tags  714

D
-Database  109, 114
Database Actions  92

Action parameters  98
Displaying the current parameters  99
Error codes  824
FileMaker Pro error codes  830
Finding all records  93
HTML forms  94
Inline method  90
JDBC error codes  833
Lasso MySQL error codes  827
Response tags  95
Results  101
Searching for records  93
Tags  92
Tokens  96

DatabaseBrowser.LassoApp  673
Database Errors  257
[Database_FMContainer]  188
[Database_Name]  98
[Database_NameItem]  105
[Database_Names]  105
[Database_Names] … [/Database_Names]

Listing available databases  105
[Database_RealName]  109, 110
Databases

Listing available databases  105
Listing fields  106
Required fields  107

Database Schema
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Showing  104
[Database_SchemaNameItem]  195
[Database_SchemaNames]  195
Database Searches  115

Classic Lasso  117
Complex queries  122
Detail links  138
Displaying data  127
Displaying results from a named inline  128
Displaying results out of order  129
Displaying search results  128
Error reporting  116
Field operators  120
Finding all records  125
Finding random records  126
HTML forms  119
Limiting returned fields  125
Linking to data  129
Logical operators  121
Manipulating the found set  123
Navigation links  135
Operators  119
Performing a logical not search  122
Random sorting  127
Results  123
Returning part of a found set  124
Returning unique field values  126
Searching records  118
Security  117
Security command tags  117
Sorting links  137
Sorting results  123, 124
Specifying field operators  120
Specifying username and password  117
Using a logical and operator  121
Using a logical or operator  121
Using inline tags  118

[Database_TableNameItem]  105
[Database_TableNames]  105
[Database_TableNames] … [/Database_TableNames]

Listing available tables  106
Data Output  207
Data Source Connector Code  782
Data Source Connector Operation  747, 781
Data Source Connector Tutorial  748, 782
Data Source Connector Walk-Through  790
Data Source Host  747, 781
Data Type

Boolean  243
Data Type Operation  771
Data Types  213

Casting  215, 216
Custom member tags  709
Decimal  364
Integer  363
Member tags  709
Returning the type of a variable  562
XML  466
XML-RPC  636

Data Type Tutorial  771
[Date]  214, 376
[Date_Add]  382
[Date->Add]  383
Date Data Type  374
[Date->Day]  380
[Date->DayofWeek]  380

[Date->DayofYear]  380
[Date_Difference]  382
[Date->Difference]  383
[Date->DST]  380
[Date_Format]  376
[Date->Format]  379
Date Format Symbols  377, 379
[Date_GetLocalTimeZone]  376
[Date->GMT]  380
[Date_GMTToLocal]  376
[Date->Hour]  380
[Date_LocalToGMT]  376
Date Math Symbols  384
Date Math Tags  382, 383
[Date_Maximum]  376
[Date->Millisecond]  380
[Date_Minimum]  376
[Date->Minute]  380
[Date->Month]  380
[Date_Msec]  376
Dates  73, 374

Accessors  379
Formatting  377
Math Operations  382, 384

[Date->Second]  380
[Date->Set]  379
[Date_SetFormat]  376
[Date->SetFormat]  379
[Date_Subtract]  382
[Date->Subtract]  383
Date Tags  375
[Date->Time]  380
[Date->Week]  380
[Date->Year]  380
Daylight Savings Time  374, 382
[Decimal]  214, 364
Decimals  73, 364

Assignment symbols  366
Automatic string casting  332
Casting  364
Comparing values  367
Comparison symbols  366
Formatting  367
Formatting as currency  368
Member tags  367
Random numbers  371
Rounding values  371
Scientific notation  367
Substitution tags  370
Trignometry  372
Using assignment symbols  366
Using mathematical symbols  365

[Decimal->SetFormat]  367
Parameters  367

[Decode_Base64]  249
[Decode_BHeader]  249
[Decode_Hex]  249
[Decode_HTML]  249, 250
[Decode_QHeader]  250
[Decode_QuotedPrintable]  250
[Decode_URL]  250
[Decompress]  551
[Define_Tag]  685, 706

Asynchronous tags  699
Container tags  695
Criteria  694, 702

8 3 9

L a s s o  8 . 5  L a n g u a g e  G u i d e

A p p e n d i x  C  –  I n d e x



Defining custom member tags  710
Parameters  686
Priority  701
RPC  696
XML-RPC  637, 649

[Define_Type]  706
Defining a type  707

-Delete  141
Requirements  150

Deleting Records  150
Classic Lasso  142
Deleting several records  151
Security  142
Using an inline tag  151

Delimiters  81
LassoScript  55

[Deserialize]  550
Detail Links  129

Inline Lasso  138
Displaying data  127
-Distinct  123, 160
Documentation  25
Documentation Conventions  26
Document Type Definition  465, 466
Domain Name Server  587
Downloading Files  619, 620
Drawing Graphics Direct to PDF Pages  506
DTD  466
-Duplicate  141

Requirements  152
Duplicating Records  152

Using an inline tag  153
[Duration]  381
[Duration]  214
Duration Data Type  374
[Duration->Day]  381
[Duration->Hour]  381
Duration Math Tags  383
[Duration->Minute]  381
[Duration->Month]  381
Durations  74, 374

Math Operations  382, 384
[Duration->Second]  381
Duration Tags  380
[Duration->Week]  381
[Duration->Year]  381

E
[Else]  234

Complex conditionals  235
Email  590

Attachments  595, 612
Command tags  591
Composing  599
Downloading  604
HTML  593
Multiple recipients  593
Parsing  607
Examples  609
POP  604
Queuing  599, 600
Sending  591
Sending a message  592
SMTP  602
Structure  607

[Email_Batch]  600

[Email_Compose]  600
[Email_Compose->AddAttachment]  600
[Email_Compose->AddHTMLPart]  600
[Email_Compose->AddPart]  600
[Email_Compose->AddTextPart]  600
[Email_Compose->Data]  600
[Email_Compose->From]  600
[Email_Compose->Recipients]  600
[Email_Extract]  614
[Email_FindEmails]  614
[Email_Immediate]  600
[Email_Merge]  601
[Email_MXLookup]  602
[Email_Parse]  609

Attachments  612
[Email_Parse->Body]  609
[Email_Parse->Data]  609
[Email_Parse->Get]  609
[Email_Parse->Header]  609
[Email_Parse->Headers]  609
[Email_Parse->Mode]  609
[Email_Parse->RawHeaders]  609
[Email_Parse->Recipients]  609
[Email_Parse->Size]  609
[Email_POP]  605

Attachments  612
[Email_POP->Authorize]  605
[Email_POP->Cancel]  605
[Email_POP->Close]  605
[Email_POP->Delete]  605
[Email_POP->Get]  605
[Email_POP->Headers]  605
[Email_POP->NOOP]  605
[Email_POP->Retrieve]  605
[Email_POP->Size]  605
[Email_POP->UniqueID]  605
[Email_Queue]  600
[Email_Result]  599
[Email_SafeEmail]  614
[Email_Send]  591

Parameters  592, 598
[Email_SMTP]  602
[Email_SMTP->Close]  602
[Email_SMTP->Command]  602
[Email_SMTP->Open]  602
[Email_SMTP->Send]  602
[Email_Status]  599
Email Tags  280
[Email_Token]  596
[Email_TranslateBreaksToCRLF]  614
[Encode_Base64]  250
[Encode_Break]  250

HTML encoding  247
-EncodeBreak  248

HTML encoding  247
[Encode_CRC32]  250
[Encode_HTML]  250

HTML encoding  247
-EncodeHTML  248

Default encoding  246
HTML encoding  247

[Encode_HTMlToXML]  250
-EncodeNone  248
[Encode_QHeader]  250
[Encode_QuotedPrintable]  250
[Encode_Set]
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Encoding for WML  654
Setting encoding within a LassoScript  54, 57

[Encode_Set] … [/Encode_Set]  249
Setting default encoding  249

-EncodeSmart  248
HTML encoding  247

[Encode_Smart]  250
HTML encoding  247

[Encode_SQL]  110, 250
[Encode_SQL92]  110, 250
[Encode_StrictURL]  250

URL encoding  248
-EncodeStrictURL  248

URL encoding  248
[Encode_URL]  250

URL encoding  247
-EncodeURL  248

URL encoding  247
[Encode_XML]  250

XML encoding  247
-EncodeXML  248

Encoding for WML  654
XML encoding  247

Encoding  246
Base 64 encoding  248
Container tags  695
Controls  249
Custom tags  688
Default encoding  246
HTML  247
HTML encoding  247
Keywords  248
LassoScripts  247
Rules for encoding  246
Substitution tags  246
Tags  249
URL encoding  247
Using encoding tags  250
WML  654
XML  480

Encoding Keywords  71
Encryption  546

BlowFish  546
Cipher Tags  549
MD5 hash function  546
Storing and checking passwords  548
Storing data securely  547

ENUM MySQL Data Type  163
EQ  120
Error Codes  823

FileMaker Pro  830
JDBC  833
Lasso MySQL  827

Error Control  211, 257, 265
Checking for an error  265
Displaying the current error message  263
Executing code if an error is encountered  266
Fail tags  267
Handle tags  266
Outputting debugging messages  266
Post-processing  266
Protecting a portion of a page  268
Protect tags  267
Reporting an error  267
Response tags  262
Setting the current error message  263

Standard error tags  264
Tags  262, 265

[Error_CurrentError]  262
Error Messages  258

Built-In  258
Custom  260

[Error_NoRecordsFound]  265
Error Pages  262

Custom  260
Error Reporting  205

Adding records  142
Checking for an error  116
Database searches  116
Deleting records  142
Displaying the current error  116
Updating records  142

Errors
Types  257

[Error_SetErrorCode]  262
[Error_SetErrorMessage]  262
Event Administration  558
Events  577

Waiting for a signal  577
[Event_Schedule]  558

Parameters  558
Scheduled actions  43

Event Tags  558
EW  120
Example PDF Files  509
Examples

[Ex_Background]  700
[Ex_Bold]  694
[Ex_Concatenate]  692
[Ex_Echo]  691
[Ex_EmailAddress]  687
[Ex_Font]  695
[Ex_Fortune]  647, 696, 698
[Ex_Greeting]  688, 691
[Ex_Link]  695
[Ex_Note]  689, 690
[Ex_Print]  702
[Ex_SendMail]  687, 699
[Ex_Sum]  229, 693
[Ex_TopStories]  697
[Ex_UnnamedParams]  692
[Form_Param]  701

-Exec  114
Expressions  75
Extensible Markup Language  466
Extensible Stylesheet Language  466

F
False  243
[Field]  127, 178

Database searches  119
Displaying results out of order  129
Displaying search results  128
Returning related fields  178

[Field_Name]  105, 240
Listing fields  106
Parameters  106

[Field_Names]  102, 105
Field Operators  120
Fields

Required fields  107
[File]  435
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[File_Chmod]  431
[File->Close]  436
[File_Copy]  431
[File_Create]  431
[File_CreationDate]  431
[File_CurrentError]  431
[File_Delete]  431
[File->Delete]  436
[File_Exists]  431
[File->Get]  436
[File_GetLineCount]  431
[File->GetPosition]  436
[File_GetSize]  431
[File_IsDirectory]  431
[File->IsOpen]  437
[File_ListDirectory]  431
FileMaker

Container Fields  188
FileMaker Pro  168

Adding a record through a portal  180
Adding a record with repeating fields  182
Adding records  144
Checking for databases  175
Compatibility tips  171
Deleting a record through a portal  181
Deleting repeating field values  183
Displaying a value list  185
Displaying data  178
Duplicating a record  152
Error codes  830
Executing a script  190
Field operators  120
Key fields  176
Listing databases  175
Logical operators  121
Performance tips  170
Portals  179
Record IDs  176
Referencing a record by ID  176
Related fields  178
Repeating fields  182
Returning a random record  127
Returning the current record ID  176
Returning values from a repeating field  182
Scripts  189
Sorting records  177
Terminology  169
Updating a record within a portal  180
Updating a record with repeating fields  183
Value lists  184
XML templates  481

FileMaker Server Advanced
-LayoutResponse  96, 171
-NoValueLists  123, 171, 184

[File_ModDate]  431
[File_Move]  431
[File->MoveTo]  436
[File->Name]  436
[File->Open]  436
[File->Path]  436
File Permissions  443
[File_ProbeEOL]  431
[File_Read]  431
[File->Read]  436
[File_ReadLine]  432
[File_Rename]  432

Files  428
Error codes  826
Management  45
Paths  29, 428
Security  430
Tags  428

[File_Serve]  440
[File->SetMode]  436
[File->SetPosition]  436
[File_SetSize]  432
[File->SetSize]  436
[File->Size]  436
[File_Stream]  440
[File_StreamCopy]  431
File Suffixes  211, 430
File Uploads  438
[File_Uploads]  439
[File_Write]  432
[File->Write]  436
-FindAll  115

Inline action  93
Requirements  125

-FMScript  189
-FMScriptPre  189
-FMScriptPreSort  189
Format Files  38, 204

Action methods  41
Character Encoding  40
Editing  40
File management  45
Functional types  40
HTML form actions  42
Inline actions  42
Naming  40
Output formats  44
Post-processing  266
Scheduled actions  43
Securing  44
Specificing paths  46
Startup actions  43
Storage types  39
Unicode  40
URL actions  41

[Form_Param]
Redefining  701

Form Parameters  219
Forms  219
Form Tags

Preparing LassoApps  678
[Found_Count]

Displaying the current found count  102
FT  120, 159
FTP  619
[FTP_GetFile]  620
[FTP_GetListing]  620
[FTP_PutFile]  620
Full-Text Search  159

G
GET Method  34
GIF

Serving image files  454
[Global]  226
[Global_Defined]  226
[Global_Remove]  226
[Globals]  226
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Global Variables  226
Defining at startup  226
Overriding a value  227
Retrieving a value  227
Setting a value  227
Using within custom tags  229

GroupAdmin.LassoApp  673
-GroupBy  160
GT  120
GTE  120

H
[Handle] … [/Handle]  266
[Header] … [/Header]  629
Header Tags  629
Hexadecimals  369

Creating a random color  372
Host Name  28

Looking up an IP address  587
HTML  466

Email  593
Encoding  247
Output formats  44

[HTML_Comment]  207
HTML Delimiters  82
HTML Format Files  39
HTML Forms  34

Actions  42
Adding a record  145
Creating a pop-up menu  185
Creating radio buttons  186
Executing a FileMaker Pro script  190
Format files  95
GET method  34
Inline actions  93
Input syntax  58
POST method  35
Response tags  95
Searching databases  119
Setting values  96
Updating a record  147

HTTP  619
HTTP Content and Controls  615
HTTP Delimiters  82
[HTTP_GetFile]  619
HTTP Requests  29
HTTP Responses  29
HTTPS  615, 617
HyperText Markup Language  466

I
[If]  234

Complex conditionals  235
Error control  235
LassoScript  235
Nested conditionals  235

Illegal Characters  83
[Image]  443, 444
[Image->AddComment]  446
[Image->Annotate]  450
[Image->Blur]  449
[Image->Comments]  445
[Image->Composite]  451
[Image->Contrast]  448
[Image->Crop]  447

[Image->Depth]  445
[Image->Describe]  445
[Image->Enhance]  449
[Image->File]  445
[Image->FlipH]  447
[Image->FlipV]  447
[Image->Format]  445
Image Formats  443
image/gif  454
[Image->Height]  445
image/jpeg  454
ImageMagick  442
[Image->Modulate]  448
[Image->Pixel]  445
[Image->ResolutionH]  445
[Image->ResolutionV]  445
[Image->Rotate]  447
Images  442

Generating the path to a file  453
MIME types  454
Serving an image file  454

[Image->Scale]  447
[Image->Sharpen]  449
Image Tags

Preparing LassoApps  678
[Image->Width]  445
[Include]

Preparing LassoApps  678
[Include]  212
[Include_CurrentPath]  631
[Include_Once]  212
Include Paths  211
[Include_Raw]

Serving images and multimedia  454
[Include_Raw]  212
Includes  210
[Include_URL]  616

Parameters  616
Include URLs  615
Index  835
Inheritance  721
[Inline]  430
[Inline] … [/Inline]  90

Action parameters  98
Actions  42
Adding a record  144
Array parameters  98
Checking for an error  265
Database actions  90
Deleting a record  151
Deleting several records  151
Displaying results from a named inline  128
Displaying search results  128
Duplicating a record  153
Executing a FileMaker Pro script  190
-FindAll action  93
Finding all records  125
HTML forms  94
Linking to data  134
Nesting tags  97
Passing array parameters  98
-Search action  93
Searching databases  118
Specifying field operators  120
Specifying username and password  117
Updating a record  147
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Updating several records  149
Inline Lasso  90

Detail links  138
Navigation links  135
Sorting links  137

Inline Log Level  90
Inline Name  90
-InlineName

Displaying results  128
Inline Tag  90
Installation Problems  258
[Integer]  363
Integer

Substitution tags  370
[Integer]  214
[Integer->BitAnd]  368
[Integer->BitClear]  368
[Integer->BitFlip]  368
[Integer->BitNot]  368
[Integer->BitOr]  368
[Integer->BitSet]  368
[Integer->BitShiftLeft]  368
[Integer->BitShiftRight]  368
[Integer->BitTest]  368
[Integer->BitXOr]  368
Integers  72, 363

Assignment symbols  366
Automatic string casting  332
Bit operations  369
Casting to integer  364
Comparing values  367
Comparison symbols  366
Formatting  368
Formatting as hexadecimals  369
Hexadecimal output  369
Member tags  368
Random numbers  371
Rounding numbers  371
Using assignment symbols  366
Using mathematical symbols  365

[Integer->SetFormat]  368
Parameters  369

IP Address
Looking up a host name  587

ISO 8859-1  294
ISO-8859-1  29, 40, 116, 142, 279
[Iterate]

Implementing for custom types  709
[Iterate] … [/Iterate]  241, 242

Array elements  242
Iterating through a map  402, 418
Iterating through an array  392
String characters  242

Iterators  389, 423
iText  484

J
[Java_Bean]  515
JavaBeans  514
JavaScript

Not processing square brackets  561
JDBC  192

Certification  194
Data sources  192
Error codes  833
Tips for usage  193

JDBC Schema Tags  194
JPEG

Serving image files  454

K
-KeyField

Using with FileMaker Pro  144
Using with MySQL  144

[KeyField_Name]  98
[KeyField_Value]  99

Using with FileMaker Pro  147
Using with MySQL  147

Keywords
Encoding  248

L
Lasso

Converting to LassoScript  57
Format files  39
Tag categories  67
Tag types  62

Lasso 8 Documentation  25
Lasso 8 Reference  84

Components  84
Navigation  85
Sections of the interface  85

Lasso 8 Tag Language  61
Lasso Administration  679, 747, 781
LassoApp

Removing all LassoApps from the cache  675
[LassoApp_Create]

Building LassoApps  680
Parameters  680

[LassoApp_Link]  675
Preparing <form> Tags  678
Preparing <img> Tags  678
Preparing [Include] Tags  678
Preparing [Library] Tags  678
Preparing Links  677
Preparing [Link_…] Tags  678

LassoApps  672
Administration  674
Auto-Building databases  681
Benefits  672
Building  679
Cache  674
Compiling  679
Database Action Responses  676
DatabaseBrowser.LassoApp  673
Defaults  673
Disabling  674
Enabling  674
GroupAdmin.LassoApp  673
Lasso Administration  674
Lasso Security  681
Lasso Startup  682
Lasso Startup folder  677
LDMLReference.LassoApp  674
Naming conventions  681
Preloading  675
Preparing links  677
Preparing solutions  677
Referencing files within a LassoApp  676
Removing a LassoApp from the cache  674
RPC.LassoApp  646, 674, 696
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Run-time errors  681
Serving  675
Startup.LassoApp  674
Tags  673
Tips and techniques  681
Uses  673
Using the LassoApp Builder  679
Using the [LassoApp_Create] tag  680

[Lasso_CurrentAction]  99
[Lasso_DatasourceIsFileMaker]  564
[Lasso_DataSourceIsFileMaker]  175
[Lasso_DatasourceIsMySQL]  564
[Lasso_DatasourceIsODBC]  564
[Lasso_DatasourceIsOpenBase]  564
[Lasso_DatasourceIsOracle]  565
[Lasso_DatasourceIsPostgreSQL]  565
[Lasso_DatasourceIsSpotlight]  565
[Lasso_DatasourceIsSQLite]  565
[Lasso_DatasourceIsSQLServer]  565
[Lasso_DatasourceModuleName]  565
Lasso_Internal Database  747, 781
Lasso Java API

Debugging  764
Getting started  762
Requirements  762

Lasso MySQL
Error codes  827
Field operators  120
Logical operators  121
Random sorting  127
Returning unique field values  126
SQL encoding  248

[Lasso_Parser]  583
Lasso Parser Token Types  585
Lasso Parser Type  584
LassoScript

Compound expressions  59, 582
LassoScripts

Comments  54, 56
Container tags  54, 56
Converting from square bracket syntax  57
Delimiters  55
Encoding  247
Setting default encoding  54, 57, 249
Single tag  56
Suppressing output  54, 57

Lasso Security
Databases and tables  682
Groups and tables  682
LassoApps  681
Tags  681

Lasso Service  45
Paths  48

Lasso Startup
Defining global variables  226

LassoStartup  699, 701, 704
Lasso Startup Folder  677
[Lasso_TagExists]  565
[Lasso_TagModuleName]  565
[Lasso_UniqueID]  588
[Lasso_Version]  565
Lasso Web Server Connector  45
Latin-1  30, 40, 116, 142, 294
-LayoutResponse  96, 171
[LDML]  583
LDML  205

LDMLReference.LassoApp  674
Leap Years  374
libCURL  616, 619
Libraries  703, 722
[Library]

Preparing LassoApps  678
[Library]  212
Library Files  41, 210
[Library_Once]  212
Line Endings  434
[Link_CurrentAction] … [/Link_CurrentAction]  133

Linking to the current record  138
[Link_CurrentActionURL]  132
[Link_Detail] … [/Link_Detail]  133

Linking to the current record  138
[Link_DetailURL]  132
[Link_FirstGroup] … [/Link_FirstGroup]  133

Creating sort links  137
[Link_FirstGroupURL]  132
[Link_FirstRecord] … [/Link_FirstRecord]  133
[Link_FirstRecordURL]  132
Linking to Data  129

Container tags  132
Tag parameters  130
URL tags  131

Linking to PDF Files  512
[Link_LastGroup] … [/Link_LastGroup]  133
[Link_LastGroupURL]  132
[Link_LastRecord] … [/Link_LastRecord]  133
[Link_LastRecordURL]  132
[Link_NextGroup] … [/Link_NextGroup]  133

Creating next links  135
[Link_NextGroupURL]  132
[Link_NextRecord] … [/Link_NextRecord]  133
[Link_NextRecordURL]  132
[Link_PrevGroup] … [/Link_PrevGroup]  133

Creating previous links  135
[Link_PrevGroupURL]  132
[Link_PrevRecord] … [/Link_PrevRecord]  133
[Link_PrevRecordURL]  132
Link Tags

Preparing LassoApps  678
[List]  398
List Array  389
[List->Contains]  399
[List->Difference]  399
[List->Find]  399
[List->First]  399
[List->ForEach]  399
[List->Insert]  399
[List->InsertFirst]  399
[List->InsertFrom]  399
Lists  386, 398

Members tags  399
Literals  76
LJAPI 6 vs. LCAPI 6  761
LJAPI Class Reference  794
LJAPI Interface Reference  794
[Local]  229, 685, 693, 706

# symbol  229, 693
[Local_Defined]  685, 706
[Locale_Format]  373
[Local_Remove]  686
[Locals]  686, 706
Local Variables  693

# symbol  229, 693
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Lock
Controlling access to a resource  574
Thread lock  574

[Log]  543
[Log_Always]  542
[Log_Critical]  542
[Log_Deprecated]  542
Log_Destination_Console  544
Log_Destination_Database  544
Log_Destination_File  544
[Log_Detail]  542
Logging  541

Changing log destination preferences  544
Destination codes  544
Message level codes  544
Preferences  543
Resetting log destination preferences  544

Logical Errors  258
Logical Expressions  80

Symbols  80
Logical Operators  121

Performing an and search  121
Performing an or search  121
Performing a not search  122

Log_Level_Critical  544
Log_Level_Deprecated  544
Log_Level_Detail  544
Log_Level_SQL  544
Log_Level_Warning  544
[Log_SetDestination]  544
[Log_SQL]  542
[Log_Warning]  542
[Loop] … [/Loop]  239, 240

Array elements  240
Display field names  240
Looping through a map  403, 418
Looping through an array  392
Parameters  239

[Loop_Abort]  239, 240, 243
[Loop_Continue]  240
[Loop_Count]  239, 240, 243
Lower Case

Strings  338
LT  120
LTE  120

M
Mac OS X File Permissions  431
[Map]  401
[Map]  214
Maps  75, 387, 401

Automatic string casting  332
Comparison to pair arrays  404
Creating a map  401, 417
Displaying an element  404, 419
Getting a value  402, 418
Inserting an element  403, 419
Iterating through a map  402, 418
Looping through a map  403, 418
Member tags  402
Removing an element  403, 419

Matchers  389, 421
Math  363

Addition  366
Expressions  78
Scientific notation  367

Symbols  78, 365
Trigonometry  372

[Math_Abs]  370
[Math_ACos]  372
[Math_Add]  370
[Math_ASin]  372
[Math_ATan]  372
[Math_ATan2]  372
[Math_Ceil]  370

Rounding numbers  371
[Math_ConvertEuro]  370
[Math_Cos]  372
[Math_Div]  370
[Math_Exp]  372
[Math_Floor]  370

Rounding numbers  371
[Math_Ln]  372
[Math_Log10]  372
[Math_Max]  370
[Math_Min]  370
[Math_Mod]  370
[Math_Mult]  370
[Math_Pow]  372
[Math_Random]  370

Parameters  371
[Math_RInt]  370

Rounding numbers  371
[Math_Roman]  370
[Math_Round]  370

Rounding numbers  371
[Math_Sin]  372
[Math_Sqrt]  372
[Math_Sub]  370
[Math_Tan]  372
-MaxRecords  109, 123
[MaxRecords_Value]  99
MD5  546
MD5 Hash Function

Storing and checking passwords  548
Member Tags  64, 76, 218, 709

Built-in  709
Custom  709
Decimal tags  367
Integer tags  368

Member Tag Types  219
Memory Session Driver  280
MIME Type

Image files  454
Miscellaneous Tags  587
Multimedia  442

Generating the path to a file  453
MIME types  454
Serving a multimedia file  455

MySQL
Adding and updating records  162
Error codes  827
Field operators  120
Logical operators  121
Random sorting  127
Returning unique field values  126
Search command tags  160
Search field operators  158
Searching records  158
Security  155
SQL encoding  248
Tips for usage  155
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MySQL 4.1 Character Sets  279

N
Named Inlines

Displaying results  128
Name Server  587
[Namespace_Import]  539
[Namespace_Load]  539
Namespaces  537

Scope  537
Search Order  537
Third-Party  538

[Namespace_Unload]  539
[Namespace_Using]  539
Naming Conventions

Custom tags  684, 705
RPC tags  684

Navigation Links  129
Inline Lasso  135

NEQ  120
Nesting Tags  97
[Net->Accept]  461
[Net->Bind]  462, 463
[Net->Close]  460, 462
[Net->Connect]  459, 460
[Net_ConnectInProgress]  459
[Net_ConnectOK]  459
[Net->Listen]  462
[Net->LocalAddress]  458
[Net->Read]  459, 460, 462
[Net->ReadFrom]  463
[Net->ReadString]  459, 460, 462
[Net->RemoteAddress]  458
[Net->SetBlocking]  458
[Net->SetEncoding]  458
[Net->SetType]  458
[Net_TypeSSL]  458
[Net_TypeTCP]  458
[Net_TypeUDP]  458
[Net->Wait]  460
[Net_WaitWrite]  461
[Net->Write]  459, 460, 462
[Net->WriteTo]  463
[NoProcess] … [/NoProcess]  560
NOT  121

Performing a not search  122
-Nothing  98
-NoValueLists  123, 171, 184
NRX  120, 159
[NSLookup]  587
[Null]

Member tags  709
Null

Data type  562
Value  161, 162

[Null]  562
[Null->DetachReference]  232, 709

Detaching a reference  231
[Null->DetachReference]  562
[Null->FreezeType]  709
[Null->FreezeType]  562
[Null->FreezeValue]  709
[Null->FreezeValue]  562
[Null->FullType]  709
[Null->Invoke]  709
[Null->IsA]  709

[Null->onConvert]  712
[Null->onCreate]  712
[Null->onDeserialize]  712
[Null->onDestroy]  712
[Null->onSerialize]  712
[Null->Parent]  709
[Null->Properties]  709
[Null->Properties]

Finding a tag  579
[Null->Properties]  562
[Null->RefCount]  232
[Null->RefCount]  709
[Null->Serialize]  709

Compressing an array  552
[Null->Serialize]  562
[Null->Type]  709
[Null->Type]  213, 562
[Null->_UnknownTag]  712
[Null->Unserialize]  709
[Null->UnSerialize]  562

O
On-Demand Libraries  538
-OpBegin

Complex queries  122
-OpEnd

Complex queries  122
OpenSSL  616
Operating System Errors  258
-Operator  119
-OperatorBegin  119
-OperatorEnd  119
-OperatorLogical  119

Performing an and search  121, 122
[Operator_LogicalValue]  99
Operators

Database searches  119
Field operators  120
Logical operators  121

[Option]  163, 184
Creating a pop-up menu  185

OR  121
Performing an or search  121

[Output]  207
Automatic string casting  332

Output Formats  44
[Output_None]  207

Suppressing LassoScript output  57
Output Suppressing  207
Outputting Values  207

P
Page Variables  563, 693
[Pair]  214
Pair Arrays  389, 397

Comparison to maps  404
Pairs  387, 404

Automatic string casting  332
Creating a pair  404
Displaying an element  405
Getting an element  405
Member tags  405
Setting an element  405

Parameters
Array  690
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Array objects  98
Inspecting  691
Named  689
Optional  689
Required  689
Unnamed  689, 692

[Params]  686, 706
Parameters array  690

[Params_Up]  686, 691
Parameters from calling tag  692

[Parent]  721
-Password  117
Paths

Absolute  47
Action.Lasso  47
Lasso Service  48
Relative  47
Specifying  46

PDF  484
Output Formats  45

[PDF_Barcode]  508
[PDF_Doc]  444, 487
[PDF_Doc->AddChapter]  489
[PDF_Doc->AddCheckBox]  497
[PDF_Doc->AddComboBox]  498
[PDF_Doc->AddHiddenField]  498
[PDF_Doc->AddList]  496
[PDF_Doc->AddPage]  489
[PDF_Doc->AddPasswordField]  497
[PDF_Doc->AddRadioButton]  498
[PDF_Doc->AddRadioGroup]  498
[PDF_Doc->AddResetButton]  498
[PDF_Doc->AddSelectList]  498
[PDF_Doc->AddSubmitButton]  498
[PDF_Doc->AddText]  489, 494
[PDF_Doc->AddTextArea]  497
[PDF_Doc->AddTextField]  497
[PDF_Doc->Circle]  506
[PDF_Doc->Close]  492
[PDF_Doc->CurveTo]  506
[PDF_Doc->DrawArc]  506
[PDF_Doc->DrawText]  495
[PDF_Doc->GetColor]  491
[PDF_Doc->GetHeaders]  491
[PDF_Doc->GetMargins]  491
[PDF_Doc->GetPageNumber]  489
[PDF_Doc->GetSize]  491
[PDF_Doc->InsertPage]  490
[PDF_Doc->Line]  506
[PDF_Doc->Rect]  506
[PDF_Doc->SetColor]  506
[PDF_Doc->SetFont]  491
[PDF_Doc->SetLineWidth]  506
[PDF_Doc->SetPageNumber]  489
[PDF_Font]  492
[PDF_Font->GetColor]  493
[PDF_Font->GetEncoding]  493
[PDF_Font->GetFace]  493
[PDF_Font->GetPSFontName]  493
[PDF_Font->GetSize]  493
[PDF_Font->GetFullFontName]  493
[PDF_Font->GetSupportedEncodings  493
[PDF_Font->IsTrueType]  493
[PDF_Font->SetColor]  493
[PDF_Font->SetEncoding]  493
[PDF_Font->SetFace]  493

[PDF_Font->SetSize]  493
[PDF_Font->SetUnderline]  493
[PDF_Image]  505
PDF, Introduction to Creating PDF Files  443, 484
[PDF_List->Add]  496
[PDF_Read]  485
[PDF_Serve]  513
[PDF_Table]  502
[PDF_Table->GetAbsWidth]  502
[PDF_Table->GetColumnCount]  502
[PDF_Table->GetRowCount]  502
[PDF_Table->Insert]  503
[Percent]  373
Performance Tips

FileMaker Pro  170
Personal Digital Assistants  652
Pipes  577

Processing messages  578
POP  604

Examples  606
Methodology  605

Pop-Up Menu  166
Portable Document Format  484
[Portal] … [/Portal]  178

Returning portal values  179
Portals

Adding a record through a portal  180
Deleting a record through a portal  181
FileMaker Pro  179
Updating a record within a portal  180

Port Number  28
Post-Lasso  41
POST Method  35
Post-Processing  266
Pre-Lasso  40
-Prepare  114
Priority Queue  387, 405

Member Tags  406
[PriorityQueue]  406
[Private]  706
[Process]  560

Processing code stored in a field  561
Processing code stored in a variable  561

Process Tags  63, 560
Defining  687

Programming Fundamentals  204
[Protect] … [/Protect]  267
Protocol  28

Q
[Queue]  409
Queue  387, 408

Member Tags  409

R
-Random  115

Requirements  126
Random Numbers  371
Read/Write Lock  576

Controlling access to a resource  576
Record ID  176
[RecordID_Value]  176
[Records] … [/Records]  127

Database actions  91
Database searches  119
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Displaying results from a named inline  128
Displaying search results  128

[Records_Array]  101, 102
[Records_Map]  101, 103
[Redirect_URL]  618
[Reference]  230, 232
References  230

Detaching a reference  231
Types  231
Using with custom tags  232

[Referrer]  133
[Referrer_URL]  132
Regular Expressions  159

Combination symbols  349, 351
Finding expressions  357
Matching symbols  347
Replacement symbols  350
Replacing expressions  356

Relative Paths  47
Remote Procedure Call  466
Remote Procedure Calls  696

Naming conventions  684
[Repeating] … [/Repeating]  178

Returning values from a repeating field  182
Repeating Fields  182

Adding a record  182
Deleting values  183
Returning values  182
Updatinga a record  183

[Repeating_ValueItem]  178
[Repetition]  240

Two column display  241
Request Tags  631
[Required_Field]  105

Parameters  107
-Response

Action.Lasso  95
-ResponseAnyError  262
[Response_FileExists]  631
[Response_FilePath]  99, 631
-ResponseLassoApp  676
[Response_LocalPath]  631
[Response_Path]  631
[Response_Realm]  631
Response Tags  95

Command tags  96
Error control  262

Results
Database searches  123

[Return]  686
Returning Values  687, 688

-ReturnField  123
Limiting returned fields  125

RPC  466
RPC.LassoApp  646, 674, 696
[Run_Children]  686

Defining container tags  695
RX  120, 159

S
Scheduled Events  43
Scheduling Events  558
Schema  465, 466
[Schema_Name]  195
[Scientific]  373
Scientific Notation  367

Scope  537
Scripts

Executing a Script  190
FileMaker Pro  189

-Search  115
Inline Action  93
Requirements  118

[Search_Arguments]  99
[Search_Arguments] … [/Search_Arguments]

Displaying search arguments  101
[Search_FieldItem]  99
[Search_OperatorItem]  99
[Search_ValueItem]  99
Security

Adding records  142
Command tags  117
Database searches  117
Deleting records  142
Duplicating records  142
Error codes  825
Violations  258

[Select]  237
Data type  237

[Selected]  163, 184
Displaying selected values  186

[Self]  706, 707
[Self->Parent]  706
Semaphore  575

Controlling access to a resource  575
[Serialize]  550
Series  387
[Server_Port]  633
Server Push  628
[Server_Push]  628
[Server_SiteIsRunning]  569
[Server_SiteStart]  569
[Server_SiteStop]  569
Server Tags  632
Serving PDF Files  512
Serving PDF Files to Client Browsers  513
-Session  252
[Session_Abort]  252
[Session_AddVariable]  252
[Session_DeleteExpired]  252
[Session_End]  252
[Session_ID]  252
[Session_RemoveVariable]  252
[Session_Result]  252
Sessions  251, 279

Adding variables  254
Deleting  255
Example  255
Removing variables  255
Starting a session  253
Tags  252
Using cookies  254
Using links  254

[Session_Start]  251, 252
Parameters  253

[Set]  412
Set  411

Member Tags  412
SET MySQL Data Type  163
Sets  387
SGML  466
-Show  240
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Listing fields  106
Listing required fields  107
Requirements  105
Showing database schema  104

[Shown_Count]
Displaying the current shown count  102

Simple Object Access Protocol  639
[Site_AtBegin]  568
[Site_ID]  568
[Site_Name]  568
[Site_Restart]  568
-SkipRecords  110, 123
[SkipRecords_Value]  99
[Sleep]  700
[Sleep]  560
Smart HTML Encoding  247
SMTP  602
[Sort_Arguments]  99
[Sort_Arguments] … [/Sort_Arguments]

Displaying sort arguments  101
-SortField  123

Sorting FileMaker Pro results  177
[Sort_FieldItem]  99
Sorting

Arrays  398
Sorting Links  129

Inline Lasso  137
Sorting Records

FileMaker Pro  177
-SortOrder  123
[Sort_OrderItem]  99
-SortRandom  123, 160
Specifying Paths  46
-SQL  109
SQL

Encoding  248
SQL injection  109, 111
SQL Server

XML templates  481
SQL Statements  109
Square Brackets

Converting to LassoScript  57
SSL  615
[Stack]  414
Stack  414

Member Tags  414
Stacks  387
Standard Generalized Markup Language  466
Startup Actions  43
Startup.LassoApp  674
Statement Only Inline  91
Storage Array  389
Storage Types  39
[String]  332
[String]  213
[String_FindRegExp]

Examples  357
[String_ReplaceRegExp]

Examples  356
Strings  72, 331

Assignment  333
Automatic casting  332
Casting values to string  332
Comparisons  335
Concatenation  334
Converting case  338

Converting to an array  344
Deleting a substring  334
Expressions  77
Extracting part of a string  340
Finding regular expressions  357
Joining an array  394
Lenth  340
Manipulation tags  337
Repeating a string  334
Replacing regular expressions  356
Splitting a string into an array  390
Symbols  78, 333

[String->Split]
Creating an array  390

Style Sheets  475
Submitting Form Data to Lasso-Enabled Databases  

501
Substitution Tags  62

Defining  687
Encoding  246
Module code  767
Module walk-through  768
Operation  766
Tutorial  767

Sub-Tags  76
Symbols  75, 217

Assignment  218
Boolean  244
Math  365
Overloading  715, 718, 720
Strings  333
# symbol  229, 693

Synonym  69
Syntax  61
Syntax Coloring  586
Syntax Errors  257
System.ListMethods  635
System.MethodHelp  635
System.MethodSignature  635
System.MultiCall  635

T
-Table  279
Table Batch Change  279
[Table_Name]  99
[Table_RealName]  105
[Table_RealName]  110
Tables

Listing available tables  106
Listing fields  106
Required fields  107

[Tag->asAsync]  580
[Tag->asType]  580
Tag Data Type  579

Member tags  580
Running a tag  580

[Tag->Description]  580
[Tag->Eval]  580

Evaluating compound expressions  59, 582
[Tag->Invoke]  580
[Tag->Run]  580

Parameters  580
Running compound expressions  59, 582

[Tags]
Finding tags  579

Tags
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Categories and naming  67
Naming conventions  68
Synonynms and abbreviations  69

[Tags]  563
Tag Types  62
[TCP_Open]  457
[TCP_Send]  461
Templates

XML  481
Test.Echo  635
Text Format Files  39
Text Formats  44
Third-Party Namespaces  538
[Thread_Abort]  572
[Thread_Atomic]  228, 571
[Thread_Event]  577

Member Tags  577
[Thread_Event->Signal]  577
[Thread_Event->SignalAll]  577
[Thread_Event->Wait]  577
[Thread_Exists]  572
[Thread_GetCurrentID]  572
[Thread_GetPriority]  572
[Thread_Info]  572
[Thread_List]  572
[Thread_Lock]  574

Member tags  574
[Thread_Lock->Lock]  574
[Thread_Lock->Unlock]  574
[Thread_Pipe]  577

Member Tags  577
[Thread_Pipe->Get]  578
[Thread_Pipe->Set]  577
[Thread_RWLock]  574

Member tags  576
[Thread_RWLock->ReadLock]  576
[Thread_RWLock->ReadUnlock]  576
[Thread_RWLock->WriteLock]  576
[Thread_RWLock->WriteUnlock]  576
[Thread_Semaphore]  574
[Thread_Semaphore->Decrement]  575
[Thread_Semaphore->Increment]  575
[Thread_SetPriority]  572
[Thread_Semaphore]

Member tags  575
Thread Tools

Communications  576
Controlling access to a resource  574, 575, 576
Events  577
Lock  574
Pipes  577
Processing messages  578
Read/write lock  576
Semaphore  575
Waiting for a signal  577

Time  374
Time Zone  374
Tokens  96
[Token_Value]  99
Transient  706
Transient Member Tags  710
Transient Variable  708
Tree Map  417

Member Tags  417
[TreeMap]  417
Tree Maps  387

Trigonometry  372
True  243

U
UCS Transformation Format  31
Unicode  30, 40, 116, 142, 629
-Unique

Returning unique field values  126
Unique ID  588
Universal Character Set  31
Unknown Tag Callback  714
-Update  141

Requirements  146
Updating Records  146

Classic Lasso  142
Security  142
Updating several records  149
Using an HTML form  147
Using a URL  148
Using inline tags  147

Upgrading
Email command tags  591

Uploading Files  620
Upper Case

Strings  338
URLs  28, 219

Action.Lasso  96
Actions  41
Adding a record  145
Encoding  247
Executing a FileMaker Pro script  190
Format files  95
Link Tags  131
Parameters  34, 220
Response tags  95
Syntax  58
Updating a record  148

-UseLimit  123, 160
Use MySQL 4.1 Character Sets  279
-Username  117
Using Fonts  492
UTF-8  29, 30, 40, 116, 142, 279, 629

V
Validation Tags  587
[Valid_CreditCard]  588
[Valid_Email]  588
[Valid_URL]  588
[Value_List] … [/Value_List]  163, 184
[Value_ListItem]  163, 184

Displaying selected values  186
Value Lists  163, 184

Creating a pop-up menu  185
Creating radio buttons  186
Displaying all values  185
Displaying selected values  186

[Var]  223
[Var_Defined]  223
[Variable]  223
[Variable_Defined]  223
Variables  208, 223

Accessing in asynchronous tags  699
Checking  225
Creating  208, 224
Local  693
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Page  693
Returning data types  214
Returning the type of a variable  562
Returning values  209, 224
Server-side  251
Setting  209, 225

[Variables]  563
[Var_Remove]  223

W
WAP  652

Tags  655
[WAP_IsEnabled]

Checking to see if current browser is WAP enabled  
655

Web Application Servers  36
Web Browsers  28

Authentication  32
Cookies  31

Web Companion  168
Web Servers  33

Connectors  45
Errors  257

Web Serving Folder
Serving LassoApps  675

[While]  242, 243
Wireless Application Protocol  652
Wireless Devices  652
Wireless Markup Language  466, 652
WML  466, 652

Encoding  654
Example  655
Formatting  652, 653
Forms  654
Links  653
Output formats  44
Serving  653

X
XML  465, 466

Attributes  469
Children  469, 472, 474
Contents  469
Customizing templates  483
Data type  466
Descendants  474
Document type definition  465
Encoding  247, 480
Extracting tags using an XPath  472
Extracting tags using XPath  473
Format files  39
Formatting  480
Member tags  467, 476, 477, 478
Output formats  44
Parameters  472, 474
Root tag  472
Schema  465
Serving  479
Templates  481
Transformations  475
Wireless Markup Language  652
XPath  465, 469

[XML_Extract]  470
XML-RPC  465, 466, 696

Built-in data types  636

Built-in methods  635
Calling a remote procedure  634
Calling multiple methods  635
Calling remote procedured (low-level)  636
Custom Tags  637, 649
Data Type  636
Listing available methods  635
Naming conventions  684
Processing incoming requests  637, 649
Processing tags  638

[XML_RPCCall]  634
[XML_Serve]  479

Serving WML  653
[XML_Transform]  475
XPath  465, 466, 469

Conditional expressions  473
Extracting XML Tags  472, 473
Simple expressions  471

XSL  466
Transforming XML data  475

XSLT  466, 475
XSL Transformations  466
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